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Preface

Félicitations!

Avec Logic Audio Pro ISIS, vous avez choisi l’un des systèmes 
de production musicale les plus puissants disponibles actuelle-
ment. depuis sa mise en vente, un grand nombre de hits et de 
bandes son de films ont été produits grâce à Logic Audio, dont 
la plupart vous sont familiers. de nombreux grands producteurs 
à travers le monde concidèrent Logic Audio pour sa grande 
résolution temporelle Midi, sa grande habilité à s’adapter à des 
styles de travaux spécifiques et bien sûr son haut niveau de 
disponibilité dans les systèmes configurés professionnels.

Comme nouvel utilisateur de Logic Audio Pro ISIS, ne soyez 
pas intimidé par l’immense fonctionnalité de ce programme. 
Vous serez sans doute réconforté de savoir que même les utili-
sateurs habitués depuis longtemps à Logic Audio découvrent 
constament de nouvelles possibilités dans ce programme. Tout 
d’abord, prenez le temps de lire le manuel d’introduction 
annexe. puis, si le temps le permet, nous vous recommandons 
de lire au moins le chapitre «Utilisation de Logic» qui vous 
fournit d’excellentes bases pour travailler confortablement 
avec LA Pro ISIS le plus rapidement possible. Dans les semai-
nes suivantes, alors que vous utilisez de plus en plus le 
programme, vous devriez alors vous reporter aux diverses 
sections de ce manuel qui vous concernent plus particulière-
ment.

Nous désirons remercier plus particulièrement nos utilisateurs 
de toujours qui sont passés à LA Pro ISIS 3.6 pour leur futures 
supports. Votre retour incroyablement positif est un facteur 
majeur dans notre motivation à maintenir LA Pro ISIS au fait 
de la technologie de la production musicale.

Nous espérons que vous obtiendrez une grande satisfaction et 
que vos compositions remporteront un franc succès!
Votre équipe Emagic

Février 1999
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Chapitre 1

Utilisation de Logic

Ce chapitre résume les fonctions d’utilisation générales de 
Logic. Mais avant tout, quelques mots à propos de ce manuel.

1.1 Conventions de ce manuel

Fonctions de menu

Les fonctions de menu sont écrites en caractère gras: Fonction.

Si le texte traite de fonctions qui peuvent être atteintes via les 
menus hierarchiques, les différents niveaux de menu sont 
donnés ainsi: Menu > Choix du menu > Fonction.

Raccourcis Clavier

Quand une fonction peut être effectué par un raccourci clavier 
du même nom, vous verrez ce symbole à côté du texte. Si les 
noms sont différents, ou si  une fonction n’est accessible que 
par un raccourci clavier, son nom sera imprimé comme 
ceci:raccourci clavier.

Tous les raccourcis clavier de Logic sont accessibles  avec des 
commandes midi (pour plus d’informations, voir le paragraphe 
«Raccourcis clavier et commande à distance via MIDI» à la 
page 1 - 38).

Options et paramètres

Les options réglables dans Préférences ou dans song settings, et les 
paramètres dans les boîtes de dialogue sont imprimés ainsi: 
Paramètres.
1 - 1
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Termes anglais

Certains termes de ce manuel resteront en anglais, pour la 
bonne et simple raison qu’ ils sont couramment utilisés ainsi, ou 
bien qu’il est bien plus aisé de les employer dans cette langue 
afin de simplifier la compréhension des interfaces et de leur 
utilisation. Ces termes sont imprimés en italique.

Explications détaillées

& Parfois des explications détaillées seront données pour des fonctions que vous n’avez  
pas forcément besoin de connaître pour comprendre comment utiliser Logic. Ces 
explications sont imprimées avec cette petite police.

1.2 La Souris

Fonctions de base
Si ce n’est pas précisé, c’est le bouton gauche de la souris que 
vous utiliserez lorsque le terme «bouton de la souris» est 
employé.

Cliquer

Placez le pointeur de la souris sur l’objet (bouton, champ 
d’action, etc.) et appuyez une fois sur le bouton de la souris.

Double-cliquer

C’est comme cliquer sur un objet, mais il faut appuyer deux fois 
de suite, assez rapidement. Vous pouvez régler la vitesse du 
double-clique dans les contrôles du système.

Attraper ou saisir

Même chose que pour cliquer sur un objet sauf qu’il faut main-
tenir le bouton de la souris enfoncé.
1 - 2
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Bouger ou tirer (draguer)

Attrapez l’objet et bougez la souris (en maintenant le bouton de 
la souris enfoncé) jusqu’à la position désirée.

L’action de la souris

Boîtes (ou cases) de validation (checkbox)
Ces cases sont des carrés qui sont actifs quand vous cliquez 
dessus pour activer une option (ou une fonction). Cliquez  
dessus à nouveau pour désactiver l’option.

Menus déroulants
Les menus déroulants s’ouvrent quand vous attrapez certains 
boutons ou champs d’action. Vous choisissez une commande en 
emmenant la souris dessus. Si vous voulez choisir une 
commande qui n’est pas dans la sélection visible,

• emmenez la souris jusqu’au bord supérieur ou inférieur du 
menu; la vitesse du défilement augmente si vous poussez la 
souris plus loin que le bord.

• maintenant cliquez en utilisant le bouton droit de la souris. 
Vous pouvez maintenant relâcher les deux boutons.

La souris pour changer des paramètres
On peut changer quasiment tous les paramètres numériques, 
(même les valeurs des notes hauteur, vélocité, etc) en attrapant 
le paramètre et en bougeant la souris vers le haut ou le bas. Si le 
paramètre est constitué de plusieurs chiffres (par exemple la 
position dans la song), vous pouvez changer chaque numéro 
individuellement.
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Utilisation de la souris pour l’incrémentation et la 
diminution
Tous les paramètres que vous pouvez changer avec la souris en 
la faisant glisser vers le haut ou le bas  peuvent également être 
augmentés ou diminués de façon unitaire en cliquant sur la 
moitié supérieure ou inférieure du paramètre avec le bouton 
gauche ou droit de la souris tout en maintenant enfoncée la 
touche A.

Entrée de valeurs numériques
En double-cliquant sur un paramètre numérique vous faites 
apparaître un champ d’entrée de données. La valeur précé-
dente apparaît pré-sélectionnée (en surbrillance) et permet 
d’écrire par dessus avec une nouvelle donnée. Vous pouvez 
également utiliser la souris  pour sélectionner une partie d’un 
champ d’entrée de données pour que seule la partie en 
surbrillance soit remplacée (pour plus d’informations sur ce 
sujet allez à la section paragraphe «Entrée de valeurs numéri-
ques» à la page 10 - 7).Tant que le champ d’entrée de données 
est ouvert, les touches ne servent qu’à entrer des données et ne 
peuvent servir comme raccourcis clavier (les exceptions étant 
les fonctions des menus principaux).

…avec l’arithmétique

A n’importe quel  moment vous pouvez entrer des chiffres en 
tapant une opération arithmétique par ex. «+2» ou «-5», ce qui 
change la valeur précédente de cette valeur.

…en symboles ASCII

Vous pouvez également entrer des chiffres en symboles ASCII: 
placez un ’ ou " devant, et le code ASCII sera validé comme un 
chiffre par ex:
1 - 4
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Cette fonction est particulièrement utile pour entrer du texte 
dans des lignes de commande SysEx.

Entrer du texte
Vous entrez du texte de la même façon que des chiffres mais il 
suffit de cliquer une seule fois dans les champs d’action pour 
pouvoir écrire.

Les outils et la boîte à outils
Logic permet de manier graphiquement des données enregis-
trées. Ce qui veut dire que vous n’avez pas besoin d’effectuer 
des opérations en rentrant des commandes avec des chiffres, 
mais plutôt en manipulant des «objets» graphiques.

Quand vous éditez des objets graphiquement, vous avez 
toujours deux outils disponibles à la position du pointeur de la 
souris: l’un est déjà actif, l’autre est activé par le bouton droit de 
la souris.

Vous changez d’outil actif en cliquant sur la boîte à outils. Le 
pointeur de la souris prend alors la forme de l’outil que vous 
avez sélectionné pour que puissiez savoir sa fonction en regar-
dant son symbole: L’outil gomme sert à effacer, l’outil ciseaux à 
couper et l’outil colle a coller/mélanger. Pour assigner un outil 
au bouton droit de la souris cliquez sur l’outil désiré dans la 
boîte à outil (toolbox) avec le bouton droit de la souris.

L’image ci-dessous représente une boîte à outils artificielle qui 
contient tous les outils de Logic. Vu que vous n’avez pas besoin 
de tous les outils dans toutes les fenêtres, lesBoîtes à outils dans 
les divers fenêtres contiendront une sélection appropriée des 
outils montrés ici.
1 - 5
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Champ d’application des outils
• Les outils ne sont effectifs que dans la zone de travail de la 

fenêtre duquel ils ont été sélectionné (vous pouvez  définir 
des outils individuels pour chaque fenêtre ouverte).

• Un outil a un effet sur les objets sur lesquels vous cliquez. Si 
l’objet sur lequel vous cliquez est déjà sélectionné, alors 
l’outil aura un effet sur tous les autres objets sélectionnés.

Montrer/Cacher la boîte à outils
La boîte à outils peut être cachée dans les fenêtres arrangeur et 
éditeur de partition pour économiser de la place, ce qui peut se 
révéler très utile si vous n’avez qu’un petit moniteur. La fonc-
tion se trouve dans View > Hide/Show Toolbox.

Ouverture de la boîte à outils à la position de la souris

Utilisez Show Tools (par défaut: ™) pour ouvrir une boîte à 
outils à la position de la souris.

Ligne du haut Ligne du bas

Pointeur Main

Crayon Gomme

Ciseaux Outil Colle

Marqueur Texte Crosshair

Pointeur de Mise en page Outil Midi thru

Outil Taille Séparateur de voix

Loupe Quantification

Solo Velocité

Mute
1 - 6
Emagic
Logic Audio Pro ISIS 
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Sélection des outils
Vous sélectionnez l’outil que vous voulez utiliser en cliquant 
dessus dans la boîte à outils (ou en cliquant tout en maintenant 
enfoncée le bouton droit de la souris pour utiliser l’autre outils).

Si une boîte à outils est ouverte à la place du pointeur, vous 
pouvez alors utiliser les touches numérotés pour choisir un outil 
à la position correspondante. Les outils sont toujours numéro-
tés de la gauche vers la droite et du haut vers le bas. Appuyez 
sur la touche Show Tools de nouveau pour revenir au pointeur, et 
fermer la boîte.

Déplacement jusqu’à l’outil suivant

Utilisez Set next Tool et Set previous Tool pour passer à l’outil 
adjacent dans la fenêtre du haut.

Ligne d’Information
Lors de l’utilisation de la plupart des outils une ligne d’info 
apparaît sur le bord supérieur de la fenêtre tant que le bouton 
de la souris reste enfoncé. Cette ligne d’info vous renseigne sur 
le type d’opération que vous effectuez.

Pendant des opérations qui concernent des objets arrangeur, la 
ligne aura l’aspect suivante:

De la gauche vers la droite, cela se lit ainsi:opération, position 
de la souris (ou position d’objet), nom d’objet, numéro de piste, 
et longueur de l’objet sélectionné. 

Pendant des opérations comprenant des évènements, la ligne 
ressemble à ceci:
1 - 7
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De gauche à droite, cela se lit: opération, position de la souris 
(ou événement), type d’événement, canal MIDI de l’événe-
ment, première information (la hauteur des notes), deuxième 
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information (vélocité des notes),et pour les notes: longueur de 
la note.

Les Outils

Pointeur

Le pointeur est l’outil par défaut. La souris prend cette forme 
en dehors de l’espace de travail lorsque vous êtes dans un menu 
ou lorsque vous saisissez une valeur. A l’intérieur de l’espace de 
travail, le pointeur est utilisé pour sélectionner (en cliquant sur 
des objets), pour bouger (en attrapant et en déplaçant), pour 
copier (en maintenant la touche ç enfoncée et en déplaçant), 
et pour éditer des longueurs (en attrapant le coin inférieur droit 
et en déplaçant). Attraper et déplacer n’importe où sur l’arrière 
plan ouvre un «lasso» (voir page 1 - 25)

Crayon

Le crayon est utilisé pour ajouter de nouveaux objets. Vous 
pouvez également sélectionner, déplacer et changer la 
longueur des objets.

La gomme

La gomme efface des objets en cliquant sur ces derniers. Lors-
que vous cliquez sur un objet sélectionné, tout ceux qui sont 
sélectionné à ce moment là seront effacés (comme si vous aviez 
utilisé la touche B). 

Outil Texte

L’outil texte est utilisé pour nommer des objets arrange ou pour 
ajouter du texte à un score. 

Ciseaux

Les ciseaux sont utilisés pour couper des objets, par exemple 
1 - 8
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avant de copier ou de déplacer des sections individuelles (voir 
page 3 - 19).
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Outil colle

L’outil colle fait le contraire des ciseaux: tous les objets sélec-
tionnés deviennent un seul objet qui prend le nom et position 
du premier des objets sur la ligne du temps (voir page 3 - 20).

Outil solo

Attraper des objets avec l’outil solo permet de n’écouter que 
ceux qui sont sélectionnés pendant la lecture. En bougeant la 
souris verticalement, tous les objets qui seront touchés par le 
curseur seront joués même quand le séquenceur est arrêté (voir 
le paragraphe «Solo de séquences» à la page 3 - 22)

Outil mute

Le fait de cliquer sur un objet avec l’outil mute l’empêche 
d’être joué et un point s’ajoute après le nom de l’objet pour 
indiquer qu’il ne sera pas joué. Vous pouvez le démuter en 
cliquant dessus à nouveau avec l’outil mute. Si plusieurs objets 
sont sélectionnés, le réglage de l’objet  sur lequel vous avez 
cliqué s’applique a tous les objets sélectionnés (voir aussi la 
paragraphe «Couper des séquences» à la page 3 - 21).

Loupe

La loupe permet de zoomer sur une section , jusqu’à la taille de 
fenêtre maximale. Pour revenir à la taille normale il faut cliquer 
sur le fond avec l’outil (pour plus de détails voir le paragraphe 
«Zoomer de manière sélective» à la page 1 - 14). Vous pouvez 
accéder a cette fonction à partir d’autres outils en maintenant 
enfoncée la touche A.

Le doigt

Le doigt est utilisé dans le Matrix Editor pour modifier la 
longueur des notes, et dans la fenêtre liste des marqueurs pour 
aller directement aux marqueurs et positionner les locateurs sur 
1 - 9
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la position du marqueur simultanément. 
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La croix

La croix (crosshair) est utilisée dans l’Hyper Editor pour saisir 
une série linéaire de valeurs de paramètres.

Outil Midi thru

L’outil Midi thru assigne l’instrument cliqué dans l’environne-
ment à la piste sélectionnée dans la fenêtre Arrange, ce qui en 
fait l’instrument Midi thru actif.

Outil de mise en page

L’outil de mise en page (Layout)est utilisé pour déplacer graphi-
quement des objets dans le Score Editor afin d’optimiser l’affi-
chage (par ex. changer les mesures en lignes: «formatage 
locale») sans pour autant altérer l’emplacement des évène-
ments MIDI.

Outil de taille

L’outil de taille (size)sert à ajuster la taille des éléments graphi-
ques dans le Score.

Séparateur de voix

Vous pouvez separer des voix polyphones dans le Score Editor 
en dessinant une linie à separation avec le séparateur de voix. 
Précondition: le Score Style polyphonique.

Outil de quantification (Q)

L’outil Q sert dans les éditeurs de notes pour quantifier les 
notes à la dernière valeur fixée.

Outil vélocité (V)

Dans les éditeurs de notes (Matrix et Partition), l’outil V sert à 
changer la vélocité des notes.
1 - 10
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1.3 Fonctions des fenêtres
Les fonctions de base des fenêtres dans Logic sont les mêmes 
que dans d’autres applications Windows. Cependant les 
options d’affichage dans Logic vont bien plus loin.

Dans Logic, vous pouvez ouvrir différentes combinaisons de 
fenêtres (même plusieurs du même type) et les arranger indivi-
duellement. Toutes les fenêtres ouvertes d’une song sont cons-
tamment remis à jour, ce qui veut dire que les fenêtres se 
remettent à jour suivant la position dans la song, et que des 
changements effectués dans une fenêtre se répercutent sur 
toutes les autres fenêtres avec lesquelles vous travaillez. Il est 
également facile de sauvegarder les différents arrangements de 
fenêtres appelés «screen sets», et de les rappeler avec une 
touche clavier.

Travailler avec des fenêtres

Ouvrir des fenêtres
Toutes les fenêtres de Logic peuvent être ouvertes avec le 
menu principal Window . Vous pouvez ouvrir la même fenêtre 
autant de fois que vous voulez.

Fermer des fenêtres
Pour fermer une fenêtre (A£) , cliquez sur l’icône fermer en 
haut à droite..

Remonter d’un niveau dans l’hiérarchie de l’affichage

 la boite noire sur la ligne menu à gauche vous emmène au 
prochain niveau d’affichage (pour plus d’informations, lisez le 
paragraphe «Changement du niveau d’affichage» à la page 3 - 
38).
1 - 11
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Régler la taille d’une fenêtre
Comme d’habitude avec Windows, vous pouvez changer la 
taille de la fenêtre en positionnant la souris sur un bord de fenê-
tre, ou sur un coin et en tirant.

Agrandir une fenêtre au maximum

Le bouton maximiser de Windows se trouve dans le coin supé-
rieur droit de la fenêtre et bascule la fenêtre entre la taille maxi-
male et sa taille précédente.

Réduire une fenêtre au minimum

En cliquant sur le bouton minimiser de la fenêtre, celle-ci 
prend sa taille minimale. Un double-clique sur une fenêtre 
minimisé lui redonne sa taille d’origine.

Sélectionner la zone de travail

Barres de défilement

Les barres de défilement sont situées sur la droite et en bas des 
fenêtres si  vous ne voyez qu’une partie de l’aire de travail sur 
l’axe verticale ou horizontale. 

Vous pouvez déplacer la partie visible soit en cliquant sur les 
flèches soit en attrapant la barre de défilement. Il y a deux 
choses à noter: 

• la taille du glisseur de défilement en fonction de la taille de 
la barre de défilement correspond à la taille de la section visi-
ble par rapport à l’ensemble du contenu de la fenêtre,

• quand vous bougez le glisseur, la partie visible change.

Elément X/Y 
1 - 12
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L’élément X/Y est situé dans le coin inférieur gauche. En 
l’attrapant en en le tirant vous bougez la sélection horizontale 
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et verticale de la fenêtre, comme si vous tiriez sur les deux 
barres de défilement simultanément.

Défilement de la page
Vous pouvez utiliser les touches Page Up, -Down, -Left and -Right 
pour vous déplacer d’une page vers le haut, le bas, à gauche ou 
à droite, comme si vous aviez cliqué dans la zone grise au 
dessus/en dessous de la barre de défilement verticale ou à 
gauche/à droite de la barre de défilement horizontale. Les 
touches Page Top, -Bottom, -Left most et -Right most emmènent la 
partie visible de l’aire de travail tout en haut, en bas, à gauche 
ou à droite comme si vous aviez attrapé un des glisseurs et que 
vous l’ayez déplacé jusqu’à l’une des extrémités.

Défilement jusqu’aux objets sélectionnés

Dans l’Arrange , l’Event List, l’Hyper Editor et le Matrix Editor, la 
fonction View > Scroll to Selection permet de déplacer la partie 
visible de la fenêtre jusqu’à la première série d’événements 
sélectionnés. Cette fonction existe en raccourci clavier dans la 
zone «Various sequence editors». Le raccourci clavier fonctionne 
dans la fenêtre active.

Zoomer
Les icônes zoom en forme de télescope qui sont en haut à 
droite dans la fenêtre servent à zoomer en avant en en arrière de 
l’aire de travail. En cliquant sur le côté gauche, le côté le plus 
petit, vous réduisez la taille des objets affichés, permettant ainsi 
de voir plus d’objets dans un même espace (zoom out), cliquer 
sur le côté droit agrandit les objets affichés (zoom in). 

Le télescope avec la flèche qui pointe vers le bas sert à zoomer 
sur l’axe vertical (Zoom Vertical In/Out, assignation par defaut: 
çU/çN), alors que celui avec la flèche qui pointe sur le 
1 - 13
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côté zoom sur l’axe horizontale (Zoom Horizontal In/Out, assi-
gnation par defaut:U/N). Dans certaines fenêtres, il n’y a 
qu’un télescope qui zoome sur les deux axes simultanément.
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Pendant les zooms, l’objet sélectionné le plus en haut à gauche 
reste dans la partie visible, tant que cela est possible.

Sauver et charger des réglages de zoom

Vous pouvez sauvegarder trois réglages différents du zoom pour 
chaque fenêtre en utilisant le raccourci clavier Save as Zoom 1-
3. Utilisez Recall Zoom 1-3 pour les faire revenir. Ces comman-
des concernent uniquement la fenêtre du haut.

Zoomer de manière sélective

Zoomer sur une partie de l’écran

Pour agrandir une partie de l’écran jusqu’à la taille de la fenêtre 
utilisez la loupe et tirez un lasso sur la partie que vous désirez. 
Vous pouvez le faire plusieurs fois.

Revenir au réglage précédent du zoom

Cliquez sur le fond avec la loupe. Ceci fera revenir le zoom à 
son réglage d’origine, en passant par toutes les étapes interme-
diares.

Vous pouvez obtenir la loupe avec n’importe quel outil (sauf le 
crayon) en maintenant appuyée la touche A. Le pointeur 
gardera l’aspect de l’outil précédent, mais si vous éffectuez un 
1 - 14
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lasso avec, il se comportera comme la loupe. 
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Eléments de la fenêtre

Régler la taille des éléments de la fenêtre

Si vous passez au dessus de coin supérieur gauche de la partie 
arrangeur avec la souris, le pointeur se transforme en crosshair. 
En le tirant vous pouvez maintenant changer la taille de la règle 
des mesures, de la partie arrangeur, la liste des pistes et les 
boutons de transport. Vous pouvez également arranger les 
éléments de fenêtre dans le Score Editor, l’Hyper Editor et le 
Matrix Editor en utilisant la même méthode.

Cacher/montrer les fonctions de transport

Utilisez View > Show Transport pour afficher ou pour cacher le 
panneau des boutons de transport du coin supérieur gauche des 
fenêtres Hyper, Matrix ou Arrange. Le nombre de boutons et 
d’indicateurs dépend de la quantité d’espace disponible.

Cacher/montrer les paramètres

La fonction View > Show Parameters (Hide/Show Parameters) 
vous permet d’afficher ou d’enlever la totalité de la zone à 
gauche des fenêtres arrange, environment, et autres fenêtres 
d’édition, qui contiennent les paramètres de la séquence, des 
instruments, et de la boîte à outils. En cachant ces paramètres 
vous gagnez de la place pour la fenêtre d’édition.

Dans beaucoup de fenêtres, vous pouvez cacher et/ou montrer 
d’autres éléments, comme la boîte à outils. Ces options d’affi-
chage sont toujours disponibles dans le menu View.
1 - 15
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Menus
Du fait de la grande étendue des fonctions de Logic, la plupart 
des menus ne se trouvent pas dans les menus principaux, mais 
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apparaissent comme des menus locaux. Ils se trouvent toujours 
dans les barres de menu dans les fenêtres de Logic où ils 
servent.

Menus hiérarchiques
Les menus s’utilisent (que ce soit des menus principaux ou 
locaux) de la même façon que dans d’autres applications: attra-
pez le titre du menu, emmenez la souris au dessus de la ligne 
désiré, et relâchez le bouton de la souris. Dans des menus 
hiérarchiques  il y a une flèche qui pointe à droite après la ligne. 
Si vous passez sur la ligne, un deuxième menu s’affiche à droite. 
Pour choisir une ligne dans ce deuxième menu, emmenez la 
souris à droite jusque dans le menu puis descendez jusqu’à la 
ligne désiré. Relâchez le bouton de la souris pour activer la 
fonction sélectionnée.

L’exemple précédent montre comment les menus hiérarchi-
ques seront expliqués: Structure > Track > Create New Instru-
ment.

L’utilisation d’un clavier
Vous pouvez également sélectionner le menu de la fenêtre  
1 - 16
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active en utilisant la touche A, et vous déplacer dans les 
menus comme d’habitude en utilisant les touches J et K (ou 
les touches de la machine à écrire pour les touches soulignées) 



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Fonctions des fenêtres

pour sélectionner celui que vous voulez. Puis vous utilisez les 
touches M etI pour sélectionner ce que vous voulez entrer 
dans le menu (ou valider tout de suite la fonction dans le menu 
en appuyant sur la touche qui est souligné dans le nom de la 
fonction du menu).

Si vous rencontrez une entrée hiérarchique (qui a un triangle à 
la fin de la ligne), vous pouvez utiliser la touche K pour accéder 
aux sous menus (la touche J ferme le sous-menu) et de 
nouveau M et/ou I pour faire votre choix.

Quand vous avez choisi votre fonction, tapez R pour l’activer.

Raccourcis clavier
Certains fonctions des menus sont accessible par des touches 
fixes ou des combinaisons de touches. Les touches (ou raccour-
cis clavier) sont inscrits sur l’écran à côté des entrées des menus 
et fonctionnent de façon globale. Par exemple, vous pouvez 
ouvrir une song avec ço, ou copier des données vers le 
presse papier (=Copy) via çc.

Veuillez noter que vous pouvez assigner quasiment n’importe 
quel fonction à n’importe quel touche dans la fenêtre raccourcis 
clavier.

Options menu avec «…» dans le titre
Trois points comme ceci:…, à côté du titre de fonction dans le 
menu indique que sa validation ne déclenche pas immédiate-
ment une fonction, mais ouvre une boîte de dialogue.

Boîtes de dialogue
Dans les boîtes de dialogue, vous pouvez valider le bouton avec 
la bordure épaisse en appuyant sur R, ou en cliquant avec la 
souris.
1 - 17
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bordure épaisse de bouton en bouton  avec les touches JK.
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Types de fenêtres
Il y a deux genres de fenêtres dans Logic: fenêtres normales et 
fenêtres flottantes. Le contenu de toutes les fenêtres apparte-
nant à la song en cours sont toujours remises à jour, peu importe 
le genre de fenêtre.

Fenêtres normales
Vous pouvez ouvrir autant de fenêtres normales que vous 
voulez, même plusieurs du même type. Bien que le contenu de 
toutes les fenêtres est constamment remis à jour, une seule 
fenêtre a le statut de «dessus» ou «active». C’est la fenêtre qui 
est au premier plan quand plusieurs fenêtres normales se 
chevauchent.

Fenêtre de «dessus» ou «active»

Cette fenêtre peut être reconnu par sa liste des titres qui n’est 
pas en demi-teinte. La caractéristique principale de cette fenê-
tre est que les raccourcis clavier n’affectent que cette fenêtre, 
et pas les autres. Window > Next Window (·) ramène la fenê-
tre suivante devant si elle est entièrement recouverte par les 
autres. Window > Previous Window (˜) ramène la fenêtre 
précédente à l’avant. 

Fenêtres en arrière plan

 Les fenêtres en arrière plan sont identifiables grâce à la couleur 
de leur barre de titre. Cette couleur est déterminé par votre 
réglage d’ Apparence dans Windows. Vous ramenez la fenêtre 
devant en cliquant dessus, en cliquant sur la barre des titres ou 
en ouvrant une fonction d’un des menus locaux.

Fenêtres flottantes
Les fenêtres flottantes s’appellent ainsi car elles «flottent» 
1 - 18
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toujours au premier plan, même devant  la fenêtre normale-
ment devant (s’il y a trop de fenêtres flottantes, elles se recou-
vriront inévitablement – vous n’avez qu’à cliquer dessus pour 
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les ramener devant). Les fenêtres flottantes se reconnaissent 
par leur barre de titre plus fine qui ne contient pas de nom. Les 
opérations à la souris peuvent être effectuées de la même façon 
que dans des fenêtres normales.

L’exemple de fenêtre flottante la plus courante est celle du 
transport. 

La fenêtre menu principal
La fenêtre menu principal a un statut spécial, et possède les 
caractéristiques suivantes:

• la ligne menu en haut de l’écran est toujours visible;
• elle ne recouvre jamais  les autres fenêtres Logic même 

quand elle est active;
• on peut toujours la rendre active (et vous pouvez ensuite 

accéder au menu principal avec les touches, en appuyant 
d’abord sur la touche A).

Vous pouvez garder cette fenêtre à sa taille maximale d’origine, 
mais en général ça ne sert pas à grand chose.

Le bouton «minimiser fenêtre» peut être utilisé pour passer de 
Logic à d’autres applications. Vous pouvez revenir à Logic 
quand vous voulez en cliquant sur l’icône Logic sur la barre des 
tâches.

Appuyez sur A† pour basculer entre Logic et d’autres 
applications.

Relations entre fenêtres
Les deux boutons en haut à gauche d’une fenêtre (ci-contre), 
déterminent sa relation par rapport à la position dans la song 
(attraper), ou par rapport aux autres fenêtres (lien, montrer 
contenu, ou attraper contenu.
1 - 19
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Attraper
La fonction attraper veut dire que la partie visible d’une fenê-
tre suit toujours la position dans la song pendant qu’elle joue. 

Si le bouton avec l’homme qui marche est allumé (s’il est vert), 
alors l’affichage de la fenêtre suivra la position dans la song 
pendant qu’elle joue. Si le bouton n’est pas allumé, l’affichage 
ne se remet pas à jour, même quand la ligne de position passe le 
côté droit de la partie visible de la fenêtre (Catch Clock Position).

Eteindre automatiquement la fonction attraper

Si vous bougez manuellement la partie visible, Attraper est 
automatiquement éteint, pour ne pas que la nouvelle partie 
que vous venez de sélectionner ne disparaisse pas quand l’affi-
chage est remis à jour à la position de la ligne de position.

Attraper automatique

La fonction Enable Catch when Sequencer starts (File Preferences 
> Global) fait en sorte que la fonction attraper soit toujours 
allumé quand vous appuyez sur lecture ou pause.

Lien, montrer contenu, et attraper contenu
Vous pouvez régler ces options d’affichage pour maîtriser 
comment l’information est affichée quand vous travaillez avec 
fenêtres éditeurs associées.

Lien

Lorsque le bouton avec le lien en forme de chaîne est activé 
(quand il est bleu clair), cette fenêtre affichera toujours la 
même chose que celle du haut. L’affichage est toujours ajusté 
quand la sélection  dans la fenêtre du haut change).

Voici un exemple: imaginez que la fenêtre du haut est un 
éditeur. Dans le mode lien (link), les autres fenêtres éditeurs 
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événements comme fenêtre à l’arrière plan d’une fenêtre 
arrange pendant que vous êtes en mode link).

Voici un autre exemple, qui utilise la fenêtre environnement; la 
fenêtre du haut est la fenêtre arrangeur. En mode lien, la fenê-
tre environnement affichera l’instrument qui correspond à la 
piste sélectionnée dans la fenêtre arrange. Pendant que vous 
changez de piste dans la fenêtre arrange, la fenêtre environne-
ment se remettra à jour pour tenir compte de la sélection.

Lien contenu

En double-cliquant sur le bouton lien (bleu foncé) vous activez 
le mode "Attraper Contenu". Ce qui veut dire que la fenêtre 
montre toujours le contenu de l’objet sélectionné dans la fenê-
tre du haut. L’affichage est donc toujours  inférieur d’un niveau 
à la fenêtre du dessus.

Voici un exemple: si la fenêtre du dessus est une fenêtre arran-
geur, dans le mode lien contenu les fenêtres de l’éditeur 
peuvent montrer les évènements d’une séquence sélectionnée. 
Si vous sélectionnez une séquence différente dans la fenêtre 
arrangeur, alors l’affichage de l’éditeur associé se calera égale-
ment sur cette séquence.

Vous pourriez aussi utiliser le mode Lien Contenu dans une 
fenêtre arrangeur pour afficher le contenu des dossiers dans une 
autre fenêtre arrangeur.

Attraper Contenu

En allumant simultanément Attraper et Lien Contenu, vous 
activez le mode Attraper Contenu. Au départ c’est l’équivalent 
du mode Lien Contenu, mais quand la position de la song 
arrive à l’objet suivant sur la même piste, le contenu de cet 
objet est affiché

Vous pourriez utiliser ce mode dans une fenêtre arrangeur, 
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éditeurs afficheraient du coup les événements de la séquence 
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Screensets
Normalement vous placez vos fenêtres sur l’écran d’une façon 
qui convient à votre façon de travailler. Cette disposition, avec 
divers fenêtres, ayant toutes leurs propres paramètres (affi-
chage, zoom, position de chaque fenêtre) s’appelle un screenset, 
et peut être sauvegardé. Vous pouvez ensuite changer de screen-
set comme vous changeriez de moniteur

Sauvegarder un screenset
Les screensets sont numérotés se 1 à 99 en n’utilisant que les 
chiffres de 1 à 9. Vous pouvez voir le nombre du screenset en 
cours d’utilisation dans le menu principal à côté du mot 
Window.

Vous n’avez pas besoin de sauvegarder vos screensets avec une 
commande précise. Cela se fait automatiquement dès que vous 
passez à un autre screenset. Ainsi sans effort, votre vue en cours 
est toujours sauvegardé sur le screenset en cours.

Changer de screenset
Tapez simplement le numéro du screenset désiré (1-9). Pour des 
screensets à deux chiffres maintenez la touche S pendant que 
vous tapez le premier chiffre.

Protéger les screensets
Utilisez le raccourci clavier Lock/unlock current screenset pour 
empêcher  le screenset en cours d’être modifié. Un # apparaît 
devant son numéro. Répétez le raccourci-clavier  pour déve-
rouiller le screenset.

La commande New Song désactive tous les verrous des screensets.
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Pour copier le screenset en cours, maintenez la touche ç 
pendant que  vous changez de screenset.
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Copier des screensets entre les songs

Fermez toutes les fenêtres que vous voulez copier dans le 
screenset, changez de song et ouvrez de nouveau les éditeurs. Ils 
ont gardé la taille et la forme qu’ils avaient pour le song précé-
dent.

Ceci est du au fait que les valeurs pour les positions des fenê-
tres, leur taille et toutes les autres paramètres pertinents, sont 
stoqués dans la mémoire quand vous fermez une fenêtre 
manuellement, pour que les paramètres restent les mêmes la 
prochaine fois que des fenêtres de même genre sont ouvertes.

Revenir à un screenset sauvegardé
La commande ›Revert to current screenset‹ rend à l’écran l’aspect 
qu’il avait au dernier screenset chargé.

Changements gérés par le séquenceur
Vous pouvez changer de screenset automatiquement en utilisant 
l’événement meta #49, vous n’avez qu’à le rajouter à une 
séquence dans l’Event Editor.

• positionnez vous à l’endroit dans le song où vous aimeriez 
que le sreenset change.

•  cliquez avec le bouton droit de la souris dans l’Event Editor 
sur le bouton montré. Le meta inséré a comme valeur de 
défaut 50 (Song Select).

• changez le chiffre dans la colonne NUM de 50 à 49. Le nom 
devient Screenset.

• Ientrez le numéro de screenset désiré dans la colonne 
d’entrée de données (VAL).

vous pouvez arrêter ce changement en coupant(mute) la 
séquence qui contient l’événement meta 49.
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1.4 Techniques de sélection
Lorsque vous voulez utiliser une fonction sur un ou plusieurs 
objets, vous devez tout d’abord sélectionner le(s) objet(s). Ceci 
s’applique aux objets dans l’arrange ou dans l’environment, et 
également aux événements individuels . Les objets sélection-
nés sont affichés en couleur inverse, ou clignotent (dans le Score 
Editor).

Le statut de sélection d’un objet s’applique à toutes les fenê-
tres. Un objet sélectionné dans une fenêtre le sera dans toutes 
les autres fenêtres qui affichent cet objet. Le fait de changer la 
fenêtre de dessus ne joue pas sur la sélection (tant que vous ne 
cliquez pas sur le fond, ce qui désélectionne tout. Cliquez bien 
sur la barre de titre de la fenêtre).

Sélectionner des objets individuels
Des objets individuels peuvent être sélectionnés en leur 
cliquant dessus, et désélectionné en cliquant sur le fond, ou en 
sélectionnant un autre objet.

Vous pouvez également utiliser les raccourcis clavier Select next/
previous Object (par défaut: K/ J, dans l’Event List: M/ I). Select 
first/last sélectionne le premier/dernier objet dans le niveau 
d’affichage en cours.

Sélectionner alphabétiquement 

La touche T sélectionne le prochain objet dans l’ordre alpha-
bétique. Dans les fenêtres arrangeur ou environnement vous 
pouvez appuyer sur n’importe quel touche (lettre) et l’objet 
sélectionné sera le premier objet dont le nom commence par 
cette lettre , sauf si une fonction a déjà été assigné à cette 
touche.
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Sélectionner plusieurs objets
Pour sélectionner plusieurs objets non adjacents, maintenez 
enfoncée la touche S pendant que vous cliquez sur les objets en 
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question. Comme des objets assez conséquents sont sélection-
nés ainsi, les sélections précédentes sont gardés en mémoire. 
Ceci fonctionne également avec l’utilisation de lassos horizon-
taux et verticaux.

Sélection horizontale

Pour sélectionner tous les objets d’une piste cliquez sur le nom 
de la piste dans la liste des pistes. De la même façon, vous 
pouvez sélectionner tous les événements avec une certaine 
définition d’événement dans l’éditeur Hyper, en cliquant sur le 
nom de définition de l’événement, ou toutes les notes d’une 
certaine hauteur dans l’éditeur Matrix en cliquant sur la touche 
correspondante sur le clavier à l’écran.

En mode boucle (cycle), tout ce qui a été dit au dessus ne 
concerne que la zone de boucle.

Sélection au lasso

Pour sélectionner des objets qui sont rapprochés, cliquez sur le 
fond et tirez un ›Rubber band‹ (lasso) au dessus d’eux.

Tous les objets touchés ou inclus dans sa zone seront sélection-
nés.

Basculer le statut de sélection

Lorsque vous faîtes une sélection (incluant le lasso et la sélec-
tion horizontale), en maintenant enfoncé la touche S vous 
inverserez le statut de sélection des objets.
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sélectionner tous les objets sauf quelques uns, sélectionnez 
d’abord ces quelques uns puis utilisez Toggle Selection.

Sélectionner des objets qui se suivent

Pour sélectionner tous les objets après celui qui est déjà sélec-
tionner (ou si aucun objet est sélectionné, pour sélectionner 
tous les objets après la position dans le song), choisissez Edit > 
Select all following.

Sélectionner des objets à l’intérieur des locateurs (Sélection
verticale)

Edit > Select inside Locators sélectionne tous les objets qui 
sont en totalité ou en partie à l’intérieur des locators.

Sélectionner des objets avec des chevauchements

Edit > Select overlapped Objects sélectionne tous les objets 
qui commencent après le fin (ou finissent après le commence-
ment) d’un autre objet.

Sélectionner des objets semblables ou identiques

Si vous avez selectionné un objet, vous pouvez selectionner des 
objets semblables avec la fonction Edit > Select Similar Objects 
ou des objets identiques avec la fonction Edit > Select Equal 
Objects.

Voir le tableau suivant:

Objet semblable identique

Controller Numéro de Controller 
identique, données de 
byte (valeur) quelconque

Numéro de Controller 
et données de byte 
(valeur) identiques

Notes Note identique,
octave quelconque

Note et octave iden-
tiques

Objets d’Environ- Type de l’objet identique Type de Fader identique 
1 - 26
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Sélectionner tous les objets
Pour sélectionner tous les objets, sélectionnez Edit > Select All 
ou appuyez sur ça.

Désélectionner tous les objets

Vous pouvez désélectionner tous les objets en cliquant sur le 
fond de l’écran ou en utilisant le raccourci clavier Deselect All.

1.5 Opérations d’édition
Les menus locaux d’édition dans les divers fenêtres de Logic 
prennent tous la même forme. Le premier item est Annuler. En 
dessous d’Annuler se trouvent les fonctions classiques copier 
coller et en bas de chacun se trouvent les principales comman-
des de sélection.

Undo
Undo (annuler) vous permet de défaire la dernière opération 
d’édition. Dans la page globale des Préférences, vous pouvez 
enlever le message d’alerte qui apparaît normalement quand 
vous activez Annuler, en cochant la case Disable safety alert for 
Undo box.

Le raccourci-clavier pour Annuler est toujours çz.

Le presse-papiers 
Le Clipboard (presse-papiers) est une partie invisible de la 
mémoire dans laquelle vous découpez ou copiez des objets 
sélectionnés afin de les coller dans une autre position.

Le presse-papiers garde sa mémoire au delà des songs, ce qui 
veut dire que vous pouvez vous en servir pour échanger des 
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Cut
Tous les objets sélectionnés sont retirés de leur position 
actuelle et sont placés dans le presse-papiers. Le contenu 
précédent du presse-papiers est effacé durant la manipulation 
(raccourci clavier: çx).

Copy
Une copie de tous les objets sélectionnés est placé dans le 
presse-papiers. Les objets sélectionnés restent à leur place. Ici 
aussi, le contenu précédent du presse-papiers est effacé 
(raccourci clavier: çc).

Paste
Tous les objets du presse-papiers sont copiés dans la fenêtre du 
dessus. Le presse-papiers n’est pas effacé dans la manipulation 
(raccourci clavier: çv).

Le contenu du presse-papiers est ajouté à la position actuelle 
de la song (si ce sont des évènements ou des objets arrangeur). 
La position dans la song est augmentée de la longueur des 
objets collés.

Dans la fenêtre Arrange, le contenu du presse-papiers est collé 
sur une piste sélectionnée. Si des évènements sont collés dans 
la fenêtre Arrange, soit une nouvelle séquence leur est créé, ou 
les évènements sont ajoutés à une séquence sélectionnée.

Tout objet qui existait auparavant demeure inchangé.

Dans la fenêtre Environment, les objets sont collés sur la couche 
affichée, à leur position originale.

Delete
Tout objet sélectionné est effacé. Delete Effacer n’a pas d’effet 
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1.6 Fonctions Générales des 
Editeurs

Ouvrir  un Editeur
Vous pouvez ouvrir divers éditeurs en double-cliquant sur des 
séquences dans la fenêtre arrange. Un double-clic avec le 
bouton gauche de la souris ouvrira le Score Editor. Un double-
clic avec le bouton droit de la souris ouvrira l’Event List Editor. 
Pour ouvrir le Matrix Editor, faîtes ç + double-clic avec le 
bouton gauche, et ç + double-clic avec le bouton droit ouvrira 
la fenêtre de l’Hyper Editor. Contrôle de la sortie via MIDI

Activer le bouton Midi Out permet d’envoyer les évènements 
MIDI à la sortie lorsqu’ils sont ajoutés, sélectionnés ou édités. 
Ceci vous permet un contrôle auditif de chaque stade de 
l’édition, que vous naviguiez dans l’Event List (sélection auto-
matique) ou que vous transposiez une note.

Fonctions de Défilement Automatique

… défilement jusqu’à la position du song

Le bouton avec la silhouette qui marche active la fonction attra-
per, ce qui veut dire que la fenêtre de visualisation sera toujours 
calée sur la position actuelle du song.

… défilement jusqu’à l’événement sélectionné

La commande-clavierScroll to Selection vous permet de déplacer 
automatiquement la fenêtre, afin que le premier des évène-
ments sélectionnés soit visibles.

Liens contenus
Pour activer la fonction Lien (link), cliquez sur l’icône avec la 
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content» . Dans ce dernier mode, la fenêtre affiche toujours le 
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le mode lien, la fenêtre montre les mêmes objets  que la fenêtre 
où vous faîtes des sélections. Pour une description complète 
des fonction attraper et lien, rendez-vous à la page 1 - 20.

Dans les fenêtres d’édition, la fonction "liens contenus" 
(Contents link) est habituellement active. Vous pouvez donc, par 
exemple, choisir des séquences dans la fenêtre Arrange et, lors-
que vous passez à un screensetpossédant une fenêtre d’édition 
ouverte, vous verrez le contenu de la (des) séquence(s) sélec-
tionnée(s).

Fonction de lecture Alternative
Dans toutes les fenêtres qui possèdent un axe du temps hori-
zontal (Arrange, Matrix,Score, Hyper et Sample) vous pouvez 
utiliser la commande globale Play from left window corner pour 
lire à partir du début de la partie visible.

Commandes de sélection & fonctions 
d’édition

Caler les locateurs sur les objets
La commande Functions > Set Locators by Objects vous 
permet de caler les locateurs dans toutes les fenêtres d’édition 
(comme dans la fenêtre Arrange) pour qu’ils encadrent les 
événements sélectionnés. Le raccourci clavier  se trouve dans la 
fenêtre Key Commands sous Global Commands.

Fonctions d’édition
Pour une description des fonctions d’annulation (Undo)et 
presse-papiers (clipboard) (en particulier: ajouter des événe-
ments au niveau Arrange), référez-vous à la page 1 - 27.
1 - 30
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Fonctions de transformation
Le processus de faire apparaître les valeurs des paramètres 
(d’origine ou les vôtres) dans la fenêtre Transform est décrit 
dans le paragraphe «Appeler des presets» à la page 14 - 13. Vous 
pouvez y accéder directement dans les éditeurs par la 
commande du menu local Functions > Transform ….

Répéter ou Copier des Evénements
Pour répéter des événements une ou plusieurs fois (avec un 
positionnement ajustable du premier événement répété), vous 
pouvez utiliser la fonction Edit > Repeat Objects comme décrit 
à la page 3 - 16.

Effacer des Evénements
Les techniques de base sont les mêmes que pour effacer des 
séquences:

• La touche B (delete) ou ∂ efface tous les événements 
sélections,

• L’outil Gomme efface également tous les événements sélec-
tionnés, et tous les événements sur lesquels vous cliquez 
(qu’ils soient sélectionnés ou non)..

Enregistrement Pas à Pas
L’ enregistrement pas à pas vous permet d’entrer des notes avec 
le clavier, mais sans qu’il y ait de tempo comme dans l’enregis-
trement en temps réel. Après que chaque note soit insérée, le 
séquenceur prend un «pas» dont la taille est déterminé par le 
réglage de division, dans la fenêtre Transport. Chaque note ou 
accord entré reçoit automatiquement la valeur de la note du 
format d’affichage, ou un multiple de celui-ci. L’entrée MIDI 
pas à pas est activé dans le Score Editor, dans l’Event List et dans 
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Voici comment faire: sélectionnez une séquence, ou créez en 
une dans l’Arrange avec l’outil Crayon. Ouvrez un des éditeurs 
de notes (Score, Event List or Matrix).

• activer le bouton Midi In.

• Jouez et tenez une note ou bien un accord. Vous pouvez 
jouer les notes de l’accord l’une après l’autre si vous le dési-
rez. Ce qui est important c’est qu’au moins une note reste 
enfoncée depuis le début.

• Relâchez la dernière note, et la chanson avance d’un pas (la 
valeur du format sur le Transport), et vous pouvez entrer une 
novelle note.

• Les silences sont rentrés avec la pédale de sustain. A chaque 
fois que vous appuyez dessus, vous avancez d’un pas égal à 
celui de la valeur du format, sans entrer une note.

• Vous pouvez entrer des notes ou des accords plus longues en 
appuyant sur la pédale de sustain pendant que vous tenez 
ces notes appuyés.

Vous pouvez modifier la valeur du format sur le Transport à 
n’importe quel moment, même lorsque vous appuyez sur une 
ou plusieurs notes.

L’enregistrement en pas à pas est possible avec l’affichage du 
score. Cependant la valeur de la quantification par défaut devrait 
être évitée, car sinon l’affichage des notes changera à chaque 
fois que la taille du pas est modifié.

Si vous enregistrez en pas à pas dans le Score Editor vous pouvez 
définir la valeur de la note en cliquant sur des notes dans la part 
box (seulement si l’enregistrement pas à pas est activé).

Commande au clavier
Lorsque vous utilisez l’enregistrement pas à pas, il y a quelques 
1 - 32
Emagic
Logic Audio Pro ISIS 

raccourcis clavier spéciaux non éditables qui ne peuvent être 
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pour une autre fonction (voir le paragraphe «Fenêtre Key 
Commands» à la page 1 - 40).

T ou V: comme pédale de sustain. (remarquez que la touche 
Vest la touche par défaut de la fonction Record Toggle. Si vous 
désirez utiliser la touche V pour avancer dans les pas, vous 
aurez tout d’abord à enlever cette assignationpar défaut; voir le 
paragraphe «Effacer des Assignations» à la page 1 - 41).

n emmène jusqu’à la prochaine division de la mesure; en 4/
4, ça signifie donc la noire suivante.

m passe à la mesure suivante.

b revient d’un pas en arrière et efface l’événement qui s’y 
trouvait.

a règle la valeur de division sur 1⁄4.

s règle la valeur de division sur 1⁄8.

d règle la valeur de division sur 1⁄16.

q règle la valeur de division sur 1⁄32.

w règle la valeur de division sur 1⁄64.

e la valeur actuelle de division passe à la valeur de triolet 
supérieure, par exemple de 1⁄16 à 1⁄24.

r la valeur actuelle de division passe à la valeur de triolet 
inférieure, par exemple de 1⁄16 à 1⁄12.

Ces raccourcis clavier continueront à ajouter ces valeurs tant 
que la touche contrôleur Midi reste enfoncée.

Aller à la Sélection
Le raccourci clavier Goto Selection déplace le SPL (pointeur de 
position du song) à la position du premier événement sélec-
tionné dans la fenêtre du dessus. 
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Edition par entrée MIDI
En double cliquant sur le bouton Midi In, vous activez le mode 
›Edit by Midi In ‹. Les valeurs des données MIDI qui sont 
entrées sont ensuite utilisées pour éditer la hauteur (›Pitch‹) et 
la vélocité (›Velocity‹) de la note sélectionnée. La longueur de la 
note demeure inchangée. Contrairement à l’enregistrement en 
pas à pas, il n’y a pas de création de données; ce qui existe déjà 
est simplement changé. Les commandes clavier Select Next / 
Previous Event permettent d’avancer ou de reculer d’une note.

Quantification d’Evénement
L’Event Editor possède une fonction de quantification indépen-
dante qui peut être appliquée à tous les événements sélection-
nés. Contrairement à la quantification pour les objets arrange, la 
quantification d’événements s’applique à tous les événements, 
pas uniquement aux notes. Cela change leur position de façon 
irréversible (seuls les notes peuvent revenir à leur positions de 
départ).

Quantifier des Evénements
Sélectionnez les événements que vous désirezez quantifier.

Le menu déroulant de quantification s’ouvre en attrapant le 
bouton ›Q‹ montré ici.

Il est identique au menu déroulant jumeau pour les paramètres 
de relecture, et contient sa propre grille de quantification (pour 
plus de détails, voir le paragraphe «Quantification» à la page 3 - 
31). Dès que vous choisissez un article dans le menu, tous les 
événements sélectionnés sont quantifiés.

Rappelez vous que seule la quantification de notes est réversi-
ble. Tous les autres événements sont transformés de façon irré-
versible.
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d’édition), sélectionnez Functions > Quantize again, ou bien 
cliquez rapidement sur le bouton ›Q‹ à nouveau.

Quantification de note
Normalement, toutes les notes dans une séquence sont quanti-
fiées en fonction du paramètre de quantification se trouvant 
dans la boite de paramètres de séquence et la boite étendue de 
paramètres de séquence (expliqué en détail dans le paragraphe 
«Quantification» à la page 3 - 31).

Pour quantiser des notes seules dans un des éditeurs de notes 
(Matrix ou Score) vous pouvez utiliser l’outil Q, et également la 
quantification d’événement.

Si vous cliquez sur une seule note (ou un groupe sélectionné) 
avec l’outil de quantification Quantize, et que vous maintenez 
enfoncé le bouton de la souris, le menu de quantification 
devrait s’ouvrir et vous pourrez choisir la quantification que 
vous désirez.

Si vous cliquez rapidement sur des notes, la dernière valeur de 
quantification sera réutilisée, comme avec la commande Quan-
tize Again.

Si vous cliquez sur l’arrière plan avec l’outil Q, vous obtiendrez 
le lasso pour sélectionner plusieurs objets à la fois.

remarque spéciale au travail dans la fenêtre Score: afficher 
valeur de quantification aura un effet sur la façon dont la quan-
tification fonctionne.

Annuler la quantification des notes
Les événements des notes peuvent retourner à leur position 
d’enregistrement d’origine, ou peuvent être déplacés à la main, 
en sélectionnant Qua off (3840),ou en cliquant sur le bouton Q 
tout en maintenant enfoncée la touche ç.
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Vous pouvez aussi déquantiser toutes les notes sélectionnées 
en cliquant dessus avec l’outil Q tout en maintenant enfoncée 
la touche ç.

Vous obtiendrez un résultat identique en sélectionnant la fonc-
tion Functions > De-Quantize.

Fonctions d’Affichage
Le paragraphe «Fonctions des fenêtres» à la page 1 - 11 décrit 
les fonctions fenêtres de base, avec entre autre, comment 
placer les fenêtres afin de gagner de la place pour l’affichage des 
événements dans les éditeurs graphiques, et comment utiliser 
les fonctions de zoom.

Beaucoup d’options d’affichage dans les fenêtres d’édition 
correspondent à celles dans la fenêtre Arrange:

En choisissant View > Parameters vous pouvez cacher ou 
montrer les champs de paramètres afin d’agrandir l’espace de 
travail de la fenêtre. La commande clavier est Hide/Show Para-
meters.

Dans le Matrix Editor et l’Hyper Editor , vous pouvez cacher ou 
montrer le panneau de transport dans le coin supérieur gauche 
en choisissant View > Transport.

Changer le Niveau d’Affichage
Normalement, les fenêtres d’édition se trouvent au niveau 
d’affichage le plus bas, qui montre les événements individuels. 
Cependant, en cliquant sur le bouton de la petite boîte noire 
qui se trouve dans le coin supérieur gauche de la fenêtre 
d’édition, vous pouvez remonter d’un niveau dans l’hiérarchie 
dossier/séquence. Par exemple, si vous êtes en train de regarder 
les événements d’une séquence dans un dossier, l’affichage 
basculera à une vue des séquences dans le dossier parent.
1 - 36
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Le Matrix Editor et l’Hyper Editor

Dans le Matrix Editor et l’Hyper Editor, ceci signifie que vous 
verrez une fenêtre Arrange. Dans ce cas,lorsque vous passez au 
niveau le plus bas, l’éditeur concerné réapparaît. A ce niveau 
Arrange, vous verrez les menus locaux du Matrix Editor ou du 
Score Editor, qui contiennent également toutes les fonctions de 
la fenêtre Arrange. En double cliquant sur une séquence, vous 
ouvrez l’affichage Hyper ou Matrix du contenu d’une séquence. 
Ce qui veut dire que vous pouvez passer rapidement à une 
autre séquence, et éditer son contenu.

Event List

En cliquant sur le bouton de la petite boîte noire qui se trouve 
dans l’Event List, vous pouvez remonter d’un niveau dans la 
hiérarchie, comme dans les autres éditeurs. Cependant, dans la 
l’Event List, la forme de l’affichage reste identique, mais au lieu 
d’une liste des événements individuels, vous voyez maintenant 
une liste des séquences avec leur position,leur nom, leur 
numéro de piste et leur longueur. La séquence que vous venez 
de quitter sera sélectionnée.
1 - 37
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Ici aussi un double-clic sur une séquence (ou en utilisant la 
commande clavier ›Go into Folder/Sequence‹) vous ramène au 
niveau d’affichage le plus bas, et montre le contenu de la 
séquence.

Score Editor

Dans le Score Editor, cliquer sur le bouton de la boîte noire, ou 
double-cliquer sur l’arrière plan vous amène au niveau d’affi-
chage le plus élevé. Contrairement aux autres éditeurs, des 
événements individuels peuvent être édités dans des niveaux 
d’affichage plus élevés avec le Score Editor. En double-cliquant 
sur une portée (à un endroit vide) vous revenez à un niveau 
d’affichage inférieur.

Ne vous inquiétez pas si tout ceci paraît un peu compliqué. En 
réalité, les changements de niveau sont faciles à comprendre, il 
suffit d’essayer par soi-même. Lisez d’abord puis expérimentez 
avec les différents éditeurs sur un des songs d’apprentissage.

1.7 Raccourcis clavier et 
commande à distance via 
MIDI

Vous pouvez activer presque toutes les fonctions de Logic avec 
des raccourcis clavier. C’est dans la fenêtre KeyCommands que 
vous assignez des raccourcis clavier aux touches, ou bien des 
commandes aux messages MIDI.

A chaque fois que ce manuel parle de commande clavier, il 
s’agit d’une commande qui peut provenir  d’un raccourci 
clavier(donc d’une touche ou bien d’une combinaison de 
touches) . Ceci vous permet de «customiser» Logic pour corres-
pondre à votre façon de travailler.
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Vos assignations de touches sont sauvegardées (avec les régla-
ges de la page préférences) dans un fichier appelé ›LA Pro 
ISIS.PRF‹ dans le dossier Windows de votre PC. Vous devriez:

• Faire une copie de sécurité de ce fichier à un autre endroit de 
votre disque dur;

• En faire une copie sur disquette au cas où vous auriez besoin 
d’utiliser Logic sur un autre ordinateur.

Lorsque vous installez des mises à jour de votre version de 
Logic, vos assignations pesonnelles resteront inchangées.

Touches Spéciales
Certaines touches ont des fonctions spéciales:

• Les touches de modification S, ç, et A  ne peut être 
utilisé qu’en combinaison avec d’autres touches.

• La touche backspace (D) a la fonction fixe ›delete selected 
objects‹. On ne peut lui assigner une fonction qu’en combi-
naison avec les touches de modification S, ç, et A .

• La touche £ (fermeture de fenêtre) et la combinaison de 
touches A£ (fermeture d’application) ne peuvent être 
asignées de nouveau.

• Les combinaisons de touches assignées aux options dans la 
barre du menu principal ne peuvent être réassignées. Les 
touches en question dont affichées après les items du menu 
principal.

• Les touches + et _ augmentent ou descendent d’une 
unité n’importe quel valeur de paramètre. Cependant on 
peut leur assigner différentes fonctions qui prendraient la 
place de celle-ci.

• Les touches T,n,m,b,a,s,d,q,w,e,r possèdent 
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Fenêtre Key Commands 
La fenêtre Key Commands peut être ouverte en sélectionnant 
Windows > Key Commands.

Toutes les commandes clavier sont sur une liste à droite. Elles 
sont regroupées suivant les catégories suivantes:

• comandes globales
• Fonctions qui affectent toutes les fenêtres (diverses fenê-

tres)
• Fonctions qui affectent toutes les fenêtres d’édition (divers 

éditeurs de séquence)
• Fonctions de la fenêtre Arrange 
• Fonctions de la fenêtre Environment 
• Fonctions du Score Editor (fenêtre Score)
• Fonction de l’Event List Editor (fenêtre Event)

Un ›Ø‹ devant le descriptif d’une fonction indique qui la fonc-
tion n’existe qu’en raccourci clavier ou en commande MIDI. A 
1 - 40
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gauche, vous voyez la touche actuellement assignée, et encore 
plus à gauche le message MIDI assigné. Une étoile à cet 
endroit indique qu’il n’y a pas encore eu d’assignement.
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Assigner une fonction à une touche
• Cliquez sur le bouton Learn Key .
• Sélectionnez la fonction désirée avec la souris.
• Appuyez sur la touche désirée, avec les touches modificatri-

ces (S, ç, et A) si cela est nécessaire.
• Si vous désirez effectuer une autre assignation répétez les 

étapes 2 et 3.
• Désactivez Learn Key!

Il est possible d’assigner la touche (Key) et la touche modifica-
trice avec les menus déroulants dans la boîte de paramètres (en 
haut à gauche).

Learn Separate Key

 la commande Learn Separate Key fonctionne de la même façon, 
mais diffère dans la mesure où ce n'est pas qu'une référence à 
un code ASCII qui est stocké, mais le véritable code de la 
touche qui est appuyée.

En pratique, ça veut dire que vous pouvez par exemple assigner 
des commandes différentes aux touches du pavé numérique et 
aux touches chiffrées sur la partie principale du clavier. La 
même chose est vrai en ce qui concerne les différentes touches 
›+‹ et ›-‹ sur le pavé numérique et sur la partie principal. Les 
seuls désavantages sont que le code de la touche (un chiffre) est 
affiché dans la fenêtre commandes clavier au lieu du symbole 
ASCII qui est plus pratique pour la consultation des raccourcis 
clavier.

Effacer des Assignations 
• Cliquez sur Learn Key, poue effacer un assignation de touche.
• Utilisez la souris pour sélectionner la fonction assignée à la 

touche que vous désirez effacer.
• Appuyez sur la touche D.
• Pour effacer d’autres assignations, répétez les étapes 2 et 3.
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Vérification de la fonction d’une touche
Désactivez Learn Key, et appuyez sur la touche dont vous voulez 
vérifier la fonction. La fonction sera automatiquement sélec-
tionnée, et affichée au milieu de la fenêtre.

Rendre l’Affichage plus clair
vous pouvez utiliser les boutons Hide Used et Hide Unused utilisé 
pour enlever les commandes desraccourcis clavier utilisées ou 
non-utilisées.

Toutes les autres fonctions de fenêtre en raccourci clavier 
restent à votre diposition.

Rechercher les raccourcis clavier
En raison du très grand nombre de possibilités de raccourci 
Clavier, il peut parfois se révéler difficile d’en trouver un en 
particulier. C’est pourquoi Logic offre la fonction Find , qui 
vous permet de chercher un raccourci clavier en tapant son nom 
(ou une partie).

Cliquez simplement sur l’espace blanc à droite du bouton Find 
et entrez quelques lettres de la fonction que vous cherchez. La 
fenêtre n’affichera que les Raccourcis Clavier qui contiennent  
ces lettres (plus la commande sélectionnée même si elle ne 
contient pas ces caractères.

La fenêtre Key Commands reste active, même en mode Find . 
Vous n’avez pas besoin de quitter ce mode pour continuer a 
assigner des touches.

La fonction Find n’est pas sensible aux Majuscules/Minuscu-
les, elle ne fait pas la différence.

Les boutons Hide Unused et Hide Used fonctionnent en conbi-
naison avec la fonction Find, vous devez donc désactiver les 
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Le bouton Find active ou désactive le mode Find. Ce bouton 
est automatiquement activé si une série de caractères est saisie.

1.8 Fonctionnes globales

Definir les couleurs
Dans la fenêtre Arrange et dans la fenêtre Environment , vous 
pouvez définir une couleur pour les objets (or sles symboles) 
sélectionnés. View > Object Colors (Open Object Colors) ouvre 
une palette de couleurs . sélectionner une seconde fois la 
commande clavier referme la palette.

Cliquez sur la couleur que vous désirez pour colorer tous les 
objets sélectionnés de cette couleur. 

Les séquences qui viennent d’être enregistrées prennent la 
couleur de leur Instument. La fonction View > Instrument 
Colors to Objects , colorie toutes les séquences sélectionnées 
de la même couleur que celle de l’instrument de piste.

Ceci peut se révéler particulièrement utile Lorsque vous 
copiez des séquences d’une piste à une autre. Cette fonction 
recoloriera les séquences copiées pour qu’elles aient la même 
couleur que celle de l’instrument de leur nouvelle piste.

Aide Online 
Logic possède une aide online: le fichier en question, ›LA Pro 
ISIS.HLP‹ est automatiquement installé, et doit se trouver 
dans Windows > Help folder.

Si vous sélectionnez Info > Help, LA Pro ISIS vous donnera une 
introduction et des renvois vers des instructions détaillées dans 
le manuel imprimé.
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Nous travaillons actuellement sur une aide détaillée pour 
toutes les fonctions de Logic. Restez à l’écoute…
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1.9 Gestion des Songs
Tous les événements, autres objets et réglages (sauf les Préfe-
rences et les raccourcis clavier) sont des parties constituantes 
d’un song. Le maniement des songs s’effectue dans le menu File.

Nouveau Song
Lorsque vous lancez Logic pour la première fois, un song présé-
lectionné s’ouvre. Vous apprendrez vite à apporter vos propres 
réglages à l’environnement, aux screensets et à vos réglages de 
songs, et vous voudrez sans doute garder ces réglages afin de les 
utiliser dans vos futurs songs, car ils sont adaptés à votre façon de 
travailler personnellement avec Logic. La meilleure façon de le 
faire est de créer votre propre ›song par défaut‹, et de le sauve-
garder dans le même dossier que le programme Logic en 
l’appelant ›Autoload‹. Faîtes attention de bien le sauvegarder 
sous le format ›Logic Song‹.

Song Autoload 
Suivez les instructions suivantes si vous voulez que Logic 
charge automatiquement le song Autoload au démarrage du 
programme:

• Dans Windows, selectionnez Start > Settings > Task & Start 
Menu….

• Sélectionnez la page Start Menu Programs.
• Cliquez sur Advanced. Windows explorer s’ouvre avec le 

menu de démarrage de Windows.
• Ouvrez le répertoire Programs .
• Ouvrez le répertoire Emagic
• Ouvrez le répertoire LA Pro ISIS et sélectionnez l’applica-

tion›LA Pro ISIS‹ .
• Sélectionnez File> Properties.

Cliquez sur Shortcut. Vous devrez voir le chemin du fichier 
1 - 44
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pour l’application Logic dans la ligne Target: .

• A la fin de ce chemin, ajoutez ›Autoload.LSO‹, séparé du 
reste du texte par un espacement.
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• Cliquez sur Apply.

• Fermez toutes les fenêtres que vous avez ouvert.

Maintenant, à chaque fois que vous démarrerez Logic, la chan-
son Autoload.LSO sera ouverte automatiquement (sauf si  vous 
ouvrez Logic en double cliquant sur un autre song).

Créer un nouveau Song
Si vous sélectionnez File > New (çn), LA Pro ISISconçoit un 
nouveau song par défaut.

Charger un Song
Utilisez File > Open (ço) pour ouvrir une boîte de sélection 
de fichiers classique. 

  Fonctions spéciales

Vérifier/Réparer des Songs
Si vous double-cliquez sur l’affichage sur le Transort qui 
montre le nombre d’événements libres restants (voir page 2 - 
5), la mémoire sera reconfigurée. En même temps, le song en 
cours sera verifié afin de rechercher des signes de dommages, 
de problèmes de structure ou bien de blocs inutilisés.

Si des blocs inutilisés sont trouvés (ce qui ne devrait pas arriver) 
vous pourrez les enlever, et réparer le song.

Sauvegarde des Songs
Lorsque vous sélectionnez File > Save (ou çs) le song en 
cours sera sauvé avec son nom actuel intact.

Si vous ne souhaitez pas écraser la dernière version de ce song 
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> Save As…. Vous pouvez ici donner un nouveau titre a votre 
song (et sélectionner un nouveau chemin, ou même créer un 
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nouveau dossier). La prochaine fois que vous sauvegarderez 
avec Save (çs), le nouveau nom et le nouveau chemin 
d’accès seront utilisés.

Revenir à la version Sauvegardée
Lorsque vous faîtes une erreur, vous pouvez l’annuler en 
faisant Edit > Undo (çz).

Si vous avez réellement fait une très grosse erreur (il y a peu de 
chances tout de même), ou que vous décidez que les 15 derniè-
res minutes de vos créations ne pourraient être décrits poliment 
ici, vous allez apprécier la fonction File > Revert to Saved. 
Cette fonction remplace le song en cours par la dernière version 
sauvegardée.

Fermer un Song
File > Close (çc)) ferme le song active. Si vous avez apporté 
des changements depuis la dernière sauvegarde, Logic vous 
demandera si le song doit êtresauvegardé de nouveau avant 
d’être fermé, afin de mémoriser vos modifications.

Quitter le Programme…
Choisissez File > Quit (çq) pour quitter le programme. Si 
vous n’avez pas encore savegardé vos derniers changements, 
Logic vous demandera si vous voulez le faire avant de quitter 
(appuyez sur R pour sauvegarder).
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Fonctions de 
transport

2.1 La fenêtre Transport
La fenêtre de transport est utilisée pour contrôler et pour visua-
liser les fonctions d’affichage et d’enregistrement.

En tant que fenêtre flottante, la fenêtre de transport horizon-
tale montrée ci-dessus est toujours au premier plan, et elle ne 
pourra en aucun cas être couverte par une autre fenêtre.

Ouvrir la fenêtre de transport
Pour ouvrir la fenêtre de transport , selectionnez Open Trans-
port à partir du menu principal Window , ou bien appuyez sur 
Í.

Fermer la fenêtre Transport
 Cliquez sur la boîte de fermeture en haut à gauche de la fenê-
tre.

La barre de transport dans d’autre fenêtres
Vous pouvez également configurer une fenêtre fixe de transport 
dans les fenêtres Arrange, Score, et Matrix. Lorsque vous choi-
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sissez View > Show Transport, les fonctions de barre de trans-
port apparaissent dans le coin en haut à gauche. Le nombre de 
boutons et d’affichages visibles dépendent de la taille de la 
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zone disponible, que vous pouvez ajuster en saisissant le coin 
en haut à droite et en le déplaçant comme montré dans le 
diagramme.

Modifier l’affichage
Pour déplacer la fenêtre de transport dans l’écran, saisissez-la 
par la barre de titre.

Le menu déroulant de la fenêtre Transport s’ouvre lorsque vous 
vous cliquez sur le symbole se trouvant en haut à gauche 
(comme montré ici). C’est là que vous changez l’apparence de 
la fenêtre de transport.

Smaller/Larger

Vous pouvez changer la taille de la barre de transport.

Legend

Cette fonction d’affichage cache ou bien fait apparaître une 
description de tous les éléments de la fenêtre, ce qui est très 
pratique si vous prenez en main le programme.

Position Slider

Cette fonction permet de montrer ou de masquer une bande 
2 - 2
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dans le fond de la fenêtre, dont la taille représente la quantité 
courante du Song (morceau) à l’écran, relative à la longueur (lire 
le paragraphe «Fin de Song» à la page 2 - 8). Vous pouvez égale-
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ment saisir la bande et la faire bouger rapidement, pour obtenir 
des positions de Song différentes.

 Champs de paramètre et affichage
Tous les affichages dans les panneaux de transports (à part celui 
du nom du Song), peuvent être utilisés pour importer des 
données .Vous pouvez aussi bien importer des nombres via le 
clavier, après avoir double-cliqué sur le champs d’affichage, ou 
bien encore en ajustant les nombres individuels en utilisant la 
souris comme curseur.

Affichage de position

La position courante du Song est affichée sous deux formats:

Au dessus: temps SMPTE .

Heure: Minutes: Secondes: Frames / Subframes.

Pour plus de renseignements sur le temps de départ du Song 
lorsque vous utilisez des synchros SMPTE externes, rendez-
vous au paragraphe «SMPTE Offset» à la page 16 - 4. En 
dessous: position en mesures

mesure—pulsation—Division—pas d’horloge.
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Une pulsation (beat) correspond au dénominateur dans une 
échelle temps, une division peut-être définie comme une 
partie d’une pulsation (voir paragraphe «signature et divisions» 
à la page 2 - 6). Un pas d’horloge (tick) est la plus petite subdi-
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vision d’une mesure ou d’un système de quantification, exacte-
ment 1/3840 note .

Boutons

Il y a une colonne de quatre petits boutons gris, entre la zone 
d’affichage de position, et la zone d’affichage du tempo .Les 
deux d’entre eux les plus en bas sont alignés juste à la droite 
des deux points de localisations . Le plus haut placera le SPL 
jusqu’au locator  gauche, quand vous le presserez . Le plus bas 
placera le SPL jusqu’au locator  droit.

Locators

Vous définissez deux sets  de points de localisations appelés 
Locators,, une pour la zone cycle (boucle), l’autre pour la zone 
autodrop .

Les locators sur la gauche définissent la zone du cycle, laquelle 
est un passage sans cesse répété (jetez un œil au paragraphe 
«Mode cycle» à la page 2 - 14).

Les locators sur la droite la zone d’autodrop (voir le paragraphe 
«Autodrop» à la page 2 - 10). Ils sont tous les deux affichés lors-
que les fonctions cycle et autodrop sont activées.

Lorsque les locators  gauche et droit sont mentionnés, c’est une 
référence aux locators de cycle. Celui du haut est le locator 
gauche , celui du bas est le locator droit.

Interrupteurs
2 - 4
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Sur la droite des locators  de cycle, il y a deux boutons. Lorsque 
vous cliquez sur l’un d’eux, la position du Song  saute jusqu’au 
locator correspondant (Goto Left / Right Locator).

X
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Inversement, cliquer sur eux alors que vous maintenez la 
touche ç enfonçées place le locator  sélectionné à l’emplace-
ment actuel du Song (Set Left / Right Locator by rounded Song Posi-
tion).

Finalement, cliquer sur les locators  pendant que vous mainte-
nez les touches Sç enfonçées empêche tous dépassements 
de la mesure la plus proche. (Set Left / Right Locator by Song Posi-
tion).

Tempo

Le tempo est donné en 1/4 de notes par minutes ou battement 
par minute (Bpm). Dans Logic, il est gradué de 0,5 à 9999 Bpm 
(précis à 4 chiffres après la virgule).

Programmer des modifications de tempo

Référez-vous au paragraphe «Tempo» à la page 15 - 1.

Mémoire disponible

Au dessous du tempo vous est affichée la mémoire disponible 
dans le buffer d’enregistrement, en événements (d’une limite 
supérieure approximative de 65500). Vous pouvez augmentez 
2 - 5
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la quantité de mémoire libre des façons suivantes:

• En reconfigurant la mémoire .Si vous double cliquez sur 
l’affichage de la mémoire disponible, vous obtiendrez la 
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question ›Reconfigure Memory?‹. Confirmez en appuyant 
sur la touche R. Cette réorganisation est automatiquement 
enclenchée après avoir sauvé ou chargé un Song .Une bonne 
utilisation de cette caractéristique permet de libérer de la 
mémoire après avoir chargé un Song, si plusieurs Songs ont 
été ouvert en même temps .

• Choisissez Structure > Trash > Empty Trash avant de recon-
figurer la mémoire.

• Si rien de tout cela ne vous aide, vous devriez ajouter de la 
mémoireà votre PC. Demander conseil à votre fournisseur 
informatique.

Lorsque vous utilisez des synchronisations externes, la mesure 
externe de  de la fréquence d’échantillonnage est montrée 
ici(seulement si le Phase Control Timer est activé).

signature et divisions 

C’est ici que vous pouvez voir et éditer la signature du Song .Le 
format est:

numérateur de la mesure/ denominateur de la mesure/ Division

La division correspond au troisième chiffre de l’afficheur du 
pointeur de position des notes (c’est à dire dans la fenêtre 
d’événement), et forme la grille pour différentes longueurs et 
opérations de placements .La division par défaut est de 1/16 de 
mesure, mais peut être réglée de _ à 1/96  de mesure. Si le déno-
minateur est égal ou plus grand que le dénominateur de la 
mesure, la troisième valeur d’affichage des positions est auto-
2 - 6
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matiquement supprimer .

La fonctionSelect next higher / lower format peut-être utilisée pour 
passer à la plus haute ou la plus basse division suivante .

X
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Programmation des modifications de la signature 

Si vous modifiez le numérateur ou le dénominateur de mesu-
rein dans la fenêtre de transport, un changement de signature 
temporelle va être crée au début de la mesure à la position 
actuelle du Song . Ceci est montré dans la règle de mesure. Bien 
sûr, un changement de temps n’affecte la position absolue des 
événements qui sont présents.

Edition des modifications de signature 

Déplacez la ligne de position du Song jusqu’à la première 
mesure qui possède la signature temporelle que vous désirez 
modifier. Etablissez une nouvelle signature temporelle à partir 
de la barre de transport .

Vous pouvez tout aussi bien éditer la signature temporelle dans 
le Score Editor en double-cliquant simplement dessus.

Effacer les signatures 

Modifiez simplement la signature temporelle afin d’obtenir la 
valeur précédente.

Vous pouvez également effacer les signatures temporelles dans 
le Score Editor en les sélectionnant et en appuyant sur la touche 
B. Pour toutes les supprimer , sélectionnez Edit > Select simi-
lar Objects avant de le faire.

Moniteur MIDI et fonction Panic 

La ligne du haut montre le dernier message midi reçu, et la 
ligne inférieure montre le dernier message midi transmis .Le 
2 - 7
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

moniteur MIDI est principalement utilisé pour vérifier les 
connexions MIDI.
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Cliquez sur le moniteur MIDI pour arrêter des notes résiduel-
les. Si cela ne fonctionne pas, double-cliquez dessus, ça devrait 
fonctionner (Emballement total: jetez un oeil au paragraphe 
«Pour les notes qui s’emballent – la fonction Panic» à la page 3 
- 49).

Titre du song
Le titre du Song actif est indiqué en dessous du Moniteur 
MIDI.

Fin de Song 

En dessous du titre du Song, sur la droite, on vous donne la 
mesure de fin du Song .Dès que le séquenceur atteint cette 
position, il s’arrête, sauf lorsqu’il enregistre . Dans ce cas, le 
Song est automatiquement déplacé à la fin de l’enregistrement.

Pour des raisons internes au système, la longueur maximum 
d’un Song est de 8550 notes (noires), ou environ 2138 mesures 
en 4/4.

Un Song peur donc faire environ 70 minutes à un tempo de 120 
Bpm. A 95 Bpm, la longueur maximum va au-delà d’une heure 
et demi.

Si vous avez besoin d’agrandir  la longueur pour synchroniser 
votre song avec un film, Réduisez de moitié le tempo .Vous 
pouvez obtenir le même résultat en utilisant des mesures en 4/
8 .

Un Song en 4/8 à un tempo de 60 Bpm , (équivalent à une 
2 - 8
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mesure de 4/4 à un tempo de 120) à une longueur de 
4273mesures, soit 2 heures et 22 minutes.
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Boutons et touches 
Toutes les fonctions du panneau de transport sont également 
disponibles comme commandes clavier, même si la fenêtre 
transport est fermée .

Transport
Les fonctions de base de ces touches sont les mêmes que sur 
les platines cassettes classiques et seront familières à tous le 
monde. voici quelques caractéristiques spéciales:

Record

L’enregistrement démarre normalement après le décompte, au 
départ de la mesure courante. En mode cycle, il commence au 
locator gauche. Vous pouvez également choisir d’avoir une 
plusation constamment répété, jusqu’à ce qu’un message Midi 
soit reçu lorsque l’enregistrement commence (voir page 2 - 18).

Pause

Mettez en pause l’enregistrement ou bien la lecture en 
appuyant sur  ce bouton. Cela arrête le séquenceur jusqu’à ce 
que vous appuyiez un nouvelle fois sur pause ou  sur play . 
Durant la pause d’un enregistrement, vous pouvez ajouter des 
événements qui seront enregistré.

Play

débute la lectureà la position actuelle, ou en mode cycle à partir 
du locator gauche.

Stop

Arrête la lecture ou l’enregistrement; le séquenceur s’arrête 
donc. Si le séquenceur est déjà arrêté, le fait d’appuyer sur stop 
renvoie le pointeur de position au début du Song, ou au locator 
2 - 9
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gauche en mode cycle .
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Rewind/Forward

Lorsque le séquenceur est arrêté, ces boutons fonctionnent de 
manière classique. Si le séquenceur  est en route, vous enten-
drez le défilement des événements (cueing-scrubbing- les 
messages midi sont générés plus rapidement). En maintenant 
le bouton de la souris enfonçé, et en tirant dans la direction de 
défilement, vous pouvez accélérer le défilement, (en tirant dans 
le sens opposé, vous pouvez même revenir en arrière) .

Les défilements normaux (Rewind/Forward) et rapides (Fast 
Rewind/ Fast Forward) sont tout deux pilotables par le clavier .

Mode
Les boutons de modes n’effectuent pas à proprement parler 
une opération, mais modifient une option de fonctionnement 
du Logic .Les modes activés sont signalés par l’éclairage de leur 
bouton correspondant .

Cycle

Active le mode cycle (voir page 2 - 14).

Autodrop

Active le mode autodrop (voir page 2 - 21).

Replace

Active le mode Replace (voir page 2 - 20).

Solo and Solo Lock

En mode Solo, seuls les objets sélectionnés seront joués. La 
sortie de données de tous les autres objets est coupée. Bien sûr 
vous pouvez changer le statut Solo des objets par la méthode  
classique de sélection (si nécessaire consultez le paragraphe 
«Techniques de sélection» à la page 1 - 24).
2 - 10
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Si vous désirez effectuer des fonctions particulières sur des 
objets, sans prendre en compte les séquences ou les dossiers 
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qui sont soumis au mode solo, vous devez pouvoir sélectionnez  
ces objets sans modifier le statut de Solo.

C’est pour ceci que la fonction solo lock existe. après avoir mis 
en Solo les objets désirés, double-cliquez sur le bouton Solo. 
celui-ci doit changer de couleur (voir ci-contre). Vous pouvez 
maintenant modifier la sélection sans affecter le statut des 
objets.

Sync

Ce bouton permet de choisir la référence externe de synchro de 
Logic. Si Logic fonctionne en référence interne, ou comme une 
source de synchro (c’est à dire en master), vous n’aurez pas à 
activez ce bouton. Lorsque vous démarrer Logic, le mode 
Manual Sync est automatiquement désactivé.

sélectionner le bouton sync (c’est à dire cliquer dessus et main-
tenir le bouton de la souris enfonçé) permet l’ouverture d’un 
menu déroulant, ou vous pouvez définir les caractéristiques 
suivantes:

• Le type de synchronisation externe (voir page 16 - 1), 

• Si les commandes MMC (Midi Machine Command)sont 
transmises à Logic via le bouton de transport, vous pourrez 
ainsi piloter des machines MIDI (voir page 16 - 1),

• L’accés direct aux éditeurs de tempo (voir page 15 - 1).

Metronome

Ce bouton sert à activer et désactiver le métronome. Logic 
propose deux paramétrages du métronome distincts pour la 
lecture et l’enregistrement. Ce bouton active un menu par 
lequel 

• Vous accédez  directement à Recording Options à partir de 
Song Settings (décrit à la page 17 - 2),
2 - 11
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• Vous pouvez ouvrir une fenêtre environnement avec Midi 
Metronome Click.
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2.2 Regle de mesure
Il y a une règle de mesure en haut de chaque fenêtre horizon-
tale éditant des événements temporels (c’est à dire les fenêtres 
matrix, arrange, hyper et score). 

Cette règle est utilisée pour afficher et éditer;

• La position du song,
• Le début et la fin du song ou bien d’un dossier,
• Les locators de cycle et d’autodrop s, et

Affichage

Suivant le réglage du zoom (page 1 - 13) la mesure est affichée 
dans la barre du haut par unité de 1, 4, 8 ou 16. Les change-
ments de signature temporelle y sont également indiqués.

Dans le tiers inférieur, il y a une ligne verticale pour chaque 
mesure. La plus petite ligne représente un temps, mais elles ne 
sont pas toujours visible (suivant le réglage du zoom).

Marqueurs de début et de fin

Le début d’un Song est normalement à la mesure 1111. Vous 
pouvez déplacer le début avant cette mesure, pour générer un 
décompte, ou pour placer des Program Changes, en tirant le 
2 - 12
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marqueur avec la souris. La fin d’un Song (par défaut: la mesure 
201) peut être positionné de la même manière, ou par un affi-
chage numérique (page 2 - 8). 
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Dans les dossiers, les marqueurs de début et de fin correspon-
dent au dossier plutôt qu’au song. La longueur d’un dossier peut 
donc être ajustée à partir de ce dossier lui-même.

Le pointeur de position
Le pointeur de position (que l’on peut également surnommé 
SPL pour song position line) est une ligne verticale qui indique la 
position courante du song, et ce dans toutes les fenêtres horizon-
tales basées sur le temps. Vous pouvez la faire glisser avec la 
souris (seulement s’il n’y a rien d’autre sous la souris que vous 
pourriez attraper). En choisissant l’option Wide Song Position 
Line dans la page Display de Preferences, on obtient une ligne 
représentant le pointeur de position plus épaisse.

Positionnement rapide ...
Comme il n’est pas toujours évidant d’attraper le pointeur de 
position dans la fenêtre ou vous vous trouvez, vous pouvez posi-
tionner le pointeur directement dans le tiers inférieur de la 
règle de mesure. Il suffit de cliquer à un endroit de cette zone 
pour y faire passer le pointeur.

…en démarrant ou arrêtant le séquenceur

Double cliquez dans le tiers inférieur de la règle de mesure 
pour repositionner le pointeur de position en inversant le statut 
du transport.

…numériquement
2 - 13
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Choisir la fonction Goto Position (touche par défaut: #),ouvre  
la boîte de dialogue (montréeici) pour y entrer numériquement 
la nouvelle position du pointeur de position. La dernière divi-

X
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sion utilisée (position de mesure ou temps SMPTE) est auto-
matiquement sélectionné avec la dernière valeur entrée 
comme valeur par défaut.Il suffira souvent de ne rentrer que le 
numéro de mesure (l’entrée des chiffres se fait de gauche à 
droite).

Positionnement sur un marqueur 
Si vous avez étiquetez un passage avec un marqueur, cliquez 
n’importe où sur le marqueur en maintenant enfoncée la 
touche ç pour positionner le pointeur de position au début du 
marqueur. Si le séquenceur est arrêté, double-cliquer dessus 
permet de lancer la lecture au début du marqueur.

Scrubbing
Mettez le séquenceur en lecture et cliquez sur un endroit du 
tiers inférieur. En déplacant la souris sur la droite ou sur la 
gauche, vous pouvez maintenant effectuer un Scrubbing du song 
en déplacant le pointeur de position afin d’entendre les événe-
ments. Dés que vous arrêtez le déplacement de la souris, la 
lecture reprend normalement son cours. 

2.3 Mode cycle
En mode cycle, un passage du Song est constamment répété, ceci 
s’avère utile pour;

• Créer une partie d’un song,
• S’entraîner pour un enregistrement
• Enregistrer plusieurs pistes consécutivement
• éditer des événements.

La région du cycle est visualisée par une barre noire dans la 
partie supérieure de la barre de mesure.
2 - 14
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Activer le mode cycle
Il existe quatre façons d’activer ou de désactiver le mode cycle;

• Cliquer sur le bouton cycle,
• Utiliser le racourcci clavier Cycle,
• Cliquer dans la partie supérieure de la barre de mesure, et
• Entrer graphiquement le segment dans la règle de mesure.

Comment Logic se comporte en mode cycle
• Le pointeur de position passe de la fin de la région du cycle à 

son début;
• Lorsque cela se produit, la lecture des objets environments 

qui produisent les notes à cet instant précis est interrompue;
• La mise en lecture commencera toujours au début du cycle;
• Pour commencer d’un autre point appuyez sur pause deux 

fois ou bien sur pause puis sur play;
• Au point de saut du cycle, vous pouvez utiliser la fonction 

Chase Events (Cette fonction est détaillée un peu plus tard — 
File > Song Settings > Chase Events > Chase on Cycle Jump.

• Vous pouvez déterminer la façon dont vous voulez enregis-
trer en mode cycle, en utilisant diverses options se trouvant à 
la page File > Song Settings > Recording Options (pour plus 
d’informations, jetez un coup d’oeil au paragraphe «Enregis-
trement en mode Cycle» à la page 2 - 20).

Définir la région du cycle

utilisation de la barre de mesure graphiquement
• Cliquez dans le tiers supérieur de la règle de mesure, gardez 

le bouton de souris appuyé, et définissez la région voulue en 
déplaçant la souris (déplacer la souris de droite à gauche 
génère un Skip Cycle.
2 - 15
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• saisissez le segment par le milieu et repositionnez-le avec 
précision.
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• Attrapez le coin inférieur pour déplacer les points de départ 
et de fin du cycle (vous pouvez même le faire lorsque le 
séquenceur fonctionne). Si vous éditez le point de départ au 
même endroit que le point de fin, le mode cycle est annulé.

• Vous pouvez redéfinir le point le plus proche(même si celui-
ci est en dehors de la zone  visible ou si le mode cycle est 
désactivé), en maintenant enfoncée la touche S.

• .

Lorsque vous éditez la taille d’un cycle graphiquement dans la 
barre de mesure, cette taille est quantifiée à la mesure la plus 
proche. Les positions des locators ne peuvent uniquement 
déplacés de divisions en divisions qu’avec le zoom en haute 
résolution, ou bien en maintenant enfoncée la touche A 
pendant que vous déplacez. Si vous maintenez enfoncées les 
touches S et A, vous pourrez modifier la taille de la zone en 
pas d’horloge avec une très grande résolution de zoom.

Pour régler la position d’un Locator afin qu’il ne trouve pas à 
l’emplacement même d’une barre de mesure en fonction de la 
résolution du zoom, saisissez la position de votre locator numé-
riquement dans la fenêtre Transport.

Saisie numérique
La position des points gauche(départ) et droit (fin) sont affi-
chées dans la fenêtre de transport ou elles peuvent être éditées.

Il y a également deux raccourcis clavier disponible (Set Left / 
Right Locator) qui vous permettent d’entrer la position de ces 
2 - 16
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points dans une boîte de dialogue (par défaut = dernière 
entrée).
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Par objet
Vous pouvez utiliser les raccourcis clavier Set Locators by 
Object(s) et Set Locators & Play Pour placer les locators au début 
et à la fin des objets sélectionnés; La seconde commande lance 
également la lecture.

Set rounded Locators by Object(s) arrondit les positions des locators 
à la barre de mesure la plus proche.

Les commandes  ont le même résultat, mais lancent réspective-
ment la lecture et l’enregistrement.

Par marqueurs
Avec la commande clavier Set Locators by Marker & Enable Cycle 
vous pouvez définir le Cycle par les marqueurs à la position du 
Song. La commande clavier Set Locators by next Marker and En-
able Cycle utilise le prochain marqueur à partir de la position ac-
tuelle du Song.

Cettes commandes surtout se prêtent à spontanéement répéter 
la passage actuelle ou prochaîne, par example pendant q’une 
scène. Pour utiliser cette fonctionalité il faut d’avance definir 
des marqueurs au dessus de toutes les passages concernantes 
de votre Song.

Skip Cycle
Quand vous jouez un Song , vous pouvez sauter un passage, ce 
qui est pratique pour des effets ou des transitions.

paramètrage des Skip Cycle
Déplacez la région du skip cycle de droite à gauche dans la barre 
de mesure.

S’il existe déjà une région de cycle, déplacez le locator gauche 
2 - 17
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au delà du locator droit.
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La région skip est signalée par une 
bande très fine se trouvant en haut 
de la barre de mesure.

Caractéristiques du mode Cycle 
Lorsque le pointeur de position atteint le locator droit, il saute 
au locator gauche (c’est à dire que les locators ›droit‹ et ›gauche‹ 
ont leurs positions inversées par rapport au mode cycle).

Le Skip cycle est une manière rapide de quitter un passage dans 
un arrangement, sans avoir physiquement effacé ce passage des 
pistes.

Vous pouvez aussi l’utiliser lorsque vous éditez, pour quitter les 
parties que vous ne désirez pas dans l’édition.

2.4 Enregistrement

Choisir une piste
Il vous faut tout d’abord sélectionner une piste dans laquelle 
vous allez enregistrer, par exemple en cliquant dessus (voir 
page 3 - 3). Rappelez vous qu’une seule piste ne peut être 
sélectionnée, et que cette dernière peut se trouver dans un 
autre dossier, (voir page 3 - 36). Durant l’enregistrement, tous 
les événements arrivant au port midi sont enregistrés dans une 
séquence sur la piste sélectionnée.

Changer de piste

Vous pouvez changer de piste au milieu d’un enregistrement 
sans avoir à tout arrêter. Il suffit de sélectionner une autre 
piste(par exemple via la commande Select previous / next 
track)(touche par défaut: I or M).
2 - 18
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Décompte
Dés que vous pressez la touche record, un décompte 
commence. Ceci est défini à la page Recording Options de Song 
Settings. Les choix sont:

No count-in Lenregistrement commence sans 
décompte.

Wait for note Logic répète le premier temps de la 
mesure jusqu’à ce qu’il reçoive une 
note Midi. L’enregistrement 
commence dès cet instant.

1-4 Bar count-in Il y a un décompte de 1à 4 mesures 
(par défaut: 1mesure).

3/4–5/4 count in Il y a un décompte de 3 à 5 noires. 
(Ces options sont particulièrement 
pratiques pour le décompte le temps 
d’un changement de signature 
temporelle).

…Présence du Clic seulement durant le décompte

Si l’option File > Song Settings > Recording Options > Click only 
during Count In est active, Le Click sera désactivé lorsque le 
décompte sera terminé. Egalement appelé ›Drummer mode‹.

Ceci est vraiment pratique si la section du Song se trouvant 
juste avant la partie que vous enregistrez manque du click 
nécessaire à la mise en place lors de la création de nouvelles 
parties, mais que l’on est en présence de rythmes complexes et 
fouillés, une fois que la section que vous enregistrez 
commence.

Options d’enregistrement
Record Toggle (par défaut: V) permet de passer de la lecture à 
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l’enregistrement. Record Repeat répete l’enregistrement à partir 
du point de drop-in.
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Enregistrement dans les séquences sélectionnées

Normalement, une nouvelle séquence est créée à chaque enre-
gistrement. Dans Recording Options deSong Settings, vous 
pouvez activer Merge New Recording With Selected Sequences, ainsi 
toutes les nouvelles données sont incorporées dans une 
séquence existante, lorsque cette séquence est sélectionnée.

Mode Replace 
Pour activer le mode replace, appuyer sur le bouton Replace. 
Dans ce mode, toutes les nouvelles données sont enregistrées 
dans une nouvelle séquence. De plus, toute séquence existant 
auparavant sur la piste d’enregistrement sera coupée entre les 
points de punch in/out et toutes les anciennes données y seront 
effacées.

Enregistrement MIDI destructif
Si vous sélectionnez Merge New Recording With Selected Sequences 
(r) and switch on replace mode (Le symbole de tête d’enregis-
tement dans la fenêtre Transport), les  nouveaux événements 
enregistrés vont remplacer ceux qui existaient déjà dans la 
séquence.

La combinaison Merge/Replace peut elle même être couplée 
avec les fonctions Autodrop et/ou Cycle.

Enregistrement en mode Cycle
Tous les réglages concernant l’enregistrement en mode cycle 
peuvent se faire dans Recording Options de Song Settings (voir 
page 17 - 2). Vous pouvez tout aussi bien utiliser plusieurs cycle 
pour enregistrer une seule séquence (Merge only New Sequences in 
Cycle Record validé), ou vous pouvez créer une nouvelle 
séquence pour chaque cycle(…non validé). Une nouvelle piste 
peut être automatiquement crée pour chacune de ces séquen-
2 - 20
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ces (Auto Create Tracks in Cycle Record). La séquence que vous 
créez peut également être automatiquement coupée 
(muted)(Auto Mute in Cycle Record). Ce mode est énormément 
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utilisé afin d’enregistrer plusieurs versions concécutives d’un 
solo, et ensuite ne garder que la meilleure.

Cycle et Replace
Lors d’un enregistrement Cycle en mode Replace, les séquences 
existantes auparavant sont effacées pendant le premier 
passage, à partir du point de punch in jusqu’au point de punch out 
ou jusqu’à la fin du cycle. Au second passage, l’enregistrement 
continue, mais rien n’est effacé en plus. Si vous désirez rempla-
cer la fin d’une séquence, vous n’avez pas à arrêter l’enregistre-
ment avant que le second cycle ne commence: Le début de la 
séquence existante reste intact.

Autodrop
l’Autodrop est une technique qui permet de rentrer et de sortir 
automatiquement de l’état enregistrement à des positions défi-
nies à l’avance. L’autodrop est principalement utilisé pour 
corriger une partie ratée, ou que l’on veut modifier .L’avantage 
est que vous pouvez vous concentrer sur le jeu.

Si le mode cycle est inactif, les locators gauche et droit définis-
sent le segment autodrop. L’autodrop est enclenché en 
appuyant sur le bouton ci-contre.

Définir la région d’autodrop

Si les fonctions cycle et autodrop sont actives , une deuxième 
paire de locators indépendante est disponible  pour l’autodrop. 
Dans ce cas, il y aura deux bandes dans la règle de mesure, celle 
du haut représentera le zone du cycle et celle du bas la zone de 
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l’autodrop. Le segment de l’autodrop peut aussi bien être modi-
fiée graphiquement que le segment du cycle. Si l’affichage de la 
barre de mesure est très restreint, maintenez appuyée la touche 
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ç pendant que vous la modifiez vous assure que vos actions 
s’appliquent au segment de l’autodrop. Pour activer graphique-
ment l’autodrop dans la règle de mesure déplacez le segment 
tout en maintenant enfoncée la touche ç.

Pour les opérations graphiques, la grille peut-être paramètrée à 
la résolution de division en maintenant la touche A, et à la 
résolution de pas d’horloge en maintenant les touches SA.

paramètrage de l’autodrop numériquement
La position des locators de l’autodrop sont affichés numérique-
ment, à droite des locators de cycle sur la fenêtre transport. 
Leurs positions peur être modifiée de là.

Enregistrement en autodrop
Pour mener un enregistrement en autodrop, mettez le séquen-
ceur en enregistrement avant le point de drop in. Tous les 
événements arrivant avant le drop in et après le drop out sont 
reconnus par le séquenceur mais ne sont pas enregistrés.

Si le pointeur de position se trouve derrière le locator droit lors-
que vous commencez l’enregistrement, l’enregistrement 
débute automatiquement au point de Drop In après le 
décompte.

Combinaison du Cycle et de l’Autodrop

Si vous voulez réussir une partie particulièrement difficile, vous 
pouvez utiliser une combinaison du cycle et de l’autodrop .Le 
mode cycle permet de vous entraîner aussi longtemps que vous 
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le désirez avant la prise finale. A chaque fois, seule la partie en 
autodrop sera enregistrée. Vous pouvez utiliser la section précé-
dente pour vous mettre dans le bain.
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Enregistrer en mode Skip Cycle
Si la fonction skip cycle est activée, la région du cycle est laissée 
de côté durant l’enregistrement.

2.5 Chase Events
Chase Events est une fonction qui recherche toutes les séquen-
ces jouant à un point de jump-in. La fonction examine ce que 
toutes ces séquences font avant le point de jump-in point afin de 
déterminer quels sont les événements qui seront succeptibles 
d’affecter la lecture au point de jump-in , si ce dernier a été 
atteint par la lecture du song .

C’est un point qui est relativement compliqué à comprendre, 
donc voici une autre explication:

Si vous commencez la lecture en plein milieu d’un Song ,en 
passant directement à ce point (via mode cycle en boucle ou 
simplement en vous y plaçant disectement), Vous aurez peut-
être quelques soucis. Si une note importante commence juste 
avant le le point de départ, Logic la manquera probablement, et 
elle ne sera pas jouée. Les notes ne sont pas le seul problème 
potentiel, si un message de pitch bend maximum était produit 
jusye avant le point de départ, la lecture le laissera de côté 
également. Heureusement que Logic est plus astucieux que la 
plupart des séquenceurs...

Ouvrez la page Chase Events dans Song Settings, pour para-
mettrer la fonction chase events.

La fonction recherche dans toutes les séquences jouant au 
point de départ, recherchant avant le début de la lecture une 
sélection parmi:

• toute note devant être jouée au point de départ de la lecture;
• toute note devant être jouée au point de départ de la lecture 
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en raison d’une pédale de sustain activée (Chase sustained 
Notes);

• les program changes;
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• les imformations de pitch-bend;
• Les contrôleurs continus de 0 à15;
• les contrôleurs ›switch‹ continus de 64 à 71;
• Tout autre contrôleur (all other Controls);
• aftertouch monophonique (canal);
• aftertouch polyphonique;
• Données SysEx (Le dernier message SysEx avant le point 

de départ de la lecture est envoyé)

Remarque spéciale: 

Un problème potentiel existe lorsque les notes détectées sont 
utilisées pour trigger une boucle de percussions dans un échan-
tillonneur. Sauf si vous aviez assez de chance pour commencer 
la lecture juste au point ou la boucle de l’échantillon démarre, 
l’échantillon sera le plus souvent triggé au mauvais moment et 
sera presque toujours décalé par rapport au reste de la séquence 
(au moins par rapport à la note suivante). Le problème réside 
dans le fait que la plupart des échantillonneurs ne savent pas 
déclencher une note en plein milieu d’un échantillon puisqu’ils 
ne se synchronisent pas à la pulsation.

Comment résoudre se problème:

Activez le paramètre No Seq Trp de l’instrument déclenchant 
ces échantillons et désactivez l’option Chase Notes in No Seq Trp 
Instruments à la page Chase Events dans Song Settings. Le 
résultat en est que dès que le song passe à une nouvelle position, 
votre boucle d’échantillon ne sera jouée avant la note triggée 
suivante.

Remarque: Le paramètre No Seq Trp prévient toute transposi-
tion selon les paramètres de lecture de séquence, qui est indé-
sirable pour les sons de batterie ou les boucles.
2 - 24
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Fenêtre Arrange

3.1 généralités
La Fenêtre Arrange est le cœur de Logic Audio Pro ISIS. 
Etudiez la bien consciencieusement  car c’est l’interface que 
vous utiliserez le plus souvent lorsque vous travaillerez avec le 
programme. 

Elle apparaît tout de suite à l’écran lorsque vous ouvrez 
Logic.L’espace d’arrangement 1 est celui ou toutes les infor-
mations Midi sont enregistrées dans les pistes horizontales. Les 
enregistrements Midi ou Audio sont appelés séquences et sont 
représentées par des barres. Au-dessus de cette zone est située 

1

3

7

4

5

6

2
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la règle de mesures qui vous permet de calculer la position de 
chaque séquences dans un Song 2.
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A gauche de la zone d’arrangement se situe la liste des pistes 
(track list) 3. C’est ici que vous déterminés quel instrument 
joue les informations Midi ou audio de chaque piste. Vous 
pouvez définir plusieurs configurations d’instruments dans la 
boîte de paramètre d’instrument 4 dans le coin inférieur 
gauche.

Comme les séquences sont gérées graphiquement, vous 
pouvez vous servir d’un certain nombre d’outils à actionner par 
la souris, dans la boîte à outil 5.

La boîte de paramètre de séquence 6 est là où vous configurez 
les paramètres qui détermineront la façon de jouer de chaque 
séquences comme la transposition et la quantification.

Dans le coin supérieur gauche se trouve le panneau de Trans-
port 7, fonctionnellement identique à  la fenêtre Transport.

Ouvrir la fenêtre Arrange 

Pour ouvrir la fenêtre Arrange, actionnez la fonction Window > 
Open Arrange du menu principal, ou appuyez sur Aw then 
a.

3.2 Pistes
Chaque piste est étalée horizontalement dans la zone d’arran-
gement et les différentes pistes sont disposées verticalement. 
Une piste est là ou sont enregistrés les événements Midi.

Dans la track list, les pistes sont numérotées de haut en bas. 
Pendant la lecture, un petit vumètre apparaît au-dessus du 
numéro de piste. celui-ci indique la vélocité des notes lues et 
s’allume en rouge lorsque la vélocité maximale est atteinte. Le 
petit ‹c›,lui, indique les commandes des contrôleurs.

A la droite de ceci se situe un espace où vous assignerez 
3 - 2
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l’instrument à la piste, représenté par un icône et un nom.
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L’instrument détermine quel générateur sonore va jouer les 
événements Midi ou audio de la piste. Pour plus d’informa-
tions, voir le paragraphe «Instruments» à la page 3 - 8.

De façon plus exacte, cette assignation va beaucoup plus loin 
qu’une simple assignation d’instrument car vous pouvez assi-
gnez n’importe quel objet de type environnement à une piste.

Les données de la piste peuvent tout aussi bien être envoyés à 
un fader virtuel ou directement à un port Midi. Cependant, 
comme vous assignerez le plus souvent un instrument «réel» à 
une piste, nous garderons le terme «instrument» plutôt qu’un 
fastidieux «objet destinataire des données de pistes».

Généralement, une seule piste peut-être sélectionnée à la fois. 
l’exception est dans la combinaison de l’enregistrement Midi et 
Audio, ou il est possible de sélectionner simultanément une 
piste audio et une piste Midi. Pendant l’enregistrement, une 
séquence est créée, contenant les informations Midi ou les 
données audio.

Sélectionner une piste
Vous sélectionnez une piste en cliquant son nom ou son icône 
dans la track list. Cela sélectionne en conséquence tous les 
objets de la piste(si la fonction Cycle est activée, cela ne sélec-
tionne que les objet situés dans la zone définie de la boucle).

Utilisez la fonction Select Next/Previous Track pour sélectionner 
les pistes respectives  au-dessous et au-dessus (raccourci 
clavier: M / I).

Changer de piste sans changer la sélection en cours
Si vous cliquez sur une nouvelle piste tout en maintenant la 
touche ç, la piste sera sélectionnée sans que la sélection en 
cours des séquences et folders ne soit modifiée. 
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Déplacer une piste 
Cliquez sur la piste près du numéro et faites glisser avec la 
souris, vers le haut ou vers le bas.

Sélectionner des Objets de même couleur 

Si vous avez sélectionné une séquence d’une certaine couleur, 
vous pouvez utiliser Edit > Select equal colored objects pour 
sélectionner les objets de même couleur. Ceci peut être prati-
que lorsque vous combinez des groupes de Solo ou de Mute.

Créer une piste 
Pour créer une piste, utilisez la fonction Structure > Track > 
Create. la nouvelle piste est créée au même endroit que les 
pistes sélectionnées. Toutes les pistes y compris la piste sélec-
tionnée descendent d’un cran.

Pour créer une piste en fin de track list, double-cliquez en 
dessous de la dernière piste (Append Track to Track List).

La nouvelle piste garde les attributs d’instrument de la piste 
sélectionnée.

Créer une piste avec un autre instrument

La fonction Structure > Track > Create with next Instrument 
forme une nouvelle piste sous la piste sélectionnée et lui assi-
gne un autre instrument contenu dans la sélection d’instru-
ments. Dans de nombreux cas, ceci implique aussi l’arrivée 
d’un nouveau canal Midi dans le même module de son.

Vous pouvez également utiliser les touches A. Lorsque vous 
créez une nouvelle piste en double cliquant sous la track list, ou 
alors utiliser la fonction ‹Append Track with next Instrument to 
Track List›.
3 - 4
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Déplacer des Objets vers une piste 

La fonction Structure > Track > Move Selected Objects to 
Track déplace les séquences sélectionnées de différentes pistes 
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vers la piste sélectionnée. La position dans le temps de toutes 
le séquences est retenue.

C’est pratique lorsque l’on veux rassembler plusieurs séquen-
ces en une seule.

Suppression de pistes
Utilisez la fonction Structure > Track > Delete pour supprimer 
la piste sélectionnée. Si la piste n’est pas vide, un message de 
confirmation apparaîtra.

Si aucun objet n’est sélectionné dans la zone Arrange, vous 
obtiendrez le même résultat en pressant la touche B.

Une troisième méthode est de tirer la piste comme pour la 
repositionner (voir ci-dessus), mais vers la gauche de la Track 
list.

Suppression de pistes vides
Utilisez la fonction Structure > Track > Delete Unused pour 
supprimer les pistes ne contenant aucune séquence ni folders.

Nommer des pistes 
Pour nommer une piste indépendamment de l’instrument qui 
lui est assigné, sélectionnez Structure > Track > Create Track-
name.

Vous pouvez également changer le nom d’une piste existante 
en double-cliquant sur le nom de l’instrument dans la Track list 
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pendant que vous maintenez la touche A Vous pouvez ainsi 
saisir le nouveau nom dans l’emplacement qui apparaît.

Le nom  de la piste est alors affiché à la place du nom de 
l’instrument. Il sera alors utilisé par défaut pour enregistrer les 
séquences.

S’il y a assez de place verticalement (zoomez verticalement), 
les deux noms, piste et instrument seront affichés.

Vous pouvez voir la liste d’instruments, dans la boîte de para-
mètres d’instruments, ou vérifier en cliquant sur le nom de la 
piste et en maintenant le bouton de la souris appuyé.

Nommer pendant que vous créez une piste 

Lorsque vous créez une piste (en double cliquant dans la Track 
list)vous pouvez maintenir la touche √, afin d’ouvtrir le 
champ de saisie des noms de pistes.

Effacer des noms de pistes
Pour effacer des noms de pistes, choisissez Structure > Track > 
Delete Trackname.

Vous pouvez également double-cliquer sur le nom de la piste 
pendant que vous maintenez enfoncée la touche A. Ceci 
ouvre le champ de saisie pour le nom de la piste. Le nom peut 
être effacé en utilisant la touche B. Le nom de l’instrument 
3 - 6
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apparaîtra alors dans la Track list.
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Couper des pistes (Mute)
Les pistes audio et Midi possèdent des boutons Mute sur la 
gauche de la Track list entre le numéro de piste et l’icône. 
Couper (Muter) une piste l’empêche de jouer. Pour montrer ou 
cacher le bouton bleu mute choisissez View > Mute Switch.

Couper une piste lorsque le bouton est caché

Si le bouton Mute est caché (pour gagner de la place), vous 
pouvez  quand même couper une piste en cliquant à gauche du 
numéro de piste. 

Si vous cliquezsur la gauche de la Track list, à côté du numéro de 
piste, la piste sur laquelle vous vous trouvez sera coupée(ou le 
Mute existant sera enlevé, selon l’état de la piste au moment du 
clic.

Vous pouvez également utiliser la commande clavierMute Track 
pour couper une piste.

Les pistes coupées sont indiquées par un Ø.

Couper toutes les pistes
Si vous maintenez la touche ç enfoncée tout en cliquant sur 
la gauche de la colonne des pistes, toutes les pistes du niveau 
en cours (ou dossier) seront coupées (ou rétabliées si elles 
étaient déjà coupées).

Vous pouvez également utiliser la commande clavier Mute All 
Tracks of Folder.

Couper un instrument
Si vous coupez une piste en maintenant enfoncées les touches 
çA toute les pistes du Song  en cours avec le même instru-
ment seront coupées (ainsi que celles qui se trouvent dans le 
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Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

dossier).



Chapitre 3
Fenêtre Arrange

Sélectionner un instrument
Lorsque vous cliquez sur le nom ou l’icône d’instrument dans 
la Track list et que vous maintenez enfoncé le bouton de la 
souris, un menu s’ouvre pour vous permettre de choisir un autre 
instrument.

Changer globalement un instrument

Si vous maintenez enfoncée la touche ç tout en sélectionnant 
un instrument, l’instrument précédent sera remplacé dans 
toutes les pistes du Song en cours par le nouvel instrument 
(même dans les pistes des dossiers).

Type spéciaux d’instruments
En plus des instruments classiques qui sont décrits dans le 
paragraphe «Instruments» à la page 3 - 8, il y a d’autres configu-
rations de pistes possible pour lesquelles il ne correspond pas 
d’objets dans l’Environnement.

No Output

Ceci coupe la sortie de toutes les pistes qui sont assignées à «No 
Output». Ceci est très pratique lorsque vous désirez sauvegarder 
des données (comme des sys-ex) que vous ne désirez pas 
envoyer.

Folder

Ce réglage est utile lorsque vous souhaitez faire lire un folder 
par la piste(voir page 3 - 36).). Les séquences normales ne 
seront pas jouées sur la piste réglée sur l’instrument Folder.

3.3 Instruments
Pour savoir où les messages Midi spécifiques doivent être 
3 - 8
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envoyés,Logic doit pouvoir se faire une idée de la façon dont 
les machines Midi sont connectées. Ceci est représenté graphi-
quement dans une fenêtre d’environnement qui contient le 
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séquenceur et un certain nombre d’objets (comme des instru-
ments). Chaque instrument est un objet d’environnement et 
représente un générateur physique. Vous pouvez considérez 
ces objets comme des instruments «virtuels», représentation 
symbolique de l’instrument réel.

Pour savoir comment donner à Logic toutes les informations 
relatives à son environnement, voir le chapitre  L’environnement.

Rendre un instrument visible 
Si vous double-cliquez sur le nom de l’instrument dans la Track 
list, ceci ouvre directement la fenêtre d’Environnement avec 
cet objet sélectionné.

Créer un Nouvel Instrument
Il est préférable de créer  les instruments directement dans la 
fenêtre Environnement. Autrement, vous pouvez le faire de la 
fenêtre Arrange avec la fonction Structure > Track > Create New 
Instrument. La piste sélectionnée sera assignée à un nouvel 
instrument dont les paramètres peuvent être configurés dans la 
boîte d’instrument. Cet instrument sera par ailleurs créé dans 
l’environnement. 

Les paramètres d’instrument
La boîte de paramètres d’instrument se trouve dans le coin en 
bas à gauche de la fenêtre Arrange.

Les paramètres d’instrument appartiennent à l’instrument lui 
même et non à la piste. Donc, si vous modifiez les paramètres, 
ceci affectera l’ensemble des pistes utilisant cet instrument.

La boîte de paramètres d’instrument se trouvant dans la fenêtre 
Arrange est identique à la boîte de paramètre correspondante 
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Ouvrir et fermer la boîte de paramètres d’instru-
ments
Cliquez dans le petit triangle (en haut à gauche) pour ouvrir ou 
fermer la boîte.

Nom
La ligne du haut montre le nom de l’instrument, lequel peut 
être édité en cliquant dessus.

Type d’objet de piste 
Le type d’objet de piste est entre parenthèses et ne peut être 
changé. Normalement il s’agira de: (Instrument) ou, si vous utili-
sés des multi-instruments (Subchannel).

Sélectionner une icône
En attrapant l’icône, vous ouvrez un menu déroulant où vous 
pouvez choisir l’icône qui représentera l’instrument. Si vous 
maintenez enfoncé le bouton droit de la sourisdurant cette 
opération, le menu reste ouvert même si vous relâchez la souris, 
vous permettant ainsi de vous servir des ascenseurs pour 
rechercher l’icône la plus appropriée.

Si vous cliquez sur l’icône et que vous maintenez le bouton 
droit de la souris, vous pouvez défiler parmi les icônes en dépla-
çant la souris.

Cacher un instrument
La petite case à côté de l’icône détermine si l’instrument est 
visible dans la liste d’instrument disponible de la Track list. 
Cette case sera pratiquement toujours cochée dans le cas 
d’instruments courants.
3 - 10
Emagic
Logic Audio Pro ISIS 

Vous pouvez cachez ainsi les composants d’environnement tels 
que les Faders ou les ports Midi.
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Paramètrer le canal Midi
Le canal Midi est indiqué à droite du paramètre Cha. Il définit 
le canal Midi sur lequel les données assignées à cet instrument 
seront émises, correspondant au canal de réception de votre 
instrument.

Si l’instrument a été connecté manuellement dans la fenêtre 
environnement par un «câble»,, la ligne de dessous doit conte-
nirun petit signe de division (‹÷›) .

Si l’instrument n’a pas été connecté avec des câbles dans l’envi-
ronnement, alors cette ligne affichera le port de sortie dans la 
boîte de paramètres d’instrument. Ceci signifie que l’instru-
ment  est directement connecté à une de vos interfaces Midi 
qui sont des sorties Midi, ou à un synthétiseur intégré à votre 
carte son. Ceci est une sorte de connexion cachée, puisqu’il n’y 
a aucune connexion visible pour l’instrument dans la fenêtre 
Environnement.

Vous pouvez installer une sortie de port dans cette ligne via le 
menu contenant des noms de drivers installés.

Le but de ces connexions cachées est de vous permettre 
d’atteindre les ports Midi directement à partir de la fenêtre 
Arrange sans être obligé d’ouvrir une fenêtre Environnement. 

Gardez à l’esprit que si vous assignez directement un port, et 
que vous connectez un instrument vers la  sortie Midi d’un 
objet avec des câbles, toutes les données Midi envoyées via cet 
instrument seront doublées. Dans le cas où vous essayeriez de 
faire ceci, Logic affiche une boîte de dialogue, qui vous 
demande de garder (keep) ou d’enlever (remove) la connexion 
directe. Vous sélectionnerez le plus souvent «remove» dans ce 
cas.

Configurer le canal Midi:multi-instruments
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Dans la boîte de paramètres d’instrument de la fenêtre Arrange, 
vous pouvez changer le canal Midi d’un instrument(subchannel 
ou part d’un instrument multiple). Ceci n’ assignera pas le canal 
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pour la partie courante, mais seulement sélectionner un autre 
sub-channel provenant de l’instrument multiple.(dans la version 
3.0 un message d’alerte s’affiche: «channel is protected»).

& Vous ne pouvez pas modifier le canal de réception d’une partie du synthétiseur 
multitimbral.Ceci n’est possible que dans  très peu de cas. Le paramètre cha est une 
réelle alternative de changement de piste d’instrument, de manière à ce que la piste  
soit jouée par une partie différente dans le synthétiseur multitimmbral.

Si le message Midi est réglé sur  «All», vous pouvez éditer les 
paramètres de tous les instruments multiples (Midi driver).

Règler le son d’une piste
Les paramètres Prg, Vol et Pan transmettent des program chan-
ges, Des contrôleurs de volume (n°7) et des contrôleurs de 
panoramiques (n°10).

Si les cases ne sont pas cochées, la valeur par défaut est utilisée. 
La valeur correspondante ne sera émise que si vous cochez la 
case en lui cliquant dessus. Si la case est cochée, toute altéra-
tion du paramètre entraîne la transmission immédiate d’un 
message avec la valeur correspondante.

Un Program Change peut être sélectionné sur la droite via un 
menu roulant; le volume et le panoramique  peuvent être para-
mètrés en utilisant la souris comme curseur. Si un lien vers 
Sound Surfer ou Sound Diver est actif, ou lors de l’utilisation de 
sous-canaux d’un multi-instrument, les sons peuvent être choi-
sis par nom à partir d’un menu déroulant. si vous maintenez la 
touche A enfoncée, toute valeur sera augmentée ou dimi-
nuée en cliquant  dessus grâce au bouton gauche ou au bouton 
droit.

A gauche du numéro de programme, il y a un paramètre suplé-
mentaire utilisé pour la sélection de la banque. Si vos synthés 
utilisent les messages Bank Select (via les contrôleurs n°0 ou 
n°32-vérifiez dans le manuel de votre synthé), vous pouvez 
3 - 12
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alors passer d’une banque à une autre, contenant chacune au 
maximum 128 sons. 
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Etant donné que plusieurs appareils ne reçoivent pas ces 
messages, vous pouvez désactiver ce paramètre en efffectuant 
le réglage ci-contre.

Pour plus de renseignements, jetez un oeil au paragraphe 
«Instrument» à la page 5 - 21.

Enregistrer les program changes ou bien  les contrôleurs de
volume et de  panoramique

N’importe quel type d’événement peut-être transmis en 
cochant la bonne case dans la boîte de paramètres d’instru-
ment, mais peuventégalement être stocké lorsque vous êtes en 
mode enregistrement. Par exemple, en mode pause enregistre-
ment, vous pouvez  stocker des program changes à des positions 
spécifiques de la façon suivante:

• Décochez la case à côté  de prg (ou vol, ou encore pan);
• Cliquez sur Pause, puis sur Record;
• Déplacez le pointeur de position à l’endroit que vous dési-

rez;
• Choisissez le son (programme) que vous souhaitez (ou bien 

la valeur de volume/pan que vous désirez);
• Cliquez sur la case à côté de prog (,vol, ou pan).L’événement 

correspondant sera envoyé et enregistré.

Cliquez sur stop pour quitter le mode enregistrement.

3.4 Séquences
Les séquences sont des bouts d’enregistrement contenant des 
événements Midi. Leur rôle est de faciliter la gestion et la 
modification de vos enregistrements. Elles concordent avec la 
convention musicale qui traite les phrases musicales ou riffs 
comme des objets à part entière. Il est le plus souvent indispen-
sable de pouvoir effectuer un bon nombre d’opérations(ex: la 
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quantification) sur ces objets plutôt que sur des notes indivi-
duelles.



Chapitre 3
Fenêtre Arrange

Les séquences à l’intérieur d’une piste  peuvent se chevaucher  
en partie  ou entièrement, mais pour la clarté de la construction 
musicale, ceci devra être évité.

Rappelez vous que même si le titre d’une des rubriques qui 
suivent mentionne un pluriel (séquences), l’opération en ques-
tion ne s’applique qu’aux séquences sélectionnées.

Créer une séquence
En général, une séquence est automatiquement créée lorsque 
vous enregistrez sur une piste. Celle-ci commence au début de 
la première mesure contenant le premier événement, et finit à 
la fin de la mesure contenant le dernier événement enregistré.

Des séquences peuvent aussi être créées en insérant directe-
ment des événements à partir du press papier dans la fenêtre 
Arrange (voir le paragraphe «Insérer des événements» à la page 
3 - 23).

Créer une séquence vide
Cliquez avec l’outil stylo dans la zone d’arrangement à l’endroit 
où la séquence doit débuter. Vous pouvez maintenant entrer les 
événements manuellement à l’aide d’un éditeur.

Supprimer une séquence 
Vous pouvez supprimer toutes les séquences sélectionnées en 
lui cliquant dessus avec l’outil gomme, ou bien en appuyant sur 
la touche B. L’outil gomme vous permet également de suppri-
mer une séquence non sélectionnée.
3 - 14
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Récupérer des séquences supprimées
Bien sûr, si vous effacez accidentellement une séquence, vous 
pouvez la récupérer immédiatement avec la fonction Edit > 
Undo (çz).

Déplacement de séquences
les séquences peuvent être déplacées en les attrapant et en les 
faisant glisser. Vous pouvez les  déplacer dans les deux direc-
tions du temps, et entre pistes différentes. 

Joindre des séquences ensemble 
En sélectionnant Functions > Modify Object Borders > Tie 
Objects by Position Change, Vous pouvez supprimer les espa-
ces vides, appelés gaps, se trouvant entre les séquences sélec-
tionnées en les déplaçant ensemble.Lorsque vous faites ceci, la 
première séquence reste inchangée. Ceci est particulièrement 
utile pour joindre des régions audio dans Logic Audio.

Editer le début d’une séquence de façon numérique
Vous pouvez éditer le début d’une séquence (et sa longueur) 
d’une façon numérique. Ceci s’opère à partir d’une Event List  
au niveau Arrange (voir le paragraphe «Structure de la liste au 
niveau de l’Arrange» à la page 10 - 10) ou bien dans une fenêtre 
Event Float (voir le paragraphe «Fenêtre Event Float» à la page 
10 - 18).

Copie de séquences
Pour copier des séquences à une position différente ou sur une 
autre piste, maintenez la touche ç enfoncée pendant que 
vous les déplacez.
3 - 15
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Copies multiples de séquences 
La fonction Repeat Objects… dans le menuEdit permet de 
répéter une séquence. La répétition commence toujours à la 
suite de la séquence elle-même ou à la fin de la dernière 
séquence sur la piste.

Number of Copies

c’est là que vous entrez le nombre de copies (sans compter 
l’original).

Adjustment

C’est là que vous déterminez si vous voulez une copie pour 
commencer exactement à la fin de l’original (de la copie précé-
dente) (setting: none) ou si vous voulez que le point de départ 
soit quantifié. Dans la plupart des cas, la configuration automa-
tique répondra toujours à vos demandes.

As

Ce paramètre (qui signifit statut) détermine si les objets utilisés 
sont des copies ou des alias de l’original (voir page 3 - 40).

Notez également qu’il y a un paramètre de séquence appelé 
«Loop», qui répète la séquence jusqu’au prochain objet sur la 
même piste (voir le paragraphe «Loop» à la page 3 - 26). Il est 
peut être préférable de copier les séquences dans la plupart des 
cas.
3 - 16
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Modifier la longueur d’une séquence…
Attrapez une séquence grâce aux outils pointeur ou stylo par le 
coin inférieur droit. Vous pouvez maintenant déplacer le point 
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de fin de la séquence là où vous le désirez. Même lorsque vous 
raccourcissez une séquence, les événements qu’elle contient 
ne sont jamais effacés; la lecture de la séquence s’arrêtera 
cependant au point de fin.

Le paramètre de séquence «Clip Length» détermine si les notes  
qui sont jouées lorsque la séquence se termine doivent être 
coupées brusquement (on), ou si elles doivent être jouées 
jusqu’à leur point de fin normal (off), quelle que soit la fin de la 
séquence.

… d’une multiple sélection …
Vous pouvez modifier la longueur d’objets multiples de la 
même façon. La longueur sera changée de la même valeur 
absolue.

… de la même longueur absolue

Si vous voulez que toutes les séquences sélectionnées aient la 
même longueur absolue, même si elle ont une longueur origi-
nelle différente, maintenez simplement les touches çS 
enfoncées pendant que vous modifiez la longueur (tout comme 
dans le Matrix Editor ou l’Even list).

… Ajuster le départ
Vous pouvez  également ajuster la longueur de la séquence en 
la saisissant au coin gauche. Cependant, vous ne pouvez pas 
déplacer le coin gauche derrière le premier événement de la 
séquence(vous ne pouvez jamais cacher des événements du 
premier plan). Si vous voulez déplacer le début d’une 
séquence, vous devez le couper (mute), ou effacer le début.

…arrondi à la mesure

la fonction Modify Object Borders > Snap Objects dans le 
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menu Functions, positionne le début de l’objet à la barre de 
mesure la plus proche.
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Lorsque vous modifiez la longueur d’une séquence, les événe-
ments qu’elle contient ne sont pas altérés et gardent toujours la 
même position temporelle. Si vous désirez toutefois le faire, 
effectuez les étapes suivantes:

…en compressant ou en étirant le temps 

Maintenez enfoncée la touche ç pendant que vous modifiez 
la longueur. La séquence est alors compressée ou bien étirée de 
manière proportionnelle.

Grâce à cette méthode, vous pouvez diviser par deux le tempo 
d’une séquence en étirant la séquence sur le double de sa 
longueur, ou doubler le tempo en comprimant la séquence sur 
sa moitié.

…pour encadrer le contenu

La fonction Functions > Modify Object Borders > Set Optimal 
Object Sizes réduit ou étire l’objet de façon à encadrer tous les 
événements qu’il contient, au plus près. Les bordures de 
l’objet (début et fin) sont positionnées sur la barre de mesure la 
plus proche.

Si vous maintenez enfoncée la touche A les bordures de 
l’objet seront arrondies à la pulsation la plus proche.

…pour éliminer les chevauchement de séquences

Lorsque vous choisissez Functions > Modify Object Borders > 
Remove Overlaps, une recherche des recouvrements (overlaps) 
des séquences des pistes sélectionnées est lancée. Lorsqu’un 
recouvrement est trouvé, la séquence qui débute en première 
est réduite afin d’annuler ce recouvrement.

…en utilisant une règle plus fine

Toutes ces opérations (déplacer, copier, rallonger, raccour-
cir)sont effectuées selon les mesures ou selon la pulsation de la 
3 - 18
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règle (dépendant du facteur zoom). On peut cependant utiliser 
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Affichage de grille selon les divisions:
A + operation.

Pas de grille (résolution en pas d’horloge):
AS + operation.

Tout ce que vous devez faire est de tenir ces touches pendant 
l’opération spéciale.

Vous voulez raccourcir une séquence en 4/4 de façon à ce que le 
quatrième temps (pulsation) de la dernière mesure soit joué, 
mais pas le reste du temps («4 et demi»).Réglez le facteur zoom 
de manière à faire apparaître les demi-temps. Attrapez la 
séquence par son coin inférieur droit et raccourcissez la d’un 
temps. Puis maintenez la touche A et tirez doucement le 
point de fin de séquence d’une division. Pendant cette opéra-
tion, la partie droite de la barre de titre de la fenêtre Arrange affi-
che le numéro de piste et la longueur courante de l’objet en 
mesure, pulsation, division et pas d’horloge. Dans l’exemple, 
les trois derniers chiffres devraient être «310».

Séparer des séquences…
Sélectionnez l’outil ciseaux. Maintenant, cliquez et tenez 
l’extrémité du segment à couper. La partie gauche de la barre 
de titre de la fenêtre Arrange vous indique avec précision  la 
position de la souris.  Lorsque vous relâchez la souris, tous les 
éléments situés dans le segment ainsi défini sont coupés. Le 
pas de la grille est déterminé par le paramètre Display Format, 
que l’on peut éditer dans la fenêtre transport, juste au dessous 
de l’indication de signature.

Si des notes se chevauchent  de plus de 1/16 de note, le 
message suivant apparaît à l’écran:

Overlapping Notes found! Do you want to keep, to shorten or 
to split those? [KEEP|SHORTEN|SPLIT]
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KEEP (par défaut) ne change pas les notes. La séquence est 
coupée normalement, mais lorsque vous faites ceci, vous 
pouvez terminer avec des notes qui sont plus longue que la 
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séquence. Ces notes sont jouées normalement sauf si Clip lenght 
est réglé pour couper les notes jouant jusqu’à la fin d’une 
séquence.

SHORTEN tronque toutes les notes qui se chevauchent, pour que 
la fin des notes tombe sur le point de coupure.

SPLIT divise les notes qui se chevauchent sur deux séquences 
créées quand lors d’une coupure; deux notes voisines sont 
créées, avec la même hauteur et la même vélocité que les notes 
d’origine.

…Division multiple avec les ciseaux
Si vous maintenez enfoncée la touche ç» tout en coupant un 
objet avec l’outil ciseaux, la séquence sélectionnée sera coupée 
en plusieurs morceaux, dont la longueur est déterminée par la 
longueur du premier morceau.

Par exemple: Pour diviser une séquence de 16 mesures  en 8 
séquences de 2 mesures, coupez la séquence au début de la 
mesure 3 tout en maintenant enfoncée la touche ç.

Fusion de Séquences
Vous pouvez fusionner plusieurs séquences se trouvant sur une 
piste en une seule séquence en utilisant l’outil «colle».

L’outil colle est identique à la fonction Structure > Merge > 
Objects. Les séquences sélectionnées sont fusionnées, même à 
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partir de pistes différentes, en une seule séquence dans 
laquelle tous les événement conservent leur position d’origine. 
Il faut que vous sachiez que les canaux Midi individuels sont 
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remplacés par le canal Midi de l’instrument actuel de la piste. 
Le nouvel objet adopte le nom et la piste du premier objet 
(chronologiquement) de ceux qui ont été fusionnés.

Jetez un oeil sur le paragraphe «Merge /Normalize et canaux 
Midi» à la page 3 - 30 pour plus d’informations.

La fonction Structure > Merge > Objects per Tracks a le même 
effet que la fonction Merge Objects, mais si les objets sélection-
nés se trouvent sur différentes pistes, ils sont alors combinés en 
un objet par piste.

Demixage de Sequences
La fonction Structure > Split/Demix > Demix by Event Channel 
Recherche la séquence sélectionnée pour les évènements qui 
possèdent des canaux Midi différents.Une séquence à part 
contenant les évènements est créée pour chacun des canaux 
Midi trouvés. Chacune de ces séquences est créée sur une piste 
avec un instrument qui possède la même canal Midi. destina-
taire. Si aucune piste n’existe, une piste est créée avec un 
instrument original.

La fonction Demix by Note Pitch, cherche la séquence sélec-
tionnée pour les notes avec différents numéros. Une séquence 
différente de la même longueur est créée pour chaque numéro 
de note trouvé. Les pistes créées pour ces séquences possèdent 
le même instrument que les séquences originales. Cette carac-
téristique est particulièrement utile pour séparer les parties de 
percussion qui ont été enregistrées dans Logic via une boîte à 
rythme. 

Couper des séquences
Souvent, votre travail vous amènera à vouloir couper le son de 
certaines parties, ou de certaines pistes. C’est le rôle de l’outil 
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mute.

Vous pouvez couper des objets individuels ou une sélection en 
cliquant dessus avec cet outil. Un point apparaît alors à côté de 
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leur nom. Cliquer sur un objet coupé rend à celui ci son statut 
normal.

Vous pouvez lancer la même fonction avec la commande 
clavierMute Folders/Sequences.

Solo de séquences
Vous pouvez mettre en Solo toute une séquence sélectionnée 
avec le bouton solo de la barre de Transport ou avec la 
commande clavier du même nom. Un double-clic sur le bouton 
soloverrouille le statut de Solo. Vous pouvez alors modifier la 
sélection, revenir plus tard à une séquence verrouillée qui sera 
toujours en mode Solo. Un clic supplémentaire (ou la 
commande clavier de nouveau), permet de quitter le mode 
Solo. Pour plus d’informations à ce sujet, lisez le paragraphe 
«Solo and Solo Lock» à la page 2 - 10.

L’outil Solo vous permet de lire en mode Solo un objet particu-
lier ou une sélection en cliquant et en maintenant le bouton de 
la souris enfoncé. Vous pouvez garder la souris immobile 
(lecture normale si Logic est en mode lecture), ou bien la 
déplacer dans le sens horizontal (scrubbing). Dès que vous relâ-
chez le bouton de la souris, le fonctionnement de Logic rede-
vient normal.

Nommer une séquence
Pour nommer une seule sequence: cliquez sur la séquence avec 
l’outil texte et une boîte de saisie doit apparaître. Saisissez le 
nom et appuyez ensuite sur la touche R, sur un autre objet ou 
encore sur le fond d’écran.

La même chose est nécessaire si vous devez saisir le nom dans 
une boîte de de paramètres de séquence.
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Nomminations multiples…
Selectionnez un groupe de séquences (par exemple avec le 
lasso) et cliquez sur l’une d’elles avec l’outil texte. Une boîte de 
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saisie doit alors apparaître où vous pouvez donner un nom à la 
séquence: Le même nom est alors donné à toutes les séquences 
sélectionnées.

…Avec des nombres en incrémentation

Si vous terminez le nom d’une séquence par un numéro, toutes 
les séquences sélectionnées sont pourvuent du même nom 
mais avec le numéro qui est incrémenté à chacune d’elles. Elles 
sont alors numérotées en fonction de la position temporelle des 
séquences. Si vous désirez donner à toutes les séquences le 
même numéro, ajoutez simplement un espace juste après le 
numéro.

La même façon de procédé est nécessaire lorsque vous saisissez 
un nom via la ligne supérieure dans la boîte de paramètres de 
séquence au lieu d’utiliser l’outil texte.

Fonctions spéciales 

Insérer des événements
Des événements Midi peuvent être ajoutés directement dans 
la piste sélectionnée dans la fenêtre Arrange, à la position 
courante du Song, à partir d’une fenêtre d’édition via le presse-
papiers.

Cette fonction vous permet d’insérer des événements Midi 
(par exemple dans le Matrix Editor) directement dans la fenêtre 
Arrange. Logic vérifie que vous avez bien sélectionné une  
séquence, puis ajoute les données dans cette séquence sur la 
piste sélectionnée. Si vous n’avez sélectionné aucune 
séquence, Logic doit créer une nouvelle séquence sur cette 
piste.
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Supprimer des événements 

…Evénements en double 

 La commande clavier Erase Duplicates  recherche dans toutes 
les séquences sélectionnées et dans toutes les séquences des 
dossiers sélectionnés des événements identiques avec la même 
position temporelle. Tout événement intervenant plusieurs 
fois à la même position sont supprimés (il n’en reste alors plus 
qu’un).

• La recherche porte sur les notes, sur les contrôleurs, sur les 
aftertouch monophoniques et sur les program changes.

• Les événements du même type mais sur des canaux diffé-
rents sont considérés comme différents.

• La même position temporelle inclue deux notes qui jouent 
en même temps du fait de la valeur de quantification en 
cours.

3.5 Paramètres de jeux de 
séquences 

La boîte de paramètres de séquence est située sur la gauche de 
la Track list, au dessus de la boîte à outils. 

Affichage des paramètres de séquence 

Sélectionnez simplement une séquence et vous devez immé-
diatement voir ses paramètres. Si la boîte de sélection de para-
mètres n’est pas visible, sélectionnez View > Hide/Show Para-
meters).

Aucun de ces paramètre ne modifient la manière dont les 
événements sont enregistrés. Il n’affecte que la façon dont 
Logic va relire ces événements.
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Paramètres de séquence par défaut
Si aucune séquences n’est sélectionnée, la ligne du haut de la 
boîte de paramètres de séquence indique «MidiThru». Lorsque 
vous enregistrez une nouvelle séquence, les réglages de la boîte 
de paramètres Midi Thru sont copiés dans la boîte de paramè-
tres de séquence pour la séquence résultante. La boîte de para-
mètre Midi Thru sert donc de configuration par défaut. 

Traitement en temps réel

Les données Midi sont toujours reliés «à travers» l’instrument 
assigné à la piste sélectionnée.Ces données sont traitées par la 
boîte de paramètres Midi Thru. Vous pouvez toujours voir les 
paramètres de Midi Thru affichés, ou les éditer lorsqu’il n’y a pas 
de séquence sélectionnée (en cliquant sur le fond d’écran pour 
déselectionner toutes les séquences, par exemple).

Editer plusieurs séquences simultanément
Si plusieurs séquences sont sélectionnées simultanément, le 
nombre de séquences sélectionnées apparaît à la place du nom. 
La modification d’un paramètre dans la boîte de paramètres de 
séquence affectera toutes les séquences sélectionnées. Si un 
paramètre est réglé différemment parmi les séquences du 
groupe de sélection, un >*< est affiché à la place de sa valeur. Si 
vous désirez caler un paramètre à la même valeur pour toutes 
les séquences de la sélection, maintenez enfoncée la toucheç 
pendant la modification (modification absolue).

Ouvrir et fermer la boîte 
A gauche du nom est disposé un petit triangle. En cliquant 
dessus, vous faites apparaître ou disparaître le contenu de la 
boîte, exactement comme pour les dossiers dans Windows 
Explorer. Lorsque la boîte est fermée, les éléments situés en 
dessous disposent de plus de place.
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Les paramètres de séquence
Ces paramètres de séquence peuvent également affecter des 
dossiers, auquel cas ils sont valides pour l’ensemble des 
séquences à l’intérieur du dossier. Les paragraphes suivant se 
réfèrent souvent à des objets, qui dans ce cas sont des séquen-
ces ou des dossiers (Folders).

Lorsqu’un paramètre de séquence prend la valeur par défaut, 
son affichage est supprimé pour plus de clarté.

Name
la ligne du haut de la boîte de paramètres de séquence indique 
simplement le nom de la séquence sélectionnée: dans l’exem-
ple ci-contre, c’est «séquence».

Qua
Traité dans le paragraphe «Quantification» à la page 3 - 31.

Loop
Prend comme valeur On ou Off. Valeur par défaut: Off.

Lorsque cette fonction est activée (on) l’objet est répété sur la 
piste, jusqu’à ce qu’il rencontre l’objet suivant. Une boucle se 
termine aussi au marqueur de fin de dossier (si la séquence est 
en boucle à l’intérieur d’un dossier ou d’un Song de premier 
niveau). Ces répétitions sont visibles sous la forme de barres 
grises(sans figuration de nom).La longueur de chaque élément 
de répétition est exactement la longueur de l’original, et si vous 
voulez des structures polyrythmiques, expérimentez la 
longueur de l’objet d’origine.

Une façon d’arrêter une boucle est de placer une séquence une 
séquence vide avec l’outil stylo.Une méthode plus judicieuse 
est de placer la boucle et son objet de référence dans un 
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s’agissait d’une séquence simple, en manipulant l’objet 
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La commande clavier Toggle Loop permet de commuter le statut 
de boucle(on ou off).

Functions > Sequence/Instrument Parameters > Turn Loops 
to Real Copies transforme les répétitions en copies réelles de 
l’objet d’origine et désactive automatiquement le paramètre 
Loop pour les objets résultants de cette manipulation.

Functions > Sequence/Instrument Parameter > Loops to Alia-
ses transforme les répétitions en alias. Cette fonction est égale-
ment disponible en commande clavier.

Transpose
Valeurs: +/- 96 demitons. valeur par défaut: 0.

Toutes les notes de la séquences sont transposées de la valeur 
indiquée à la lecture. Un dossier complet peut-être transposé 
par cette technique. Si, à l’intérieur du Dossier, des séquences 
étaient déjà transposées, les écarts relatifs à l’intérieur du 
Dossier sont maintenus.

Si vous désirez ce paramètre octave par octave, attrapez le par la 
gauche (entre le mot transpose et sa valeur affichée). cela ouvre 
un menu donnant directement  accès aux valeurs d’octave.

Pour éviter que des notes ayant une signification spéciale (ex. 
percussion) ne soient transposées, Le paramètre No Name 
Transpose doit être validé. Le paramètre de transposition sera 
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Velocity
Valeurs: +/- 99. valeur par défaut: 0.

toutes les notes de l’objet correspondant sont affectées par ce 
réglage. Une valeur positive s’ajoute aux vélocités propres des 
notes, une valeur négative se soustrait, sachant que de toute 
façon, il n’est pas possible de sortir de la plage défini par le stan-
dard Midi (0-127). si vous jouez une note particulière avec une 
vélocité maximum, cette note sera jouée avec l’action la plus 
extrême possible. Exemple: un réglage de +20, donnera une 
note de 120 pour être jouée à 127.

Dynamics
Valeurs: voir le diagramme. Valeur par défaut: 100%.

Ce paramètre affecte aussi la vélocité des notes, mais d’une 
autre façon. Au lieu d’ajouter ou de retrancher une valeur fixe à 
la vélocité, se sont les écarts entre les notes «fortes» et les notes 
«faibles» qui sont augmentés ou réduits. Cela ressemble beau-
coup aux fonctions d’un compresseur-expandeur. Les valeurs 
au dessus de 100% étendent la dynamique donc l’écart entre 
les notes «fortes» et «faibles», tandis que les valeurs inférieures 
à 100% compressent cette dynamique.

La valeur «fix»donne à toute les notes une vélocité  fixe de 64. 
En conjonction avec le paramètre vélocité (voir au dessus), 
toutes les valeurs fixes de vélocités sont possibles.

Gate Time
Valeurs: voir le diagramme. Valeur par défaut: 100%.

Le terme Gate Time nous vient de la technologie analogique des 
synthés et se réfère au temps écoulé entre la pression et le relâ-
chement. Ce paramètre affecte donc la durée des notes. Cette 
durée ne doit pas être confondue avec la valeur, en termes de 
notation musicale, de la note. Le terme technique «temps de 
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porte»(gate on time) ou «longueur de note» sont décrit normale-
ment comme un Staccato  et un Legato. La valeur «fix» signifie 
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durée de la note, tandis que les valeurs inférieures à 100% dimi-
nuent la longueur de note. La valeur «Leg» produit un parfait 
legato pour toutes les notes, peu importe leur longueur 
d’origine, éliminant tous les espaces entre les notes. Si cela est 
utilisé dans un Dossier, toutes les notes de toutes les séquences 
seront affectées.

Delay
Valeurs: -999 to 9999 pas d’horloge. valeur par défaut: 0.

Ce paramètre introduit un retard dans l’exécution des notes 
sélectionnées. Ce retard peut être négatif, auquel cas il s’agira 
d’une avance.

Le retard est exprimé en pas d’horloge, l’horloge est la résolu-
tion la plus fine qu’un séquenceur puisse connaître, 1/3840 ème 
de mesure dans Logic. Vous pouvez utiliser la souris comme 
slider pour entrer la valeur sur le côté droit du champ de saisie 
du Delay.

Si vous cliquez sur la gauche, entre la valeur affichée et le nom 
du paramètre, vous activez un menu qui vous permet de choisir 
des valeurs de retard quantifiées selon des fractions de ronde.

Une option du menu View exprime le délai en millisecondes: 
utilisez Delay in ms. Cela permet également de calculer le 
temps de délai à un tempo donné:

• Entrez la note désirée en cliquant sur la valeur de délai à 
gauche.

• Entrez dans le menu View et activez Delay in ms.

• Régler le tempo désiré dans la fenêtre transport.

• Le paramètre délai affiche alors la valeur en ms.

Le délai est principalement utilisé pour des fonctions musica-
les. Mais il est possible d’utiliser ce paramètre pour corriger des 
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• La phase d’attaque des sons déclenchés est trop longue. Un 
bon instrumentiste corrige de lui même ce retard apparent. 
Avec des sons joués très doucement il faudra parfois monter 
jusqu’à un pre-delay de 100ms pour pouvoir corriger se 
défaut.

• Le générateur de son réagit trop lentement aux messages 
Midi. Les vieux synthés multi timbraux prennent souvent 
plusieurs dizaines de ms entre la réception d’un message 
note on, et la sortie du son. Il sera préférable de traiter ce 
retard par le paramètre delay de la boîte d’instrument. Cela 
permet de réserver le délai de piste au traitement des atta-
ques.

• Le retard des notes produites dépend de l’ordre d’allocation 
des voix lorsque beaucoup de messages arrivent au même 
moment. Ce phénomène est aléatoire. Il suffit en général 
d’avancer une partie des rythmiques d’un pas d’horloge. 
Cela marche à merveille!

Fixer et neutraliser les paramètres de séquence
Vous pouvez fixer une fois pour toute les modifications de 
lecture des séquences par la fonction Functions > Sequence/
Instrument Parameters > Normalize Sequence Parameters 
(Normalize). Cette fonction modifie les événements de façon à 
appliquer des modificateurs, puis remet les paramètres de la 
boîte de séquence à leur valeur normale. Le résultat n’est 
évidemment pas audible. Les paramètres de boucle et d’éten-
dues ne sont pas modifiés. Dans la plupart des cas, il est préfé-
rable de laisser les données originales. Ceci, vous laissant des 
possibilités infinies de changer votre manière de voir l’édition 
de séquences.

Merge /Normalize et canaux Midi

Comme la fonction Merge ou l’outil colle, la fonction Normalize 
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courante. Si les événements se trouvent sur des canaux diffé-
rents, Logic vous demande si vous voulez reconvertir les 
canaux.

Fonctions spéciales pour les séquences

3.6 Quantification
La quantification est la correction rythmique des notes selon 
une grille spécifique. Toute notes jouée approximativement est 
replacée à la position la plus proche de la grille. 

Par exemple: si la plus faible valeur de durée de note d’un 
passage est de 1/16ème, vous utiliserez une quantification au 1/
16ème pour replacer toute les notes dans le rythme idéal. Cela 
ne fonctionne bien que si les notes ont été jouées avec une 
précision inférieure au 1/32ème, sinon la note sera replacée sur 
la position suivante.

Fonctionnement
Le paramètrage de la quantification est exécuté dans la boîte de 
paramètres de séquence (normale ou étendue).Ce n’est pas 
une fonction destructrice: elle peut être modifiée à tous 
moments. En règlant le paramètre qua sur off (3840), vous 
pouvez toujours revenir à la version originale de l’enregistre-
ment. Contrairement aux autres paramètres de lecture, les 
effets de ces paramètres sont visibles dans les fenêtres 
d’édition, de façon à pouvoir vérifier leur portée. La quantifica-
tion ne fonctionne que pour les notes, et non les autres types 
d’événements(ex: contrôleur).

& pour chaque notes, deux positions sont mémorisées en interne: la position d’origine, 
et la position de lecture. Pour les séquences non quantifiées, ces deux positions sont 
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les mêmes. A chaque quantification, une nouvelle position de lecture est calculée à 
partir de la position d’origine.
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& La commande Fix Quantize (voir le paragraphe «Fixer la quantification» à la page 3 
- 34) remplace la position d’origine par la position de lecture. Il se passe la même 
chose lorsque vous changez une note dans un éditeur à la main: vous ne pourrez plus 
revenir à la position d’origine.

Quels événements peut on quantifier?
La quantification ne fonctionne que sur les notes, et non sur 
des événement tels que des contrôleurs. A part les notes, tous 
les événements n’ont qu’un seul paramètre de position, que 
vous pouvez laisser ou modifier à l’aide de la souris.

Pour quantifier d’autres événements que les notes, lisez le 
paragraphe «Quantifier des Evénements» à la page 1 - 34.

En général la quantification fonctionne pour toute la séquence. 
Pour ne quantifier que certaines notes, utilisez la quantification 
d’événements dans une des fenêtres d’édition (voir le paragra-
phe «Quantification d’Evénement» à la page 1 - 34). Gardez à 
l’esprit que cette opération remplace la position de l’enregistre-
ment original de la note quantifiée.

Si vous désirez quantifier différentes parties d’une séquence de 
façons différentes, vous pouvez coupez la séquence, et utiliser 
différentes quantifications pour chaque partie de cette 
séquence. Vous pouvez alors recombiner les parties de celle-ci 
sans modifier la façon dont les parties sont jouées. 

Remarque: la quantification démarre toujours au début de la 
séquence. Si la séquence ne débute pas à une mesure entière, 
la grille de quantification non plus.

Qua

La grille de quantifiquation se détermine à partir d’un menu 
déroulant sous la paramètre Qua dans la boîte de paramètre de 
séquence.
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Quantification désactivée

Le réglageoff(3840) joue les notes avec la résolution la plus fine 
possible: 1/3840ème de note, soit pratiquement sans quantifica-
tion.

Quantification standard

Les valeurs 1/1,1/2,1/4, 1/8,1/16,1/32, et 1/64èmes quantifient la 
séquence selon un découpage binaire.

Quantification par triolets

Les valeurs 1/3,1/6,1/12,1/24,1/48 et 1/96èmes quantifient les 
séquences selon un découpage ternaire. Un 1/6ème équivaut à 
un triolet de noires, 1/12ème à un triolet de croche, 1/24ème à 
un triolet de double croche, etc.

Quantification mixte

Le réglage 8 & 12 correspond à un mélange de croches et de 
triolets de croches, 16 & 12 à des doubles croches et triolets de 
croches et 16 & 24 à des doubles croches et triolet de double 
croches. Les triolets sont reconnus à condition d’une mise en 
place suffisamment précise.

Quantification impaire

Le réglage 9-Tuplet signifie nonuplet (1 mesure=9 temps), 7-
Tuplet tuplet est un septuplé (1 mesure= 7temps), 5-Tuplet/4 est 
un quintuplet de noires (1 mesure=5temps), et 5-Tuplet/8 est un 
quintuplé de croches (1 mesure=10 temps). 

Quantification de paramètres

Les paramètres de quantification suivant se trouvent dans la 
boîte de paramètres de séquence étendue, qui peut être 
ouverte soit en double-cliquant sur la moitié gauche de la boîte 
de paramètres de séquence, soit par l’intermédiaire de la fonc-
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Q-Swing

Valeurs: 1% – 99%. valeur par défaut: 50%.

Ce pourcentage altère les positions correspondant à la notation 
double point de la mesure. Des valeurs au dessus de 50 % retar-
dent ces événements, et au dessus de 50% les avancent.

Les résultats les plus probant sont pour une valeur comprise 
entre  50% et 75%.

Fixer la quantification
De la même manière que les paramètres de séquence peuvent 
être normalisés, la quantification peut faire partie courante des 
données mémorisées. 

Pour ceci, utilisez la commande clavier Fix Quantize.

Bien sûr, une fois que ceci est fait, il est impossible de revenir 
en arrière, c’est à dire à l’enregistrement original.

La pré-quantification

La fonction Fix Quantize sert essentiellement à la pré-quantifi-
cation. Par exemple, si une séquence ne peut pas être enregis-
trée directement sur un modèle 1/16 swing (parce que la quan-
tification ne le permet pas) commencez par le quantifier au 1/
16ème (standard), puis fixez la quantification. Vous pouvez 
maintenant appliquer des swings sur cette version «nettoyée» 
de la séquence.

Si vous enregistrez une pattern de charleston sur une base d’1/
16ème, avec quelques contretemps au 1/32ème, jouez la partie 
en éliminant les contre temps et requantifier au 1/32ème sans 
risquer de fausser le rythme de base. L’opération complète 
prend 2 cycles sans interrompre l’enregistrement. 
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3.7 Hyper Draw dans la fenêtre 
Arrange

Hyper draw est la fonction la plus simple pour éditer et modifier 
des informations de Volume ou de Panoramique  dans la fenêtre 
Arrange. Les changements de données Midi sont fait graphi-
quement par insertion de points, ceux ci représentant les 
valeurs des contrôleurs. Les points sont automatiquement 
placés par Logic, ce qui crée une série d’événements pour 
connecter les données Midi d’un point à un autre (ceci génère 
automatiquement des événements qui sont re-calculés à 
chaque fois que vous éditez les points de la courbe).

Vous pouvez activer Hyper Draw pour chaque séquence Par 
exemple, vous pouvez ouvrir la fenêtreHyper Draw pour contrô-
ler le volume sur une séquence, et le panoramique sur une 
autre.

Dans les sections où le contrôleur Midi édité ne change pas de 
valeur, la courbe du contrôleur est linéaire et horizontale.

Rappelez-vous de choisir un zoom vertical adéquat, pour vrai-
ment voir les courbes HyperDraw.

Activer l’Hyper Draw
• Pour activer l’Hyper Draw pour les séquences sélectionnées, 

choisissez le type d’événements que vous vdésirez afficher 
et éditer, puis sélectionnez Options > Hyper Draw…. Vous 
pouvez choisir des modes Hyper Draw différents pour 
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chaque séquence.Vous pouvez choisir les types d’événe-
ments suivants directement dans le menu Hyper 
Draw:Volume
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• Panning

Canal Midi

En choisissant Options > Hyper Draw > Channel … vous pouvez 
choisir le canal Midi des événements affichés. En sélectionnant 
la valeur any, les événements seront affichés quel que soit leur 
canal Midi. Lorsque vous éditerez ces événements, le canal 
Midi des événements traités sera celui qui aura été sélectionné 
en dernier.

Affichage
Lorsque les séquences sont affichées en mode Hyper Draw, le 
canal  Midi et le contrôleur édité sont affichés à gauche, séparés 
par une virgule.

Si le canal est réglé sur any (par défaut)), le premier numéro 
(Canal Midi) ne sera pas affiché. Le contrôleur d’événements 
de tous les canaux sera affiché. Les événements insérés 
donnent le canal de la piste d’instrument.

Désactiver l’Hyper Draw
Pour désactiver l’Hyper Draw pour les séquences sélectionnées, 
choisissez Options>Hyper Draw>Disable.

3.8 Tout sur les Dossiers
Un folder (ou dossier) est un objet d’arrangement pouvant 
contenir des séquences et, de manière plus générale, d’autres 
objets d’arrangement comme un répertoire sur votre disque dur 

Midi channel # 1,
Controller # 7 (Volume)
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Le mieux est de considérer un Folder comme un Song à l’inté-
rieur d’un autre Song. Un Folder peut contenir autant de pistes, 
contenant des séquences, que vous désirez. L’intérieur d’un 
Folder est identique à la zone d’arrangement et à la Track List 
d’un Song.

Sur une piste d’un Song, un Folder ressemble à une séquence. 
La différence se fait sur la barre de titre qui est tramée pour ces 
derniers.

Vous pouvez créer un Folder comprenant trois pistes (trom-
pette, saxophone et trombone) que vous arrangez en une 
section de cuivres, ou comprenant 14 pistes de batterie que 
vous pouvez traiter comme un objet unique.

Suivant le même principe, un Song entier peut apparaître sous 
la forme d’un Folder dans un autre Song. Vous pouvez donc asso-
cier des Songs pour programmer un concert entier.

Ce n‘est pas la seule utilisation des folders. Un folder peut struc-
turer des parties différentes de votre Song, comme un couplet 
ou un refrain. Et comme en bureautique, vous pouvez placer 
autant de folders que vous voulez à l’intérieur d’autre folders, 
eux mêmes dans des folders (pour un groupe d’instrument à 
l’intérieure du Song, par exemple), avec aucune limite quant au 
nombre de niveaux que vous pouvez créer.

Une autre utilisation possible est de stocker différents arrange-
ments d’un Song dans différents folders, vous pourrez alors les 
passer en revue rapidement…

C’est maintenant suffisant pour que vous puissiez y réfléchir un 
petit moment. Nous laissons le reste à votre imagination…

Le folder comme instrument de piste 
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Un folder est normalement placé sur une piste réglée sur Folder 
dans la Track list, plutôt que sur un instrument.
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Ceci signifie que tous les objets du folder sont lus par le set 
d’instrument réglé dans la Track list du folder. Tous les instru-
ments à l’intérieur du Dossiersont joués comme ils le seraient 
au niveau supérieur de la fenêtre Arrange.

Si vous mettez un folder sur une piste réglée sur un instrument 
normal, l’ensemble de son contenu sera joué par cet instru-
ment. Cela n’a de sens que si le folder contient des pistes sur ce 
même instrument. Malgré tout, ceci peut être utile pour écou-
ter rapidement un arrangement de cordes, par exemple, si 
toutes les sources sonores ne sont pas disponibles.

Création de Dossiers
La fonction Structure > Pack Folder place le contenu de la 
sélection dans un nouveau folder. Ce dernier est créé sur une 
piste assignée à un folder. Si aucune piste de ce type n’existe, 
Logic en conçoit une.

Si aucun objet n’a été sélectionné, Logic crée une piste conpre-
nant un folder. Celui ci ne contient pas d’objets, mais unique-
ment des pistes avec les instruments du niveau courant. 

Changement du niveau d’affichage

Entrer dans un Dossier
Pour passer à un niveau inférieur dans la fenêtre Arrange, 
double-cliquez sur le Dossier correspondant.

Sortir d’un dossier
Pour passer à un niveau d’affichage supérieur de la fenêtre 
Arrange, double-cliquez le fond d’écran, ou cliquez le symbole 
de fermeture (rectangle noir) dans le coin supérieur gauche, à 
3 - 38
Emagic
Logic Audio Pro ISIS 

côté du menu.



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix

X

Tout sur les Dossiers

Déplacer des objets dans les Dossiers
…c’est aussi facile qu’un Drag & Drop. Prenez l’objet sur la 
piste originale et déplacez le jusqu’au Dossier à la place dési-
rée, puis relâchez le bouton de la souris. Si le dossier ne 
contient pas de piste pourvue du même instrument que la piste 
originale, Logic en crée une. Si vous regardez à l’intérieur du 
Dossier vous verrez l’objet déplacé à l’endroit désiré.

Décompacter des objets individuels
Si vous désirez déplacer un objet individuel d’un Dossier vers 
un niveau supérieur:

• Rendez-vous au niveau d’affichage ou se trouve l’objet que 
vous désirez déplacer. Sélectionnez l’objet et transférez le 
dans le presse-papiers (Clipboard) en appuyant sur les 
touches çx. Déplacez-vous ensuite au niveau d’affichage 
ou vous désirez ajouter l’objet. Sélectionnez la piste désirée, 
et éditez la position de la ligne du Song à l’endroit choisi, puis 
ajoutez l’objet en appuyant sur çv.

Décompacter un folder 
Utilisez la commande Structure > Unpack Folder pour déman-
teler le folder sélectionné. Les objets du folder sont copiés dans 
le niveau immédiatement supérieure, sur les pistes correspon-
dant au même instruments. Si de telles pistes n’existent pas, 
Logic les créera.

Autres opérations avec les folders
En principe, tout ce qui est possible de faire avec les séquences 
l’est aussi avec les folders. Voir les fonctions qui sont détaillées à 
partir de la page 3 - 14 si vous désirez vous remémorer ces 
dernières. Tout ce qui est décrit en terme de séquences est 
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3.9 Alias
Un Alias dans Logic est la même chose qu’un raccourci dans 
Windows 95. Cela ressemble à un objet, mais ne contient 
aucune données; il s’agit seulement d’une référence aux 
données de la source (un double virtuel de l’original). Vous 
pouvez le repérer par sa couleur orange.

Si les données de l’original sont modifiées, alors tous les Alias 
associés le sont de même.

C’est la caractéristique essentielle des Alias. Par exemple, si 
une même ligne mélodique tourne tout au long d’un Song, il est 
conseillé d’utiliser des Alias sauf pour l’objet original évidem-
ment. Si une modulation, une note n’est pas exactement ce que 
vous désirez, modifiez la dans l’objet original, et tout le Song 
sera modifié. Si vous voulez apporter une variation à cette 
séquence à un endroit particulier du morceau, il est toujours 
possible de transformer l’Alias en un objet autonome et 
pouvant être édité.

Création d’un Alias
Pour créer un Alias, maintenez simplement la touche S enfon-
cée lorsque vous copiez l’objet (en maintenant enfoncées les 
touchesçSet en déplacant l’objet).

Il existe également la commande Alias > Make dans le menu 
Structure. L’Alias de l’objet sélectionné apparaît sur la piste en 
sélection, à l’endroit courant du début du Song.

S’il s’agit d’une sélection multiple, les écarts en temps et les 
écarts de piste entre les différent objets sont conservés. La 
piste de référence est celle correspondant à l’objet de plus 
faible position (le plus à gauche).

Lorsque vous utilisez la fonction Repeat Objects dans le menu 
3 - 40
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Paramètres de lecture 
Bien qu’un Alias soit un double virtuel de l’objet original, il 
dispose de ses propres paramètres de lecture. Exception:en 
raison de leur action particulière, les paramètres de quantifica-
tion de l’Alias sont toujours ceux de l’original.

Fonctions de recherche pour un Original ou 
un Alias

Rechercher l’original d’un Alias
Si vous avez oubliez quel est l’original d’un Alias, ou que vous 
avez maintenant beaucoup d’objets dans votre Song, la fonc-
tion Structure > Alias > Find Original retrouve et sélectionne le 
bon original. Une autre méthode est décrite dans la section 
Contenu Visible Dans l’Objet au paragraphe «Contenu Visible 
dans l’objet» à la page 3 - 47.

Rechercher l’alias d’un original
A l’inverse, vous pouvez sélectionner l’original d’un objet parti-
culier, et trouver tous les Alias que vous avez créés à partir de 
cet objet; Sélectionnez Structure > Alias > Select All Aliases of 
Object. Tous les Alias existant seront alors sélectionnés.

Alias «Orphelins»
Si vous effacez un objet à partir duquel plusieurs Alias ont été 
créés, Logic vous avertit en affichant le message suivant:

One or more Aliases are made from objects to be cleared! Do 
you still want to clear these?

‹Don’t Clear› annule la procédure d’effacement, alors que 
‹Clear› supprime l’objet. Si vous faites ceci, cela n’a plus de sens 
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de garder les Alias une fois l’original éliminé, mais comme 
Logic ne le fait pas à votre place, vous vous retrouverez avec se 
qu’on appelle des Alias orphelins, c’est à dire des Alias sans 
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original. Bien que de tels objets n’aient aucune utilité Logic ne 
les supprime pas puisque vous pouvez les assigner à un autre 
original plus tard.

Sélectionner tous les Alias orphelins
Structure > Alias > Select All Orphan Aliases sélectionne tous 
les Alias dont la séquence d’origine n’existe plus.

Effacer les Alias «Orphelins»
Structure > Alias > Delete All Orphan Aliases supprime tous les 
Alias qui n’ont plus d’original. Vous pouvez utiliser cette fonc-
tion pour faire un coup de nettoyage après avoir supprimé 
beaucoup d’objets, étant donné que cela pourrait laisser un bon 
nombre d’anciens Alias un peu partout qui ne servent à rien.

Convertir un Alias en Objet réel
Vous pouvez utiliser Structure > Alias > Turn to Real Copy pour 
créer un objet réel à partir d’un Alias; son contenu sera identi-
que à l’objet d’origine de l’Alias.

Editer un Alias
Ceci n’est pas possible. Si vous double cliquez sur un Alias, 
Logic supposera que vous voulez modifier l’original ou bien 
que vous désirez convertir l’Alias en question en objet réel. la 
boîte de dialogue suivante est alors affichée:
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Mixer plusieurs objets ensemble
Si vous éditez un objet d’origine en le mixant avec d’autres, 
tout Alias existant est automatiquement mis à jour pour refléter 
les modifications.
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3.10 Utilisation de la fenêtre 
Arrange

Si nécessaire, relisez le paragraphe «La Souris» à la page 1 - 2, 
le paragraphe «Techniques de sélection» à la page 1 - 24 et le 
paragraphe «Opérations d’édition» à la page 1 - 27 dans le 
chapitre Utilisation de Logic. Ces paragraphes, ainsi que les tech-
niques expliquées dans le paragraphe «Séquences» à la page 3 
- 13 couvrent l’essentiel des opérations d’Arrangement.

Ce paragraphe ne décrit que les fonctions qui:

• N’on un effet que sur une partie spéciale du Song, que vous 
déterminez avec les positions des locators(Locator positions), 
ou

• Engendrent une réaction entre les objets et les positions des 
locators.

Ajuster les locators en fonction des objets
Sélectionnez Functions > Set Locators by Objects pour régler 
les locators pour qu’ils soient alignés avec le (ou les) objet(s) 
sélectionné(s).

3.11 Modification de l’affichage
Pour obtenir des informations sur les fonctions de base des 
fenêtres, référez-vous au paragraphe «Fonctions des fenêtres» 
à la page 1 - 11.

Si vous désirez savoir comment optimiser la place disponible 
dans la Zone Arrange, rendez-vous au paragraphe «Relations 
entre fenêtres» à la page 1 - 19. La fenêtre Arrange contient 
également les fonctions suivantes:
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Affichage des options pour la Track List 
Vous pouvez utiliser le menu View pour montrer ou cacher les 
différents partie de la track list: 

Track numbers / Level meters
Choisir View > Track Numbers/Level Meters vous permet 
d’afficher/cacher les numéros de piste ainsi que son indicateur 
de niveau intégré.

Mute Switch
chaque piste possède sont propre Mute Switch. Si ces interrup-
teurs sont cachés, vous pouvez couper (mute) la piste en 
cliquant à gauche du numéro de piste. Une piste coupée est 
indiquée par un ‹Ø›.

Record Audio Switch

options d’affichage
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Choisir Record Audio Switch vous permet de cacher ou de 
montrer l’interrupteur d’enregistrement audio(voir le paragra-
phe «›Armement‹ des pistes» à la page 4 - 13).
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Instrument Icon
Choisir Instrument Icon montre ou masque l’icône de l’instru-
ment de la piste.

Instrument Name et Track Name
Cacher l’un des noms permet de gagner de la place horizonta-
lement. Pour les distinguer, le nom de l’instrument est toujours 
en caractère gras. L’un des deux noms est toujours caché.

Présentation horizontale

Si les deux noms (d’instrument et 
de piste) sont affichés, ils sont 
alors présentés en ligne.Vous 
pouvez déplacer cette ligne avec 
la souris en haut  du marqueur.

Presentation verticale des noms 

Si vous Zoomez verticalement, 
vous découvrirez les deux noms, 
l’un sur l’autre, le nom de l’instru-
ment en gras au dessus et le nom de 
piste en dessous.

Classer les pistes

Vous pouvez classer les pistes en cliquant sur le numéro de 
piste et en le déplaçant verticalement. Vous pouvez aussi utili-
ser le bord du nom pour effectuer cette opération. 

Voici les autres fonctions concernant les noms:

Sélectionner une piste d’instrument

Vous pouvez assigner un instrument à une piste, en cliquant et 
en maintenant la moitié gauche du nom ou de l’icône.
3 - 46
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Ouvrir la fenêtre d’Environnement pour un instrument

Vous pouvez ouvrir un fenêtre d’Environnement ou l’instru-
ment choisi sera visible en double-cliquant sur le nom de cet 
instrument.

Editer les noms d’instruments

Vous pouvez éditer le nom d’un objet audioen maintenant la 
touche ç enfoncée tout en double-cliquant directement 
dans la track list. Vous pouvez également utiliser la boîte de 
paramètres d’instrument.

Editer des noms de pistes

Vous pouvez éditez les noms des pistes en maintenant enfon-
cée la touche Atout en double-cliquant directement dans la 
Track list, même si un seul nom d’instrument y apparaît.

Affichage des objets

Rendre les paramètres de séquence visibles
Elargissez l’affichage avec le zoom vertical. A partir d’un certain 
réglage de zoom, vous pouvez voir les paramètres de séquences 
affichés dans la moitié inférieure de tous les objets. Vous 
pouvez modifier ici les paramètres de séquence avec la souris (à 
l’aide des sliders ou bien des menus déroulants).

Contenu Visible dans l’objet
Si vous augmentez encore le zoom vertical, vous pouvez voir le 
contenu des objets.
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Les séquences indiquent les événements de notes et les 
contrôleurs, les dossiers indiquent les objets qu’ils contiennent 
et les Alias indiquent le nom et la position de leur original

L’option View > Object Content vous permet de visualiser le 
contenu, même avec un petit zoom, mais c’est au détriment  du 
nom de l’objet. Sélectionnez de nouveau cette option, soit par 
le menu soit par le clavier, pour revenir à l’affichage normal.

Couleur des objets
Les nouvelles séquences enregistrées  adoptent la couleur de 
l’instrument de la piste. Cependant, après la copie de séquen-
ces entre pistes, l’Arrange commence à ressembler à un vrai 
patchwork. Dans ce cas, la fonction View > Instrument Colors 
To Objects remplace la couleur des objets sélectionnés par la 
couleur des instrument jouant les objets concernés.

Les couleurs des instruments doivent être paramètrées dans 
l’environnement.

Modifier le fond d’écran de la zone Arrange
Utilisez la fonction View > Show Grid pour afficher/masquer 
une piste ou bien une grille de mesure dans le fond d’écran de 
la zone Arrange. 

White Background, commute entre le fond d’écran gris, celui 
qui est en haute résolution (selon le réglage de l’option File > 
Preferences… > Display >High Resolution Background) ou celui 
qui est blanc.

3.12 Fonctions de réinitialisation
Pour couper les notes bloquées, cliquez sur le moniteur Midi de 
la fenêtre transport, ou appuyez deux fois rapidement sur 
3 - 48
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Fonctions de réinitialisation

> Reset Messages. Plus de détails sont disponibles à ce sujet 
dans le paragraphe «Reset Messages» à la page 17 - 18.

Pour les notes qui s’emballent – la fonction Panic
Si les notes continuent de sonner, il se peut que vos sources de 
son ne répondent pas aux messages  «All notes off». Si ceci à lieu, 
tentez la manipulation suivante:

Double cliquez sur le moniteur Midi de la fenêtre Transport (ou 
utilisez la commande clavier Send discrete Note Offs). Des messa-
ges «Note Off «séparés sont alors envoyés pour toutes les notes 
sur tous les canaux de tous les ports Midi. Ceci devrait résoudre 
le problème.

Modulation indésirable – 
réinitialisation des contrôleurs
Options > Send to Midi > Reset Controllers émet un contrôleur 
n°121 avec une valeur nulle(reset all controllers) sur tous les 
canaux Midi et sorties utilisées par les instruments définis. Cela 
neutralise toutes les modulations Midi résiduelles comme le 
pitch wheel ou la modulation.

Si des sons sont tout à coup trop faible – 
réinitialisation des volumes
La fonction Options > Send to Midi > Maximum Volume émet 
un contrôleur n°7, d’une valeur de 127 sur tous les canaux Midi 
et sorties utilisée par les instruments définis. Tous les généra-
teurs sonores sont calés au volume maximum, avec le meilleur 
rapport signal /bruit.

Si vous entendez les mauvais sons –
transmission des réglages d’instrument
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La fonction Options > Send to Midi > Used Instrument Midi 
Settings transmet les réglages de prg, de vol et de pan, de toutes 
les boîtes de paramètres d’instrument utilisés par tous les 
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instruments du Song. Cela peut aider à réinitialiser vos sources 
de sons pour le Song en cours, si vos synthés changent brusque-
ment de Patch.

Vous pouvez régler cette fonction afin qu’elle se lance automa-
tiquement après le chargement d’un Song en activant l’option 
Send Used Midi Instrument Settings after loading à la page File > 
Song Settings > Midi Options.

3.13 Autres fonctions

Localisation du métronome Midi
Options > Locate Midi Metronome Click… Ouvre une fenêtre 
d’Environnement où le métronome Midi est sélectionné. Vous 
pouvez configurer le clic Midi par les paramètres d’instruments 
du métronome. Voir le paragraphe «Clic du Métronome Midi» 
à la page 5 - 44.

Enregistrement des Options… – 
Options Midi…, Chase Events…
Ouvre directement les pages dans les Song Settings. Pour plus de 
détails, voir le paragraphe «Song Settings» à la page 17 - 1.

Ouvrir l’éditeur de tempo
Choisissez Options > Tempo and Synchronisation > … Pour 
ouvrir les différents éditeurs de tempo, décrits dans le chapitre  
Synchronisation.
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3.14 Conseils

Enregistrer plusieurs musiciens

Le problème:

Vous désirez enregistrer des événements Midi de différents 
musiciens simultanément sur différentes pistes, cependant 
Logic accepte qu’un enregistrement par piste. 

La Solution:

• Editez différents canaux de transmission pour chaque musi-
cien.

• Créez un nouvel instrument. Réglez sont paramètre Cha sur 
All (un instrument «tout canal»).

• Créez un séparateur (Splitter) de canaux dans l’environne-
ment.

• Connectez  un câble à partir de chacun des canaux des 
instruments jusqu’au séparateur.

• Connectez des câbles depuis les canaux de transmission des 
sorties du séparateur de canal vers les instruments.

• Assignez l’instrument «All channel» dans la Track List comme 
pour les instruments pour la piste d’enregistrements. Les 
différents instruments peuvent être maintenant  joués par 
plusieurs musiciens. Le séparateur distribuera les nouvelles 
notes vers les différents modules de sons, basé sur le 
nouveau canal Midi.

• Effectuez l’enregistrement.

• Choisissez la fonction Structure > Split/Demix > Demix by 
Event Channel pour la séquence enregistrée.
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Vous avez ainsi les enregistrements des différents musiciens sur 
différentes pistes, et vous pouvez donc les éditer séparément.
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Utilisation de l’Audio 
dans la fenêtre 
Arrange

4.1 Les Regions dans la fenêtre 
Arrange

Créer des Régions
Lorsque vous enregistrez de l’audio, Logic crée automatique-
ment des régions qui représentent ce que vous enregistrez, à la 
fois dans la fenêtre Arrange et dans la fenêtre Audio. Les régions 
sont en fait des séquences audio.

Pour importer un fichier Audio créé sur un autre logiciel ou 
dans un Song de Logic, il est nécessaire de mettre en place 
manuellement les régions dans la fenêtre Arrange.

& Immédiatement après avoir importé un fichier Audio d’un autre Song, nous vous 
recommandons de copier le fichier dans un dossier courant en utilisant la fonction 
de la fenêtre Audio› ›Copy Files‹. La réponse à ›Change References?‹ doit être ›Yes‹, 
sinon les éditions destructrices de ces fichiers Audio affecteront le Song original.

Pour relire une région à un endroit précis d’un Song, vous 
devez « affecter »celle ci à une séquence audio de l’Arrange 
(paragraphe «Ajouter une région à l’arrangement» à la page 7 - 
19).

& Une petite révision: lorsque vous placez des régions sur des pistes, n’oubliez pas 
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d’assigner à chaque piste son propre objet Audio (le ›track instrument‹ d’une piste 
Audio). Pour plus d’informations à ce sujet, jetez un oeil au paragraphe «Création 
de pistes audio» à la page 4 - 12.
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Insérer des fichiers Audio en utilisant l’outil crayon
Les fichiers Audio peuvent être insérés en appuyant sur la 
toucheStout en cliquant à l’endroit désiré des pistes audio à 
l’aide de l’outil crayon. Un choix de fichier apparaît vous 
permettant de choisir le fichier que vous désirez insérer. La 
longueur de la nouvelle région ainsi ajoutée est indépendante 
de la longueur totale du fichier, qui peut être librement éditée 
ultérieurement.

Diviser des Regions
Lorsque vous coupez une séquence audio avec les ciseaux, 
vous créez deux nouvelles régions. Les deux nouvelles régions 
sont numérotées en suivant l’ordre séquentiel normal.

Resolution

Lorsque vous sélectionnez un point de coupe avec les ciseaux, 
vous pouvez le déplacer vers l’avant ou vers l’arrière d’une divi-
sion. si vous désirez une définition plus précise, appuyez sur la 
toucheA après avoir sélectionné la séquence avec le point en 
question. Pour obtenir la résolution la plus précise (pas 
d’horloge) appuyez sur S de la même façon.

On Zero Crossings

Si la fonction Edit > Search Zero Crossings est activée dans la 
fenêtre Audio, Le point de coupe sera établi sur le zero crossing 
le plus proche. L’activation de cette fonction autorise égale-
ment toutes les autres méthodes de modification du point de 
départ ou du point de fin de la région dans la fenêtre Arrange.

& Souvenez-vous que ceci peut être la cause d’une petite différence dans le position-
nement des points de départ et de fin par rapport à celui choisi. La plupart du temps, 
ceci restera inaudible.
4 - 2
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Effacer des Regions
Les régions peuvent facilement être effacées en appuyant sur 
la touche B ou bien en leur cliquant dessus avec l’outil 
gomme.

Effacer des enregistements

Lorsque vous supprimez une région que vous venez d’enregis-
trer, Logic vous demandera si vous voulez également effacer le 
fichier Audio correspondant. C’est une manière intelligente de 
gagner de la place et de ne pas oublier d’effacer des données 
dont on n’a plus besoin.

Si l’enregistrement à été fait avant que  le Song  ne soit chargé 
pour la session courante, cette question n’apparaîtra pas. Ceci 
vous empêchent d’effacer d’éventuels enregistrement de 
valeur. Appuyer la touche B permet seulement de retirer la 
région de la zone d’arrangement. Si vous désirez effacer du dis-
que dur le fichier Audio correspondant, choisissez File > Delete 
File(s) dans la fenêtre Audio.

Copier des Regions

Création de nouvelles Regions
Les copies de séquences sont effectuées exactement de la 
même manière que celles des séquences Midi, en les déplacant 
tout en maintenant la touche ç enfoncée. Ceci crée automati-
quement une nouvelle région dans la fenêtre Audio. La 
nouvelle séquence aura le même nom que l’ancienne mais se 
verra atribué un nombre de façon séquencielle.

Ceci vous permet de modifier les points de départ et de fin de 
la région copiée indépendamment de l’originale. Ceci est com-
parable aux copies de séquences Midi.
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Utiliser une région existante plus d’une fois
Vous pouvez créer une autre version de la même séquence dans 
la  fenêtre Arrange, une séquence clonée, si vous le désirez. 
Pour ce faire maintenez les touchesç et S pendant que vous 
copiez. Ceci est comparable à un alias d’une séquence Midi, 
laquelle est créée de la même façon.

Chaque fois que vous ajusterez le point de début et le point de 
fin de chacune de ces régions, toutes les autres régions qui ont 
été clonées s’ajusteront de la même manière. 

Rendre des régions clonées indépendantes
Pour rendre des régions clonées à partir de la même région 
indépendantes, choisissez Functions > Convert Regions to 
Individual Regions dans la fenêtre Arrange. Ceci convertit tous 
les clones sélectionnés en régions individuelles.

Création de copies multiples de régions
En choisissant Edit > Repeat Objects… Vous pouvez effectuer 
plusieurs copies de régions Audio et de séquences Midi. Cette 
fonction crée tout le temps des clones de la même région (les 
régions ne sont pas indépendantes). Voir le paragraphe «Copies 
multiples de séquences» à la page 3 - 16.

Une autre façon est d’utiliser le paramètre Loop dans la boîte de 
paramètres derégion (voir le paragraphe «Loop» à la page 4 - 8). 

La commande Functions > Sequence Instrument Parameters 
> Turn Loops to Real Copies change maintenant les boucles 
dans les régions audio. Les objet Arrange qui sont créés repré-
sente cependant la même région. Ainsi chaque altérations dans 
la longueur de la région ou des effets Audio agit sur les objets.

Déplacer des régions
4 - 4
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Vous pouvez déplacer des régionss audio dans la fenêtre 
Arrange, comme vous le faites déjà avec des séquences Midi. 
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Les déplacements se font par pas d’une pulsation. (ex: noires, 
voir ci-dessous).

Si vous maintenez enfoncée la touche A pendant que vous 
bougez les séquences, la résolution de déplacement passe à la 
division près (ex: double croche).

Si vous maintenez enfoncées les touches A et S pendant le 
déplacement, la résolution passe au pas d’horloge (résolution 
maximale).

Vous pouvez aussi utiliser le paramètre Delay dans la boîte de 
paramètres de région pour modifier l’emplacement de la 
séquence(voir le paragraphe «Delay» à la page 4 - 9).

Ajustement précis

En pratique, une résolution d’un pas d’horloge, s’avére large-
ment suffisante.

Pour déplacer la séquence dans une résolution encore plus fine, 
allez dans la fenêtre Arrange est utilisez la fonction ancre dans 
les fenêtres Audio ou Sample Edit.

N’oubliez pas que toutes les régions clonées dans la fenêtre 
Arrange seront affectées.

Déplacer des séquences dans l’Event List
Vous pouvez déplacer une séquence en important des données 
dans l’Event List. Sélectionnez la région que vous désirez éditer 
et choisissez Windows > Open Event List. Vous pouvez désor-
mais déplacer les séquences par unités d’un simple pas 
4 - 5
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d’horloge si vous le désirez, en modifiant la  valeur dans la 
colonne Position.

& Les fichiers Audio dans la fenêtre Arrange 2 peuvent être affichés dans l’Event List 
1. Ainsi les changements de positions très précis et de longueur peuvent être effec-
tués dans l’Event List.

Replacer des séquences à leur position d’enregistre-
ment
Vous pouvez déplacer n’importe quel séquence dans la fenêtre 
Arrange jusqu’à l’endroit précis où elle à été enregistrée en 
choisissant Functions > Region(s) to Original Record Position.

Cette fonction ne marche que si le fichier Audio a été crée sur 
le Song courant. Les fichiers Audio pour lesquels la fonction 
Add Audio File à été utilisée , n’ont pas de position d’enregistre-
ment d’origine.

Cette fonction est aussi disponible par raccourci clavier: Set 
Region(s) to original Recording Position.

2

1

4 - 6
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Insertion à la position d’enregistrement

Comme alternative, vous pouvez copier (çc) ou bien couper 
(çx) une région dans le presse-papiers, et utiliser Edit > 
Paste at Original Position pour l’insérer dans la piste sélection-
née à la position d’enregistrement originale.

Modifier les points de départ et de fin
Vous pouvez rallonger ou raccourcir toute région en la saisissant 
par le coin inférieur droit du bloc séquence et en la faisant glis-
ser. Vous ne pouvez pas faire une région plus longue que son 
fichier audio d’origine. Toutes les régions dérivées de la région 
modifiée seront réduitent de la même façon, et ne pourront pas 
être plus grandes qu’elle(regions clonées – voir page 4 - 4).

Bien sûr, tout ceci est valable lorsque vous modifiez le point de 
début d’une région en saisissant le coin inférieur gauche du 
bloc séquence avec la souris et en le faisant glisser.

Les points de début et de fin peuvent être édités avec plus de 
précision par le Sample Editor, que vous ouvrez en double-
cliquant sur la région. Faites simplement glisser les marqueurs 
S et E  pour modifier la position des points de de début (Start) 
et de fin (End). Pendant que vous déplacez le point de départ, 
maintenez la touche çenfoncée pour vous assurez que l’ancre 
et que le temps relatif à l’arrangement restent inchangés. Si 
vous voulez déplacer le point de départ vers la droite, déplacez 
le tout d’abord à l’endroit appriximatif où vous voulez qu’il soit. 
Ouvrez le Sample Editor et utilisez  la touche çpour déplacer 
le point à la position exacte.

Ajuster la grille aux Zero Crossings
Si la fonction Edit > Search Zero Crossings est activée dans la 
fenêtre Audio, chaque fois que vous changerez la place des 
points de fin et de début d’une séquence, l’ajustement fera en 
4 - 7
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sorte de tout replacer le plus près possible de l’endroit de la 
forme du signal qui passe par le zéro. L’ancre n’est pas affectée.



Chapitre 4
Utilisation de l’Audio dans la fenêtre Arrange

Le seul désavantage de cette fonction est qu’après avoir changé 
la place de ces points, ils ne seront jamais exactement dans la 
grille musicale, mais toujours quelques pas d’horloge à côté. 
Ceci n’est pas un problème car l’ancre n’est pas affectée. 
Cependant si cela vous cause des problèmes dans certaines 
situations, désactiver l’option Search Zero Crossings. cela évitera 
quelques bruits et cliques près des points en question.

Boîte de paramètres de région

Name
Comme pour les séquences Midi, la première ligne de la boîte 
de paramètre indique le nom donné à la région. Vous pouvez 
nommer plusieurs régions à la fois; elles recevront alors le 
même nom, indexé d’un nombre séquentiel, que logic Audio 
ajoute automatiquement, sauf si vous ajoutez délibérément un 
espace à la fin du nom.

Lorsque vous renommez une région, la région associée dans la 
fenêtre Audio est automatiquement renommée.

Loop
Comme pour les séquences Midi, le paramètre Loop vous 
permet de faire boucler automatiquement une région. La 
région ainsi rebouclée est répétée indéfiniment jusqu’à ce que 
Logic trouve une autre région sur la même piste, ou arrive à la 
fin du Song ou du Dossier contenant la région.

N’oubliez pas que ces boucles sont basées sur la grille d’échan-
tillon de la région. Cela signifie que même si le Song est à un 
tempo précis, il est possible que la boucle ne retombe pas dans 
la synchro du morceau. Vous pouvez éviter ceci en éditant très 
précisément dans la séquence un point de fin. dans ce cas vous 
pourrez utiliser la fonction Repeat Objects (référez-vous au para-
4 - 8
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Delay
Tout comme avec les séquences Midi, vous pouvez avancer ou 
retarder la lecture des régions avec la fonction delay. L’unité la 
plus fine de mesure disponible est le pas d’horloge.

L’ancre
L’ancre est un point de référence temporel. Quand vous dépla-
cez la séquence, ce n’est pas le point de départ qui est inscrit 
dans la colonne d’informations (comme avec les séquences 
Midi), mais l’ancre.

Pour garantir une synchro parfaite entre, par exemple, une 
mesure de percussions en boucle et votre séquenceur, l’ancre 
devra être assigné à un point  défini musicalement. Si la boucle 
commence à un endroit où le niveau de peak est significatif (ex: 
Kick de batterie), éditez l’ancre à cet endroit, où le volume de 
ce temps est très précisément défini.

La procédure suivante peut être utile pour savoir si l’ancre est 
à une position optimum ou non: Jouez une séquence de batte-
rie, via Midi, en dupliquant la rythmique calée sur la boucle de 
percussion. Vous ne devriez être capable de corriger le position-
nement de l’ancre à l’oreille.
4 - 9
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#4-06 Anchor Arrange

Les modifications de position de l’ancre dans la fenêtre Audio 
(2 and 4) 4) affectent directement la région dans la fenêtre 
Arrange (1 and 3). La position relative de l’Audio se décale par 
rapport à l’ axe de temps du séquenceur alors que l’ancre reste 
à la même valeur de mesure, et est repéré par une ligne en 
pointillés 5.

1

2

3

4
5
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Comparaison des séquences Midi et des 
régions
Le tableau suivant résume les différences importantes entre les 
séquences Audio (régions) et Midi. Quelques notes en fin de 
tableau apportent quelques explications supplémentaires.

Charactéristique séquences Midi

Regions

Composé de don-
nées discrêtes

oui Non, puisque les régions ne sont 
que des références à des fichiers 
audio

peut être nommé oui oui

paramètre Loop dis-
ponible

oui oui

Paramètre ›Quan-
tize‹ disponible

oui Non,puisque la position des régions 
peut être quantifiée par ‘utilisation 
de l’affichage de l’Event List

Paramètre ›Trans-
pose‹ disponible

oui Non

paramètre ›Velo-
city‹ disponible 

oui Non

Paramètre ›Dyna-
mics‹ disponible 

oui Non

Paramètre ›Gate 
Time‹ disponible

oui Non

Paramètre ›Delay‹ 
disponible

oui oui

positionnement 
libre

oui oui

Edition des côtés 
gauche et droit

oui oui, et ceci affecte la région, mais 
pas la positiondes signaux audio 
par rapport à l’axe de temps du 
séquenceur 

peut être séctionné 
par l’outil ciseauxl

oui oui, ça créé de nouvelles régions
4 - 11
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peut être la source 
d’alias

oui oui, les régions sont déjà des alias 

intro masquable non oui
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Naturellement, quelques fonctions peuvent être appliquées 
aux événements Midi et n’ont aucun effet sur l’Audio.

Seules les régions possèdent la référence flexibleque fournit 
l’ancre.

Les fonctions fondamentales (Telles que la détermination libre 
de la position et de la longueur, l’habilité à créer des arrange-
ments complexes avec des Dossiers, et l’ habilité de nommer 
,de couper et de faire des solo), sont en général possible avec un 
certain nombre d’objets (Séquences Midi, régions, Dossiers et 
objet Alias.

4.2 Enregistrement
Ce paragraphe ne traite que de l’enregistrement audio. Pour 
obtenir des détails sur les préparations nécessaires avant 
d’effectuer un enregistrement Audio, référez-vous au chapitre 
Audio Driver.

possède un point 
de référence musi-
cale variable

non oui, une ancre variable. ceci affecte 
toutes les régionsdérivées d’uneet 
peut modifier la positions des 
signaux audio par rapport à l’axe 
du temps du séquenceur.

Peut être désactivé 
avec la fonction 
Mute

oui oui

peuvent être grou-
pés en dossiers

oui oui

peut être mis en 
solo

oui oui

Charactéristique séquences Midi

Regions
4 - 12
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Création de pistes audio
Pour créer une piste audio, vous devez en premier lieu assigner 
un objet comme instrument de piste en cliquant sur le nom 
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d’une piste dans la fenêtre Arrange et en maintenant enfoncé le 
bouton de la souris. Ceci ouvre la liste des instruments, où vous 
sélectionnez votre objet Audio.Les objets Audio « audio1 » 
jusqu’à « audio X » sont les presets pour toutes les pistes du 
Hardware HDR, mais vous pouvez bien sûr en ajouter. Pour 
plus d’informations à ce sujet, lire le paragraphe «Objets 
Audio» à la page 6 - 2.

Si vous désirez faire quelques ajustements, vous pouvez le faire 
directement dans la fenêtre Arrange.La boîte de paramètres 
d’instrument se trouve en dessous de la boîte à outils.

›Armement‹ des pistes

Première méthode:

• Cliquez sur le bouton rond aver le ›R‹ rouge se trouvant dans 
la track list. Pour montrer ou masquer ces boutons, choisissez 
View > Record Audio Switch.

& Si vous avez validé View > Record Audio Switch mais que le bouton n’est 
toujours pas visible, vous devriez activer le driver de l’hardware audio qui est utilisé 
dans les préférences audio (sous «extensions«) et ensuite redémarrer Logic

Seconde méthode:

• Ouvrez le calque de l’environnement contenant les objets 
Audio , (par exemple à partir de la fenêtre Audio en sélection-
nant Options > Audio Record).

• Cliquez sur le bouton REC de tous les objets audio qui 
possèdent les pistes sur lesquelles vous désirez effectuer 
l’enregistrement.

Cliquez sur l’objet audio une seconde fois (comme montré ci-
dessus) pour désarmer les pistes.

Vous ne pouvez enregistrer que sur les pistes qui ont été 
armées, la piste sélectionnée dans la fenêtre Arrange n’a pas 
4 - 13
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d’importance.

• Si vous avez choisi une piste Midi, vous enregistrez des 
événements Midi.
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• Si vous choisissez une piste Audio, vous enregistrerez sur 
toutes les pistes armées.

• De la place est réservée sur le dique dur pour les pistes 
armées et ne sera plus disponible pour les fichiers effacés. 
Pour cette raison, Logic désarmera automatiquement les 
pistes Audio si elles sont éditées dans le Sample Editor lors-
que le disque est pratiquement plein.

• Vous pouvez enregistrer simultanément sur une piste Midi 
et sur plusieurs pistes Audio en cliquant sur la piste Midi et 
sur les pistes Audio que vous voulez enregistrer tout en 
maintenant enfoncée la touche S. 

Si plusieurs pistes de la fenêtre Arrange sont assignées au 
même instrument Audio (par exemple «Audio 1«), alors le 
nouveau fichier Audio (ou région)sera enregistré sur la piste 
sélectionnée.

›Désarmement‹ de toutes les pistes

Si plusieurs pistes sont en position d’enregistrement, vous 
pouvez les désarmer les unes après les autres en cliquant sur le 
bouton Rec clignotant pendant que vous maintenez la touche 
ç enfoncée.

Modes d’enregistrement
Logic vous propose plusieurs options pour démarrer un enre-
gistrement à un endroit précis de votre Song.

Enregistrement standard avec décompte
Vous pouvez enregistrer à n’importe quel endroit de votre Song, 
il vous suffit de déplacer le pointeur de position à l’emplace-
ment désiré. Si les pistes sont correctement configurées, et que 
tous les signaux d’entrée sont présents et correctement routés 
4 - 14
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et ajustés, vous n’avez qu’à appuyer sur la touche Record du 
pavé de transports, ou pressez sur la touche *. X
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Un décompte sera donné. les signaux seront enregistrés 
pendant ce décompte. En fonction du nombre de pistes requis, 
Logic générera un temps de retard entre l’action sur la touche 
Record et le début de l’enregistrement.

Pendant l’enregistrement, la 
fenêtre d’enregistrement flot-
tante sera ouverte. cet affi-
chage indiquera le temps 
d’enregistrement .

Logic créera automatiquement une région dans la fenêtre 
Arrange après l’enregistrement.Vous pouvez écouter le nouvel 
enregistrement dans la fenêtre Arrange.

Enregistrement Punch-in 
Vous pouvez actuellement engager un mode d’enregistrement 
au milieu de la lecture (à la volée). Pour ce faire, pendant la 
lecture, appuyez  sur la touche V (Raccourci clavier par 
défaut pour la fonction Record Toggle) au point où vous voulez 
commencer l’enregistrement. l’enregistrement Audio 
commence immédiatement et peut être arrêté à tous moments, 
en pressant la touche Stop, ou en appuyant de nouveau sur la 
toucheV. Si vous utilisez la deuxième solution l’enregistre-
ment cessera mais le séquenceur continuera la lecture.

& Un enregistrement peut être effectuer durant la lecture en appuyant deux fois sur la 
touche V (aux points montrés par ❶ et ❷).

1 2
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enregistrement à la volée

Si vous maintenez appuyé le bouton Record dans la fenêtre de 
Transport, le menu d’enregistrement s’ouvrira, et là, vous pour-
rez activer ›Punch on the Fly‹ (enregistrement à la volée).

& L’enregistrement Punch (ou encore Drop) est lorsque vous effectuez un ›punch in‹ à 
un passage précédemment enregistré tandis que la lecture fonctionne de façon à 
corriger une erreur dans l’enregistrement précédent . Effectuer un ›punch out‹ de 
l’enregistrement lest l’action de stopper l’enregistrement lorsque l’erreur a été 
corrigée.

& Sur certains disques dur cette fonction n’est pas utilisable, en raison du délai entre 
la lecture et l’enregistrement (créer un fichier etc...). En pratique, l’enregistrement 
prend place au moment où vous commencez. Ensuite, Logic ajoute le résultat de ces 
enregistrements à l’endroit exact où vous voulez les placer. Une piste libre doit être 
prète pour cette opération. Une piste est libre à partir du moment où il n’y a pas de 
séquences (même mutées) adans la zone de lecture .
A free track therefore has to be available for this purpose. A track is ›free‹ if there are 
no regions (or only muted regions) on it within the area that playback is started and 
ended.

Si vous tentez un enregistrement à la volée et que Logic vous 
donne un message d’erreur, il vous faut couper (mute) temporai-
rement quelques pistes audios qui ne sont pas nécessaires.

Enregistrement à la volée pré-programmé
La fonction autodrop de Logic peut être utilisée sur les pistes 
Audio exactement de la même manière que des séquences 
Midi . Vous activez ce mode en cliquant sur le bouton Autodrop 
dans la fenêtre Transport. Voici une description pas à pas de la 
procédure à suivre:
4 - 16
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2-07 AudioDrop

❶ Le bouton autodrop doit être activé.

❷ Vous pouvez définir numériquement les locators de l’Auto-
drop dans la fenêtre Transport.

❸ La zone d’enregistrement en Autodrop est visualisée par
une barre noire dans le tiers inférieur de la règle de mesu-
re.

❹ L’enregistrement est uniquement réalisé à l’intérieur de la
zone que vous avez mis en place, à l’exception d’un court
temps de pré roll avant le point d’entrée (voir ci après).

Les points de départ et de fin de la zone Autodrop peuvent para-
mètrés soit dans la barre de mesure, soit dans la fenêtre Trans-
port. Si la fonction Cycle est activée, vous pouvez régler la fonc-
tion Autodrop dans la fenêtre à droite des locators de Cycle (en 
dessous du tempo).

Commencez l’enregistrement. Logic débutera l’enregistre-
ment environ une mesure avant le Locator de drop in. une 
séquence est ensuite créée, qui correspond exactement à la 
longueur de la zone de l’Autodrop. Ceci permet au départ de la 
séquence d’être modifier ultérieurement. Cependant, cette 
modification ne modifie pas la position relative de l’enregistre-
ment par rapport à l’axe de temps.

1 2

3

4
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Une petite astuce: Si vous le désirez, vous pouvez déterminer 
une petite zone d’Autodrop dans une zone de cycle plus large. 
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Ceci peut être pratique si vous désirezne modifier qu’un 
passage difficile au milieu d’un Song.

L’enregistrement et la pause
Si Logic est en mode pause, vous pouvez enregistrer en cliquant 
sur ›Record Toggle‹,›Pause‹ ou encore ‹Play‹. l’enregistrement 
commence alors à la position en cours du Song.

Enregistrement audio en mode Cycle 
Vous pouvez effectuer des enregistrements même si vous êtes 
en mode Cycle. Une nouvelle piste est créée pour chaque cycle. 
Toutes les pistes créées jouent via le même objet audio. Ceci 
protège les pistes afin quelles ne soient pas jouées en même 
temps

& Si vous arrêtez l’enregistrement après la fin d’un cycle, aucune séquence ne sera 
créée pour le cycle qui vient juste de commencer. Cependant l’Audio n’est pas 
perdue, mais simplement enregistré après la dernièrerégion dans le fichier Audio.

& Tout l’enregistrement est sauvegardé dans un seul fichier Audio. Ce fichier Audio est 
organisé en régions qui sont de la même longueur que le cycle. La région du cycle 
précédent est automatiquement mutée au début du cycle suivant.

L’enregistrement en mode cycle fonctionne aussi lorsque vous 
enregistrez deux canaux simultanément (par exemple des 
pistes stéréo).

Après l’enregistrement, remarquez que…

Après avoir fait votre premier enregistrement dans un Song, 
vous ne devrez pas effectuer de modification de tempo de ce 
Song. Décidez du tempo a utiliser avant d’enregistrer le premier 
événement Audio, et restez-y! Les enregistrements audio ont 
une vitesse de lecture fixe et ne peuvent changer de tempo que 
si vous êtes prèt à faire un travail titanesque de re-synchronisa-
tion, qui n’est pas toujours possible. Les algorithmes de 
4 - 18
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compression et d’expansion du temps disponibles ne vous 
permettent de modifier le tempo de l’audio lorsque la diffé-
rence de tempo est faible, et si vous tentez de les utiliser pour 
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modifier le tempo de façon sensible, vous compromettrez la 
qualité de votre song.

Si vous avez enregistré en temps réel, en vous basant sur une 
arrangement Midi, nous vous conseillons de ne toucher qu’avec 
circoncpection la position de l’ancre des régions Audio. Les 
petits réajustements de calage peuvent être effectués par le 
paramètre d’objet « delay »des régions.

Ecoute de l’entrée automatique
L’écoute d’entrée(input monitoring) vous permet de déterminer 
quel signal vous écoutez parmi les pistes d’enregistrement. Si la 
fonction Auto Input Monitoring est activée, vous n’entendrez 
que le signal d’entrée pendant l’enregistrement en cours, avant 
et après avoir entendu le signal précédent enregistré pendant la 
lecture du séquenceur. Ceci vous aide à placer les points de 
drop in et drop out pour les enregistrement en mode punch. Si la 
fonction Auto Input Monitoring est désactivée, vous entendrez 
toujours le signal d’entrée. Avec cette fonction activée, vous 
entendrez la source d’entrée lorsque le séquenceur sera stoppé. 
Ceci permet de faire les niveaux assez facilement.

Activer ou désactiver la fonction Auto Input Monitoring 

Si vous cliquez sur le bouton record(dans la fenêtre Transport) le 
menu d’enregistrement sera ouvert. C’est là que vous pouvez 
activer ou non l’écoute d’entrée.

Le tableau dessous montre ce que vous entendez à la sortie des 
pistes d’enregistrements:

Playback Record

LA Pro ISIS 
stopped

LA Pro ISIS 
running

Auto Input 
Monitoring Signal entrant

signal de 
l’ancienne piste Signal entrant
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activé
Auto Input 
Monitoring 
désactivé

Signal entrant
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Problème possibles avec l’écoute de l’entrée

Problèmes typiques qui peuvent survenir avec des pistes 
d’enregistrement:

• Les chanteurs ne peuvent pas s’entendre pendant que Logic 
joue, tout ce qu’ils entendent c’est l’ancien enregistrement.

❍ Désactiver l’Auto Input Monitoring.

• Je ne peut pas entendre la piste même lorsque je n’enregis-
tre pas encore!

❍ Activer l’Auto Input Monitoring.

En fonction de la situation, les deux options peuvent être prati-
que. Normalement, la fonction Auto Input Monitoring est acti-
vée, et elle n’est désactivée que dans de rares occasions.

Dès que vous effectuez des enregistrements en mode 
punch(par exemple un enregistrement à la volée), vous deriez 
actionner la fonction Auto Input Monitoring.

Pendant l’enregistrement, assurez vous que vous n’avez pas en 
écoute le son direct, mais les sorties des pistes de Logic. Ceci 
requiert généralement un panneau d’enregistrement muni de 
bus. L’auto input monitoring assure que durant le punch, le son, le 
volume, et le mix restent les mêmes.

Enregistrements Stéréo
Les enregistrements stéréos seront sauvgardés comme fichiers 
stéréos entrelacés. Le nom des régions créés dans les fichiers 
stéréos entrelacés apparaissant dans la fenêtre Arrange seront 
représentées avec un symbole stéréo (ci-dessous, à gauche).
4 - 20
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Les noms de régions splitées seront représentées avec un 
symbole stéréo (ci-dessus, à droite).

Vous pouvez mixer librement les deux formats, sur la même 
piste. Cependant, si votre système Hardware supporte le 
format stéréo entrelacé (par exemple Audio werk 8, AV/MME, 
Korg1212 I/O), nous vous recommandons de l’utiliser.

& Alors que des fichiers stéréo splités utilisent approximativement deux fois plus de 
performance des performances I/O du disque dur par rapport à des fichiers mono, 
Les fichiers stéréo entrlacés n’ont besoin que de 150%.

Dans les préférences Audio, vous pouvez forcer Logic à créer 
un fichier stéréo splité; par exemple, pour être compatible avec 
les systèmes  SoundScape.

4.3 Fonctions

Calage de tempo automatique
Parmi toutes ses autres fonctions incroyables, Logic Audio 
dispose d’une fonction automatique permettant de caler la 
longueur d’un passage de musique de forme libre sur la 
longueur d’une région Audio. La longueur de la région reste 
constante, mais le tempo du passage musical est recalculé de 
façon à ce que celui-ci soit de la même longueur que la 
séquence.

Pour montrer comment utiliser cette fonction, nous pouvons 
prendre une boucle de batterie d’une durée d’une mesure:

Imaginons que vous venez d’enregistrer un pattern de batterie 
« live » ou bien à partir d’un CD d’échantillon sonores. Dans la 
fenêtre Audio et dans le Score Editor, vous avez ajusté vos points 
de débuts et de fin de sorte que la pattern reboucle parfaite-
ment sur elle-même, sans à coup, ni saut de signal.
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Maintenant vous prenez cette boucle de batterie dans la fenê-
tre Arrange, où elle apparait comme région.  Assurez vous que le 
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début de cette séquence correspond bien au début d’une 
mesure. 

Construisez, dans la fenêtre Arrange, un Cycle représentant la 
durée en mesure à laquelle est censée correspondre la longeur 
de la région. La boucle de batterie fait une mesure, le segment 
sera calé sur une mesure.

& Dans la barre de mesure, vous réglez le cycle ❶ à la longueur désirée. La longueur 
actuelle de la région est montrée ❷ et elle doit être différente du cycle jusqu’à ce 
que vous utilisiez la fonction ›Adjust Tempo...‹…

Sélectionnez Functions > Adjust Tempo using Object Length & 
Locators.

Le tempo est recalculé de sorte que la région est maintenant 
exactement d’une mesure et est identique à la longueur du 
Cycle. Ceci ne change pas le tempo de l’Audio, mais recale le 
tempo du Song sur l’Audio.

Mix down numérique

2

1

1

2

3
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En utilisant Logic , vous pouvez mixer des données Audio dans 
le domaine numérique dans la fenêtre Arrange.grâce à l’outil 
colle. Cette fonction n’est pas destructive, puisque Logic crée 
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toujours un nouveau fichier pour les mixdowns. Ce nouveau 
fichier est sauvegardé sur votre disque dur.

Pour éxécuter un mixdown, utilisez l’outil colle est sélection-
nez la région désirée pour le mixdown (si nécessaire utilisez la 
touche S).

Situation sans Mixdown

• S’il y a plusieurs régions (mono ou stéréo) sur la même piste 
provenant du même fichier Audio et qui ont été séparées 
avec les ciseaux, aucun mixdown n’est effectué. Au lieu de 
ça, une simple région est simplement créée par dessus la 
zone entière. On obtient ainsi le résultat souhaité, sans pour 
cela utiliser de la place supplémentaire sur le disque dur.

& Logic peut reconnaitre les séquences associées même s’il y a des vides (gaps) entre 
elles. Le facteur déterminant est la position de la séquence dans l’arrangement, qui 
correspond à la position relative de la région dans le fichier Audio.

• Dans la fenêtre arrange, si vous voulez mixer deux régions 
dont les pistes ont un panoramique inverse, aucun mixdown 
ne éxécuté.

& Les deux fichiers de mixdown résultant devront être identiques au fichier audio 
original dans les zones utilisées des régions, si vous n’avez pas besoin des zones non 
utilisées, choisissez ›Optimize Files‹.

›Mixdown‹ de régions sur une piste

Si plusieurs séquences concurrentes (séparées les une des 
autres) sont sélectionnées dans une même pistes, le 
programme ne les mixera pas. Au lieu de ça, il vous est 
demandé si vous désirez créer un nouveau fichier Audio, lequel 
est nommé après la première Région. Les régions sélection-
nées sont alors mixées ensemble sans aucun changement de 
volume, et sans « clip scanning ».

S’il y a des sections vides entre deux régions, celles-ci seront 
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remplacées par des silences dans les fichiers résultants.
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Mixage gémeaux avec Clip Scan

Si vous combinez des données Audio de deux pistes ou plus, les 
valeurs courantes pour les panoramiques et volumes trouvée 
dans l’Environnement pour des pistes individuelles définiront 
les paramètres Pan et Vol dans le nouveau fichier Audio. Si vous 
combinez les deux côtés de d’un fichier Audio stéréo, réglez 
tout d’abord les composants mono des côtés à fond à droite et à 
fond à gauche respectivement.

Vous pouvez faire un mixage pendant la lecture du séquenceur.

Après que le clipscan numérique soit fini et le mixage soit 
terminé, Logic replace la région sélectionnée précédemment 
avec une région qui contient le nouveau fichier mixé dans son 
intégralité. Si vous le désirez, vous pouvez utiliser la fonction 
undo pour restaurer les régions Audio originelles. Si vous faites 
ceci, on vous demandera alors si vous désirez garder le fichier 
audio nouvellement créée ou si vous désirez l’effacer.

Si vous avez décidé de le garder, il sera transporté dans la fenê-
tre Audio.

& Pendant le mixage la fonction clipscan réclame 32 bits, pour fonctionner correcte-
ment.

Crossfades Audio
La fonction Digital Mixdown (avec la colle, le menu ou la com-
mande clavier) dans la fenêtre Arrange supporte les Crossfade 
Audio des régions sélectionnées.

Les paramètres sont définis dans la fenêtre de dialogue Audio 
Crossfades , qui peut être ouverte en choisissant: Structure > 
Merge > Audio Crossfade Options.

Le racourcci clavier pour ouvrir la fenêtre de dialogue peut éga-
lement servir à la fermer.
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Les paramètres s’appliquent globalement et sont sauvegardés 
dans le fichier préférences.

Il y a deux paramètres:
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Time [ms]: c’est la longueur du crossfade en 
entier. Pour désactiver le crossfade
réglez la valeur sur Zéro.

Curve: Pour obtenir un crossfade linéaire, 
sélectionner la valeur à zéro . Toutes 
les autres valeurs (positive ou néga-
tive), produisent alors des fades 
exponentiels. Les fades out et les 
fades in sont toujours symétriques, 
pour éviter les déviations de niveau.

Les valeurs par défaut sont: Time = 20ms, Curve = 0 (linéaire).

Le graphique montre la forme actuelle du crossfade, les algo-
rythmes originaux sont utilisés pour calculer l’affichage de la 
courbe.Les valeurs supérieures à 250 ms sont réduites dans le 
graphe, pour assurer que tout le crossfade est visible.

HyperDraw pour les Regions
l’HyperDraw™ peut être utilisé directement dans les séquences 
Audio, et dessiner directement les changements de volume et 
de panoramique. 
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Choisissez Options > HyperDraw > … . Si vous n’êtes pas fami-
lier à l’hyperdraw, voir le paragraphe «HyperDraw» au chapitre 
«la fenêtre arrange» du manuel de Logic.

Si vous désirez utiliser l’hyperdraw sur des régions stéréo, vous 
devez toujours utiliser la séquence de gauche (en haut). Logic 
utilise automatiquement cette information pour les deux côtés.

Lorsque vous utilisez l’hyperdraw sur des régions Audio. Les 
événements Midi sont créés, lesquels sont toujours organisés 
ensemble dans les régions Audio. Vous pouvez également 
éditer les événements Midi dans l’Event list ou l’Hyper editor.

Fades Non-destructif
Les fades In, les fades Out, et les crossfades peuvent 
être éxécutés avec l’outil Fade (se trouvant dans la 
boîte à outils), ou avec les paramètres qui y corres-
pondent. Les courbes et temps de paramètres de 
Fade in et de fade out se trouvent dans la boîte de 
paramètres. Vous pouvez ajuster ces paramètres 
dans toutes les régions sélectionnées simultané-

ment.

Ces paramètres de fade sont non-destructifs (il ne changent pas 
le fichier Audio original), à l’opposé de la fonction fade se trou-
vant dans le Sample Editor.

Discussion technique

Un fichier background existe pour chaque Song qui contient les 
zones de fade. Vous ne devez normalement pas à avoir besoin 
d’accéder à ce fichier. Il est dans le même dossier que la région 
originale et est nommé après le Song, avec l’extension f16m,ou 
f24m lorsque vous utilisez un enregistrement en 24 bits.

• Ce fond de fichier est créé au moment ou vous commencez 
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la lecture. Si vous utilisez plusieurs fades sur plusieurs 
séquences, ceci prendra quelques secondes..· Vous pouvez 
effacer un fade en utilisant l’outil fade avec la touche 
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Vous pouvez accéder à la forme courbe en utilisant l’outil fade 
en conjonction avec la touche. 
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L’environnement

La Situation
Ce chapitre vous permet de découvrir le concept de base de 
l’Environnement, et d’apprendre à en utiliser pleinement 
toutes les options.

• Votre installation comprend probablement différents péri-
phériques Midi. Vous attendez de Logic qu’il puisse gérer 
aussi facilement, qu’efficacement votre installation, et si 
nécessaire, jusqu’au plus petit détail (par exemple un para-
mètre de sonorité dans un générateur de son).

• Logic n’est pas seulement un séquenceur, c’est aussi: des 
arpégiateurs, des délay Midi,  etc. Vous pourrez également 
n’utilisez que ce dont vous avez vraiment besoin, et ce de la 
façon la plus souple et la plus simple qui soit.

L’idée
L’Environnement a été développé pour satisfaire à ces exigen-
ces. Logic offre un environnement virtuel qui reproduit l’envi-
ronnement extérieur sur votre écran.

Imaginez que la fenêtre Environment affiche l’image virtuelle 
de votre studio Midi. Tout d’abord, vous pouvez voir les objets 
port qui représentent les entrées et les sorties Midi de votre 
ordinateur. Ensuite, la représentation virtuelle de chaque 
matériel périphérique (Midi) que vous avez connecté à votre 
ordinateur. En principe, ces périphériques sont répertoriés, 
dans l’Environnement, en tant qu’ ‹instruments›. Vous pouvez 
dès lors adresser vos périphériques Midi avec ces instruments. 
Certains instruments particuliers ont en charge des tâches 
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Pour que l’ensemble fonctionne correctement, vous devez 
connecter ces différents objets dans l’Environnement, avec des 
câbles virtuels. Ceux-ci vous permettent de contrôler, au 
moyen de votre interface Logicielle, les chemins que les 
signaux doivent emprunter.

Les modules de Logic, tels le séquenceur lui-même ou les 
modules d’effets (par exemple arpégiateurs ou delays Midi) 
sont également des objets de l’Environnement. Dans l’Envi-
ronnement, vous pouvez aussi créer des «faders» virtuels qui, 
lorsque vous les actionner, génèrent des événements Midi. Les 
variations de ces objets «faders» peuvent aussi bien être pilotés 
par d’autres événements Midi, et enregistrés par le séquenceur. 
Il existe aussi des objets spéciaux qui peuvent splitter (séparer) 
un signal Midi et les diriger vers différents canaux, constituer 
des filtres prédéterminés, ou même définir un nouvel achemi-
nement du signal Midi. 

Les Layers (nivaux de l’interface, ou encore couches)

Vous imaginez aisément que l’Environnement puisse rapide-
ment se retrouver encombré d’une telle quantité d’objets, qu’il 
devienne illisible et ingérable. Pour assurer une organisation 
cohérente, vous pouvez répartir les objets sur différents 
niveaux d’interface. Ainsi architecturée, votre interface assure 
une mise en ordre, par couche, de vos objets. Ces couches sont 
appelées «layers». Considérez ces couches comme autant de 
vues, différentes et partielles, de l’ensemble de l’environne-
ment. Bien sûr, il est facile de connecter des objets entre eux, 
d’un niveau à un autre.

Pas de panique!

Pour l’utilisateur expérimenté, cette opportunité de modifier le 
cheminement des signaux, ouvre des possibilités fantastiques, 
et fait de Logic, parmi les séquenceurs du marché, un 
programme unique.
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En même temps, cette grande souplesse peut sembler un peu 
déconcertante pour des utilisateurs moins chevronnés. Ne vous 
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inquiétez pas. La section «Cheminement du Signal», page 7 – 
10, vous explique comment paramètrer les fonctions élémen-
taires de Logic, au moyen de quelques principes simples. Il en 
est de même pour la définition des Songs.

Le Concept d’Environnement 

Souplesse

L’Environnement vous permet d’exercer un contrôle sur 
l’entourage immédiat de Logic dans l’ordinateur. Les câbles 
virtuels Midi vous assurent le contrôle total du chemin suivi par 
les signaux Midi, depuis les ports d’entrée aux ports de sortie. 
Ceci vous offre un haut degré de souplesse lors de connexions 
individuelles de ‹modules d’effets›.

Adaptabilité

Logic n’adresse pas directement les ports Midi de votre inter-
face physique, mais effectue les connexions via des instru-
ments virtuels que vous créez dans l’Environnement. Ces 
instruments virtuels se comportent comme les jonctions d’un 
réseau: les événements peuvent facilement être adressés à 
partir d’un séquenceur, puis, partant de là, être envoyés à un 
générateur de sons physique. Les instruments comprennent un 
jeu de paramètres au moyen duquel vous pouvez définir les 
sons, les transposer, les «splitter» et compenser les retards Midi  
– ou système –  de l’installation. De ce fait, les instruments 
peuvent également être employés pour obtenir, dans votre 
générateur de sons, des copies virtuelles de sons spécifiques. 
De plus, il existe des instruments complexes (la batterie), 
comportant une table d’allocation des notes, qui peuvent vous 
permettre de conserver vos habitudes de travail et de program-
mation dans n’importe quelle situation. Enfin, vous pouvez 
créer une table d’allocation de faders ou de boutons pour 
contrôler des périphériques ou automatiser des tables de mixa-
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ges. En fait, l’Environnement vous permet d’adapter, en toutes 
circonstances, la configuration de Logic à votre équipement 
matériel (hardware).
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5.1 Utilisation

Ouvrir la fenêtre Environment
Pour ouvrir une fenêtre Environment, sélectionnez Window > 
Open Environment . Double-clicking on an instrument 
Double-cliquer sur un instrument dans la liste des pistes (Track 
List) de la fenêtre Arrange ouvre également une fenêtre Envi-
ronment. La fenêtre est ouverte sur la couche contenant l’instru-
ment piste, avec celui-ci affiché en surbrillance.

Il est possible d’ouvrir de multiples fenêtres Environment 
simultanément.

1 Boutons
2 Boîte à outils
3 Boîte des couches
4 Boîte des paramètres d’objet
5 Menu local
6 la couche ‹Click & Ports›, avec différents objets 

1
2
3

4

6

5
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Les couches
Les couches sont les «niveaux d’affichage» de la fenêtre Envi-
ronnement. Les couches vous permettent de configurer l’affi-
chage de l’environnement en «modules». Vous pouvez ainsi, 
dans chaque «module environnemental», regrouper un ensem-
ble d’objets spécifiques (par exemple les instruments audio), 
propre à un type de travail donné. Vous pouvez voir le nom du 
calque affiché dans la boîte de calque.

La répartition des objets en différentes couches n’a aucun effet 
sur leurs fonctions – il s’agit simplement d’un moyen de per-
sonnaliser et de faciliter la lisibilité et l’usage des objets.

& Il y a des exceptions: les objets regroupés sur la couche ‹global objects› (objets géné-
raux) apparaissent aussi dans d’autres couches; et la couche ‹All Objects› affiche tous 
les objets de l’environnement sous forme de liste. Cependant, vous pouvez ignorer 
dans un premier temps ces deux couches. Ils ne sont pas très souvent utilisés, même 
dans des environnements très complexes.

Changement de calque
Un clic prolongé dans la boîte des couches ouvre un menu 
déroulant, que vous pouvez utiliser pour sélectionner les 
couches.

Sélectionnez Options > Goto previous Layer pour revenir au 
calque précédemment actif. Ceci vous permet d’alterner aisé-
ment l’affichage de deux couches.

Création de couches
Choisir ‹**Create!**› dans le menu des couches, pour créer un 
nouveau calque vide nommé ‹(unnamed)› placée en fin de liste. 
Sélectionner la fonction Options > Layer > Insert vous permet 
d’ajouter un nouveau calque dans la liste, à hauteur de la posi-
tion en cours.
5 - 5
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C



X

Chapitre 5
L’environnement

Nommer les couches
Un double-clique sur la boîte des couches ouvre le champ 
texte, dans lequel vous pouvez saisir un nom pour désigner la 
couche en cours.

Effacer des couches
Sélectionner la fonction Options > Layer > Delete, vous permet 
d’effacer de la liste la couche en cours. Cette manœuvre 
supprime également tous les objets contenus dans la couche. 
Une boîte d’alerte apparaît pour éviter toute destruction invo-
lontaire des objets. Vous devez cliquer sur ‹Delete› pour confir-
mer l’opération. ‹Cancel› ou R annule l’opération.

Couches particulières
La position et l’existence des deux premièrela couches couches 
sont protégées:

All Objects

La première couche du menu déroulant affiche toujours tous 
les objets de l’environnement. Cette couche présente toujours 
les objets sous forme de liste. Si vous désactivez l’option File > 
Preferences > Display > Allow ’All Objects’ Layer Option in Envi-
ronment, la couche ‹All Objects› n’apparaît plus dans le menu 
déroulant.

La fonction Options > Goto Layer of Object permet d’afficher 
directement la couche correspondant à l’objet sélectionné.

Global Objects

Dans la seconde couche du menu déroulant, vous pouvez 
placer les objets que vous voulez voir apparaître dans toutes les 
couches (par exemple les ports de sorties). Ceux-ci sont alors 
affichés au même endroit dans chacune d’elles. Cependant, en 
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raison de l’encombrement des objets à l’écran, limitez autant 
que possible le nombre d’objets sur cette couche. 
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Affichage

Montrer/masquer les paramètres

Le recours à l’option View > Parameters. vous permet de 
masquer la colonne comportant les boutons, la boite à outils, les 
commandes d’affichage des couches, et la boîte de paramétrage 
des objets. Cette fonction vous permet de libérer davantage de 
place sur l’écran, au bénéfice de la fenêtre elle-même.

Masquer/afficher les câbles

L’option View > Cables (Hide/Show Cables), vous permet d’acti-
ver ou de désactiver l’affichage des câbles. Elle permet égale-
ment d’afficher ou masquer la poignée située à droite des objets 
individuels. (La poignée est employée pour déplacer ou redi-
mensionner les objets fader).

Protection des câbles et des positions

Vous pouvez protéger, contre toute modification accidentelle, la 
position, la taille et la connexion par câbles (virtuels) de tous les 
objets, en sélectionnant l’option View > Protect Cabling/Posi-
tions.

Arrière plan

ISi la position des câbles et des objets est protégée, et si les 
câbles sont masqués, cela modifie également l’aspect de 
l’arrière-plan qui passe de blanc à gris (ou en haute résolution  
voir page 17 - 16). Ce dernier aspect convient beaucoup mieux 
à la présentation des consoles virtuelles et des faders.

Affichage par liste

L’option View > by Text bascule l’affichage graphique des 
couches en mode d’affichage par liste. Les câbles ne sont pas 
apparents avec cet affichage, surtout utilisé dans la couche ‹All 
5 - 7
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Objects› (paragraphe «Couches particulières» à la page 5 - 6), et 
pour l’importation des Environnements d’autres Songs (para-
graphe «Échange d’Environnement» à la page 5 - 63).
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Objets 

Créer des Objets

Quand, à partir du menu New vous sélectionnez un type 
d’objet donné, vous créez un objet de ce type dans la couche en 
cours (Pour plus de détails reportez-vous au paragraphe «Type 
d’Objet» à la page 5 - 20). Cliquez sur le fond de l’écran avec le 
stylo, pour créer un nouvel objet (standard)..

Vous pouvez également copier des objets déjà existant: il suffit 
de saisir un objet tout en maintenant enfoncée la touche ç 
(voir également le paragraphe «Déplacer les objets» à la page 5 
5 - 8
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- 9). Les paramètres de câblage virtuel sont préservés et les 
objets copiés de cette façon, possèdent les mêmes connexions 
que leurs originaux.
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Effacer des Objets

Cliquer avec l’outil gomme actif, ou presser la touche B efface 
tous les objets sélectionnés.

Ajuster la Dimension des Objets
Vous pouvez définir la dimension d’un fader, d’un clavier, ou 
d’un autre objet à l’écran, en saisissant le coin inférieur droit de 
l’objet et en le déplaçant (exactement comme avec une fenê-
tre). Lorsque vous changez la dimension d’un objet dans le 
cadre d’une sélection multiple (obtenue avec le lasso, appelé 
‹rubber-band› , ou en cliquant tout en maintenant enfoncée la 
touche S) vous modifiez la dimension de chacun des objets de 
la sélection dans la même proportion; de sorte que la taille rela-
tive de chacun d’entre eux, au sein de la sélection, est conser-
vée.

La commande Options > Clean up > Size by Default (Reset Size), 
réinitialise la taille des objets sélectionnés, selon sa valeur par 
défaut.

Déplacer les objets
Vous pouvez déplacer les objets par presser-glisser, à partir de 
leur icône ou à partir de leur nom, jusqu’à la position voulue. 
Par contre, la surface d’un fader ou d’un clavier assume d’autres 
types de fonctions. Vous devrez donc, en ce qui concerne ces 
objets, saisissez le nom (si c’est possible) ou la broche de 
connexion placée sur la droite de l’objet.

Si vous maintenez enfoncée la touche S vous pouvez égale-
ment déplacer les claviers et faders directement à partir de leur 
surface. Avant une nouvelle sélection multiple, pensez à désé-
lectionner la précédente sélection, d’un clic sur le fond d’écran, 
si vous souhaitez éviter de déplacer aussi les objets qu’elle 
contient.
5 - 9
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Grille

Sélectionnez View > Snap Positions pour aligner les objets sur 
une grille invisible. C’est une bonne idée de laisser les posi-
tions snap actives. Vous n’aurez à désactiver cette fonction, que 
pour le cas où vous voudriez déplacer un objet de seulement 
quelques pixels.

Alignement des Objets…

…en ligne ou en colonne

Pour aligner, horizontalement ou verticalement, une sélection 
d’objets, activez la fonction Options > Clean up > Align Objects. 
L’objet situé à l’angle supérieur gauche de la sélection reste à sa 
place, et définit le point initial à partir duquel les autres objets 
s’aligneront. L’objet le plus proche du point initial définit le 
sens d’alignement, en ligne ou en colonne, de tous les autres 
objets de la sélection. Quand cet objet se trouve à droite de 
l’objet initial, tous les objets sont alignés horizontalement, 
quand il se trouve en dessous, ils sont alignés verticalement.

Déplacer les Objets entre les couches

… avec la boîte de sélection de couches

Pour modifier l’assignation de couche d’un groupe d’objets 
dans l’Environnement, sélectionnez les objets, maintenez 
enfoncée la toucheç et sélectionnez la couche de destination. 
La sélection est alors déplacée de la couche d’origine vers la 
couche sélectionnée.

… via le presse-papiers

Une autre possibilité consiste à déplacer les objets au moyen du 
presse-papiers (via le menu Edit ou les raccourcis habituels):
5 - 10
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• Sélectionnez les objets à déplacer et activez Edit > Cut 
(çx).

• Passez à la couche de destination.
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• Assurez-vous alors qu’aucun objet n’est sélectionné (en 
cliquant sur le fond d’écran).

• Choisissez Edit > Paste (çv).

Remplacer des Objets 
Lorsque vous collez des objets contenus dans le presse papiers 
(via Edit > Paste ou C-v) sur une couche destination, si des 
objets sont sélectionnés sur la couche, un message d’alerte 
s’affiche et vous demande si vous voulez remplacer la sélection 
en cours: ‹Replace current selection? No/Replace›. Si vous 
pressez R ou cliquez sur >Replace<, les objets sélectionnés 
seront remplacés par les objets contenus dans le presse-papier. 
Le câblage existant reste intact.

Remplacer l’objet de la piste sélectionnée

Vous pouvez remplacer l’instrument assigné à la piste sélection-
née (dans la fenêtre Arrange) par n’importe quel objet d’envi-
ronnement. Il suffit d’un simple clic sur le nouvel objet 
souhaité avec l’outil Midi Thru activé.

Souvenez-vous: dans le séquenceur, la fonction Midi Thru 
dirige tous les événements Midi reçus, vers l’objet d’environ-
nement assigné à la piste sélectionnée. Après avoir cliqué avec 
l’outil Midi Thru vous pouvez ‹adresser› l’objet directement.

Commandes de Sélections Spéciales

Sélectionnez tous les instruments utilisés

La fonction Edit > Select Used Instruments vous permet de 
sélectionner tous les objets qui sont assignés aux différentes 
pistes dans la fenêtre Arrange.

Sélectionnez tous les instruments inutilisés
5 - 11
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La fonction Edit > Select Unused Instruments Instruments 
vous permet de sélectionner tous les objets qui ne sont pas uti-
lisés dans la fenêtre Arrange, ni adressés par aucun instrument.
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Sélection des Objets de Destination d’un Câble

La fonction Edit > Select Cable Destination vous permet de 
sélectionner l’objet de destination d’un câble sélectionné. Ce 
qui s’avère particulièrement utile dans deux cas:

• L’objet de destination est dans une couche différente. Vous 
pouvez employer cette fonction pour sélectionner et afficher 
l’objet de destination dans cette couche;

• Dans l’affichage par liste (View > by Text)) vous pouvez loca-
liser l’objet de destination d’un objet source, car en sélec-
tionnant un objet source vous sélectionner aussi ses câbles 
de connexion.

Cette fonction vous permet, dans un réseau câblé en série, de 
suivre le câblage d’un objet à l’autre. Si plusieurs objets sont 
connectés, ou plusieurs câbles de connexion sélectionnés, la 
fonction s’applique toujours à suivre le cheminement du 
premier câble de connexion.

Basculer votre sélection

Comme dans les fenêtres Arrange et Editor, vous pouvez modi-
fier l’état de n’importe quelle sélection d’objet dans la couche 
active, via la commande Edit > Toggle Selection.

5.2 Chemin d’accès des signaux 
Lors d’un enregistrement via le séquenceur, avant qu’un 
événement Midi quelconque ne parviennent sur les entrées 
Midi de votre ordinateur, il faut câbler deux objets de l’Envi-
ronnement: l’entrée physique (Physical Input) qui représente 
l’interface Midi de l’ordinateur et l’entrée du séquenceur 
(Sequencer input), qui constitue l’entrée de Logic. 
5 - 12
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Dans le séquenceur, les éléments entrants sont toujours dirigés 
vers la piste sélectionnée, piste dans laquelle ils peuvent eux-
mêmes être sélectionnés. Les événements joués par la piste et 
les éléments entrant qui arrivent sur cette piste sont mélangés, 
puis l’ensemble est envoyé à l’instrument assigné à cette même 
piste dans la Track List .

À partir de là, les événements sont alors dirigés vers la piste 
Midi (voir le section paragraphe «Assignation de Sortie 
Directe» à la page 5 - 13).

Cependant, vous pouvez «manuellement» modifier le chemin 
d’accès entre l’entrée physique et le séquenceur, et entre 
l’instrument et le port de sortie Midi, de façon à y inclure 
d’autres objets de l’Environnement. (voir le paragraphe 
«Câblage» à la page 5 - 14).

Assignation de Sortie Directe
Vous pouvez connecter directement un instrument à une sortie 
physique Midi. Définissez la sortie voulue, dans la boîte des 
paramètres en dessous de Cha.

C’est dans la boîte des paramètres que vous pouvez sélection-
ner l’une des sorties Midi de votre interface ou de votre carte 
son. La source de sons internes de votre carte son, peut aussi 
être adressée à partir de la boîte des paramètres si vous effec-
tuez les réglages appropriées.

Le nom affiché dans la boîte des paramètres est le même que 
celui utilisé par le pilote multimédia de Windows qui reconnaît 
l’interface, ou la carte son. L’adresse d’entrée/sortie (s’il s’agit 
de cartes sons) apparaît souvent entre crochets, par exemple 
[330].

Tout objet doté d’une assignation de sortie directe est marqué 
d’un triangle sombre, affiché à sa droite.
5 - 13
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Suppression de l’Assignation de Sortie Directe
Pour supprimer l’assignation de sortie directe, activez la com-
mande ‹No Driver› dans le menu déroulant situé sous l’option 
‹Cha›. Lorsque vous sélectionnez ‹No Driver›,la ligne corres-
pondant au port de sortie affiche un signe de «division», comme 
il apparaît sur l’illustration, à droite.

Câblage
Le câblage entre les objets de l’Environnement vous donne un 
contrôle total sur le chemin d’accès des signaux Midi. Un câble 
est en principe représenté par une ligne grise entre un objet 
source et un objet destination.

Dans le chemin d’accès d’un signal audio, la direction du flux 
est toujours de gauche à droite. Par exemple, pour ce qui est de 
la répartition des entrées/sorties des objets: les entrées sont 
toujours disposées sur le côté gauche de l’objet, et les sorties 
sur le côté droit. La sortie d’un objet est marquée par un petit 
triangle pointé sur la droite.

Si vous saisissez le triangle, le pointeur se transforme en une 
prise mâle. Le mouvement de la souris développe alors un 
câble virtuel, dont vous emmenez l’embout jusqu’à l’objet de 
destination que vous souhaitez connecter. Une fois l’objet 
sélectionné par le survole du pointeur, il suffit de relâcher le 
bouton de souris pour réaliser la connexion.

Si l’objet source était déjà directement assigné à une sortie, un 
message d’alerte vous le signale et vous demande si vous 
voulez remplacer l’assignation directe par une nouvelle 
connexion. Trois options vous sont proposées:

• Cancel: la connexion n’est pas réalisée, et l’assignation 
directe demeure intacte.

• No: votre câblage est réalisé, et l’assignation directe demeure 
5 - 14
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intacte. Cela signifie que l’objet supporte maintenant deux 
connexions: l’une via le câble apparent, et l’autre, invisible, 
via le port d’assignation directe (Direct Port assignment).
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• Remove (ou R): votre câblage est réalisé, et l’assignation 
directe est supprimée. (C’est l’option retenue par défaut, car 
en général vous ne souhaitez pas disposer d’un objet 
connecté sur deux destinations différentes)

Câblage entre couches

Si l’objet destination du câblage se trouve sur une autre couche 
que l’objet source, vous pouvez relier les deux objets via un 
menu de sélection. Pour cela, maintenez enfoncée la touche 
ç etout en saisissant et en déplaçant le triangle de sortie. Un 
menu déroulant, contenant la liste de tous les objets existant, 
est affiché. Sélectionnez l’objet cible de votre choix.

Un câble de connexion vers une autre couche 
ressemble à ceci.

Câblage multiple

Entrées multiples

Il n’y a pas de limite quant au nombre de câbles que vous pou-
vez brancher dans un objet cible.

Sorties multiples 

Une fois que la sortie d’un objet (source) est connectée quel-
que part, apparaît un second triangle qui vous permet de tirer 
un autre câble pour une autre connexion. Vous pouvez dévelop-
per autant de câbles que vous le voulez, pour diverses destina-
tions.

Special outputs

Il existe une exception: certains objets disposent d’un nombre 
fini de sorties aux fonctions distinctes, et chaque sortie n’est 
valable qu’une fois (par exemple: channel splitter, cable switcher or 
physical input). Si vous voulez acheminer le signal de l’une de 
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ces sorties vers différentes destinations, vous devez d’abord 
créer un transformeur (New > Transformer), pour y brancher le 
câble à démultiplier. Vous pouvez alors brancher le transfor-
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meur sur toutes les destinations que vous voulez, pour y ache-
miner le signal. La création d’un nouveau transformeur 
n’affecte pas le signal.

Pour raccorder divers câbles existant à une destination com-
mune, commencez par sélectionner les câbles. Si les câbles ont 
déjà un destinataire commun, le plus simple consiste à le sélec-
tionner également. Puis saisir l’un des câbles, et le brancher sur 
le nouvel objet cible. Un message d’alerte vous demande con-
firmation (‹Do you want to connect all selected cables with new 
Destination? No/Connect›). Cliquez sur Connect ou bien 
appuyez sur R.

Câblage en série
La fonction Options > Cable câble un groupe d’objets sélection-
nés en série, en commençant par l’objet situé en haut à gauche.

Suppression de Câbles
Pour supprimer une connexion par câble, cliquez sur le câble 
avec l’outil gomme. Cette action supprime exclusivement le 
câble cliqué, et non l’ensemble d’une sélection multiple. Vous 
pouvez aussi, pour supprimer un câble, le saisir et le brancher 
sur l’entrée de son propre objet source.

Vous pouvez encore utilisez la commande Clear Cables only 
5 - 16
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Cette fonction supprime tous les câbles de la sélection (mais 
attention: sélectionner des objets, c’est également sélectionner 
tous les câbles connectés à l’objet).
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5.3 Les objets

Instruments (Standard)

Les objets standards de l’Environnement. Vous choisirez 
communément les instruments dans la Track List de la fenêtre 
Arrange, de sorte que les événements de piste y seront 
envoyés. L’instrument détermine alors le canal Midi, la sortie 
ou d’autres paramètres (page 3 - 8).

Mapped Instruments (Instruments complexes)

Cet instrument est particulièrement utile pour piloter les batte-
ries. Chaque note entrante peut être acheminée vers une autre 
note en sortie, et lui assigner sa propre valeur de vélocité, sa 
notation, son nom, et un câble de sortie (voir page 5 - 24). Vous 
pouvez également protéger les instruments «mappés» contre 
les risques de transpositions accidentelles. 

Multi-Instruments

Un multi-instrument se compose de 16 «sous instruments», 
individuellement adressés, et assignés à 16 canaux Midi vali-
des. Chacun d’entre eux est reliés à un port de sortie, et dispose 
de 15 banques, et de 127 programmes de sons destinés à l’usage 
des messages de Program change (voir page 5 - 29). C’est le 
type d’instrument que vous utiliserez généralement pour 
adresser chaque synthé multitimbral ou chaque sampler de 
votre studio.

Faders

Les Faders peuvent être utilisés pour créer toutes sortes d’évé-
nements Midi. Les faders peuvent prendre différentes formes 
(par exemple, boutons ou curseurs) et peuvent être contrôlés 
manuellement (avec la souris) ou par les événements Midi (voir 
page 5 - 52).
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Boutons (Buttons)

Faders spéciaux, qui se comportent comme des boutons ou des 
interrupteurs (voir page 5 - 50).

Texte (Text)

Faders spéciaux destinés à l’affichage de textes (page 5 - 50).

Mixeur GM (GM Mixer)
Une sélection de faders qui sont câblés ensemble, et combinés 
pour former une table de mixage virtuelle. Le choix se fonde 
sur les paramètres qui sont souvent valides dans les modules 
GM (XG, GS); cependant il peut également s’effectuer avec 
d’autres instruments ou périphériques Midi. Pour plus de 
détails (voir page 6 - 46).

Clavier (Keyboard)

Clavier musical virtuel permettant de jouer, ou d’afficher, les 
notes (voir page 5 - 36).

Afficheur (Monitor)

L’afficheur est un objet qui, lorsqu’il est inséré dans un chemin 
d’accès Midi, affiche les événements qui parcourent ce chemin. 
(voir page 5 - 37).

Arpégiateur (Arpeggiator)

C’est un objet qui offre de multiples options pour arpéger les 
accords. Il fonctionne de façon semblable à un arpégiateur 
«ancienne manière» (voir page 5 - 38).

Transformeur (Transformer)

Cet instrument transforme une partie des événements Midi de 
différentes manières. Il peut être utilisé pour convertir un type 
5 - 18
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d’événement dans un autre, ou modifier les valeurs d’événe-
ments entrant. Il est totalement programmable (voir page 5 - 
40).
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Ligne de retard (Delay Line)

C’est une unité d’effets Midi, qui permet de créer toutes sortes 
d’effets d’échos (voir page 5 - 40).

Séparateur de Canal (Channel Splitter)

Cet objet sépare un signal d’entrée sur différentes sorties, rela-
tives aux canaux Midi des événements entrants (voir page 5 - 
42).

Entrée physique (Physical Input)

Cet objet représente les entrées physiques de l’interface Midi 
de votre ordinateur, il est en principe relié à l’objet sequencer 
input (voir page 5 - 43).

Entrée du Séquenceur (Sequencer Input)

Constitue l’entrée de Logic. Les signaux qui arrivent sur ce 
point sont acheminés vers la piste sélectionnée, où ils peuvent 
être enregistrés et réorientés vers l’instrument assigné à la piste 
sélectionnée dans la Track list. (voir page 5 - 42).

Click du Métronome Midi (Midi Metronome Click)

Cet instrument génère une note programmable quand le 
métronome est activé. S’il est joué par un son de percussion, il 
sonne comme le clic d’un métronome. (voir page 5 - 44).

Port Midi Out 

Cet objet représente les sorties physiques de l’interface Midi. 
Si vous utilisez une interface avec plusieurs ports, vous pouvez 
créer un objet de ce type pour chaque port, et pour un maxi-
mum de 99 objets .

Paramètres d’Objet
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Les paramètres des objets sont définis dans la boîte des para-
mètres objets, dont l’aspect doit déjà vous être familier, 
puisqu’il est semblable à celui de la boîte de paramètres des 
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instruments, dans la fenêtre Arrange. En fait, le même objet, 
que ce soit dans la fenêtre Arrange ou dans la fenêtre Environ-
nement, est représenté par la même boîte.

Ouverture/Fermeture de la boîte des paramètres d’Objet 

En cliquant dans le triangle en haut à gauche, vous pouvez 
cacher tous les paramètres, sauf le nom et le type. Ce réglage 
réduit au minimum la hauteur de la boîte.

Paramètres d’Objets Généraux
Les paramètres suivant sont communs à tous les types d’objets:

Nom 

Le nom de l’objet est affiché près du triangle, il est possible de 
le sélectionner pour l’éditer en cliquant dessus. Vous pouvez 
aussi éditer le nom en cliquant sur l’objet, l’outils de sélection 
activé.

Type d’Objet

Le type d’objet est affiché entre parenthèses, et ne peut pas 
être édité.

Icône/Filtre d’Affichage de la Liste des Instruments

Un clic prolongé dans ce champs, placé sur la droite, ouvre un 
menu déroulant, dans lequel vous pouvez choisir une icône 
représentant l’objet dans l’Environnement. Vous pouvez égale-
ment utiliser, à cet effet, la Track List de la fenêtre Arrange.

En cochant la case voisine, vous autorisez l’affichage de l’objet 
parmi les instruments disponibles dans la Track List . Dans ce 
cas, l’instrument ne peut pas être assigné à un instrument de 
piste (track instrument).

 Si la case de validation n’est pas cochée, l’objet n’apparaît pas 
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dans la liste, et une ligne diagonale barre son icône pour vous 
indiquer que l’objet est masqué dans la liste. Pour autant, ni 
l’objet, ni son icône, ne seront masqués dans l’Environnement.
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Vous pouvez cochez uniquement la case d’icône, si l’objet doit 
être assigné à une piste.

Instrument
Pour créer un nouvel instrument activez la fonction New > Ins-
trument ou bien cliquez sur l’arrière plan avec l’outil stylo. Les 
instruments servent d’interface entre les pistes de Logic et vos 
sources physiques de son .

La boîte des paramètres d’instrument doit maintenant vous 
être familière. Vous trouverez ci-dessous un résumé de la signi-
fication de chacun des paramètres.

Cha Vous réglez le canal Midi dans la 
partie droite du paramètre Cha. Tous 
les événements Midi sont alors 
dirigés sur ce canal de sorte que 
«l’instrument réel» puisse recevoir 
des données à partir de ce canal. 
N’oubliez pas que vous pouvez assi-
gner directement une sortie (voir 
page 5 - 42).

Prg, Vol and Pan
Les paramètres Prg, Vol et Pan trans-
mettent les Program changes, contrô-
leurs de volume (#7) et de 
panoramique (#10). Si la case n’est 
pas cochée, vous pouvez éditer cette 
valeur, mais elle ne sera pas trans-
mise. Si la case est déjà cochée, 
chaque modification de valeur est 
immédiatement transmise.

÷ La partie gauche du champ attribuée 
au Program changes contient les 
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paramètres de sélection de banque 
de sons. Si vos périphériques géné-
rateurs de sons reconnaissent ce type 
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de message (vérifiez dans leurs 
notices), vous pouvez alors piloter 
les changements de banques de sons 
directement depuis le Program 
changes. Sinon, reportez-vous au 
paragraphe «Définition de Vos 
Propres commandes de sélection de 
banque» à la page 5 - 34.

Transpose Le paramètre Transpose vous permet 
de définir le nombre de demi-tons, 
selon lequel les événements de 
notes sont transposés lorsqu’ils sont 
joués. Les valeurs négatives transpo-
sent vers le bas.

Velocity Le paramètre Velocity vous permet de 
diminuer ou d’augmenter la vélocité 
des notes entrantes, selon des unités 
de valeur paramétrables.

Lim Les deux notes du paramètre Lim 
définissent une plage de jeu. Toutes 
les notes extérieures à ces deux 
limites sont ignorées par l’instru-
ment lorsqu’il joue la séquence.

VLim Les deux valeurs du paramètre VLim 
définissent l’étendue de la gamme 
de vélocité. Toutes les notes dont la 
vélocité est extérieure à cette 
gamme ne sont pas jouées par 
l’instrument.

Delay Certains modules réagissent légère-
ment moins vite que les autres aux 
commandes Midi. Pour garantir une 
parfaite synchronisation à travers 
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Delay (toutes les séquences seront 
alors légèrement en avance). Vous 
obtenez ce résultat en attribuant au 
nombre de pas d’horloge une valeur 
négative. Avec des valeurs positives 
l’instrument jouera légèrement en 
retard. Toute fois, si vous souhaitez 
créer des effets de retard, il est 
préférable de recourir au paramètre 
du même nom, dans la boîte 
Sequence. Cette fonction vous auto-
rise des temps de retard plus longs.

No Seq Trp Si la case située à côté du paramètre 
No Sequence Transpose est cochée, 
toutes les séquences jouées par cet 
instrument sont protégées contre les 
transpositions, quelle que soit leur 
piste. En d’autres termes, le para-
mètre de séquence «transpose» est 
ignoré. Cela est très utile pour les 
instruments de type batterie. Toutes 
les pistes batteries peuvent être 
protégées contre une transposition, 
même si l’ensemble du dossier dans 
lequel elles se trouvent est trans-
posé.

No Reset Si la case située à côté du paramètre 
No Reset est cochée, plus aucun 
message «reset» ne sera envoyé à cet 
instrument. Ceci peut être utile 
quand les contrôleurs ne sont pas 
employés dans un but musical; par 
exemple, si un instrument repré-
sente une automation de console, et 
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non un synthé. Les messages Reset 
qui peuvent être envoyés sont 
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définis dans Preferences > Reset 
Messages; Mais les instruments ‹No 
Reset› en sont exclus.

Default Score Style
Le paramètre Default Score Style en 
dernière ligne de la boîte des para-
mètres d’instrument, détermine le 
style de notation par défaut, utilisé 
pour une séquence enregistrée sur la 
piste de cet instrument. Après un 
enregistrement, l’option Auto Style 
définira la notation appropriée, en 
fonction de la position de la note et 
de sa hauteur. Éditer le style de 
notation de l’enregistrement d’une 
séquence (dans le Score Editor) ne 
modifie pas le style de notation par 
défaut de l’instrument.

N’oubliez pas: Le style de notation, qui peut être définit pour 
chaque séquence, détermine la façon d’exprimer le score, par 
exemple le type de clef ou le nombre de portée. Ce paramètre 
peut être modifié dans la boîte des paramètres d’affichage de 
séquence de la fenêtre Score.

Lorsque vous sélectionnez le style de notation, vous pouvez 
définir un même style pour toutes les séquences jouées par un 
même instrument, en maintenant enfoncée la touche O lors 
de la sélection.

Instruments complexes
Pour créer un nouvel instrument complexe activez New > 
Mapped Instrument.

Un instrument complexe s’avère fort utile pour la programma-
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• La transposition est inhibée d’office,

Chaque note entrante peut individuellement:

• être nommée (par exemple «snare», «hi hat»…);
• transmettre une note de sortie différente (par exemple pour 

permettre de jouer des roulements d’une caisse claire en 
note F#1 hi hat à partir de plusieurs notes de clavier);

• recevoir un décalage (offset) de vélocité;
• être assignée à son propre canal Midi;
• être envoyée sur l’un des 16 câbles de sortie (cela vous 

permet de créer un instrument simple qui adresse de multi-
ples sources sonores);

Boîte des Paramètres d’Objet

Les paramètres de la boîte des paramètres d’objet constituent 
un sous-ensemble des paramètres d’objet d’un instrument 
standard (décrit page 5 - 21). Vous pouvez spécifiez un réglage 
dans la fenêtre d’instrument complexe (voir page 5 - 27).

Cha C’est avec ce paramètre que vous 
déterminez le canal et le port 
physique sur lequel seront émises 
toutes les notes que vous n’aurez pas 
explicitement assignées. 

Prg, Vol, Pan Ce sont les mêmes fonctions que 
pour les instruments standards. 
Elles vous permettent d’envoyer 
program changes, volume, et panora-
miques. Si la case est cochée, la 
valeur est envoyée immédiatement. 
Sinon, elle ne sera pas envoyée tant 
que vous ne cochez pas la case. 
N’oubliez pas que les contrôleurs de 
volumes et de panoramiques sont 
des messages en mode «canal», et 
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que de la sorte, ils affectent 
l’ensemble des réglages de percus-
sions. Vous pouvez opérer des chan-
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gements de Banques de sons avec le 
signe de division, employé dans la 
ligne Prg, pour autant que vos 
sources de son soient compatibles 
avec le contrôleur de sélection de 
banque (n°32).

Delay C’est la même fonction que pour les 
instruments standards. Toutes les 
notes sont décalées selon un nombre 
des pas d’horloge paramétré (+/- 99). 
Une valeur positive génère des notes 
de sortie retardées; une valeur néga-
tive des notes de sortie avancées. 
Cela vous permet de compenser le 
temps de retard pris par les sources 
sonores les plus lentes à répondre 
aux messages Midi. Si vous voulez 
créer des effets musicaux avec déca-
lage, vous devrez utiliser le para-
mètre de séquenceur du même nom, 
qui vous permet des temps de déca-
lage plus longs. 

No Seq Trp (No Sequence Transpose)
Si cette case est cochée, tous les 
paramètres de transposition des 
séquences (ou des dossier qui les 
contiennent) sont ignorés par cet 
instrument complexe. Par exemple, 
si vous placez dans un dossier toute 
la partie rythmique, plus la batterie, 
vous pouvez transposez l’ensemble 
(par les paramètres de transposition 
du Dossier) sans modifier le jeu de la 
batterie envoyé en sortie par cet 
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Default Score Style
Ce paramètre, qui termine la liste, 
définit le style de la notation par 
défaut pour toute séquence appli-
quée à une piste assignée à cet 
instrument. En ce qui concerne les 
instruments complexes utilisés 
conjointement avec les ‹mapped 
score styles› cela peut vous 
permettre d’automatiser la notation 
des «percussions». Utilisée conjoin-
tement avec les ‹mapped score 
styles› celle peut être utilisée afin de 
générer automatiquement une nota-
tion de type percussion.

Fenêtre d’instrument complexe
Pour ouvrir la fenêtre d’instrument complexe, double cliquez 
sur l’élément complexe voulu. Les notes d’entrée sont alignées 
horizontalement, et leurs paramètres disposés verticalement .
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Clavier de référence (Selecting Notes)

Le clavier de référence disposé à gauche représente les notes 
entrantes. Il peut jouer une note sur laquelle vous cliquez. Vous 
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pouvez aussi sélectionner vos notes, soit individuellement, soit 
par rangées de notes, en saisissant les notes voulues (donc en 
leur cliquant dessus et en maintenant le bouton de la souris) et 
en les déplaçant. Pour une sélection multiple de notes sépa-
rées, cliquez les notes voulues en tenant la touche S enfoncée.

Input Name

Dans la colonne voisine, vous pouvez cliquer sur un note 
entrante, et lui donner un nom (une étiquette) de 12 caractères 
maximum. Vous pouvez initialiser les étiquettes d’une sélec-
tion de notes selon la notation américaine (comme C#3) en acti-
vant Initialize > Names as Notes selon les noms de son du stan-
dard GM (standard General Midi) en choisissant Initialize > 
Names as General Midi.

Output Note

C’est dans cette colonne que vous réglez la note sortante; ou 
bien en mode texte, en double cliquant dans le champ de para-
mètre, ou bien graphiquement en tirant le curseur. Chaque fois 
que vous modifiez la valeur de ce paramètre, les notes Midi 
sont émises en sortie afin que vous puissiez en vérifier la sono-
rité. Si vous activez Initialize > Output Notes, la palette des 
notes sélectionnées est alors réinitialisée sur le modèle des 
notes entrantes correspondantes.

Velocity

Vous déterminez avec ce paramètre un offset de vélocité, en 
augmentant ou en diminuant la vélocité réelle de la note. Vous 
pouvez saisir graphiquement la valeur affichée et faire varier 
l’affichage en déplaçant la souris, qui agit comme un curseur, ou 
par un clic sur ce dernier au point désiré. La valeur par défaut 
est la valeur médiane 64, valeur égale à celle envoyée par les 
claviers non sensibles à la vélocité. Initialize > Output Veloci-
ties neutralise tous les décalages de vélocité.
5 - 28
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Cha

Ici vous réglez le canal Midi pour chaque note de 1 à 16, ce qui 
vous permet de combiner des sons issus, par exemple, de deux 
générateurs de percussions différents. En général vous utilise-
rez la valeur Base , qui est le réglage par défaut. Dans ce cas, les 
notes sont envoyées sur le canal défini dans la boîte des para-
mètres d’instruments complexes. Si vous choisissez la valeur 
All au lieu de 1 à 16, le canal de la note d’entrée est conservé. 
Cette option est utile si vous voulez insérer l’instrument 
complexe dans le chemin d’accès du signal après un instrument 
standard, ou un mutli-instrument. Pour régler toutes les notes 
sélectionnées sur Base , choisissez Initialize > Output Channels. 
Reportez vous au paragraphe «Configurer le canal Midi:multi-
instruments» à la page 3 - 11.

Cable

Vous pouvez envoyer chaque note sur un câble de sortie diffé-
rent et jouer des sons de différentes sources. Vous devez 
d’abord câbler l’instrument complexe vers au moins une autre 
destination (jusqu’à 16). Initialize > Output Cables redirige 
toutes les notes sélectionnées vers le câble le plus haut, le câble 
n° 1.

Multi-Instruments
Pour créer un multi-instrument, sélectionnez New > Multi 
Instrument.

Un multi-instrument est, en fait, prédéfini pour donner une 
représentation virtuelle d’un générateur de son multitimbral..
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ments (sub-channel) tous assignés à un canal Midi différent. 
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Chacun des sous-instruments est doté de sa propre boîte de 
paramètres. Mais celle-ci ne comporte pas de paramètres de 
nom, ni de canal Midi, ni de sortie, ces paramètres n’étant pas 
définis au niveau du multi-instrument. Tous les sous-instru-
ment utilisent une table répertoriant l’accès à 128 programmes 
de sons, et 15 banques, répondant au format de message Bank 
Select conventionnel.

Boîte de paramètres Multi-Instrument 

Lorsque vous avez créé un multi-instrument, vous obtenez 
l’affichage de la boîte de paramètres multi-instrument, ci-
contre.

Vous devez, maintenant, être familiarisé avec ces paramètres (si 
non reportez-vous à leur description, page 5 - 29). Les réglages 
effectués dans cette boîte s’appliquent aux sous-instruments 
(sous-canaux), et ne peuvent servir que pour des tests. Déter-
minez le port de sortie dans la ligne située sous le paramètre 
‹Cha›(voir page 5 - 12).

Initialiser et Sélectionner les Sous-canaux

Pour sélectionner un sous-instrument (sous-canal), cliquez la 
case correspondante. Le premier clic l’initialise, il est alors 
disponible dans la liste des instruments (Arrange track). Pour ne 
pas surcharger l’affichage, vous ne devez pas initialiser plus de 
sous-instruments qu’il ne vous est nécessaire. Comme avec un 
instrument standard, vous pouvez supprimer le sous-instru-
ment de la liste des instruments, en décochant la case de vali-
dation correspondante. Le bouton du sous-instrument est alors 
barré d’une ligne transversale. Si vous voulez sélectionner tous 
les sous-instruments, plutôt que de les sélectionner un à un, 
optez pour un sélection globale en cliquant sur le bord supé-
rieur du multi-instrument.
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Dans l’exemple ci-dessus, le sous-instrument 1 est sélectionné, 
les sous-instruments 1 à 8 sont initialisés, et les sous-instru-
ments de 9 à 16 sont supprimés de la piste.

La Boîte de paramètres Sub-channel 

Identique à celle d’un instrument standard, elle permet d’assi-
gner sa propre icône et sa couleur. Toute fois, si vous essayez de 
modifier le canal Midi, le message d’alerte suivant: ‹Channel 
protected! Please select a sub-channel from the Instrument flip menu.›

Câblage

Pour connecter directement la sortie d’un objet de l’environne-
ment à l’entrée d’un sous-instrument, maintenez enfoncée la 
toucheç , et connectez la sortie via le menu déroulant (voir le 
paragraphe «Câblage entre couches» à la page 5 - 15.

Fenêtre Multi-Instrument 
Double cliquer sur un multi-instrument ouvre la fenêtre multi-
instrument..
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Nom et Label

En haut à gauche, sous la mention Device Name, , vous saisissez 
le nom complet du multi-instrument. En haut à droite, sous la 
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mention Short Device Name, vous saisissez, comme label, un 
nom plus court. Il sera utile dans le menu déroulant de la Track 
List de la fenêtre Arrange, pour permettre d’économiser de la 
place, notamment si le nom du programme y est affiché aussi. 
Le label commence à droite de l’icône. Pour uniformiser l’affi-
chage, laissez un espace vierge devant le nom.

Selon que vous avez ou non cochée la case Prg box, d’un sous-
instrument, l’information suivante apparaît dans la Track List:

• Le nom du multi-instrument et le numéro de canal (si la case 
n’est pas cochée), ou

• le label, le numéro du canal et le nom du programme (si la 
case est cochée).

Noms de programme

La fenêtre multi-instrument contient 128 noms de programme. 
Il y a, au total, une disponibilité de 15 banques, contenant 
chacune les noms de 128 sons. Différentes façons de saisir le 
nom des programmes vous sont proposées:

• par double clique sur le nom (via le champ de saisie texte),

• avec le presse papiers, par copier-coller à partir du nom d’un 
autre instrument, ou à partir du gestionnaire de texte. Le 
presse-papiers peut gérer également l’importation de toute 
une banque de sons dans le menu d’importation des textes. 
(activez la flêche de vue par liste, en haut à droite). Copiez 
d’abord les numéros de programmes, ou les noms au format 
General Midi, dans le presse-papiers, puis ajoutez les au 
gestionnaire de textes. Vous pouvez alors éditer les noms et 
copier à nouveau la section précédente en entier.

• si vous désirez utiliser les numéros de programme à la place 
des noms, sélectionnez Init Names as Numbers depuis le 
menu d’importation des textes.
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Si la case Use GM Drum Names for Channel 10 est cochée, les 
noms de batteries du sous-instrument 10 seront affichés au 
format GM, dans la fenêtre multi-instrument.

Si la case Prg est cochée dans la boîte de sélection de paramè-
tres des sous-instruments, vous pouvez envoyez immédiate-
ment un Program change en sélectionnant un nom de 
programme (soit en cliquant sur le nom, soit par une sélection 
au moyen des touches «flêche»).

Banques

Sous les noms de programmes, vous pouvez sélectionner l’une 
des 15 banques disponibles (0-14), via un menu déroulant. 
L’option du haut (‹No Bank specified. Names of Bank 0 used.›) 
peut être activée, si le générateur de son employé ne sait pas 
reconnaître les ordres de changement de banque, ou s’il ne 
contient pas plus de 128 programmes sonores. La banque 0 est 
toujours initialisée. La première fois que vous choisissez l’une 
des banques entre 1 et 14, Logic vous demandera si vous voulez 
l’initialiser. Appuyez sur R ou Cancel si vous ne voulez pas 
initialiser la banque. Les banques non initialisées ne disposent 
pas de leur propre table de noms. Elles utilisent les noms de 
programme équivalents de la banque 0. Par contre, vous devez 
initialiser les banques additionnelles pour exploiter leurs fonc-
tions d’accès direct aux programmes.
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communication entre les banques et le multi-instrument. 
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Malheureusement, il existe des formats variés qui dépendent 
des fabricants. Il vous faut vous reporter aux notices de vos 
périphériques pour savoir quels formats de message ils suppor-
tent; certains matériels n’en supportant aucun. Toute fois, avec 
des synthés récents, il y a de bonnes chances que soit reconnu 
le format de l’une des premières options du menu déroulant: 
controller n° 32 ou controller n° 0. Il y a aussi des options 
compatibles avec plusieurs types de paramètres courants. Si 
votre matériel ne répond pas aux standards cités ci-dessus, et 
s’il n’est pas non plus répertorié dans la liste des pré-réglages, 
n’abandonnez pas – tous n’est pas perdu!

Définition de Vos Propres commandes de sélection 
de banque
Vous pouvez créer une chaîne comportant autant d’événements 
que vous le souhaitez – même un message SysEx de n’importe 
quel longueur – pour appeler chacune des banques, que ce soit 
à partir d’un instrument simple, d’un instrument complexe, ou 
d’un multi-instrument. De la sorte – que vous changiez de ban-
que manuellement, ou que vous adressiez un ordre de sélection 
de banque (Bank Select) via Logic – tous les messages de sélec-
tion à destination de vos synthés seront transmis, quelque soit 
le standard qu’ils utilisent.

Pour exploiter cette fonction, sélectionnez l’instrument stan-
dard, complexe, ou multi, qui vous est nécessaire, puis activez 
Options > Define Custom Bank Messages.... Une fenêtre 
5 - 34
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semblable à l’Event List est alors ouverte, avec un échantillon 
de 15 chaînes d’événements préétablies.

Vous pouvez créer là un événement Midi, exactement comme 
vous le feriez dans l’Event Editor, par couper, copier, coller et 
éditions. La seule différence est que vous entrez le numéro de 
banque de votre choix à la place de la position.

Une lettre apparaît alors, entre parenthèses, derrière le numéro 
de banque. Cette lettre vous permet de déterminer l’ordre dans 
lequel les événements que vous avez définis seront envoyés.

Exemple

Ici, la commande de sélection de banque ‹Bank 1›a été configu-
rée pour envoyer trois événements: d’abord, (a) un message de 
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contrôleur n°32 avec la valeur 1, puis (b) un message de contrô-
leur n°0 avec la valeur 0, et finalement, (c) un message SysEx 
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pour un périphérique, pionnier des synthés numériques dans 
les années 80, le PPG ($29).

Vous pouvez envoyer une chaîne d’événements pour appeler 
chaque banque, et elle peut être aussi longue que vous le sou-
haitez.

Si aucun événement n’a été défini pour une banque particu-
lière, c’est un ordre de sélection de banque (Bank Select) stan-
dard qui sera envoyé à la place.

L’information d’assignation de banque se rapporte à l’instru-
ment sélectionné et peut être copiée et collée avec lui.

Le choix du canal Midi employé à la transmission des messages 
évènement est défini automatiquement – ou, si l’objet est réglé 
sur l’option de canal «All» (tous les canaux), la chaîne est 
envoyée sur le même canal que celui du changement de ban-
que en entrée. Cette caractéristique est pratique avec les multi-
instruments, car vous pouvez créer vos ordres de banque en une 
seule fois, et ainsi les envoyer à tous les canaux Midi qui sont 
rattachés à l’instrument.

Il semblerait que chaque constructeur ait son propre format de 
commandes de sélection de banque. Nous espérons que cette 
fonction, si commode, offrira toujours une solution à ce pro-
blème de compatibilité.

Clavier
Vous pouvez créer un clavier virtuel avec la commande New > 
Keyboard.
5 - 36
Emagic
Logic Audio Pro ISIS 

Le clavier peut être utilisé pour produire des notes testes. 
Connectez la sortie du clavier sur un instrument, un port de 
sortie, ou l’entrée d’un séquenceur. Dans ce dernier cas, vous 
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pouvez théoriquement enregistrer toutes les Songs sans recou-
rir à un clavier maître externe, si ce n’est qu’aucune information 
dynamique (données de vélocité Midi) ne sera enregistrée.

En plus des paramètres standards vous pouvez également défi-
nir le canal Midi et la vélocité des notes produites (malheureu-
sement, il n’y a pas encore de possibilité d’exploiter une vélo-
cité sensitive liée aux mouvements de la souris), ainsi que 
l’octave du Do inférieur.

Vous pouvez définir la plage de notes du clavier en saisissant et 
en déplaçant l’angle inférieur droit. Pour sélectionner ou dépla-
cer un clavier, en maintenant la touche S enfoncée, puis 
cliquer à droite du nom de l’objet, ou effectuez un «presser-
glisser» à partir de ce point .

Outre jouer des symphonies à la souris, le clavier vous permet 
d’afficher les évènements de note. Connectez la sortie d’un 
objet (par exemple un instrument, ou une sortie physique) au 
clavier, et admirez le feux d’artifice!!! 

Moniteur

Pour créer un moniteur d’événement choisir New > Monitor. La 
ligne inférieure affiche les événements qui arrivent sur son 
entrée. Les plus anciennes données occupent alors les lignes 
supérieures, remontant progressivement la pile. Un «presser-
glisser» du coin inférieur droit vous permet d’augmenter l’affi-
chage jusqu’à 32 lignes.

Toutes les données qui arrivent sur l’entrée du moniteur sont 
directement acheminées, sans aucune modification, à la sortie 
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du moniteur. C’est pourquoi les Moniteurs sont très commodes 
pour réaliser des testes, en quelque point que ce soit du chemin 
Midi.
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Arpégiateur
Pour créer un arpégiateur, sélectionnez New > Arpeggiator. 

Vous pouvez l’utiliser pour transformer un accord en arpège. 
Connectez la sortie de l’arpégiateur à l’instrument dont vous 
voulez arpéger les accords. Remplacez cet instrument par 
l’arpégiateur dans la Track List de la fenêtre Arrange, pour la 
piste à traiter. (Evidemment, vous pouvez l’insérer à un tout 
autre endroit du chemin d’accès du signal)

Vous pouvez alors jouer en mode «live» ou employer des 
séquences enregistrées. N’oubliez pas les points suivants:

• L’arpégiateur travaille seulement quand le séquenceur est 
actif.

• Les notes résiduelles sont coupées lorsqu’un nouveau cycle 
est recommencé (pour des raisons internes au système).

Un arpégiateur dispose des paramètres suivants (les numéros 
entre parenthèses sont expliqués ci-dessous dans la rubrique 
intitulée CTRL Base):

Direction (+0)

La direction de l’accord arpégé:

Up  ascendant
Down  descendant
UpDn  ascendant et descendant (les notes extrêmes sont jouées 
deux fois)
Auto  la direction dépend de l’ordre d’enregistrement
UpD2  ascendant et descendant (les notes extrêmes sont jouées 
une seule fois)
Rand ordre aléatoire
All all toutes les notes répétées simultanément comme un 
accord
5 - 38
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Vel (+1)

Valeur de vélocité des notes arpégées.
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1 – 127 vélocité fixe
Orig  la vélocité des notes est conservée
Rand vélocités aléatoire entre 1 et la valeur originale

Lim (Low: +2, High: +3)

Définit la plage des notes (entre C-2 et G8), à l’intérieure de 
laquelle les accords sont arpégés. Toutes les notes en dehors de 
cette plage ne seront pas modifiées par l’arpègiateur.

Res (+4)

Définit la valeur rythmique élémentaire de chaque note de 
l’arpège, via le menu déroulant affiché à gauche. None = arpé-
giateur désactivé.

Len (+5)

Définit la longueur des notes arpégées. La valeur Orig conserve 
la longueur d’origine des notes enregistrées.

Snap to (+6)

Cette valeur détermine la quantisation de la grille selon 
l’endroit où l’arpégiateur commence l’arpège, après les notes 
entrantes. Avec un arpège «normal» il est interressant d’utiliser 
le même réglage que celui déterminé pour les mesures (par 
exemple, 1/4).

Repeat (+7)

On Prolonge l’arpège aussi longtemp que l’accord est maintenu. 
Off conclus l’arpège après un passage.

Octaves (+8)

L’arpégiateur peut couvrir de 1à 10 octaves.

Crescendo (+9)
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La vélocité définit ici (-99 à +99) est ajoutée chaque fois que 
l’arpège est répété (à condition que l’option Repeat soit réglée 
sur On, bien entendu).
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Ctrl Base

Les 10 paramètres des arpégiateurs peuvent être contrôlés via 
les contrôleurs d’événements. Avec le paramètre Ctrl Base vous 
pouvez déterminer le numéro de contrôleur nécessaire au 
premier paramètre (Direction). Les autres paramètres sont 
contrôlés via les numéros de contrôleurs suivants. Pour trouver 
quel numéro de contrôleur utiliser avec certains paramètres, 
ajoutez au numéro de base, le numéro affiché entre parenthèses 
après le nom du paramètre dans la documentation. En position 
Off , la télécommande sera désactivée.

 Ligne à Retard (Delay Line)

Pour créer une nouvelle ligne delay (on parlera de ligne de 
décalage ou d’objet de décalage), sélectionnez New > Delay 
Line.
5 - 40
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Cet objet vous permet de répéter chacun des éléments Midi, 
avec un décalage. Un événement note peut aussi être modifié 
en hauteur et en vélocité. Reliez la sortie de l’objet décalage 
(delay line) à l’instrument avec lequel vous voulez jouer les 
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événements décalés. Assignez l’objet de décalage à la piste 
sélectionnée, dans la Track List de la fenêtre Arrange. (Naturel-
lement, le delay (décalage) peut être placé en un autre point du 
chemin d’accès du signal.).

Dés lors, vous pouvez jouer l’effet de décalage en «live», ou 
bien à partir de séquences enregistrées. Gardez en mémoire les 
points suivants:

• Le retard ne peut être appliqué qu’à condition que le 
séquenceur soit actif;

• la lecture des événements décalés est interrompue, pour des 
raisons propres au système, à la fin d’un cycle;

• chaque « écho » utilise une voix de polyphonie du généra-
teur sonore.

Paramètres

Un objet de décalage dispose des paramètres suivants:

Thru Original: si la case est cochée, le signal original 
est transmis, et dans le cas contraire, 
il est effacé.

Repeats: définit le nombre de répétition (de 1 
à 99). Réglé à 0 = le delai est inhibé.

Del: définit le temps imparti entre les 
répétitions (échos). La valeur de 
gauche est exprimée en fraction 
d’unité de temps (division de 
temps), et celle de droite en nombre 
de pas d’horloge.

Trp: définit la valeur de transposition des 
notes pour chaque échos (+/- 99 
demi-tons).
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Vel: définit la valeur d’incrémentation ou 
de décrémentation de la vélocité des 
notes par répétition (+/- 99).
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Câble de sortie

Le premier écho est toujours envoyé sur le premier câble, le 
câble supérieur. Si plusieurs câbles sont connectés, chaque 
écho, au fur et à mesure des envois, est adressé sur le câble 
suivant. S’il y a plus d’échos que de câbles connectés, une fois 
la série de câbles disponibles épuisée, le cycle reprend avec le 
câble supérieur et se poursuit en exploitant successivement les 
câbles de haut en bas.

Séparateur de canaux
Pour créer un nouveau séparateur de canaux, sélectionnez New 
> Channel Splitter.

Vous pouvez utiliser le séparateur de canaux, pour réacheminer 
des événements Midi sur différents câbles, selon le canal Midi 
emprunté par chacun des messages. Chaque événement Midi, 
reçu en entrée du canal splitté, est réacheminé vers la sortie 
correspondant à son canal Midi. S’il n’y a aucun câble de 
connecté à la sortie correspondante, l’événement est acheminé 
vers la sortie SUM output (la plus haute). La sortie SUM assure 
le cheminement des événements dont les canaux n’ont pas été 
réacheminés vers des sorties individuelles.

Si vous voulez acheminer des information d’un canal particulier 
vers d’autres objets, consultez à nouveau le paragraphe 
«Câblage multiple» à la page 5 - 15.

Entrée Physique / Entrée du Séquenceur
L’objet d’entrée physique, Physical Input, représente l’entrée 
Midi de votre interface Midi PC l’entrée du séquenceur Sequen-
cer Input symbolise l’entrée Midi propre à Logic. Chacun de ces 
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nement.
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Pour créer l’un de ces objets d’entrée sélectionner New > 
Physical Input, ou New > Sequencer Input. Pour garantir l’exis-
tence d’un objet, glissez le sur la couche concernée. Ceci 
n’affecte en rien son câblage. Ces fonctions sont nécessaires 
seulement si, par erreur, vous avez supprimé ces objets. Si ces 
objets existent déjà dans l’Environnement, l’action de ces fonc-
tions sera de ramener ces objets dans la couche visible. Leur 
câblage sera conservé

Entrée Physique
En sortie de l’objet Physical Input , vous pouvez récupérer tous 
les signaux Midi provenant du port d’entrée Midi de votre ordi-
nateur.

En principe, la sortie de l’objet Physical Input est connectée à 
l’Entrée du séquenceur.

Entrée du Séquenceur
Les événements Midi parviennent au séquenceur via l’objet 
Entrée du séquenceur, à partir duquel ils peuvent être enregis-
trés sur la piste en cours, et réacheminés (au moyen de la fonc-
tion Midi Thru) sur la piste instrument. Comme pour tout objet 
de l’Environnement, vous pouvez connecter plusieurs sources 
de signaux sur l’Entrée séquenceur, sources qui peuvent alors 
être mixées ensemble.

En principe la sortie SUM de l’ entrée physique est directe-
ment connectée à l’entrée du séquenceur, de sorte que les 
événements Midi entrants puissent être enregistrés directe-
ment.
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Si vous désirez modifier les événements Midi entrants avant 
qu’ils ne soient enregistrés, vous pouvez placer les différents 
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objets nécessaires, sur le chemin d’accès du signal, entre l’objet 
d’entrée physique et l’objet d’entrée du séquenceur.

Clic du Métronome Midi 
L’objet Métronome Midi Clic crée des notes distribuées dans le 
temps, lorsque le séquenceur est activé, et lorsque le bouton 
metronome de la fenêtre Tranport est en position active. Cela 
vous permet de configurer séparément les paramètres du 
métronome pour les modes lecture et enregistrement.

Notez que l’option File > Song Settings > Recording Options > 
Midi Click doit être activée pour que vous puissiez accomplir ce 
type d’intervention.

En sélectionnant New > Midi Metronome Click vous ne pouvez 
pas créer plus d’un objet Midi metronome click . S’il en existe déjà 
un, il est déplacé sur la couche en cours.

Les cases de validation disposées en vis à vis des paramètres 
Bar, Beat et Division ,vous permettent de produire des notes 
différentes pour les mesures, les temps et les divisions. Les 
paramètres Cha, Note et Vel définissent respectivement le canal 
Midi, la hauteur et la vélocité des notes produites. La ligne du 
paramètre Bar, se trouvant juste en dessous du paramètre Cha, 
vous permet de définir le port de sortie du métronome.

Port Midi Out 
L’objet du port de sortie représente la ou les sortie(s) Midi de 
votre (ou de vos) interface(s) Midi. De plus, vous pouvez les 
employer pour adresser le synthé interne de votre carte son.

Pour créer un objet de port sortie, sélectionnez New > Midi Out 
Port .

Vous pouvez utiliser la ligne inférieure de la boîte des paramè-
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tres pour définir la sortie Midi ) de l’objet du port de sortie. Les 
signaux de tous les câbles Midi connectés à cet objet seront 
acheminés vers la sortie Midi que vous avez sélectionnée. 
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Faders

Pour créer un nouveau fader, activez New > Fader > …. Apparaît 
un sous-menu dans lequel vous pouvez sélectionner le type de 
fader de votre choix. La commande clavier de la fonction 
«nouveau fader» produit toujours un fader de type «Auto». 
L’aspect graphique d’un fader diffère de part sa taille (et sa 
fonction). Pour en mesurer l’effet, créer un fader d’un type 
quelconque, juste «pour voir», et modifier sa taille plusieurs 
fois et en tous sens. Si vous réduisez le fader jusqu’à un certain 
point, il prendra automatiquement la forme d’un potentiomè-
tre. De la même façon, si vous réduisez sa hauteur à une dimen-
sion inférieure à sa largeur, il aura l’aspect d’un curseur horizon-
tal.

En déterminant le Fader Type, vous optez pour l’un des faders 
prédéfinis selon une maniabilité et une variété de fonctions 
adaptées à tel ou tel type d’usage.

Toute fois, vous pouvez également déterminer l’effet d’un 
fader indépendamment de son type, via le paramètre Fader 
Function. En principe ceci déterminera le type d’événement 
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produit par le fader ainsi paramètré, ou bien le type d’événe-
ment que le fader est alors capable de contrôler à distance.
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Une fonction de fader spécialisée vous permet d’acheminer les 
données selon des chemins d’accès différents. 

Utilisation
En général, la surface d’un fader est redimensionnée via la sou-
ris (outil stylo activé ou non) en saisissant un des bords de 
l’objet et en le faisant glisser (utilisation en presser-glisser). 
Vous redimensionnerez les faders linéaires horizontalement ou 
verticalement, selon leur type; un potentiomètre sera redimen-
sionné à la fois verticalement et horizontalement.

Avec les faders de type 1, 4 et Numerical , les données produites 
sont affichées numériquement. Vous pouvez sélectionner le 
nombre affiché et déplacer la souris comme un curseur pour 
faire varier cette valeur. Son avantage est de toujours donner un 
résultat minimum de 1 Quand vous employez le fader lui-
même en tant que curseur l’acces a toutes les valeurs peut 
s’averer difficile car il dépend de la taille du fader lui même.

Cependant, même avec de petits fader vous pourez néanmoins 
changer les valeurs par unité, en maintenant simplement 
enfoncée la toucheA.

Les faders Texte peuvent être redimensionnés de la même 
manière, avec le curseur, ou bien via un menu déroulant (selon 
la façon dont vous les avez configurés). Les boutons sont action-
nés par un clic. 

Fonctions utiles avec les Groupes d’Objets
Si vous désirez créer, dans l’Environnement, une console de 
mixage virtuelle ou un panneau de contrôle de synthé, vous 
devez souvent gérer de grands groupes d’objets fader, dotés de 
la même taille, disposés avec régularité et/ou dotés de configu-
rations semblables. Pour réaliser de tels ensembles dans les 
meilleures conditions, sans perte de temps, Logic offre plu-
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Comment les employer

Le principe est que vous définissiez un ou plusieurs objets 
comme prototypes (templates, ou encore modèles) au moyen de 
copies via le presse-papiers (Edit > Copy). Certains paramètres 
de prototype peuvent alors être appliqués aux objets sélection-
nés. 

Noms avec des numéros

Souvenez-vous que lors de la dénomination d’une sélection 
multiple, un numéro est affecté, en ordre croissant, au nom de 
chaque objet.

Fonctions Spéciales des Faders

Groupes de Faders

Si vous actionnez l’un des faders d’une sélection, tous les faders 
sélectionnés auront le même mouvement proportionnellement 
à celui du fader sur lequel vous intervenez. Aussi longtemps 
que vous ne modifiez pas le réglage du fader sur lequel vous 
êtes intervenu, le réglage proportionnel des autres faders est 
conservé, même si certains d’entre eux ont atteint une valeur 
de réglage maximale ou minimale.

Mis à part le mouvement proportionnel, deux possibilités 
s’offrent à vous:

Actionner le groupe de faders avec le raccourci clavier ç 
modifie toutes les valeurs de façon linéaire (la valeur absolue 
des différences est conservée).

Actionner le groupe de faders avec le raccourci clavier Sç 
ajuste tous les faders selon la même valeur; celle définie par le 
fader sur lequel vous intervenez.

Envoi de la valeur des faders
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Vous pouvez utilisez Options > Send All Fader Values et …> 
Send Selected Fader Values pour que tous les objets fader, ou 
bien tous les objets fader sélectionnés, envoient leur valeur en 

X
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cours. Cette fonction est particulièrement utile avec les conso-
les de mixages virtuelles ou les panneaux de synthés, car elle 
vous permet de prendre un «cliché» de tous les réglages fader 
en cours. Cependant, vous pouvez utiliser seulement l’option 
Send All Fader Values pour enregistrer les faders dont les sorties 
sont reliées à des objets. L’option Send All Fader Values after 
loading située àla page Midi Options de Song Settings, provo-
que l’envoi automatique de toutes les valeurs de faders, une 
fois que la Song est chargée.

Enregistrement du Mouvement des Faders
Si vous désirez enregistrer les données produites par un fader, 
vous n’avez besoin d’aucune connexion particulière. Toute 
donnée produite par un fader peut être enregistrée sur la piste 
sélectionnée.

La définition de sortie du fader détermine quels événements 
seront enregistrés.

Rejouer les Mouvements des Faders
Lorsque vous rejouez les données de fader enregistrées, si vous 
voulez que le ou les fader(s) concerné(s) restitue(nt) automati-
quement les mouvements correspondant, il(s) doit(-vent) être 
localisés après la piste dans le chemin d’accès des signaux. 
C’est pourquoi chacun des faders employé doit être assigné à la 
piste de l’instrument, ou bien être situé sur le chemin d’accès 
du signal, entre l’instrument de piste et le port de sortie.

Si vous voulez câbler un groupe de faders de sorte que l’enre-
gistrement de leurs mouvements soit restitué visuellement, 
lors d’une relecture, il est profitable de créer un instrument 
pour ce groupe de fader. Cet instrument peut, en ce cas, être 
employé comme instrument de piste lors de l’enregistrement 
du mouvement des faders. Tous les faders doivent être reliés en 
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série, en commençant par cet instrument (voir le paragraphe 
«Câblage en série» à la page 5 - 16). Le câble émerge alors du 
dernier fader pour relier le port voulu.
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Le mouvement des faders suit tous les événements qui corres-
pondent aux définitions d’entrée et de sortie.

( Types de fader
Le type de fader est affiché sur la ligne située sous les fonctions 
d’icône déjà rencontrées, et peut être modifié via un menu 
local. Il suffit d’un un clic prolongé sur le type en cours pour 
développer l’affichage du menu déroulant.

Le type de fader détermine essentiellement l’aspect du fader. 
Et, n’oubliez pas que la nature des événements produits par un 
fader a peu de rapport avec son aspect. 

Les fader de type 1 et 4 sont équivalents aux faders de types 2 
et 3, à ceci près qu’ils disposent d’un affichage numérique 
supplémentaire. Les caractéristiques particulières de chaque 
type de fader sont décrites ci-dessous.

Vertical / Mute

Ce sont des faders semblables au type 4, avec un bouton de 
«mute» en plus. Lorsque vous activez ce bouton «mute», le 
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fader envoie un événement (conformément à sa définition de 
sortie) avec l’octet de donnée à 0. Tant que le bouton «mute» 
est en position enfoncé, les mouvements de fader ne sont pas 
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envoyés. Lorsque vous relâcher le bouton «mute», la valeur 
courante du fader est envoyée.

Numerical
Ce type de fader affiche le second octet des données en cours, 
sous forme numérique.

Buttons
Ces faders fonctionnent selon le mode d’un simple interrup-
teur. Le bouton relâché (bouton de type 3) ou grisé (bouton de 
type 1) signifie qu’un message a été envoyé conformément à la 
définition de sortie, avec l’octet de donnée à la valeur «left 
range value» (minimum). Quand il est pressé (le bouton 1 sera 
alors blanc ou coloré), un événement est envoyé avec l’octet de 
donnée à la valeur «right range value» (maximum). Si vous 
paramètrez ces deux valeurs (minimale et maximale) de 
manière identique, le bouton fonctionne en mode interrupteur, 
et sera toujours en position relâché. Lorsque vous cliquez sur 
un tel bouton, il s’enfonce brièvement, et envoie l’événement 
défini, avec la valeur d’octet que vous avez paramètrée.

Texte
Les faders Text fonctionnent comme les faders Numerical, mais 
ils peuvent affîcher du texte pour toutes les 128 valeurs des 
données.
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Double-cliquez la surface d’un fader Texte pour ouvrir la fenê-
tre des faders Texte.

En double cliquant l’une des valeurs affichées dans cette fenê-
tre, vous pouvez entrer le texte associé, via la boîte d’entrée de 
texte habituelle. Par défaut, le numéro de la valeur est pré-pro-
grammé au format texte dans la position correspondante.

Fonctions du Presse-papiers

La flèche de vue par liste, dans l’angle supérieur droit, vous 
permet d’accéder aux fonctions cut, copy et paste du presse 
papiers, pour l’ensemble du texte. Vous pouvez aussi éditer des 
portions de texte via un traitement de texte externe. Les 128 
premières lignes contenant du texte sont au début, et tous les 
espaces sont ignorés. Si vous voulez obtenir des lignes vides, 
insérer au moins un espace.

Behave as menu

Si la case Behave as menu est cochée, lorsque vous survolez le 
texte du fader, un menu local contenant tous les blocs texte se 
déroule. Lorsque vous sélectionnez un bloc particulier, un évé-
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nement est envoyé (conformément à la définition de sortie) 
avec une valeur de variable correspondante. Si cette case n’est 
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pas cochée, vous pouvez intervenir sur le texte en exploitant le 
pointeur comme un curseur local. 

Les faders Texte dont la plage Range est paramètrée sur les 
valeurs 0-1, affichent la valeur de nom 1 pour toutes les valeurs, 
sauf zéro

Si vous n’avez pas besoin de l’ensemble des 128 entrées pour 
un fader texte particulier, vous pouvez réduire la plage des 
valeurs à celles dont vous avez réellement besoin, en utilisant le 
réglage Range dans la boîte des paramètres. Ceci peut vous per-
mettre d’économiser beaucoup de mémoire système.

Si vous voulez utiliser un fader texte pour visualiser la position 
d’un commutateur (lequel ne peut exploiter que les valeurs 0 
ou 127), sélectionnez 0-1 dans le champ Range, et tapez le texte 
voulu dans les positions 0 et 1, de sorte que toutes les valeurs 
supérieures à 1 laisseront apparaître le texte défini pour la 
valeur 1 (et supérieures.

Fonctions du Fader 

Événements Midi (Midi Events)
les trois paramètres Out, Channel, et -1- déterminent les événe-
ments Midi qui seront envoyés (définition de sortie), alors que 
les trois paramètres In, Channel, and -1-déterminent les événe-
ments Midi qui peuvent être utilisés pour piloter le fader (défi-
nition d’entrée). On peut considérer, dés lors, qu’un fader 
convertit les définitions d’entrée de certains événements dans 
les définitions de sortie appropriées, pour en faire des événe-
ments de sortie.

Les paramètres Out (ou In) définissent le type d’événement via 
le menu local présenté ci-contre:

Channel (1-16): vous permet de définir le canal Midi..
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Remarques

Vous pouvez utilisez le paramètre -1- pour définir la hauteur de 
son, exprimée en terme de dénomination de note. La position 
du fader exprime la vélocité des notes envoyées. Ce message 
sera suivi d’un message note off (comme une note de vélocité 
0).

P-Pressure

Pour un message de type pression polyphonique, vous pouvez 
employer le paramètre -1- pour définir la hauteur, en terme de 
dénomination de note. La position du fader détermine la force 
virtuelle de pression de la dite note.

Control Change

Pour un événement de type contrôleur, vous pouvez sélection-
ner le paramètre -1- via le menu local qui déroule la liste de tous 
les contrôleurs, désignés par leurs noms et leurs numéros au 
format de la norme Midi. La disposition du fader détermine 
alors la valeur du contrôleur..

Program Change

Pour les messages de type program change, le paramètre -1- défi-
nit un numéro de banque selon le standard contrôleur 0/32 . 
Avec une valeur de 0, aucune commande de sélection de 
banque (bank select) n’est envoyée. La disposition du fader 
détermine le numéro du programme.

C-Pressure

Avec un message de pression monophonique, le paramètre -1- 
n’a aucun effet. La disposition en cours du fader est émise en 
tant que premier octet de donnée(ces messages de pression sur 
un canal ne disposent que d’un seul octet de donnée: le code 
qui définit la pression du canal).
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Pitch Bend

Pour un événement de type pitch bend, vous pouvez utiliser le 
paramètre -1- pour définir l’octet de poids le plus faible, le LSB 
(pour Least Significant Byte – c’est à dire l’octet de données 
ayant l’effet le plus faible sur la hauteur de note). La disposition 
du fader définit le MSB (pour Most Significant Byte – c’est à 
dire l’octet de données ayant l’effet le plus fort sur la hauteur de 
note). Lorsque le fader est réglé sur la position intermédiaire 
(valeur 64) il n’y a pas de modification du pitch (pour autant 
que le paramètre -1-soit réglé sur 0).

Plage de valeur (Range)
Cette fonction est déterminée par deux paramètres avec 
lesquels vous définissez la plage de valeur selon laquelle le 
curseur va évoluer, de sa position la plus basse à sa position la 
plus haute. C’est la plage utile du fader. Pour les boutons, la 
plage de valeur définit la valeur envoyé lorsque le bouton est 
pressé ou relâché. Si les deux valeurs sont identiques, le bouton 
se comporte comme un raccourci, provoquant une action ponc-
tuelle lorsqu’il est activé.

Val as
Ce paramètre détermine le format d’affichage de la valeur du 
fader.

Num: La valeur du fader est directement 
affichée sous forme d’un nombre (de 
0 à 127).

Pan: La valeur de fader 64 est affichée ‹0›; 
les valeurs inférieures sont représen-
tées par des nombres négatifs et les 
valeurs supérieurs par de nombres 
positifs (de -64 à 63).
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Hz, Oct, dB, ms: Ces formats d’affichage sont 
destinés au pilotage des fonctions 
DSP par des faders d’Environne-
ment.

Si aucun de ces formats n’est satisfaisant pour l’usage d’un 
fader particulier, vous pouvez créer un fader Texte et le placer 
à la suite du fader problématique, sur le chemin d’accès des 
signaux. Ainsi, le paramètrage des définitions d’entrée du fader 
Texte vous permet de gérer, de façon appropriée, les événe-
ments en provenance du fader situé en amont. De la sorte, vous 
pouvez, sous forme de texte, totalement reconfigurer un affi-
chage (voir page 5 - 50).

Filter
Ce paramètre vous permet de filtrer toutes les données prove-
nant du fader relativement à la définition de sortie:

off: tous les événements Midi entrant 
sont transmis par le fader. Tous les 
événements qui correspondent à la 
définition d’entrée sont modifiés 
conformément à la définition de 
sortie.

Other: tous les événements Midi qui ne 
correspondent pas à la définition 
d’entrée sont filtrés (ne sont pas 
transmis). Tous les événements qui 
correspondent à la définition 
d’entrée sont modifiés conformé-
ment à la définition de sortie, puis 
transmis.

Match: tous les événements Midi qui corres-
pondent à la définition d’entrée sont 
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filtrés, tous les autres sont transmis.

All: tous les événements Midi entrant 
sont filtrés par le fader.
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Thru: tous les événements Midi entrant 
sont transmis par le fader, sauf les 
données provenant directement de 
l’entrée physique, qui sont filtrées.

5.4 Le Wave Player
Le Wave Player est un objet de la couche Click & Ports de votre 
environnement. Il existe toujours un seul objet Wave Player. 
Vous ne pouvez pas créer plusieurs objets Wave Player.

Le Wave Player vous permet de déclencher des fichiers son au 
format WAV –  c’est à dire les fichiers dotés de l’extension *.wav 
– en utilisant des événements de note Midi, dans la fenêtre 
Arrange.

Pour employer le Wave player dans les règles, vous avez besoin 
d’une carte son Multimedia compatible  Windows.

Avant d’utiliser le Wave Player, vérifiez que la carte son et son 
pilote ont correctement été installées, et fonctionnent sans 
aucun problème

YVous pouvez jouer tous les sons standard WAV supportés par 
votre carte son. Il faut les enregistrer sur le disque dur de votre 
ordinateur ou sur un CD-ROM. 

A propos des CR-ROMs: d’après nos tests, vous pouvez jouer 
des sons directement depuis un CD-ROM, si vous disposez 
d’au moins un lecteur double vitesse. Toute fois, il n’est pas 
possible de jouer des sons à partir d’un CD audio.

Les Fonctions
Le Wave Player vous permet d’assigner 128 fichiers son aux 
notes Midi. Vous pouvez alors jouez la totalité du fichier son, ou 
bien seulement une partie du fichier. Vous effectuez les assi-
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gnées peuvent être employées pour appeler les fichiers son via 
le séquenceur ou une console Midi.

Le Wave Player dispose des fonctions suivantes:

• Supporte les fichiers WAV, mono et stéréo, quelle qu’en soit 
la longueur.

• Supporte les fichiers 8 et 16 bits et toutes les fréquences 
d’échantillonnage standard. Schématiquement, le nombre 
de bits et la fréquence d’échantillonnage détermine la 
qualité d’un fichier son. Un fichier de 16 bits avec une 
fréquence d’échantillonnage de 44,1 Khz constitue généra-
lement la qualité de référence pour les CD.

• Les fichiers Wave peuvent être appelés en temps réel, même 
à partir des claviers Midi.

• Le Wave Player est doté d’un vélocité sensitive; c’est à dire 
que le volume est déterminé par la manière plus ou moins 
vive dont vous frappez la touche, ou bien par la hauteur de 
vélocité de la note Midi utilisé pour déclencher le fichier.

• Vous pouvez réaliser un décalage de hauteur des fichiers 
Wave. Cela modifie également la vitesse et la durée comme 
si vous utilisiez la fonction vari speed d’un magnétophone à 
bande. 

• Vous pouvez choisir de ne jouer qu’une partie d’un fichier 
son. Vous pouvez également assigner différentes parties 
d’un fichier son à différentes notes Midi.

• Vous ne pouvez jouer qu’un fichier son à la fois. Si deux 
fichiers son se chevauchent dans l’Arrange, le second inter-
rompt le premier. Toute fois, vous pouvez assigner à chacune 
des 128 notes Midi un son différent.

• Le Wave Player est piloté par les contrôleurs Midi pour ce qui 
est du volume et du panoramique. Vous pouvez contrôler le 
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volume et la position du son dans l’image stéréo au moyen 
des événements de Contrôleur.
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La fenêtre Wave Player 

Vous ouvrez la fenêtre du Wave Player grâce à un double clic sur 
l’objet Wave Player dans la couche Click & Ports de l’Environne-
ment.

La fenêtre Wave Player dispose de deux articles de menu local: 
‹Initialize› et ‹View›. Ils répondent aux fonctions suivantes:

Initialize

Default Parameters paramètre tous les réglages, de tous 
les fichiers son, selon leurs valeurs 
par défaut.

Delete all assignments supprime tous les fichiers son de la 
fenêtre Wave Player. Pas de panique! 
Cette manœuvre ne supprime pas 
les fichiers son de votre disque dur.

View

Avec cette option vous pouvez déterminer quels sont les para-
mètres affichés dans la fenêtre Wave Player. Vous pouvez 
masquer ou montrer indépendamment les uns des autres la 
forme d’onde, les paramètres éditables, les information sur le 
fichier son et le clavier.

Comme avec les autres fenêtres, vous pouvez utiliser les icônes 
«longue vue» (zoom) pour ajuster le facteur de grossissement 
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Les Paramètres du Wave Player 
Pour vous aider à mieux comprendre l’emploi des paramètres 
et de l’information, dans la fenêtre Wave Player, nous vous invi-
tons à charger maintenant un fichier son. Si vous ne disposer 
pour l’instant d’aucun fichier son dans votre ordinateur, vous 
pouvez chargez l’un des sons Système livrés avec Windows.

Charger un son

• Cliquez avec le bouton gauche de la souris sur le champ vide, 
ou sur un article existant dans la partie droite du nom de 
fichier.

• Une boîte de sélection apparaît, dans laquelle vous pouvez 
choisir un fichier son. Tous les fichiers dotés de l’extension 
.wav seront automatiquement affichés.

• Après que vous ayez choisi un fichier, son nom s’affiche dans 
le champs. Les autres paramètres sont présentés du côté 
droit de la fenêtre.

• Maintenant, si vous cliquez la touche correspondante sur le 
clavier, vous pourrez jouer le fichier son.

Si vous avez sélectionné l’affichage de tous les paramètres dans 
le menu ‹View›, vous devriez être en mesure de voir les champs 
suivants, de gauche à droite:

Tune:

Dans ce champ vous pouvez modifier la hauteur du son pour 
une écoute. Les unités sont en centièmes; l’échelle musicale 
divise chaque demi-tons en 100 centièmes. De la sorte, une 
diminution d’une seconde correspond à 100 centièmes, à la 
tierce à 400 centièmes, à la quinte à 700 centièmes et à l’octave 
à 1200 centièmes. La finesse de cette division vous permet 
d’obtenir un fichier sonore rigoureusement juste dans votre 
arrangement:
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Lorsque vous modifiez la tonalité, vous modifiez également la 
durée d’exécution du fichier sonore: si vous augmentez la tona-
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lité le fichier sera joué plus rapidement, si vous la diminuez il 
sera joué plus lentement.

La transposition est obtenue en modifiant la fréquence 
d’échantillonnage pour l’écoute.

Selon les performances de votre carte son (particulièrement 
pour les fichiers sons d’une fréquence de 44,1 Khz) les transpo-
sitions vers le haut peuvent être limitées, car certaines cartes ne 
peuvent pas jouer des sons d’une fréquence supérieure à 44,1 
kKhz. De plus toutes les cartes ne supportent pas toutes les 
fréquences d’échantillonnage. De sorte que vous ne pourrez 
peut-être pas obtenir la transposition désirée. Dans ce cas, ce 
sont les fréquences d’échantillonnages les plus proches qui 
sont jouées à la place de celles que l’on ne peut pas obtenir.

Start

Le Wave Player peut aussi vous permettre de sélectionner une 
partie du fichier son. Le champ Start constitue l’endroit où vous 
définissez le point de départ de votre portion de fichier. Avec 
une valeur de 0 le fichier son est joué depuis le début. Les 
nombres indiquent les points de départ dans les samples. Vous 
pouvez en modifier la valeur par «presser-glisser», ou bien par 
un double clic dans le champs, pour saisir une nouvelle valeur 
au clavier. Vous pouvez encore définir la section voulue graphi-
quement (voir ci-dessous).

Length

Ce paramètre détermine la longueur du fichier sonore, ou de la 
partie sélectionnée. Dans ce champ vous définissez le point 
final de la portion de fichier sélectionnée, et par conséquent sa 
longueur.

Trigger

Vous pouvez choisir entre deux réglages: Freerun et Gated. Free-
run signifie que la totalité du fichier, ou de la sélection, est 
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lecture d’un fichier sonore, depuis votre clavier Midi, la lecture 
est interrompue dés que vous relâchez la touche.

Format, Sample Rate, Size

Ces trois valeurs vous informents sur le fichier chargé. Format 
vous indique la définition en bits, et si le fichier est en mode 
mono ou stéréo. Sample Rate vous indique la fréquence 
d’échantillonnage du fichier, et Size sa taille. Ces valeurs sont 
déterminées par les caractéristiques du fichier et ne sont pas 
éditables.

Affichage de la forme d’onde

Ici vous pouvez voir la forme d’onde du fichier. Vous pouvez 
recourir à cet affichage, pour définir graphiquement la sélection 
d’une partie du fichier. Vous l’obtenez par simple clics sur la 
forme d’onde. Vous disposez de trois méthodes pour modifier la 
sélection:

• Si vous cliquez sur le côté gauche de la forme d’onde, le 
pointeur se transforme en une petite main pointant sur la 
droite. Celle-ci déplace le côté gauche de l’aire de sélection, 
et de la sorte change la position du point de départ.

• D’un double clic au centre, vous pouvez déplacer l’aire de 
sélection sur la gauche ou sur la droite, sans en modifier la 
longueur. Cette méthode est pratique si vous avez défini une 
section d’une mesure, à partir d’une boucle de batterie plus 
longue, et que vous souhaitiez exploiter à la place une autre 
portion de même longueur.
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• Si vous cliquez sur le côté droit de la forme d’onde, le poin-
teur se transforme en une petite main pointant sur la gauche. 
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Vous pouvez alors ajuster le côté droit de l’aire de sélection, 
c’est à dire la position du point final.

Détruire les fichiers WAV 
Vous pouvez supprimer les fichiers son à partir de la fenêtre 
Wave Player. Cliquez le nom du fichier en utilisant le bouton 
droit de la souris. Une zone de dialogue est affichée, dans 
laquelle vous pouvez confirmer votre opération, ou l’abandon-
ner. Cette fonction ne détruit pas les fichiers sur le disque dur, 
seuls les références du fichier sous Logic sont supprimées.

Employer le Wave Player dans l’Arrange

Les sons présents dans le Wave Player sont adressés dans la 
fenêtre Arrange via la piste assignée à WAVE. Si vous choisissez 
cette piste dans la fenêtre Arrange vous serrez à même de jouer 
sur votre clavier Midi, et d’entendre, tous les sons que vous 
avez défini dans le Wave Player. N’oubliez pas que vous ne 
pouvez pas jouer plus d’un son à la fois.

Hormis ces limitations, vous pouvez enregistrer les données 
Midi des séquences de la piste Wave, et les éditer, comme avec 
n’importe quelle autre piste. Vous pouvez également exploiter 
les paramètres d’une séquence d’écoute, comme la quantifica-
tion, boucle et transposition.
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Le Wave Player et les Éditeurs

Vous pouvez aussi utiliser n’importe quel Éditeur pour éditer 
les données Midi pour le Wave Player. Si vous cliquez sur une 
note Midi, dans l’un des éditeurs correspondant, le fichier son 
sera joué, dans la mesure où le bouton Midi Out est activé.

IDans l’Event list vous pouvez aussi définir le volume des 
fichiers son, en éditant la vélocité des événements note (VAL 
column). Et vous pouvez entrer des valeurs de contrôle pour le 
Volume (Contrôleur #7) et le Pan (Contrôleur #10).

Important

Quelque soit le travail d’édition opéré à partir d’un fichier, que 
ce soit dans la fenêtre Wave Player, dans la fenêtre Arrange, ou 
dans n’importe lequel des éditeurs, le fichier sonore original 
n’est pas modifié.

Tous les réglages du Wave Player sont sauvés dans la Song. Assu-
rez vous, lorsque vous enregistrez une Song que tous les fichiers 
sons peuvent encore être localisés, vous devez éviter de les 
déplacer, ou de les supprimer. Nous vous conseillons de créer 
un dossier dans lequel conserver vos fichiers WAV.

5.5 Échange d’Environnement
Si vous avez créé un Song utilisant une configuration Midi A, et 
si vous voulez la jouer sur une configuration Midi B, vous 
devrez apporter quelques modifications dans l’Environnement. 
Logic propose un certain nombre de fonctions pour rendre ces 
interventions aussi aisées que possible. Même lorsque vous 
voulez jouer des Songs créées avant que vous ne disposiez de la 
nouvelle version de Logic, alors que vous n’utilisiez pas un 
Environnement très riche et que vous n’aviez configurés que 
très peu de périphériques, même dans ce cas, Logic peu vous 
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Mixers et Objets 
Audio

6.1 Concept
Chaque objet audio représente une piste de votre système 
Maxi Studio ISIS. Il peut également être utilisé pour contrôler 
les signaux d’entrée.

Afin de communiquer méthodiquement avec Maxi Studio 
ISIS, Logic créé automatiquement des objets audio dans 
l’Environnement. Ceux-ci apparaissent dans une ECouche de 
l’environnement appelée Audio. Cette couche, le mixer Audio, 
est décrite dans un chapitre spécifique.

Quand Logic créé un nouveau song, il contient le plus grand 
nombre d’objets audio que puissent lui allouer les réglages de 
votre système d’enregistrement HDR. 

Un rapide mémo:

Vous ouvrez une fenêtre d’Environnement en sélectionnant 
Window > Open Environment. Vous pouvez également ouvrir 
une fenêtre d’Environnement en double-cliquant sur le nom 
d’une piste, dans la fenêtre Arrange. Vous pouvez changer de 
couche (layer) en utilisant le menu déroulant dans la boîte des 
couches — layers box — (à gauche, sous la boîte à outils), en 
créant une nouvelle couche à l’aide de l’entrée **Create!** 
dans le même menu.

Pour ouvrir l’Adaptive mixer de Logic, lorsque les pistes Midi et 
audio sont invisibles, déroulez le menu principal et choisissez 
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File > Open adaptive Mixer.
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6.2 Objets Audio

Création d’Objets Audio
Activez New > Audio Object et double cliquez sur l’objet audio 
qui apparaît. Vous définissez alors quelle piste de votre système 
HDR est contrôlée par cet objet, et le paramètre de canal (Cha) 
de la boîte des paramètres. Si vous utilisez plus d’un système 
HDR, vous devez sélectionner quel système l’objet contrôlera 
avec le paramètre périphérique (Dev) de la boîte des paramè-
tres.

Éffacer des Objets Audio
Pour effacer des objets il suffit de les sélectionner (d’un clic sur 
leur bord supérieur, ou sur leur nom) et de presser la touche 
B. Effacer un objet remet le niveau de la piste qu’il contrôle à 
zéro. S’il existe un double de l’objet effacé, l’objet est restitué 
et son niveau ne sera pas remis à zéro.

La boîte de paramètres des objets (Object 
Parameter Box)
Si la colonne de paramètres est affichée (sélectionnez View > 
Parameters si ce n’est pas le cas), une boîte apparaît dans la 
colonne. Elle présente les paramètres portant sur les objets 
sélectionnés. Par un clic sur le triangle qui figure à côté du titre, 
en haut de la boîte, vous pouvez masquer ou afficher son 
contenu.

Le titre, sur la ligne supérieure de la boîte, peut être modifié 
par un double-clic. La boîte de contrôle, à gauche près de 
l’icône, vous indiquera si l’objet audio apparaît dans le menu de 
sélection des instruments de la fenêtre Arrange. Vous pouvez 
même modifier l’icône elle-même, avec un menu déroulant, si 
6 - 2
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vous le souhaitez, quoique l’icône par défaut soit l’icône 
communément utilisée.
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Cha
Le paramètre Channel définit le type et le canal d’un signal 
contrôlé par un objet audio.

Vous utilisez ce paramètre pour définir quelle piste du système 
HDR sera contrôlée par un objet audio. Ou vous pouvez définir 
l’objet audio qui contrôlera les entrées/sorties de votre matériel 
d’enregistrement, ou bien même, selon le matériel employé, 
ses auxiliaires d’envois, ou ses sous-groupes de faders.

First, you choose the type (what the audio object will control; a 
track, an input, an output etc.) then a number (Track 1, Output 
4, etc.). You make all these selections from a flip menu:

Track

Sélectionnez le numéro de piste audio. Le nombre total de 
pistes valides dépend du nombre de piste supportées par votre 
système HDR. Track est le paramètre typique d’un objet 
audio, il définit un objet qui vous permet d’obtenir un enregis-
trement, et avec lequel on peut jouer des pistes déjà enregis-
trées.

Input

Ce paramètre vous permet de contrôler les signaux adressés aux 
entrées de votre hardware. Ceci peut également être obtenu via 
les objets pistes (Track objects, si l’option piste armée est activée. 
C’est pourquoi les objets Input sont communément employés 
pour mixer les signaux externes (par exemple: les signaux en 
retour) via le système d’entrée au moment du mixdown.

Prenez soin de noter que les objets Input ne sont pas toujours 
valides — tout dépend du matériel que vous avez connecté à 
votre système.

Output
6 - 3
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Si vous sélectionnez cette option, l’objet audio contrôlera l’une 
dessorties de votre système HDR. Vous pouvez alors régler le 
niveau de sortie à partir de cet objet, et il se comportera comme 
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un «master» fader (fader général) pour tout signal passant par 
l’entrée (ou les entrées) matérielle(s) sous son contrôle.

Bus

Ce réglage définit l’objet audio comme un bus de données. 
Vous pouvez alors envoyer des portions de signaux à partir de 
plusieurs pistes (objets Track), via leurs contrôles d’achemine-
ment, sur ce bus objet; puis traiter ce submix (sous-mixage) avec 
un effet en temps réel assigné à l’insert dans le bus objet.

Le bus objet peut faire office de master send (send général) pour 
une unité externe d’effets sonore. Sélectionnez une sortie indi-
viduelle pour le bus objet, puis connectez la à l’entrée de 
l’unité d’effets externe.

Il est tout à fait possible de définir plusieurs objets qui se 
rapportent au même canal. Si vous disposez d’un configuration 
qui rassemble beaucoup de pistes mais ne comprend qu’un 
écran de petite taille, vous pouvez éprouver des difficultés pour 
réussir à embrasser les pistes d’un seul coup d’œil. Pour obtenir 
l’affichage de toute les pistes en un seul écran, vous pouvez 
créer une nouvelle couche avec une vue des pistes 1 à 16. Vous 
pouvez, par exemple, créer une couche qui ne représente que 
les canaux 3, 5 et 14, l’entrée 5 et les sorties 1 et 2.

Quand vous sélectionnez différents types d’objet, observez les 
attributs de textes employés:

Outline: Cet attribut indique que l’objet n’est 
pas valide. Cela arrive quand la Song 
a été produite par un système dispo-
sant de plus de pistes que le vôtre 
(par exemple la piste 9 sur un 
système 8 pistes).

Normal: Les caractères standards sont utilisés 
pour les objets qui n’ont pas encore 
6 - 4
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été définis dans l’Environnement, et 
qui n’ont pas été utilisés.
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Bold: Objets qui sont déjà définis dans 
l’Environnement, et qui ont été 
utilisés.

Midi Cha
Le paramètre Midi Cha permet de déterminer à quel canal Midi 
correspond l’objet audio. Vous pouvez dés lors contrôler l’objet 
audio séparément, au moyen du contrôleur d’information Midi.

Cette option permet également d’exploiter d’autres façons de 
faire. Une fois défini un canal Midi, vous pouvez contrôler 
l’information sur ce canal avec les curseurs et les potentiomè-
tres de l’objet audio lui-même.

Lorsque le paramètre Channel est réglé, le canal Midi est auto-
matiquement réglé sur le même numéro, ce qui permet 
d’exécuter des modifications avec plus de facilité.

Pour plus d’informations sur le contrôle Midi à distance, repor-
tez-vous au paragraphe «Automation» à la page 6 - 17.

Val as
Le paramètre Value as définit, pour l’objet audio sélectionné, le 
format d’affichage du fader. Utilisez ce paramètre si l’échelle 
est donnée en tant que valeur numérique

Num valeur numérique de 0 à 127, ou

dB valeur en décibel.

La valeur numérique 90 équivaut à 0 dB.

Neutraliser les valeurs de Faders
ç et cliquer sur un fader de volume définit le réglage à 90 
(0dB)
6 - 5
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ç et cliquer sur le pan pot (potentiomètre de panoramique) 
définit le réglage sur la position médiane
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ç et cliquer sur le send pot (potentiomètre d’envois) définit le 
réglage à 90 (0dB).

Vumètres et Contrôles

Level Meter
Certains objets audio disposent d’un vumètre afin d’afficher le 
niveau de lecture ou de monitoring. 

Lorsque vous armez pendant la préparation d’un enregistre-
ment, le vumètre indiquera le niveau d’entrée.

Le niveau de lecture est également affiché dans la 
fenêtre Arrange, à gauche du numéro de piste, si 

vous sélectionnez View > Track Numbers/Level Meters.

Mémoire de crête (Peak Hold)

Comme pour les vumètres d’une table de mixage conven-
tionnelle, les pics de valeur sont tenus à l’affichage 
pendant quelques secondes, et peuvent ainsi être lus plus 
facilement. Même si la puissance de votre processeur 
CPU est insuffisante pour lisser l’affichage, celui-ci rendra 
sûrement compte du dernier niveau maximum atteint.

détecteur de saturation

Si le signal sature, et génére des clips, le détecteur de clip 
(matérialisé par la représentation de LED rouges dans la 
partie supérieure des vumètres) s’allumera et restera 
éclairé. Vous pouvez réinitialiser le détecteur en cliquant 
n’importe où dans l’indicateur.

Ajuster le niveau
Le fader règle le niveau de lecture de l’objet de piste . 
6 - 6
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Le niveau d’enregistrement n’est pas déterminé dans 
Logic, mais à la source du signal. Vous ne pouvez pas 
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ajuster le niveau sur l’entrée digitale. Le fader de Logic montré 
ici est utilisé pour contrôler le moniteur.

Le niveau de lecture de l’objet audio et de l’auxiliaires d’envoi 
peut être représenté en décibels (dB), ou bien en valeurs de 
contrôleur Midi. Pour modifier l’échelle, sélectionnez l’objet 
approprié, puis modifier la valeur du paramètre ‹Val as› Un 
volume Midi de 90 équivaut à 0 dB.

L’augmentation maximale de la valeur est de +6 dB. Vous 
pouvez réinitialiser le volume du fader à 0dB (90) en cliquant 
tout en maintenant enfoncée la touche ç.

Pendant l’enregistrement

Un niveau de monitoring indépendant est valide si une piste 
objet est en mode d’enregistrement. Quand l’objet n’est pas 
encore amorcé, le niveau d’origine est restauré.

Contrôle Mute
Vous pouvez «muter» (couper via le mute) le son de chaque 
objet audio en pressant le bouton marqué «M». En pressant à 
nouveau le bouton vous restaurez le niveau précédemment 
annulé.

Contrôle de panoramique/Balance
Certains objets mono présentent un contrôle panoramique qui 
détermine la position d’un signal dans l’image stéréo.

Par ailleurs, certains objets stéréo sont dotés d’un contrôle de 
balance. La balance diffère du contrôle de panoramique, par le 
fait qu’elle régule l’équilibre entre les niveaux de deux signaux 
(L/R) à leurs sorties. Celui-ci ne régule qu’un seul signal 
source, réparti proportionnellement sur deux sorties.

En maintenant enfoncée la touche ç tout en cliquant, vous 
6 - 7
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réinitialiser le contrôle de panoramique en positionnant son 
repère au centre (64).
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Equaliseur (EQ)
BP l’interrupteur Bypass, en haut à 

droite, désactive bande EQ.

Typ à côté de l’interrupteur BP, vous 
pouvez utilisez un menu déroulant 
pour sélectionner le type d’EQ, 
(Thru, Low/High Shelf, Parametric, 
Low/Highpass Filter)

Hz régule (20 Hz — 32,4 kHz) ou coupe 
la fréquence

dB coupe ou augmente (-12 — +11,8 
dB) — (n/a pour un filtre)

Oct Largeur de bande (0,1 — 3,0 
octaves) — (n/a pour un filtre ou un 
shelf)

Les réglages EQ peuvent être conservés et joués en Midi.

Le «pointer-presser» du  bouton Thru vous permet de choisir 
un nouvel équaliseur paramètrique, ou un filtre. Les paramè-
tres du nouvel EQ sont alors affichés. Vous pouvez ainsi ajoutez 
3 EQs.

Les EQs peuvent également être ajoutés sous forme d’inser-
tion d’effets, si vous ne voulez pas créer un objet audio trop 
long, ou bien si vous souhaitez disposer de plus de 4 EQs ou 
filtres par piste.

Les Sends (Sendsauxiliaire) 
Les Sends (objet d’envoi) vous permettent d’adresser une partie 
de n’importe quel signal, depuis l’objet audio du signal vers un 
bus interne, ou une sortie auxiliaire.

Cliquez sur un slot de Send vide et sélectionnez une des quatre 
6 - 8
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destinations proposées dans le menu déroulant affiché. Lors-
que la destination est définie, vous pouvez paramétrer la tota-
lité du signal délivré, au moyen du bouton de contrôle Send 
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Amount. Lorsque vous avez ajusté le niveau, sa valeur apparaît 
dans la boîte du menu, située à gauche du potentiomètre. Vous 
pouvez assigner jusqu’à 4 envoi par piste.

Effacer un Send

Ouvrir à nouveau le menu déroulant du slot d’envoi, puis sélec-
tionnez No Send.

Normaliser le niveau de Send

Vous pouvez réinitialiser les Sends à 0dB (90) avec la combinai-
son ç-clic sur la molette.

«Couper» les Sends

Vous pouvez basculer les Sends en mode bypass avec la combi-
naison ç-clic sur le nom.

Si un Send est activé , son nom sera affiché en vert. Si un Send 
est désactivé, son nom est affiché en bleu (mode bypass)..

Sends automatiques

Les Sends peuvent également être automatisés. Le premier 
Send correspond au contrôleur #28, le second au contrôleur 
#29, etc. Reportez-vous au paragraphe «Contrôleurs pour les 
Effets Insérés» à la page 6 - 21.

Inserts
Si vous disposez de suffisamment de puissance de traitement, 
vous pouvez avoir jusqu’à 8 inserts par objet audio.

& Dés que tous les inserts habituellement affichés sont utilisés, un nouvel Insert vierge 
est créé.

Le menu déroulant Insert affiche tout Plug-in valide de Logic, 
ainsi que tout Plug-in proprement installé de DirectX.
6 - 9
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Mono/Stereo Input/Output

Vous pouvez également adresser des effets 
disposant d’une entrée mono et d’une sortie 
stéréo (m/s) à des objets mono, de la même 
façon que vous le feriez avec les effets mono 
habituels (m/m). Si vous ajoutez l’un de ces 
effets (m/s), en principe vous intercalerez ces 
effets uniquement avec l’entrée stéréo (s/s), 
devant ce point d’insertion.

&N’oubliez pas qu’en général, les effets stéréo requièrent 
deux fois plus de puissance de traitement que les effets mono.

Dans les objets stéréo, en principe, seuls les 
effets avec une entrée et une sortie stéréo (s/
s) peuvent être insérés. (voir l’illustration).

Cependant, Logic peut insérer automatique-
ment des modules de conversion en arrière-
plan, capables d’assurer les transitions 
Stereo->Mono et Mono->Stereo. Ceci vous 

permet d’employer n’importe quel Plug-in dans n’importe quel 
ordre. Mais souvenez-vous que:

• Ces conversions demandent une puissance de calculs 
supplémentaire.

• Pendant un conversion Stereo->Mono, toute information 
spatiale est perdue.

• Pendant un conversion Mono->Stereo, aucune information 
spatiale n’est ajoutée — le même signal Mono est adressé 
aux deux sorties à la fois.

Tout Plug-in susceptible de nécessiter une conversion de ce 
type est signalé par une puce située devant la description des I/
O, comme ceci: •(m/s). Pour optimiser les performances de trai-
tement, nous recommandons d’éviter l’emplois de ces Plug-in 
«marqués».
6 - 10
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«Couper» les Inserts

Les Inserts peuvent être commutés en mode bypass par la 
combinaison Oç -clic sur leur nom.

Le nom d’un Plug-In actif s’éclaire en vert. Ceux des Plug-in 
en mode bypass sont bleus.

«Armement» de piste
Le contrôle Rec (voir à droite) arme une piste, de manière à ce 
qu’elle soit préparée à recevoir un enregistrement. Une fois la 
piste armée, le contrôle allume un voyant rouge. Il reste rouge 
durant toute la durée de l’enregistrement.

Si le voyant du contrôle s’affiche avec une couleur rouge estom-
pée, cela signifie qu’aucune piste audio n’a été sélectionnée 
dans la fenêtre Arrange. Aucun enregistrement ne peut être 
effectué.

Le contrôle Rec n’existent que pour les objets de piste.

Vous pouvez sélectionner à partir de quelle entrée valide la 
piste objet sera enregistrée, au moyen du sélecteur situé dans la 
partie I/O de l’objet piste.

Un clic prolongé sur le sélecteur développe un menu déroulant, 
dans lequel sont inscrites toutes les entrées valides de votre 
hardware. Si l’enregistrement est stéréo les entrées sont affi-
chées par paires (Input 1-2, Input 3-4, etc.). Pour les pistes 
mono, elles sont présentées individuellement.

Solo
Tous les objets audio disposent d’un bouton solo. Celui-ci 
coupe le son, via la fonction mute de tous les autres objets audio. 
Les objets coupés (mutés) sont repérés par un «M» lumineux 
affiché sur le bouton mute. Notez que cette fonction n’a aucun 
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effet sur les pistes Midi.

Vous pouvez appliquer la fonction solo sur plusieurs objets à la 
fois.
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ç-clic désactive les autres boutons solo, ainsi vous pouvez 
écouter un seul canal (‹Interlocking Solo› ou ‹Solo Toggle›).

ç-clic sur n’importe quel bouton solo actif modifie l’état du 
paramètre solo de tous les objets audio.

Solo Safe

Lorsque vous attribuez à un canal l’état Solo, les canaux de 
retour d’effet ne devrait pas être mutés si vous désirez écouter 
le signal en même temps que ses effets. Contrairement aux 
tables de mixage conventionnelles Logic peut «balayer» la 
totalité du flux d’un signal et conserver les canaux de retour 
d’effet ouverts.

Il en va de même lorsque vous attribuez un état solo à un signal 
de retour d’effet Les canaux qui routent l’effet sont coupés 
mais leurs envoi d’effet (effect sends) restent ouverts; le signal 
continue d’alimenter l’effet.

Bien sûr la suppression automatique de mute est appliquée 
uniquement aux retours d’effet internes. Si vous utilisez des 
unités d’effets externes via des objet bus, le «balayage» gardera 
ouvert l’envois général d’effet effect master send. Cependant, 
Logic ne peut pas identifier quel objet d’entrée vous utilisez 
pour les unités d’effet externes. Vous devez caler manuelle-
ment ces objets d’entrée sur ‹solo safe›— exactement de la 
même manière qu’avec une table de mixage conventionnelle.

Cliquer sur un bouton solo inactivé tout en maintenant la 
touche A le définit comme un objet audio ‹solo safe›. «. Cet 
etat prend fin lorsque vous activé solo pour une autre canal. 
L’état ‹Solo safe› est indiqué par une croix sur le bouton solo.

Effectuer une seconde fois cette manipulation supprime l’état 
solo.
6 - 12
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«Couper» le contrôle à distance
Les mutes sont généralement enregistrés comme des événe-
ment de contrôleur de volume. Maintenant le Contrôleur n°9 
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est utilisé à leur place. Cela vous permet de contrôler le 
«muting» via les boutons de l’Environnement, ou les contrô-
leurs hardware.

Value 127 Mute (en fait toutes les valeurs sauf 0 
ou 64)

Value 0 désactive le mute 

Value 64 bascule le mute 

Objets Stéréo
Tous les types d’objets audio (pistes, entrées, et sorties) 
peuvent être configurés en mode stéréo. Dans la précédente 
version de Logic, la définition d’une piste audio en mode stéréo 
était obtenue par association à l’une des pistes voisines, créant 
une «paire stéréo». A l’inverse, la version 3.5 possède de vraies 
pistes stéréo. Cela signifie que lorsque vous définissez la piste 1 
comme piste stéréo, la piste 2 ne sera pas modifiée.

Les séquences audio sur les pistes des objets stéréo sont 
toujours traitées ensemble, peut importe l’édition. Si vous 
ouvrez la fenêtre de l’éditeur, les deux côtés de la paire stéréo 
s’y trouvent présentés, et traités ensemble.
6 - 13
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Création d’objets stéréo
Pour cela, sélectionnez l’objet nommé ‹Audio 1› (cliquez sur 
son nom). Cliquez sur le symbole Mono, en bas et gauche de 
l’objet, puis sur le bouton REC.

Le bouton présente alors deux cercles entrelacés, signifiant 
qu’il s’agit à présent d’un objet stéréo. 

Si vous effectuez un clic prolongé sur ce bouton, vous verrez se 
développer un menu déroulant, qui vous propose quatre choix: 

Mono Paramètre la piste pour jouer des 
fichiers mono.

Stereo Paramètre la piste pour jouer des 
fichiers stéréo. Ceux-ci peuvent être 
«entrelacés» ou «splités».

Left La piste jouera le côté gauche d’un 
fichier stéréo «splité».

Right La piste jouera le côté droit d’un 
6 - 14
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fichier stéréo «splité».
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Les Effets

Quelques soient les opérations appliquées aux objets stéréo, 
l’intervention portera, de façon égale, sur les deux côtés. Le 
contrôle de panoramique devient un contrôle de balance.

Les objets stéréo disposent de leur propre jeu de paramètres 
pour le réglage de niveau, balance, envoi d’auxilliaire et EQ. Il 
s’en suit que vous pouvez basculer entre les objets de type 
mono et stéréo, sans perdre les paramètres de chaque type.

Toutes les combinaisons d’enregistrements mono et stéréo sont 
possibles. Vous pouvez paramétrer les pistes 1 et 2, chacune en 
stéréo, et employer les pistes 3 et 4 pour des enregistrements 
mono, si vous le souhaitez.

Fonctions

Représentation en icône
Un double-clic sur le bord supérieur d’un objet audio modifie 
son aspect. Un fader large, comportant des contrôles graphi-
ques, se transforme en icône de petite taille.

A l’inverse, un double-clic sur la petite icône restitue l’affichage 
du fader. C’est une bonne manière de procéder, pour moderni-
6 - 15
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ser l’aspect des faders de Songs issues d’une ancienne version 
de Logic, lorsque vous souhaitez rafraîchir leur «look».

Taille des Objets
Si vous saisissez la poignée située en bordure, en bas et à droite, 
d’un objet, et que vous la déplaciez, vous modifiez la taille de sa 
représentation. Vous pouvez ainsi observer les effets que 
produisent les différences d’encombrement que vous obtenez.

L’échelle des dB, située sur la gauche des objets audio disparaît 
lorsque ces objets sont agrandis au-delà d’une certaine dimen-
sion. Avec l’option File > Preferences… > Audio > Audio Object 

with dB scale as default activée, en cliquant sur la représentation 
d’un objet audio sous forme d’icône, vous obtiendrez alors la 
plus petite représentation possible de l’objet… avec l’échelle 
dB intacte.

Selon la dimension des objets, les désignations peuvent être 
abrégées. Par exemple:

Double Clic
6 - 16
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Track 11-12 deviendra Trk11-12,
Output 13-14 devient simplement 13-14,
Bus 15-16 deviendra B15-16.
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Couleur
Vous pouvez assigner une couleur à un objet audio sélectionné 
avec l’option View > Object Colors.

Cette couleur sera affectée aux séquences audio enregistrées.

6.3 Automation
Sur une table de mixage, l’automation permet d’enregistrer les 
modifications de niveaux des différents canaux audio, puis de 
les reproduire pendant le mixage.

L’automation ‹complète› vous permet d’enregistrer les modifi-
cations de réglage de tous les paramètres de la table, tel que les 
réglages pan et EQ, ainsi que les niveaux de tous les canaux.

Évidemment, dans l’Environnement de Logic, les tables de 
mixage «virtuelles» sont toutes des consoles complètement 
automatisées.

Divers Concepts d’Automation dans Logic
Logic recourt à diverses techniques d’automation en fonction 
du mixer employé. Si vous utilisez des pistes Audio et Midi, 
Logic exploitera l’Adaptive Mixer, abordé à la fin du chapitre. Il 
est requis dans le cas d’une opération simple ou d’une automa-
tion. N’importe quel mouvement dans le mixer effectué 
pendant un enregistrement est mémorisé dans des pistes indi-
viduelles comme des événements Midi, et peuvent être joués 
immédiatement — simple! Vous pourriez presque ignorer les 
explications qui suivent; toute fois elles vous ouvrent des alter-
natives:

Si vous utilisez le mixer audio (il est affiché par défaut dans la 
couche Audio du Song par défaut), automatiquement réglé pour 
6 - 17
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

votre hardware, toute donnée d’automation est enregistrée sur 
une piste instrument appelée ‹A-Playback‹. Sélectionnez cette 
piste, lancez l’enregistrement et appliquez vos réglages de 
canaux du mixer audio. Les données d’automation sont stoc-
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kées en tant qu’événements Midi sur la piste sélectionnée. 
(avec l’adaptive mixer, les données d’automation sont réparties 
sur les pistes concernées). Ce mixer est approprié pour des 
applications purement audio (enregistrement sur disque dur 
sans instruments Midi). LEs données d’automation et les 
pistes audio sont aisément séparables quand il s’agit de les 
éditer individuellement.

Les mêmes principes s’appliquent lors du recours à l’automa-
tion avec les mixers GM/GS/XG. La piste instrument destinée 
aux données d’automation est appelée ‹GM Mixer›. Sélection-
nez cette piste si vous utilisez exclusivement une source sonore 
General Midi (sans audio).

Les mixeurs purement audio et purement GM/GS/XG agissent 
comme les mixeurs que vous pouvez vous-même construire 
dans l’Environnemnt. Ils font partie de l’ensemble standard 
des composantes de Logic, à ceci près que l’Audio mixer gère 
lui-même sa propre configuration selon le périphérique audio 
connecté, quel qu’il soit. La section suivante détaille l’automa-
tion à l’usage des mixeurs audio et des mixeurs configurés par 
l’utilisateur.

Principes de l’Automation Audio
Lorsque vous déplacez avec la souris, les représentations 
graphiques des contrôles (curseurs, interrupteurs, potetntiomè-
tres etc.) des objets audio, vous produisez des informations de 
contrôle Midi, qui peuvent être mémorisées sur un canal Midi 
séparé.

Si vous décidez alors d’écouter le résultat de vos interventions 
sur ces contrôleurs Midi, ceux-ci bougeront conformément à 
vos réglages lors de l’enregistrement, et naturellement, les 
résultats obtenus seront rigoureusement les mêmes.

Les événements contrôleurs peuvent être manipulés dans 
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l’Event list, comme n’importe quel autre événement. Vous 
pouvez également créer graphiquement des séquences de 
contrôle automatique via l’Hyper Editor.
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Au lieu d’utiliser les faders et les objets audio eux-mêmes, vous 
pouvez utiliser d’autres objets fader pour créer des événements 
de contrôleur Midi. De cette approche vous retirez l’avantage 
de ne plus dépendre de la présentation graphique par défaut du 
contrôle des objets audio. Vous pouvez aisément créer, pour ce 
qui est du contrôle des objets audio, votre propre visuel adapté 
à vos besoin spécifiques.

Le Flux du Signal
L’automation d’un mixeur est comparable à l’enregistrement 
des variations des objets fader ordinaires de l’Environnement.

Playback Instrument (‹Mixer Object›)

Pour enregistrer les variations des contrôleurs, vous avez besoin 
d’un objet qui se comportera comme un instrument de piste 
dans la fenêtre Arrange. Un channel splitter est le choix qui 
s’impose.

Commencez par connecter chacune des sorties du channel split-
ter avec les objets fader «assortis». «Assortis» signifie que le 
canal Midi de chaque sortie du splitter doit être le même que le 
réglage du Midi Cha défini dans la boîte des paramètres de 
chaque objet fader.

Ainsi la sortie 1 du séparateur de canal (channel splitter) est liée 
à l’objet fader de la piste 1, la sortie 2 du séparateur de canal à 
l’objet de la piste 2, etc. (à condition bien sûr que vous n’ayez 
pas modifié les valeurs par défaut attribuées aux paramètres des 
Midi Cha).

Le séparateur de canal est toujours présent lorsque vous sélec-
tionnez un nouveau song, et se nomme par défaut ‹A-Playback› 
(pour ‹Audio Playback›). Vous pouvez, bien sûr, renommer cet 
objet comme vous le souhaitez. Par soucis de simplicité, nous 
garderons le nom par défaut pour le moment.
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Dans l’image ci-dessous, vous pouvez voir l’exemple de 4 
objets audio reliés au séparateur de canal par la sélection de la 
sortie du Canal 4.
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Chemin d’accès du Signal et Objets Fader externes
Si vous préférez employer uniquement les contrôles de niveau, 
ou si vous préférez réorganiser les contrôles conformément à 
vos propres préférences, vous pouvez créer vos propres configu-
rations de contrôle.

Ceci est possible par ce que chaque fonction d’un objet audio 
(par exemple les niveaux, les contrôles de panoramique ou 
d’EQ) peut être contrôlée en mode Midi, ce qui veut dire que 
vous pouvez configurer un objet fader externe pour en adresser 
les données nécessaires au contrôle de chaque fonction.

Pour cela, ces objets fader doivent être aptes à envoyer des 
informations de contrôle Midi (en mode «out»), et à opérer en 
tant que «contrôleurs à distance» («remote-controllers») au 
moyen de la même information Midi, quand elles est reçue (en 
mode ‹In›).

Vous découvrirez quels numéros de contrôle utiliser pour régler 
6 - 20
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les divers objets de contrôle audio dans le paragraphe «Quels 
numéros de contrôle?» à la page 6 - 21. Le paragraphe suivant 
décrit les connexions (signal path) nécessaires à vos réglages.
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Quels numéros de contrôle?
Les fonctions valides dépendent du hardware que vous utili-
sez. Quel que soit le matériel sur lequel vous travaillez, vous 
aurez toujours le contrôle des niveaux et des panoramiques, 
mais l’EQ et les envois d’auxiliaire ne seront valides qu’à la 
condition que votre matériel présente les caractéristiques 
appropriées.

Notez que les descriptions données ici sont également présen-
tes dans l’Event List si le matériel que vous utilisé dispose des 
fonctions ad hoc.

Contrôleurs pour les Effets Insérés
Les opérations de contrôle (paramètres) effectuées dans les 
effets incérés de chaque object bus peuvent être automatisées. 
Les 16 premiers paramètres de chaque effet inséré peuvent 
être contrôlés à distance.

Numéro de contrôle Signification

7 Volume

8 Balance (seulement pour lesObjets stéréo)

10 Panorama

16 EQ #1 Frequence

17 EQ #1 Bandwidth

18 EQ #1 Gain

19 EQ #1 Bypass

20 EQ #2 Frequence

21 EQ #2 Bande passante

22 EQ #2 Gain

23 EQ #2 Bypass
6 - 21
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L’allocation des numéros de contrôles des paramètres des effets 
insérés vous est donnée dans la table ci-dessous. La numérota-
tion des inserts commence en haut de la table.

& L’automation des paramètres de Plug-In fonctionne de la même façon que le volume 
et le paoramique. Tous les paramètres enregistrés dans des séquences normales, sont 
mémorisés en tant qu’événements de contrôle. Ce qui signifie vous pouvez employer 
les options d’édition ordinaires de Logic pour gérer les données d’automation.

Automation des Paramètres de Plug-In
L’automation des paramètres de Plug-in opère exactement de 
la même manière que les automations déjà décrites dans la 
notice.

Pour vous familiariser avec la manipulation de ces éléments, 
faites l’essais suivant. Commencer par enregistrer via l’instru-
ment A-playback Ouvrir un Plug-In pour la piste et déplacer les 
contrôles que vous voulez automatiser. Ces réglages sont 
mémorisés en tant que commandes Midi qui peuvent alors être 
jouées et éditées.

Vous pouvez même automatiser les Plug-in dans des objets tels 
que ‹Input›, ‹Aux›, ‹Output› ou ‹Bus›. «. Pour cela, créez un 
séparateur de canal dans l’Environnement (New > Channel 

1. Insert Paramètre d’effet Contrôleur du n° 64 au n° 79

Bypass Contrôleur n° 56

2. Insert Paramètre d’effet Contrôleur du n° 80 au n° 95.

Bypass Contrôleur n° 57

3. Insert Paramètre d’effet Contrôleur du n° 96 au n° 111

Bypass Contrôleur n° 58

4. Insert Paramètre d’effet Contrôleur du n° 112 au n° 
127

Bypass Contrôleur n° 59
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Splitter) et connectez ces canaux par câbles au moyen des 
objets audio appropriés. Ajoutez le séparateur de canal à la 
fenêtre Arrange comme instrument piste, de la même manière 
que vous l’avez fait, auparavant, avec l’instrument ‹A-Play-
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back› Lorsque vous désirez automatiser des pistes, utilisez le 
‹A-Playback›, et si vous désirez automatiser un bus, ou une 
sortie, utilisez le séparateur de canal sur lequel l’objet est 
connecté.

Allocation dynamique d’un contrôleur
Pour allouer plus de 16 paramètres afin de les automatiser dans 
de futurs Plug-in, Logic organise les numéros des contrôleurs 
requis dynamiquement.

Les ‹adresses élémentaires› (numéros de contrôleur: 64, 80, 96, 
112) ne sont pas affectées. Toute fois, si vous n’avez connecté 
qu’un seul Plug-In en première position (slot d’insert du haut), 
vous pouvez automatiser 64 paramètres: 64-127.

Si vous ajoutez un Plug-In au deuxième «slot», les contrôleurs:

• 64-79 (16 paramètres) sont utilisés pour le premier Plug-In,

• 80-127 (48 paramètres) pour le second.

Si vous utilisez un Plug-In dans le premier «slot» et un 
deuxième Plug-In dans le troisième «slot», vous pouvez auto-
matiser 32 paramètres dans chacun (via les contrôleurs 64-95 et 
96-127).

Si vous voulez voir le numéro du contrôleur qui gère tel para-
mètre pour chaque Plug-In, il vous suffit d’ouvrir l’Event List et 
de cliquer sur Controller number. Un menu déroulant dévelop-
pera tous les paramètres automatisés. Les noms des paramètres 
de tous les Plug-ins connus sont présentés en mode texte dans 
l’Event List.

Enregistrement rapide
• Sélectionnez une piste ‹A-Playback›,

• à partir de la position désirée dans la song, placez-vous en 
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Record/Pause,

• sélectionnez l’objet audio voulu dans l’Environnement,
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• Choisissez Options > Send Selected Fader Values. 

Dés lors tous les contrôleurs appropriés seront mémorisés.

Enregistrement en temps réel
Pour mémoriser les ajustements opérés sur les contrôles d’objet 
audio (ou sur les faders d’un «mixeur virtuel» personnalisé) en 
temps réel, vous devez régler l’instrument ‹A-Playback› dans 
l’une des pistes de l’Arrange.

Commencez par afficher la fenêtre Environnement contenant 
l’objet audio en premier plan.

Lancez l’enregistrement. Pendant que le Song est jouée, vous 
pouvez effectuer toutes les opérations de contrôle dans votre 
«mixer virtuel», tous vos ajustements sont mémorisés sur la 
piste ‹A-Playback› en tant qu’événements de contrôle Midi.

Lorsque vous rejouez le song, vous pouvez observer que tous 
vos réglages, opérés dans le précédent essais sont fidèlement 
reproduits. Souvenez-vous que si vous mémorisez plusieurs 
mixeurs dans votre song, vous devez mémoriser les données de 
contrôle sur le séparateur de canal effectivement connecté au 
mixeur que vous essayez d’automatiser.

Réglages des groupes 

Vous pouvez modifier plusieurs faders en une fois, par simple 
sélection des objets appropriés (par exemple en cliquant sur 
eux tout en maintenant la touche S).

Paramètres d’Automation des Mixeurs
Ce paragraphe explique comment enregistrer et corriger les 
mixes en plusieurs étapes.
6 - 24
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Les mixes réalisés au 
moyen de la souris sont 
enregistrés en plusieurs 
étapes, ou «prises». Vous 
devez construire le mixage 
par l’enregistrement de 
différentes prises pour le 
niveau, le panoramique et 
les EQ sur toutes les pistes. 
Cela pose la question de 
savoir comment Logic met 
à jour les variations de 

contrôle déjà mémorisées. Logic dispose de trois modes opéra-
toires pour mettre à jour les données d’automation. Vous 
pouvez y accéder à partir de l’audio mixer, à partir de l’adaptive 
mixer, et à partir du mixeur GM/GS/XG en sélectionnant 
Options > Mixer Automation. 

Les paramètres d’automation de mixeur définissent comment 
Logic réagit, lorsque les données d’un contrôleur appliqué sur 
une piste, sont inscrites par dessus les données déjà écrites par 
le même contrôleur sur la même piste, sur le même canal Midi. 
S’il s’agit d’un contrôleur différent ou d’un canal Midi diffé-
rent, il n’y a pas de problème: un mouvement de fader (Contrô-
leur 7 = Volume Midi) sur la piste audio 3 (avec canal Midi 3) ne 
sera pas modifié par la mémorisation d’un mouvement de fader 
sur la piste 4 (avec canal 4), ni par la mémorisation du mouve-
ment d’un panoramique sur le canal 3. Tous ces mouvements 
de contrôle ne sont pas contradictoires, et peuvent être envoyés 
simultanément. Mais pendant que vous enregistrez, alors que 
les mouvements de fader, précédemment mémorisés, sont 
joués sur la piste 3, qu’arrive-t-il si vous modifiez ce même 
fader avec la souris? Bien sûr les commandes de volumes sont 
toujours mémorisés mais…

• En mode Mixer Automation > Merge , Logic réagit comme 
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avec les autres enregistrements: les nouvelles commandes 
sont enregistrées en combinaison avec les anciennes. Il en 
résulte que le fader oscille entre les nouvelles et les ancien-
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nes valeurs. Ce mode s’avère rarement d’une quelconque 
utilité, mais il est disponible satisfaire les plus exigeants.

• Avec Mixer Automation > Replace les anciens codes de 
contrôle sont détruits, et remplacés par les nouveaux. Ce 
processus ressemble à la fonction replace du panneau de 
transport, qui efface les précédents enregistrements — tout 
comme un magnétophone analogique. Cependant, quand on 
réenregistre par dessus une prise afin de corriger les données 
antérieures d’un contrôleur,  Mixer Automation > Replace 
s’applique seulement aux données de ce même contrôleur 
sur le même canal Midi. Contrairement à l’effet produit par 
la fonction de remplacement d’enregistrement, un mouve-
ment de panoramique ne pourrait pas être modifié par la 
mémorisation d’un mouvement de fader. La nouvelle sauve-
garde commence dés que vous «saisissez» le fader (dés que 
le bouton de souris est pressé). Il prend fin après le relâche-
ment du bouton de souris — mais pas immédiatement. Le 
nouveau mouvement de fader finira avec une valeur proba-
blement très différente, au même endroit, de l’ancienne 
valeur. La conséquence malheureuse serait alors un brusque 
saut de volume (dans le cas d’un fader). C’est pourquoi vous 
pouvez définir un temps d’atténuation du fader (Soft Fade 
Time), c’est le temps nécessaire pour que la valeur finale du 

nouvel enregistrement soit mise à niveau avec la valeur 
correspondante de l’ancien enregistrement. Ce temps est 
défini en millisecondes, et assure une transition en douceur.

• Dans le troisième mode, accessible via Mixer Automation > 
Update, tous les mouvements de l’ancien enregistrement 
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sont conservés, mais augmentés des nouveaux mouvements 
enregistrés pour définir des valeurs de correction pondérées. 
Si vous effectuez des mouvements de fader satisfaisants, 
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mais globalement trop forts, vous pouvez optez pour ce 
mode afin de les adoucir, par exemple de dix points.

Effacer la sauvegarde des mouvements de Fader
De temps à autre, vous aurez besoin d’effacer les mouvements 
mémorisés d’un fader particulier, et les réenregistrés.

La fenêtre Hyper Edit peut fournir une solution tout à fait adap-
tée à ce problème. Il vous faudra effectuer quelques opérations 
préparatoires: paramétrez un Hyper Set des définitions d’événe-
ments de tous les contrôles que vous utilisez. Pour plus d’infor-
mation à ce propos, reportez-vous au chapitre consacré à 
l’emplois de l’Hyper Edit, dans la première partie de la notice.

Si vous n’avez pas d’hyper set approprié à votre disposition, vous 
pouvez aussi détruire les données de la fenêtre Event List .

Si vous connaissez le canal Midi et le numéro de contrôle du 
fader, du bouton ou de l’interrupteur que vous voulez modifier:

• Sélectionnez l’un des événement que vous voulez effacer;
• choisissez Edit > Select Similar Objects;
• appuyez sur la touche B.

Le numéro du canal Midi contenant les informations du contrô-
leur, correspond, habituellement, au numéro de piste de l’objet 
audio (ainsi l’objet piste 3 définit les événements de contrôle 
Midi sur le canal Midi 3 — à moins que vous n’ayez modifié ses 
valeurs par défaut, ce qui n’est pas recommandé).

Les ajustements du fader Volume définissent une donnée 
controller n°7, tandis que les envoi de contrôles panoramiques 
définissent une donnée de contrôle controller n°10.

Si vous ne connaissez pas le canal Midi ou le numéro de 
contrôle du fader, du bouton, ou de la molette à éditer:

• Régler la fenêtre Event List sur ‹Contents Link›;
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• régler la position du Song au début de la séquence;
• appuyez sur PAUSE, puis sur RECORD;
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• appliquez au contrôle les mouvements que vous voulez 
éditer.

La fenêtre Event List affichera alors tous les événements 
produits par ce contrôle.

• Appuyez sur STOP deux fois de suite;
• désélectionnez tous les événements dans la fenêtre Event 

List;
• sélectionnez tous les événements qui viennent juste d’être 

affichés;
• choisir Edit > Select Similar Objects;
• Appuyez sur la touche B.

6.4 Effets temps Réels 

Mémoire

Les effets temps-réel nécessitent de 10 à 400 ko . Un unique 
Plug-In au format DirectX avec sa propre interface graphique 
(fenêtre d’édition), peut requérir plus de 2 Mo. Vérifiez que 
vous avez assez de mémoire «libre» disponible.

& Référez vous à la section concernant  mémoire dans le manuel d’installation.

Introduction
Voici quelques bases sur le parcours du signal des consoles de 
mixages. Si vous connaissez déjà le sujet, passez directement 
au paragraphe «Généralités sur les effets en temps réel» à la 
page 6 - 30.

En pratique, il existe deux façons d’envoyer l’audio vers des 
effets: via un insert ou via un bus (appelé également auxiliaire).
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effets inserts
Avec des effets en insert, tout le signal est traité. Ce qui signifie 
que 100% du signal passe au travers de l’effet. Cela est parfait 
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pour les équaliseurs ou les processeurs de dynamique. En théo-
rie, cela s’applique aussi aux panoramiques et faders.

Effet «Bus»
Dans ce cas, une quantité contrôlée de signaux est envoyée 
dans l’effet. L’exemple classique est la reverbe, ou le paramètre 
d’effet le plus important est la quantité envoyé, car cela déter-
mine l’endroit où le signal source doit être placé dans le champ 
audio d’écoute. Les effets d’écho (delay) et de modulation 
(chorus, flanger,…) sont aussi généralement utilisés de cette 
manière. 

Avec Logic, l’effet est positionné dans l’insert d’un objet bus. 
Chacun des signaux de piste peut être envoyé dans le bus, via 
un potentiomètre d’envoi (Send). Le signal audio est alors traité 
avec l’effet, puis mélangé avec la sortie stéréo.

L’avantage de ce type d’effet est qu’un seul traitement suffit, 
car les signaux de plusieurs pistes peuvent être gérés simulta-
nément. 

Avec des effets à traitement intensif comme la reverb, il est 
toujours préférable d’utiliser un bus. Le Chorus, le Flanger et 

Effet

Effet

C. 2C. 1

Bus 1
Sends

+
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le Delay doivent, également, toujours être dans un bus s’ils 
sont utilisés par plus d’une piste.
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Inversement, il peut être préférable dans certain cas de mettre 
un effet comme un delai directement dans l’insert d’une piste. 
Il n’y a donc aucune restriction dans Logic sur la façon d’utiliser 
les effets temps réel.

Généralités sur les effets en temps réel 
Vous pouvez ajouter des effets temps réel avec 
un clic long sur un emplacement d’insert (voir 
aussi le paragraphe «Inserts» à la page 6 - 9).

Double-cliquez sur un 
insert assigné pour ouvrir la 
fenêtre Plug-in correspon-
dante. C’est là que vous 
modifiez les paramètres de 
l’effet temps réel.

Paramètres généraux
Si vous cliquez sur un paramètre tout en maintenant la touche 
ç, vous le reconfigurez sur une valeur neutre.

Mix

‹Mix› définit le mixage proportionnel entre le signal d’origine 
(Dry) et l’effet (Wet).

Si l’effet est alimenté par un bus, il doit également être réglé 
sur une proportion mix de 100% (par défaut pour les inserts des 
objets bus). Alors, le potentiomètre d’envoi de la piste permet 
l’utilisation de toute la plage du réglage .

Region Gate

‹Region Gate› vous permet de définir l’arrêt du calcul de l‘effet, 
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après la fin de la région. Ceci économise de la puissance de trai-
tement, si l’effet n’est pas nécessaire pour de longs passages 
dans la fenêtre Arrange. Durant ces passages, la puissance de 
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traitement économisée peut être disponible pour d’autres 
effets. Et peut s’avérer utile si vous souhaitez que la «queue» 
de la réverbe ou du delay ne soit pas coupée prématurément. 

Vous pouvez également utiliser ce paramètre comme paramètre 
d’effet par lui-même, pour créer des reverbs ou des delais 
«gated».

Equaliseurs
Un équaliseur (EQ) est utilisé pour augmenter ou couper des 
plages de fréquences spécifiques.

HQParEQ

L’équaliseur complet ‹HQParEQ› possède les trois paramètres 
suivants:

Hz Fréquence centrale

dB Réduire/Amplifier

Q Qualité

Une plage de fréquence, symétriquement répartie de part et 
d’autre de la fréquence centrale, est donc amplifiée ou coupée. 
Vous pouvez régler la largueur de cette plage avec le facteur Q.

Gardez en mémoire que ‹HQParEQ› a une très bonne qualité 

dB

Hz
fc

Q

0

Exemple: certaines fréquences sont augmentées
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sonore, mais nécessite plus de puissance que les autres algorith-
mes d’équalisation.



Chapitre 6
Mixers et Objets Audio

HQSweepEQ

Contrairement à l’EQ paramétrique complet, ‹HQSweepEQ› n’a 
pas de fonction de qualité ou de (Q) réglable, et necesite de ce 
fait moins de puissance de traitement.

Le ‹HQSweepEQ› a également une bonne qualité sonore, et 
nécessite donc une grande puissance de traitement.

ParEQ

Le ‹ParEQ› possède les mêmes paramètres que ‹HQParEQ›, 
mais utilise un algorithme plus simple nécessitant bien moins 
de puissance.

LoShelv

l’équaliseur de type ‹LoShelv› n’affecte la plage de fréquence 
que sous la fréquence choisie.

L’égaliseur de type «low shelving» permet d’augmenter ou 
couper les basses fréquences.

HiShelv

L’équaliseur de type «HiShelv» n’affecte la plage de fréquences 
qu’au dessus de la fréquence choisie.

Cet équaliseur permet d’augmenter ou de couper les fréquen-
ces aigus.

dB

Hz
fc

0

Example: augmentation avec ‹LoShelv›
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Filtres

LowPass

Le filtre passe-bas («LowPass») affecte la plage de fréquences 
au dessus de la fréquence choisie; les fréquences en dessous 
passent à travers le filtre.

Vous pouvez utiliser ce filtre pour couper radicalement la plage 
de fréquences aigus au delà de la fréquence choisie.

HighPass

Le filtre passe-haut («HighPass») affecte la plage des fréquen-
ces au dessous de la fréquence choisie; les fréquences au 
dessous passent à travers le filtre.

dB

Hz
fc

0

Example: boosting with ‹HiShelv›

dB
Hz

fc
0

Low Pass Filter
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Vous pouvez utiliser cefiltre pour couper radicalement la plage 
des fréquences graves en dessous de la fréquence choisie.
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Delay
Le Delai, comme son nom le suggère, retarde le signal audio 
crée simplement des réflexions du signal d’origine.

Time

Le paramètre ‹Time› détermine le retard en millisecondes.

Des valeurs très faibles (jusqu’à 10 millisecondes) produisent 
une sorte de filtre, des valeurs plus importantes (10 à 100 milli-
secondes) des effets de doublage, et des valeurs encore plus 
grandes des échos.

Feedback

Avec ‹Feedback›,le signal retardé est envoyé à l’entrée, ce qui 
vous permet de contrôler le nombre de répétitions ou de 
réflexions.

Flanger

Offset

L’Offset du flanger définit la valeur normale du temps de 
retard, qui est alors modulé via les paramètres ‹Speed› et 

dB
Hz

fc
0

High Pass Filter
6 - 34
Emagic
Logic Audio Pro ISIS 

‹Width›. Si ‹Width› est sur zéro, vous pouvez utiliser l’offset 
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Width

La modulation d’amplitude. Cela détermine la plage de 
fréquence, à partir de laquelle est modulé le filtre combiné.

Speed

La fréquence ou vitesse de la modulation. Cela détermine la 
rapidité de modulation du filtre combiné.

Feedback

Avec ‹Feedback› le signal retardé est envoyé à l’entrée. Des 
valeurs négatives veulent dire que la phase du signal est inver-
sée.

Vous pouvez utiliser ‹Feedback› afin d’augmenter l’intensité 
du flanger qui peut alors produire des effets très puissants.

Chorus

L’effet de type «Chorus» est utilisé pour «épaissir» un signal,
en particulier ceux dont la sortie est stéréo (m/s).
Offset

L’Offset du Chorus définit la valeur normal du temps de retard, 
qui est alors modulé par les paramètres ‹Speed› and ‹Width›.

Width

Amplitude de l’effet Chorus.

Speed

Fréquence de modulation du chorus.

Feedback

Avec ‹Feedback› le signal retardé est envoyé à l’entrée, ce qui 
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augmente l’intensité de l’effet chorus. Des valeurs élevées 
peuvent produire un son irréel.
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Reverb
Les reverbs nécessitent un surcroît de puissance par rapport 
aux autres effets temps réel notamment avec des valeurs de 
qualité élevées.

Roomsize

Le paramètre ‹Roomsize› définit la taille de la pièce simulée. 
De petites pièces ont des réflexions denses, moins d’atténua-
tion aérienne des ondes sonores entre les réflexions sur les 
murs, et donc une relation de phase variable.

Decay

Temps de chute de la reverbe. N’oubliez pas que le temps de 
réverbération absolu (RT60) peut être réglé indépendamment 
du paramètre ‹Roomsize›.

Density

La densité de la reverb: des valeurs élevées donnent une 
reverbe plus dense, laquelle dépend du matériel sonore, dont la 
qualité est plus ou moins naturelle.

‹Density› détermine la géométrie des surfaces de réflexion 
virtuelles de la pièce simulé.

High Frequency Damp

Ce paramètre contrôle l’atténuation des fréquences hautes de 
la chute de la reverbération. Dans des lieux naturelles, le temps 
de reverbération dépend toujours de la fréquence: les fréquen-
ces élevées chutent plus rapidement que les fréquences basses.

Pour des simulations de pièces, ce paramètre détermine les 
caractéristiques des matériaux utilisés sur les surfaces: du métal 
(valeurs faibles) au bois (valeurs moyennes) jusqu’aux moquet-
tes (valeurs élevées).
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PreDelay

Le paramètre ‹PreDelay› définit le temps de pré-delay avant 
que la reverbe n’intervienne.

Avec un temps de pré-delay correct, la reverbe gagne en 
espace. Les valeurs idéales sont comprises entre 5 et 50 ms. 
Des valeurs très faibles sonnent mieux pour des sons isolés 
mais ont tendance, dans le mixe, à paraître amoindri par la 
reverb. Des valeurs plus importantes peuvent être intéressan-
tes afin de mélanger des effets de type Delai et Reverb, mais, 
par nature, cela n’intervient que si la source sonore se trouve à 
l’extérieur de l’embouchure d’un tunel.

Quality

Le paramètre ‹Quality› vous permet de choisir entre différents 
types d’algorithmes générateurs de reverbe. Ces algorithmes 
varient grandement en terme de puissance de traitement requis 
et de qualité sonore.

Si vous remarquez que la capacité de traitement est trop faible, 
essayez de réduire le paramètre de qualité de la reverbe.

Fonctions de la fenêtre de Plug-in
Chaque fenêtre de Plug-in possède une rangée de boutons en 
haut de sa fenêtre dont les fonctions sont identiques pour toud 
les Plug-Ins.

Link

Si le bouton Link est désactivé (valeur par défaut), vous pouvez 
ouvrir plusieurs fenêtres Plug-In simultanément.

Si le bouton Link est activé, cette fenêtre est utilisée exclusive-
ment pour le Plug-In sur lequel vous avez double cliqué.
6 - 37
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C



Chapitre 6
Mixers et Objets Audio

Bypass

Le bouton bypass supprime l’effet du cheminement du signal. 
Le signal en entrée de l’effet est dirigé directement à la sortie 
sans altération.

Choix d’un objet audio

Si vous avez utilisé l’algorhitme d’effet affiché dans un autre 
objet audio, par exemple pour une piste différente, vous 
pouvez rapidement basculer d’une piste à l’autre. Par exemple, 
vous pouvez aisément comparer les réglages.

Sélection de l’emplacement d’insert

Si vous avez installé d’autres Plug-ins dans d’autres emplace-
ments d’insert du même objet audiobus, vous pouvez rapide-
ment passer à un autre Plug-In. Cela vous permet de faire rapi-
dement la balance de tous les Plug-in de ce canal.

6.5 Plug-Ins provenant d’autres 
constructeurs

Logic supporte le standard DirectX Qui permet l’utilisation 
d’effet temps réels fabriqués par d’autres sociétés de création 
de logiciels, pouvant être intégré dans Logic.

Suivez les instructions d’installation préconisé par l’éditeur du 
ou des plugs-in afin d’en assurer la bonne mise en place. Il y a 
une application sur le CD de programmes de Logic qui vous 
permet d’exclure certain plug-in. S’il vous plaît référez vous au 
manuel d’installation de Logic pour de plus amples informa-
tions sur cette application.

Les Plug Ins sont automatiquement disponibles dans le menu 
Plug In, tout comme les effet internes propres à Logic. C’est le 
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Double-cliquez sur un plug-in inséré pour ouvrir son éditeur. Si 
le plug-in sélectionné ne possède pas sa propre fenêtre 
d’édition, l’interface standard de plug in de Logic sera utilisé 
afin d’accéder aux paramètres de réglage.

6.6 Mixeur GM/GS/XG 
Dans le Song par défaut de Logic, une couche de l’environne-
ment le mixeur GM/GS/XG, est lancée au démarrage du 
programme. Ce mixeur purement Midi n’a rien à voir avec les 

objets audio: son but est le contrôle d’éxpendeur General Midi 
(GM). Il y a aussi une adaptation particulièrement destinée au 
standards Roland GS (General Standard) et Yamaha XG 
(Extended General Midi). 

Le General Midi est une extension du standard Midi, qui 
nécessite des modules sonores spécifiques. Ceci incluant les 
points suivants:

• Permet de recevoir 16 canaux Midi simultanément

• 128 programmes fixes avec les sons standard GM

• Chorus et reverb.
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• Panoramique et volume pour chacun des canaux contrôla-
bles via Midi.
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Les fonctions du mixeur sont généralement accessibles aux 
expendeurs qui ne supportent pas le standard GM —aussi loin 
que leur implémentation Midi le permet. Techniquement le 
mixeur GM génère des événements Midi de type ‹control 
change›, lesquelles sont reconnus par tous les expendeurs de 
sons Midi. Quoi qu’il en soit, seul les expendeurs GM sont 
garantis pour répondre à ces événements. 

La boîte de paramètres d’objet pour le mixeur GM/GS/XG est 
visible seulement si View>Parameters est activé et si le mixeur 
GM/GS/XG est sélectionné en tant qu’objet (en cliquant son 
nom en dessous de la fenêtre).

Bank
Si votre source sonore répond aux événements de sélection de 
banque, vous pouvez choisir le numéro de banque pour chacun 
des 16 canaux Midi. Souvenez vous toutefois que tous les 
synthétiseurs ne supportent pas les messages de sélection de 
banque.

Format de sélection de banque

Le mixeur GM/GS/XG envoie des messages bank select (de 
sélection de banque) au format standard. Toutefois, si vous 
connectez la sortie du mixeur à l’entrée du multi-instrument, 
les messages bank select sont automatiquement convertis au 
format multi-instrument. Pour plus d’infos sur le paramétrage 
du format pré-définis de bank select du multi instrument, 
reportez-vous au paragraphe «Définition de Vos Propres 
commandes de sélection de banque» à la page 5 - 34.

& Une banque est un groupe d’un maximum de 128 programmes de sons. Vous 
pouvez appeler un programme de son particulier dans une banque, via le 
programme de menu déroulant. Pour les expendeurs GS et XG, le fonctionnement 
est différent: dans un programme (obtenu via une commande de program change) 
vous pouvez utiliser la commande de sélection de banque afin de faire votre choix 
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Program
Dans un module GM, le menu déroulant des programmes cons-
titue l’espace dans lequel vous choisissez un son par son nom. 
La partie supérieure permet de choisir les programmes pour les 
numéros de canaux Midi impairs (1, 3, 5...15), et la partie infé-
rieure les programmes pour les numéro de canaux pairs (2, 
4...16).

Pour choisir le son d’un canal Midi:

• Cliquez sur le nom du son, et maintenez le bouton de la 
souris enfoncé.

Un menu déroulant apparaît contenant tous les noms des sons 
GM.

• Choisissez un son depuis le menu et relâchez le bouton de la 
souris.

Logic sélectionne le son dans l’expendeur GM.

Volume
Vous pouvez utiliser le fader de volume afin de contrôler le 
volume de chaque canal individuellement.

• Cliquez le fader et déplacez le, tout en gardant le bouton de 
la souris enfoncé.

Mute
Le bouton de «mute» déplace le volume du canal entre zéro et 
la position en cours du fader. En pratique cela signifie que si le 
bouton est en «bas», le canal est «coupé». Si vous positionnez 
mute sur off, la position du fader redeviendra valide.

Si vous souhaitez «couper» un canal:

• Cliquez sur le bouton mute du canal Midi.
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• Cliquez le bouton de nouveau afin de revenir à la position 
précédente (canal actif).
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Pan
La molette de panoramique (pan) vous permet de contrôler 
directement le panoramique du son.

• Cliquez sur le potentiomètre, et maintenez le bouton de la 
souris enfoncé.

• Déplacez la souris en haut ou en bas.

The molette bouge en fonction du déplacement de la souris.

Controller
Vous pouvez envoyer toutes les données de contrôleur afin de 
contrôler les différents paramètres de votre source sonore via 
les trois molettes. D’abord, voici une description des fonctions 
prédéfinis:

Reverb

Ce potentiomètre contrôle la reverbération. Plus vous tournez 
le potentiomètre, plus le signal affecté deviendra important (en 
d’autres termes, une quantité plus importante de signal prove-
nant du canal est traité par le processeur d’effet).

Chorus Depth

Ce potentiomètre contrôle la profondeur de l’effet chorus. Plus 
vous tournez le potentiomètre, plus important devient l’effet.

Cutoff Frequency

Ce potentiomètre contrôle le contenue harmonique du son. 
L’action à pour effet de rendre le son plus ou moins brillant.
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Sélection des autres Contrôleurs
Si vous effectuez un clic-prolongé la boîte de texte située sur le 
bord gauche du mixeur, la liste des contrôleurs apparaît.

Ici vous pouvez choisir le contrôleur que vous souhaitez 
envoyer via le potentiomètre Situé à coté, sur la même ligne.

Dans la liste des contrôleurs, tous les contrôleurs sont listés par 
nom, si le standard Midi est en vigueur pour ces numéros. Tous 
les contrôleurs entre 1 et 120 sont accessibles.

Résumé des fonctions du mixeur GM 
Ces fonctions sont également disponibles:

Nom Symbole Description Midi Event Ctrl.No.

Program menu Son dans les modules 
GM

Program 
Change

–

Bank boîte sélection de la 
banque de son

Dépend du message de 
sélection de banque

Volume Fader Volume Volume 7

Mute Bouton Volume: 
Mute: bouton activé
Fader: bouton désac-
tivé

Volume
0
Fader value

7
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mixeur GM, il doit être positionné afin de répondre aux contrô-

Pan Fader panoramique stéréo Pan 10

Note



Chapitre 6
Mixers et Objets Audio

leurs correspondants (voir la colonne ‹Ctrl. no.› column) pour 
plus de détails voir le manuel du générateur sonore. 

Parfois la réaction aux contrôleurs peut être globalement inhi-
bée (ex: Midi-Menu, ‹Receive Control Change›. positionnez-le 
sur ‹Enable›).

Ces fonctions peuvent être contrôlées dans les synthétiseurs 
GS et XG:

Souvenez-vous: nombre de synthétiseurs ne peuvent réagir à 

Nom Description Midi Event Ctrl.No.

Resonance Filtre de résonnance (Q) Resonance 71

Cutoff Filtre de fréquence(Fc) Cutoff 74

Attack Temps d’attaque du généra-
teur d’enveloppe

Attack Time 73

Release temps de relâchement du 
générateur d’enveloppe

Release Time 72

Reverb Profondeur de la reverb Effect Depth 91

Chorus Profondeur du Chorus Chorus Depth 93

Phaser Profondeur du Phasing Phaser 95

Modula-
tion

Comme une molette de 
modulation (Vibrato)

Modulation 1

Breath Comme un contrôleur de 
souffle

Breath Con-
troller

2

Foot Con-
trol

Comme une pédale de con-
trôle

Foot Control-
ler

4

Porta-
mento

Temps de Portamento Porta Time 5

Tremolo Effet Tremolo (modulation de 
volume)

Tremolo 
Depth

92

Detune Déviation de ton entre les 
oscillateurs

Detune 94
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Sauvegarder les réglages du mixeur GM 
Les réglages du mixeur affectent directement la boîte de 
programme dans le coin gauche de la fenêtre Arrange. Les 
derniers réglages y sont sauvegardés avec la song. Si la mémoire 
dans votre instrument GM n’est pas maintenue par une batte-
rie, à chaque fois que vous le mettez hors-circuit il ne gardera 
pas en mémoire les paramètres que Logic lui a transmi. Pour 
restaurer les anciens paramètres après que vous ayez lancé la 
song, allez dans la fenêtre Arrange et choisissez Options > Send 
to Midi > Used Instrument Midi Settings. 

Fonctions étendues GM, GS et XG
En plus du standard GM il y a des set up standards étendus de 
Roland (GS) et Yamaha (XG). Dans les modes GS et XG 
comme vous contrôlez le niveau de la réverbération et du 
chorus, vous pouvez également choisir différents programmes 
d’effets.

• Cliquez sur ‹GM› se trouvant sur le côté droit de la fenêtre 
du mixeur et gardez le bouton de la souris enfoncés. Un 
menu déroulant apparaît .

• Choisissez le standard étendu (GS ou XG).

En fonction des choix que vous avez effectué, les contrôleurs 
de l’effet étendu appraîssent alors.

• Choisissez la réverbération ou le chorus désiré à partir du 
menu déroulant. 

• Programmez la réverbération ou le temps de delay désiré en 
dessous de ‹Time› en maintenant enfoncé le bouton de la 
souris.

Bouton d’initialisation
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Le bouton d’initialisation transmet une commande ‹GS On› ou 
‹XG On› et initialise les contrôleur. Ceci vous permet de remet-
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tre en position de départ tous les expendeurs connectés, vous 
pouvez alors commencer le mixage.

Apparence des mixeurs GM/GS/XG 
Si vous ouvrez un song qui a été créé avec une version plus 
ancienne de Logic, vous pouvez constater que l’apparence du 
mixer GM a été modifié pour concorder avec les objets audio. 

Sélectionner Legend pour voir/cacher les descriptions des fonc-
tions du mixeur.

Notez que si vous avez un préréglage de mixeur GM en style 1 
vous aurez a l’élargir en déplaçant vers le bas le coin inférieur 
droit avant d’apercevoir les boutons de sélection de banques 
dans la boîte de dialogue du mixeur GM(case de validation 
‹Bank›).

Les potentiomètres de la ligne située sous les potentiomètres 
de panoramique, sont maintenant réglés pour le contrôleur 74, 
celui qui correspond au filtre de fréquence de coupure (porta-
mento). 

Gardez en mémoire que contrairement aux expendeurs GM 
ordinaires, les modules de sons GS ou XG possèdent des filtres 
modulables.

Automation pour mixeurs GM/GS/XG
Sélectionnez une piste via l’instrument de piste GM Mixer . 
Démarrez l’enregistrement et déplacez les contrôleurs du 
mixeur GM/GS/XG. Le mouvement de tous les canaux sont 
enregistrés sur une piste du mixeur GM où ils pourront être 
édités. Pendant la reproduction les mouvements sont repro-
duits, toutefois si vous coupez la piste du mixeur GM vous 
pourrez l’éviter. Pour plus de détails référez vous à la section 
automation.
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6.7 Audio Mixer
Une des couches d’environnement de la song par défaut (ex. La 
song que Logic ouvre après son lancement) est le mixeur audio. 
Ce mixeur est constitué d’objet audio qui peuvent opérer et 
automatiser comme décrit plus haut. Pour l’ouvrir allez dans 
l’Environnement (Window> ) et cliquer sur le bouton de 
couches (layer) .

& Le schéma ci-dessus montre une section de 12 objets audio (canneaux1—12) pour12 
pistes différentes du mixeur. Dans la moitié droite de la fenêtre Environnement se 
trouvent les retours d’effets ainsi que les sorties pour ces objets (schéma ci-dessus).
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mixeur occupe le moins de place possible. Si les équaliseurs et 
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les envoi d’auxiliaires sont inclus la taille du mixeur augmente 
automatiquement.

Automation pour le mixeur audio
Selectionnez une piste à l’aide de la piste A-Playback . Démar-
rez l’enregistrement et déplacez les contrôleurs du mixeur. Le 
mouvement de toutes les pistes est enregistré sur la piste A-
Playback , ou elles peuvent êtres édités. Durant l’écoute les 
mouvements sont reproduits mais peuvent être inhibés en 
coupant la piste A-Playback à l’aide de la touche mute. Pour plus 
de détails référez vous à la section automation.

6.8 Adaptive Mixer
L’Adaptive mixer est la plus simple et la plus pratique des façons 
de mixer des pistes Midi et audio. Logic crée un mixeur en se 
basant sur l’ensemble des pistes qui sont assignées à la track list 
de la fenêtre Arrange. Il contient autant de canaux qu’il y a de 
pistes. A la différence du mixeur GM, ou du mixeur audio, 
l’Adaptive mixer incorpore, à la fois les pistes audio et Midi. 
Celles-ci se présentent dans le même ordre que dans la fenêtre 
Arrange. Chaque canal représente un objet dans l’Environne-
ment: les canaux audio sont des objets audio, les canaux Midi 
sont des instruments (parties de multi-instruments).Les para-
mètres que vous ajustez dans l’Adaptive mixer sont également 
disponibles dans les autres affichages de l’Environnement, ou 
6 - 48
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dans la fenêtre Arrange. Pour ouvrir l’Adaptive mixer allez dans la 
fenêtre Arrange et sélectionnez Window>Open Track Mixer.

Sur la gauche se trouve l’affichage des paramètres 1 Lesquelles 
vous indiquent (entre autres choses) quels effets sont assignés 
aux auxiliaires d’envois. Les pistes sélectionnées sont cerclés 
de rouge 2. L’opération et les paramètres des objets de pistes 
audio 3 et les objets de piste Midi 4 sont les mêmes que 
d’habitude. Le nombre en bas du canal indique le numéro de la 
piste. La représentation graphique des noms de programmes et 
de commandes de sélection de banque 5 est légèrement diffé-
rente par rapport au design du mixeur GM/GS (pour une déno-
mination plus claire). A la différence du mixeur audio, vous 
pouvez ajuster la taille de l’affichage tant verticale qu’horizon-
tale en utilisant la fonction «zoom» longue-vue 6.

Les pistes qui ne possèdent pas leurs propres paramètres de 
mixeur sont invisibles dans l’Adaptive mixeur. Ce qui inclus les 
objets delai, arpégiateurs, etc. Si il y a plusieurs pistes consécu-
tives dans la fenêtre Arrange partageant la même piste instru-
ment, cet instrument est représenté par un seul canal dans 
l’Adaptive mixer.

1 2 3 4

5
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Affichage
C’est dans le menu Track que vous définissez le 
type de piste affiché dans l’Adaptive mixeur. 
Vous pouvez désélectionner le Midi ou les 
pistes Folder, si nécessaire. Bien que les objets 
Bus et Master ne soient pas une piste instru-
ment, ils peuvent néanmoins être affichés dans 

l’Adaptive mixer.

C’est dans le menu View que vous personna-
liser l’affichage afin de le soumettre à vos 
exigences. Vous pouvez cacher l’appellation 
des potentiomètres définis par l’utilisateur 
pour les canaux du mixeur Midi. Vous pouvez 
individuellement couper l’affichage des noms 
d’instrument, le numéro des programmes, les 
numéros de bank, les potentiomètres définis 
par l’utilisateur dans les canaux du mixer 
(Assign), les potentiomètres de panoramique 
(Pan), les faders (Volume), et le nom et le 
numéro de la piste, afin de gagner de l’espace. 

Si vous souhaitez inhiber de l’affichage le nom des instruments, 
ainsi que les noms de programmes, le canal garde son aspect 
rectangulaire sans les étiquettes dont ont besoin les libellés 
trop longs. Si vous inhibez juste l’affichage des noms d’instru-
ments, le nom de la piste apparaît à la place. Vous pouvez égale-
ment désactiver l’affichage des équaliseurs, des envois d’auxi-
liaires et des Plug-ins pour les canaux audio.

Comme les autres éditeurs, l’Adaptive mixer est toujours sauve-
gardé dans les Screensets. Vous pouvez passer des uns aux autres 
en utilisant le pavé numérique !—), ou éventuellement 
appeler un sreenset à deux chiffres en maintenant enfoncée la 
touche S au moment d’entrer le premier chiffre.
6 - 50
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Folders et l’Adaptive Mixer
L’Adaptive mixer peut afficher, non seulement le contenu 
de la fenêtre Arrange à son plus haut niveau, mais égale-
ment le contenu des folders. L’Adaptive mixer enregistre 
automatiquement n’importe quel changement dans la 
structure d’un Folder ou d’une piste instrument. Si vous 
sélectionnez un Folder, ou bien si la fenêtre de premier 
plan affiche le contenu du folder, lorsque vous ouvrez 
l’Adaptive mixer, ces pistes n’apparaîtront que dans le 
folder. Si vous cliquez sur la case de fermeture du folder 
(la case grise dans l’angle supérieur gauche, sous la case 
de fermeture habituelle de la fenêtre), vous affichez au 

premier plan le niveau supérieur de l’Adaptive mixer; dans cet 
exemple: l’écran contenant le folder. Un double clic sur le canal 
folder restaure l’affichage du contenu du folder. Naturellement, 
l’affichage des Folder Tracks doit être activé dans le menu 
Tracks.

Sélection des pistes en cours de jeux
Si vous désactivez l’option Option> Change Track in Play Mode 
vous pouvez prévenir tout changement dans la piste sélection-
née, quand vous voulez faire un ajustement à un canal en cours 
de jeux. De toute façons, si vous êtes en train d’enregistrer, 
chaque mouvement sera enregistré dans la piste concernée. 
C’est à Logic de sélectionner la piste.

6.9 Bouncing
Les objets de sortie possèdent chacun un interrupteur de 
Bounce («BNCE»). Ceci s’applique également aux objets de 
sortie des mixeurs Adaptive et Audio, ce que l’on peut constater 
dans le song par défaut, comme une couche de l’Environne-
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ment. Cela vous permet de créer un fichier audio basé sur 
toutes les pistes audio assignées à cette sortie. Tous les paramè-
tres, incluant le volume, les panoramiques, et les effets sont 



Chapitre 6
Mixers et Objets Audio

enregistrés dans le fichier «bouncé». Cette fonction s’opère en 
temps réel, ce qui permet à tous les signaux provenant des 
Plug-ins ou des périphériques Midi routés aux entrées utilisés 
d’être enregistré:

• Appuyez sur le bouton bounce de l’objet de sortie

• Configurez les paramètres dans la fenêtre de dialogue Bounce 
(voir ci-dessous).

• Appuyez sur le bouton bounce dans la fenêtre de dialogue 
bounce.

Un sélecteur de fichier apparaît à l’endroit ou vous choisissez 
un nom et une destination pour le fichier «bouncé».

Options de la fenêtre de dialogue de Bounce

Position de départ et de fin 

C’est ici que vous 
déterminez le passage à 
enregistrer dans le 
fichier «bouncé». la 
présélection est le song 
entière depuis le début 
de la première région 
audio jusqu’à la fin de la 

dernière. Cependant, si la fonction cycle est active, la présélec-
tion sera déterminé par la positions des locators. Par exemple, si 
vous souhaitez prendre en compte les modules de sons mixés 
via les entrées objet audio en dehors des régions présélection-
nés.

En dessous vous est indiqué la mémoire requise pour le fichier 
bouncé.
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Résolution

C’est ici que vous définissez la résolution du fichier «Bouncé». 
Les options sont 16 Bits, 8 Bits(Ex. pour des productions multi-
média) ou 24 Bits (Ex. pour le mastering sur DVD).

Type de fichiers stéréo

Ici vous pouvez choisir entre le format «split stereo» (pour une 
utilisation dans ProTools), ou le format stéréo entrelacé (pour 
une utilisation ultérieure dans Logic, avec une carte Sample-
Cell II ou pour un logiciel de gravure de CD). 
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La Fenêtre Audio

Logic vous permet d'accéder à des fichiers de son numérisé 
(fichiers audio)  qui sont disponibles dans le format 
Wave(.WAV). les enregistrements effectués au sein de Logic 
sont  stockés au format wave.

La fenêtre Audio d'un song de Logic se trouve là où vous orga-
nisez les fichiers audio utilisés dans le song sur votre disque dur, 
que ces fichiers proviennent d'enregistrement venant d'être 
effectués ou qu'ils aient été copiés d'un CD-ROM sur votre 
disque dur quelques jours auparavant. La fenêtre Audio vous 
donnera accès à tous les fichiers correspondant aux formats 
reconnus par Logic.

La fenêtre Audio ne gère aucune relation temporelle entre les 
enregistrements. Un fichier audio ne contient en effet aucune 
information sur sa relation temporelle avec l'axe des temps du 
séquenceur. Cette relation n'apparaît que lorsque ces fichiers 
audio sont découpés en régions, elle-même assignées à des 
séquences audio, ces dernières définissant la relation tempo-
relle avec l'axe du séquenceur, comme pour les séquences 
Midi.

La fenêtre Audio est à envisager comme un catalogue des 
matériaux sonores dont vous disposez. Par ailleurs elle vous 
donne une vue générale de toutes les régions qui ont étés défi-
nies dans ces fichiers audio.

Vous pouvez y créer de nouvelles régions, les supprimer, les 
éditer ou encore renommer des régions existantes. Lors de 
l'édition, votre résolution est limitée à des pas de 256 mots 
(échantillons instantanés). Pour une édition plus précise, utili-
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sez la fenêtre d'édition d'échantillons.

Ces régions peuvent alors être glissées dans la fenêtre Arrange , 
ou elles pourront être réorganisées en séquences audio.
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La Fenêtre Audio

Les menus de la fenêtre Audio contiennent toutes les fonctions 
relatives à la gestion des fichiers audio et des régions, ainsi que 
des paramètres systèmes destinés à configurer votre hardware 
(HDR hardware).

Ouverture de la fenêtre Audio
Pour ouvrir la fenêtre audio activez la fonction Window > Open 
Audio. Vous pouvez ouvrir plusieurs fenêtres Audio à la fois 
((éventuellement dans le même Screenset) par exemple pour 
travailler à des facteurs de zoom différents.

1 bouton lien (Link)
2 bouton du mode cycle 
3 bouton de monitoring (Monitor)
4 Champ de sélection de canal de sortie pour le monitoring
5 Boite à outils pour la fenêtre Audio
6

6

8

9

!≠

!

!

!

!

7
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Cliquer sur le petit triangle pour voir ou cacher les régions
du fichier audio correspondant

7 Cliquer sur le symbole de verrouillage pour protéger les pa-
ramètres d'une région
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8 Nom du fichier audio (grands caractères)
9 Nom de la région (petits caractères)
!≠ Attraper et glisser ce point pour ajuster la division horizon-

tale de la fenêtre
!¡ Outil de zoom (telescope) pour l'ajustement de l'affichage
!“ Région avec la forme d'onde affichée
!¶ Affichage des passages en dehors de la région sélectionnée
!¢ L'ancre (point de référence musical de la région)

Si vous ajoutez un fichier audio dans la fenêtre Audio, Logic 
créera automatiquement une région englobant la totalité du 
fichier.

Vous pouvez créer autant de régions que vous le voulez à partir 
du même fichier audio sans limite aucune en terme de durée, 
dans la mesure ou la région n'excède pas la longueur du fichier 
audio source.

Les régions peuvent être déplacées à l'aide de la souris dans la 
fenêtre Arrange. Le fichier Audio est alors joué à la position 
souhaitée dans le song.

7.1 Mise en forme de l'affichage
Dans la partie gauche de la fenêtre il y a une Colonne. Dans 
celle-ci se trouvent, en haut les boutons de mode, en bas la 
boite à outils dont les fonctions sont décrites ci-après.

La colonne de droitepropose la liste de tous les fichiers audio et 
leurs régions par noms.

D’avantage sur la droite, les formes d'onde des régions sont affi-
chées graphiquement dans le large espace blanc de la fenêtre. 
Une région est affichée dans une boite noire ou en couleur, 
tandis que le reste de la forme d'onde est affichée en gris clair, 
indiquant que cette partie de fichier audio n'est pas utilisée par 
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Fonctions de zoom
Les deux  «longue-vues» en haut à droite, juste en dessous de 
la barre de titre, peuvent être utilisées pour  redimensionner 
l'affichage (fonction de zoom).

vous pouvez utiliser la «longue-vue» de gauche pour étendre 
ou rétrécir verticalement l'affichage de la taille de la forme 
d'onde de la région. 

La longue-vue de droite permet d'étendre ou de rétrécir hori-
zontalement la taille de l'affichage en modifiant l'échelle 
temporelle des régions .

Les boutons de mode
Les boutons de mode vous permettent de commuter entre  
différents modes de réaction du programme. Ils affectent à la 
fois l'affichage et la relecture des informations dans la fenêtre 
Audio.

Link (Mode lié)
Le mode lié dans la fenêtre Audio signifie que quelle que soit 
la région audio sélectionnée dans la fenêtre Arrange la même 
région est automatiquement sélectionnée et visualisée dans la 
fenêtre Audio. 

Vous pouvez commuter ce mode en cliquant sur le bouton 
symbolisé par une chaîne (le bouton link).

Les «régions cachées»  ne peuvent être affichées en mode 
«lié».   Si vous désirez les voir, vous devez ‹Montrer› les regions 
(voir paragraphe «Masquer et montrer les Régions» à la page 7 
- 6).

Monitoring
7 - 4
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pendante de la relation temporelle imposée par le séquenceur. 
Il existe plusieurs méthodes pour écouter ces régions:

Ecouter à partir d'une position précise

Cliquer dans une région avec la souris au point de la forme 
d'onde à partir duquel vous voulez l'écouter et maintenez la 
souris enfoncée. La lecture commence immédiatement à partir 
de ce point. Vous pouvez ainsi accéder directement à n'importe 
quel segment de votre fichier audio.

La lecture s'arrête dès que vous relâchez la souris.

Jouer la région entière

Si vous voulez jouez une région dans sa totalité, sélectionnez-là 
en cliquant son nom dans la liste. Cliquez à présent sur le 
bouton représentant un haut-parleur pour faire démarrer la 
lecture. Cliquer à nouveau sur ce bouton pour arrêter la lecture.

De la même façon que vous utilisez la souris, vous pouvez utili-
ser la commandes clavier ‹Play/Stop Region›.

Lecture Stéréo 

Si une région en provenance d'un fichier audio stéréo est sélec-
tionnée, cliquer sur  le bouton haut-parleur  permet de jouer les 
deux voies du fichier stéréo. Néanmoins, si vous cliquez en 
maintenant enfoncé ç ou S,seule la région mono sélection-
née sera jouée. Si vous sélectionnez de nouveau une région pro-
venant d'un autre fichier audio stéréo, Logic retourne au mode 
de lecture stéréo précédant.

Bouclage d’une région (cycle)
Les régions peuvent être bouclées de façon continue durant le 
monitoring.   Pour commuter le mode cycle, cliquez sur le 
bouton cycle (identifié par deux flèches en cercle). Ce mode 
7 - 5
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s'applique à toutes les régions définies dans la fenêtre Audio.

Ce bouclage n'affecte que la pré-écoute à partir de la fenêtre 
audio, et ne change aucunement le séquencement déterminé 

Note
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par l'Arrange. Il ne doit pas être confondu avec la fonction cycle 
de la fenêtre Arrange.

Vous pouvez ajuster les points de début de fin de la région 
pendant que celle-ci est écoutée en boucle. C'est particulière-
ment utile pour déterminer précisément la longueur de la 
région, par exemple pour ajuster très précisément une boucle 
de batterie.

Choisir la sortie Audio pour la pré-écoute
Le routage de sortie des signaux Audio est en général défini 
dans la programmation des objets Audio et leur assignation aux 
pistes dans l'Arrange.

Cependant, vous pouvez définir un canal d'écoute particulier 
pour le monitoring dans la fenêtre Audio. Choisissez un canal 
de sortie dans le bouton Cha situé au-dessous du bouton de 
monitoring.

7.2 Affichage

La liste Audio
La liste de tous les fichiers et régions (dite Audio List) donne 
une vue générale de tous les fichiers audio utilisés dans le song, 
ainsi que des régions qui y ont été définies. C'est là que les 
fichiers Audio peuvent être ajoutés, retirés, effacés ou renom-
més. C'est également là qu'il est possible d'ajouter, supprimer 
voir renommer des régions.

Masquer et montrer les Régions
Dès que vous ajoutez un fichier audio à l'Audio List, son nom 
apparaît en caractères larges. Cela ne prend pas une place 
7 - 6
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fichiers présents. Un petit triangle est affiché à gauche du nom 
du fichier 1.
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3-09 RegFolder

En cliquant sur le petit triangle 2 derrière le fichier audio, vous 
révélez l'affichage de toutes les régions définies dans ce fichier. 
Exactement comme dans le Windows explorer, vous affichez 
ainsi le «contenu» du fichier audio. Le petit triangle pointe 
alors vers le bas et les régions sont affichées en petits caractères. 
Cliquez le triangle de nouveau pour revenir à l'affichage simple 
du fichier audio.

Vous pouvez également maintenir enfoncée la touche ç tout 
en cliquant sur le triangle afin d'activer/désactiver l'affichage de 
l'ensemble des régions.

Activer l'affichage de toutes les régions

En choisissant View > Show All Regions, vous activez instanta-
nément l'affichage de toutes les régions de tous les fichiers 
audio présents dans la fenêtre Audio.

Hiding the Display of all Regions

En choisissant View > Hide all Regions vous désactivez instan-
tanément l'affichage de toutes les régions de tous les fichiers 
audio présents dans la fenêtre Audio.

Si vous souhaitez voir le contenu d'un seul et unique fichier, 
alors cliquez simplement le petit triangle à gauche du nom du 
fichier.

1 2
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Afficher la longueur des régions
La longueur des régions peut être affichée sous différents 
formats.

Choisissez View > Show Length as…. Le niveau le plus bas de 
cette arborescence vous permet de choisir l'unité pour l'affi-
chage de la longueur de toutes les régions.

Show Length as… > None

Pas d'affichage de longueur.

Show Length as… > Min:Sec:Ms

Longueur absolue de la région en heures, minutes, secondes et 
millisecondes. La région, dans l'exemple, a une longueur de 
779 ms.

Show Length as… > Samples

Nombre de mots d'échantillonnage dans la région.

Show Length as… > SMPTE Time

Longueur en unités SMPTE, qui, contrairement au temps 
absolu, donne la valeur en images et bits au lieu de millisecon-
des.

Show Length as… > Bars/Beats…

La région est affichée en unités musicales: Mesures: pulsation: 
division et pas d'horloge.

Si le tempo, la signature ou les «divisions» sont modifiées, la 
longueur est immédiatement recalculée.
7 - 8
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Afficher les informations à propos des fichiers 
Audio
Les informations relatives à tous les fichiers ouverts de la fenê-
tre Audio peuvent être affichées de gauche à droite dans la 
forme d'onde de la région sous la forme:

Fréquence d'échantillonnage (Hz), taille (kByte) et chemin 
d'accès ou répertoire.

Cet affichage peut être activé ou désactivé en choisissant View 
> Show File Info.

Trier les fichiers audio
Les fichiers audio peuvent être triés selon divers critères par la 
fonction View > Files sorted by…:

Files sorted by… > None

Les fichiers apparaissent dans l'ordre où ils ont étes ajoutés ou 
enregistrés.

Files sorted by… > Name

Les fichiers sont triés par nom dans l'ordre alphabétique.

Files sorted by… > Size

Les fichiers sont triés par taille décroissante.

Files sorted by… > Drive

Les fichiers sont triés selon leur chemin d'accès (disque dur, 
disque amovible, partition)..
7 - 9
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Tri des régions
Les régions peuvent apparaître triées dans un fichier audio, 
selon un certain nombre de critères, grâce à la fonction View > 
Sort Regions by…

Sort Regions by… > Start

Les régions sont triées dans l'ordre temporel de leur point de 
départ. C'est la position par défaut.

Sort Regions by… > Length

Les régions sont triées selon leur longueur.

Sort Regions by… > Name

Les régions sont triées selon leur nom, dans l'ordre alphabéti-
que.

Affichage de la forme d’onde en dehors de 
la région
Logic Audio est configuré par défaut de sorte que la partie de la 
forme d'onde à l'extérieur de la région apparaisse en gris clair.

Vous pouvez modifier le mode d'affichage en maintenant la 
touche ç enfoncée lorsque vous cliquez dans une région. Le 
fait de maintenir enfoncé le bouton de la souris fait apparaître 
un menu dans lequel vous pouvez choisir l'une des options 
suivantes:

None

La partie extérieure à la région n'est pas affichée.

Bright

La partie extérieure à la région est affichée en gris clair.
7 - 10
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Dark

La partie extérieure à la région est affichée en gris sombre.

Calcul de la vue générale de l’onde
En plus  des données purement audio, un fichier audio contient 
également des données nécessaires à l'affichage de la forme 
d'onde dans la fenêtre audio et dans le Sample Editor (données 
‹Overview›).

Calcul automatique de la vue générale de l’onde

Si l’option Create Overviews after recording est activée dans File > 
Preferences > Audio, la vue générale de l’onde est automati-
quement calculée après l’enregistrement audio.

Si vous n’utilisez pas cette option, la vue générale de l’onde 
n’est pas automatiquement calculée. Cependant vous pouvez 
déclencher son calcul manuellement.

Déclenchement manuel du calcul de la vue générale de l’onde 

Parfois, lorsque vous ouvrez/importez un fichier audio, il vous 
faut déclencher manuellement le calcul de la vue générale de 
l’onde si le fichier audio  ne contient aucune donnée de vue 

1

2
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Contrôler le calcul de la vue générale de l’onde
Le calcul des données de vue générale d’onde pour un fichier 
audio apparaît dans une fenêtre flottante.  Ce calcul est opéré 
en tache de fond, ce qui vous permet de continuer de travailler 
avec Logic.

YVous pouvez positionner cette fenêtre flottante où vous le 
voulez. La dernière position est sauvegardée dans les préféren-
ces.

Un double-clic sur cette fenêtre fait apparaître la boite de dialo-
gue suivante:

Si vous stoppez le calcul en cliquant sur Abort, vous pouvez tout 
de même faire jouer le fichier audio. Toutefois, gardez en 
mémoire que sans vue générale d’onde il ne sera pas facile 
d’éditer l’audio.

Continue permet de reprendre le calcul de la vue générale de 
l’onde en tache de fond comme à l’accoutumé.

Cliquer sur Finish permet de transférer le calcul au «premier 
plan» et par conséquent d’en accélérer considérablement le 
rendu. L’inconvénient est que vous ne pouvez plus utiliser 
l’ordinateur à d’autre fin tant que le calcul est en cour.
7 - 12
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7.3 Utilisation

Techniques de sélection
Il y a plusieurs manières de sélectionner des fichiers audio ou 
des régions dans la fenêtre Audio.

Pour sélectionner un élément unique, cliquez sur son nom dans 
l'Audio liste ou directement sur sa forme d'onde.

SI vous maintenez la touche S aenfoncée vous pourrez ajouter 
d'autres éléments à la sélection, même s’ils sont éparpillés à 
travers la fenêtre. Dans l'Audio liste, vous pouvez aussi utiliser 
la technique de la sélection par ‹rubberband› (lasso, ou encore 
rectangle de sélection).

Pour tout sélectionner, choisissez la fonction Edit > Select All 
(ça).

Fichiers Audio

Selection du fichier suivant

La commande clavier Select Next Audio File sélectionne le fichier 
suivant dans l'audio list.

Sélection du fichier précédent

La commande clavier Select Previous Audio File sélectionne le 
fichier précédent dans l'Audio liste.

Les fichiers audio et les régions

Sélection des régions utilisées 

Lorsque vous choisissez Edit > Select used, toutes les régions et 
tous les fichiers audio utilisées dans l'arrangement sont sélec-
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Sélection des régions inutilisées

Choisir Edit > Select unused permet la sélection de tous fichiers 
audio et régions qui ne sont pas utilisés dans l'arrangement du 
morceau en cours.

Par exemple vous pouvez utiliser cette fonction à la fin d'une 
production dans le but d'effacer tous les éléments inutilisés 
(B).

Commandes d'édition
Toutes les commandes standard d'édition sont utilisables dans 
la fenêtre Audio. Comme toujours, elle s'appliquent à la sélec-
tion courante (fichiers ou régions). 

Les commandes Cut, Copy et Paste ne servent que pour 
l'échange de fichiers entre deux songs différents. Un fichier 
audio ne peut apparaître qu'une fois dans l’Audio List et de ce 
fait ne peut être copié en dehors d'un song. Pour savoir 
comment copier physiquement un fichier audio sur le disque 
dur, référez vous au paragraphe «Copier les fichiers audio» à la 
page 7 - 29.

Couper (Cut)

Les fichiers ou régions sélectionnés sont enlevés de la fenêtre 
Audio puis copiés dans le presse-papiers. raccourçi clavier: 
çx.

Copier (copy)

Les fichiers ou régions sélectionnés sont copiés dans le presse-
papiers, mais leur originaux demeurent dans la fenêtre Audio. 
Raccourci clavier: çc.

Coller (Paste)

Le contenu du presse-papiers est ajouté à la fenêtre Audio 
7 - 14
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Effacer (Clear)

Tous les fichiers audio et régions sélectionnés sont effacés. Cela 
revient à appuyer sur B.

N'oubliez pas: les commandes Cut ou Clear ne suppriment pas 
le fichier du disque dur. Elles ne font que l'enlever de la fenêtre 
Audio du song en cours.

Si certaines régions provenant d’un fichier audio dans la fenêtre 
Arrange sont déjà utilisées comme séquences audio, ces 
séquences seront également effacées de la fenêtre Arrange.

Pour effacer définitivement des fichiers audio du disque dur, 
choisissez la fonction File > Delete File(s).

Undo

Rétablit la précédente action (raccourci clavier: çz). Vous 
devez utiliser cette fonction si vous souhaitez rétablir l'état 
précédent à la dernière commande.

Toutes les actions ne peuvent pas être rétablies en utilisant la 
commande Undo. Si vous sélectionnez une fonction qui ne peut 
être annulée, vous en serez averti par un message avant de 
pouvoir l'exécuter.

Regions

Créer une région
Sélectionner le fichier audio désiré et choisissez File > Add 
Region. .  La nouvelle région apparaîtra dans la liste des régions, 
à la suite de celles déjà existantes.

Copier une région

Si vous sélectionnez une région déjà existante et que vous exé-
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cutez la fonction Add Region, une autre région est créée dont les 
caractéristiques (point de départ de fin et ancre) sont exacte-
ment les mêmes que celles de la région sélectionnée.
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Supprimer une région
Vous pouvez utiliser l’outil gomme pour supprimer une ou 
plusieurs régions. Si une de ces régions existe dans la fenêtre 
Arrange, elle en sera également supprimée. Il est souhaitable, 
par conséquent, de manipuler cette fonction avec précaution. 
Cependant la fonction Undo est toujours disponible si vous 
supprimez par inadvertance une région utile..

Vous pouvez également effacer n'importe quelle région sélec-
tionnée à l'aide de la touche B.

Modifier les limites d’une région
Vous pouvez changer directement les limites d’une région dans 
l’affichage graphique en utilisant l’outil d’édition graphique de 
régions (doigt).

Vous pouvez également utiliser l’outil de pointage standard. 
Assurez- vous seulement de bien attraper la région par son tiers 
inférieur avant de procéder aux opérations suivantes:

Déplacer le point de départ

Attraper le coin inférieur gauche.  Vous pouvez maintenant 
ajuster le point de départ.

Déplacer le point de fin

Attraper le coin inférieur droit.  Vous pouvez maintenant ajuster 
le point de fin.

Déplacer la région entière

Vous pouvez également déplacer la région entière en l’attrapant 
en son milieu. L’outil se transforme en une Double flèche hori-
zontale. Si la région est très courte, utiliser les fonctions de 
zoom afin d’élargir l’affichage. Assurez-vous de bien voir les 
deux flèches avant toute intervention.
7 - 16
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Cela s’applique aussi bien au point de départ, au point de fin, 
qu’à la région entière.

Déplacer l’ancre
Pour déplacer l’ancre, attrapez le petit triangle noir situé sous le 
cadre de région. Une Ligne guide apparaît au dessus du triangle 
d’ancre. 

Dans les séquences audio de l’arrange, l’ancre est marquée par 
une ligne pointillé verticale.

Se déplacer jusqu’aux Zero Crossings
Si Edit > Search Zero Crossings est activé, le déplacement des 
points de début et de fin d’une région ne peut se faire que sur 
les points où le signal passe par zéro, pour éviter une «saute» 
audible (ou click) lors de la lecture. Pour le point de début, c’est 
le point de passage antérieur qui est recherché, pour le point de 
fin, c’est le point de passage postérieur. Cette option est très 
utile pour définir des régions dans un fichier audio.

Noter que Search Zero Crossings s’applique à toutes les opéra-
tions dans la fenêtre Arrange.

Déplacement précis
L’affichage graphique dans la fenêtre Audio est géré de façon à 
fournir une vue rapide et complète des fichiers et régions. Cela 
implique que des concessions ont dûes être faites quant à la 
résolution. La résolution de déplacement dans la fenêtre Audio 
est limitée à des pas de 256 échantillons. C’est en général suffi-
sant, surtout si l’option de recherche de passage par zéro est 
activée.

Cependant, vous aurez parfois besoin de procéder à des ajuste-
ments à l’échantillon près. C’est particulièrement vrai pour les 
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boucles de batterie. La fenêtre Sample Editor est plus adaptée à 
ce travail. Pour ouvrir celle-ci, double-cliquez dans une région.
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Protection des paramètres de région
Les régions peuvent être ‹vérouillées›, afin de les protéger 
contre d’éventuelles modifications des points de départ, de fin 
ou de position de l’ancre. Le petit cadenas se trouvant à coté de 
chaque région peut être ouvert ou fermé par simple clic. Si la 
région est verrouillée, vous pouvez la jouer mais pas l’éditer.

 Une région verrouillée peut toujours être effacée.

Renommer des fichiers audio ou des régions
Pour renommer des fichiers ou des régions dans la fenêtre 
Audio, double-cliquez sur leur nom dans l’Audio liste. Une 
boite d’entrée de texte apparaît où vous pouvez éditez le nom.

Avant de renommer des fichiers audio le message d’alerte 
suivant apparaît: 

Keep in mind other songs may use the same file! Do you still 
want to rename the file?

YVous feriez mieux de vérifier que les fichiers audio que vous 
voulez renommer sont utilisés par d’autres songs. Si c’est le cas, 
ne les renommer pas. Les autres songs ne pourraient plus ni 
trouver ni  jouer ces fichiers! 

Logic peut vous venir en aide dans pareil cas:

• LA Pro ISIS change le nom du fichier audio dans toutes les 
songs ouverts qu’il utilise.

• LA Pro ISIS assigne automatiquement le nouveau nom à 
n’importe quel fichier stéréo SDII connecté au fichier 
renommé et sera enregistré à la même place dans le même 
disque (et sous le même nom). .
7 - 18
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Si vous renommez un fichier stéréo, Logic assigne automati-
quement ce nouveau nom à (jusqu’à) cinq fichiers (les deux 
fichiers mono dans Logic, leurs fichiers de sauvegarde et le 
fichier stéréo).  Il est conseillé de tous les enregistrer sous le 
même chemin d’accès (reportez vous à la section traitant des 
déplacements de fichiers).

Vous pouvez renommer les régions à n’importe quel moment.

Si les régions sont nommées par rapport au nom du fichier 
audio, le nouveau nom du fichier audio est reporté dans toutes 
les régions qui y sont associés.

Ajouter une région à l’arrangement
Pour ajouter une région à l’arrangement d’un song, glissez sa 
représentation graphique dans la fenêtre Arrange afin de créer 
une séquence audio. 

D’Abord sélectionnez la piste souhaitée dans la fenêtre Arrange 
et déplacez la ligne de position du song jusqu’à l’endroit ou vous 
désirez créer une séquence audio.

Dans la fenêtre Audio, attrapez la représentation graphique de 
la région par son milieu et glissez-la dans la fenêtre Arrange. Si 
vous souhaitez insérer un fichier stéréo splitté, utilisez la région 
de gauche (celle qui se trouve en haut).

Ne vous inquiétez pas si la région est jouée. La pré-écoute sera 
arrêtée aussi tôt que vous déplacerez la souris en dehors de la 
fenêtre Audio. Vous pouvez prévenir cela en utilisant l’outil de 
déplacement (la petite main ouverte), ou en saisissant le nom 
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de la région dans l’Audio List puis en le glissant dans l’arrange-
ment. 

.

03-45 MinSilence
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03-49 StripStripStrip

7.4 Gestion de fichier

Fichier d’enregistrement

Définition du chemin d’accès
Chaque enregistrement dans la fenêtre Arrange crée un 
nouveau fichier audio. Pour garder une vue d’ensemble sur vos 
enregistrements, vous devez indiquer à Logic où les données 
devront être enregistrées avant le premier enregistrement.

2

1
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Vous pouvez également définir un nom générique par défaut 
pour tous les fichiers audio nouvellement crées que Logic peut 
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constamment utiliser en lui ajoutant une indexation pour 
chaque fichier nouvellement constitué.

Le chemin d’accès (dossier) pour les enregistrements audio 
peut être défini indépendamment pour chaque song.  Vous 
pouvez également avoir différents chemins d’accès pour 
chacun de vos hardwares tournant en même temps.

Pour ouvrir la boîte de dialogue pour ces réglages, ouvrez la 
fenêtre audio et choisissez File > Set Record Path… ou ouvrez 
le menu record (Cliquer Maintenez le bouton record de la boite 
de transport):

Use Audio Object Name for File Name

Si cette option est activée, le nom de l’objet audio est utilisé 
comme nom de fichier pour l’enregistrement.

Pre-Allocate Recording Files

Si cette option est activée, Logic crée le fichier audio pour 
l’enregistrement suivant après que vous ayez armé la piste en 
mode enregistrement. De plus, à la fin de chaque enregistre-
ment, le fichier audio pour l’enregistrement suivant est immé-
diatement créé, cela vous permet de lancer des enregistre-
ments audio plus rapidement.

Les fichiers d’enregistrement inutilisés sont supprimés lorsque 
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Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

vous quittez Logic.



Chapitre 7
La Fenêtre Audio

Maximum Recording Time (Recommended): xxx Minutes

Ce paramètre définit le temps maximum autorisé pour un 
nouvel enregistrement en minutes et détermine par consé-
quent la taille du fichier d’enregistrement temporaire.

Vous pouvez désactiver cette option. Dans ce cas, un fichier 
d’enregistrement aussi grand que l’espace libre sur le disque 
dûr sera crée.

Inconvénients:

• Le fichier audio peut être fortement fragmenté, si le temps 
d’enregistrement réel est moins important que la valeur 
maximale disponible.

Il est fortement recommandé d’activer cette option et de régler 
une limite pour le temps d’enregistrement.

S’il n’y a pas assez d’espace de stockage disponible, la longueur 
maximum d’enregistrement est temporairement réduite. 
Pendant l’enregistrement, vous pouvez voir le temps restant 
dans la fenêtre flottante record (avec la barre rouge).

Global Record Path / Song Record Path

Le global Record Path (chemin d’accès genéral d’enregistre-
ment) était déjà disponible dans les précédentes versions. Il est 
stocké dans les préférences et s’applique à tous les songs. 
L’avantage est que vous n’avez pas besoin de définir un chemin 
d’accès pour chaque nouveau song avant de commencer l ‘enre-
gistrement, en supposant que vous vouliez enregistrer en 
permanence dans le même dossier.

Le chemin d’accès permet d’organiser vos enregistrements 
audio pour chaque song dans un dossier unique. L’avantage, ici, 
est que lorsque vous changez de song, tous les nouveaux enre-
gistrements sont automatiquement sauvegardés dans le dossier 
choisi, sans pour autant avoir à redéterminer le chemin à la 
7 - 24
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Set

Ces boutons peuvent être utilisés pour définir le chemin pour 
chaque hardware du système. Vous pouvez créer un nouveau 
dossier (si nécessaire) dans la boite de dialogue.

À droite, vous voyez le drivesélectionné et la capacité restante 
(uniquement si le drive est enregistré).

Si vous cliquez et maintenez le bouton de la souris sur le 
drive,le chemin complet est affiché. Vous pouvez ainsi voir 
exactement dans quel dossier vous allez enregistrer.

Voici un exemple illustrant cette procédure:

Il est préférable d’enregistrer tous les fichiers d’une session 
dans le même dossier. Supposons que le song que nous allons 
travailler s’appelle ‹Morning Light›.

• Choisissez File > Set Record Path.

• Créez un nouveau dossier en cliquant sur le symbole 
‹dossier›dans la boite de sélection.

• Appelez ce dossier d’un nom tel que ‹Morning Light Audio› 
et cliquez sur Open.

• A présent, entrez le nom par défaut des fichiers audio. C’est 
une bonne idée d’attribuer un nom rappelant le song et le 
type d’enregistrement. Si vous enregistrez des voix pour la 
chanson ‹Morning Light› Vous pourriez appeler celles-ci 
disons ‹Morning LeadVoc› .

• Cliquez ensuite sur Store

Pour tout nouvel enregistrement, un nombre d’index est 
rajouté après le nom.Par exemple:

Morning LeadVoc.#01

Morning LeadVoc.#02
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Morning LeadVoc.#03 …

Vous pouvez modifier le chemin d’accès et le nom quand vous 
le souhaitez en rappelant la fonction Set Record Path .
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Supposons maintenant que vous vouliez enregistrer les guitares 
de votre song ‹Morning Light›. Entrez alors un nom comme 
‹Morning LeadGuit›.

Lorsque vous choisissez un chemin d’accès, 
rappelez vous…
• Si le volume sélectionné comme chemin d’accès est inacces-

sible ou inexistant, celui-ci est effacé.

• Si vous renommez le drive, LA Pro ISIS ne pourra plus le 
trouver.

Lorsque vous déterminez le temps maximal d’enre-
gistrement, souvenez vous…

Important: l’affichage des mémoires restantes et du temps 
maximal d’enregistrement utilisé pour l’enregistrement 
dépend des facteurs suivants:

• Le nombre de pistes à enregistrer simultanément.

• La fréquence d’échantillonnage.

Si vous démarrez Logic pour la première fois, cette affichage 
correspond par défaut à l’enregistrement d’une seule piste 
mono.

Après chaque nouvel enregistrement, Logic «rend» la mémoire 
inutilisée pour le prochain enregistrement.

Il est toujours sage de choisir une valeur aussi juste que possi-
ble. Autrement, après le premier enregistrement, vous risquez 
de ne plus avoir de place sur le volume pour continuer, ce qui 
vous obligera à réduire la valeur.

Si vous définissez un temps trop long, ou que vous multipliez le 
nombre de pistes ou augmentez la fréquence d’échantillon-
nage, jusqu’à ne plus avoir de place sur votre disque dur, Logic 
vous en avisera d’abord par un message d’alerte.
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Ajout de fichiers Audio
Si vous voulez ajouter un fichier audio à votre song en cours 
depuis votre disque dûr, activez la fonction File > Add Audio 
File.

Une boite de sélection apparaît ou vous pouvez choisir votre 
fichier audio.

All Files

‹All Files› montre tous les types de fichiers ‹xxx.wal›, ‹xxx.war› 
et ‹xxx.wav› simultanément.

Cliquez sur Cancel dans la boite de sélection de fichiers lorsque 
vous avez fait votre choix.

Le nom du fichier sera dès lors listé dans la fenêtre Audio.

Ajout de fichiers audio provenant d’un CD
Si des fichiers audio ont été rajoutés depuis un CD ou autre 
volume protégé, Logic vous demande un emplacement où 
copier ces fichiers sur le disque dur.

Supprimer des fichiers audio
Pour supprimer des fichiers audio de la song en cours, sélection-
nez son nom dans la fenêtre Audio et pressez B. Cela n’efface 
pas les fichiers du disque dur.

Créer des fichiers audio
Normalement les fichiers audio sont créés en enregistrant un 
signal. Après un mixdown digital de plusieurs régions dans la 
fenêtre Arrange un nouveau fichier audio est également créé 
(voir le paragraphe «Mix down numérique» à la page 4 - 22).
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Effacer des fichiers audio
En théorie les fichiers audio sont visualisés et organisés par le 
sytème d’exploitation de Windows exactement de la même 
façon que les autres fichiers Windows . Vous pouvez de ce fait 
les effacer ou les copier dans  Windows Explorer. Cependant, il 
y a des désaventages:

• Si vous effacez un fichier audio, vous ne saurez plus s’il est 
utilisé par un song.

• Si vous effacez accidentellement un fichier audio, Logic 
vous avertira lorsque vous lancez le song. De plus, certains 
éléments de la fenêtre Audio, ainsi que les séquences audio 
dans la fenêtre Arrange, se référant à ce fichier manquant, 
sont devenus «orphelins».  Vous n’aurez plus une vision très 
exacte du song.

Pour cette raison, il est préférable d’effacer les fichiers audio 
redondants dans la fenêtre Audio. D’abord, sélectionnez ceux 
que vous souhaitez effacer. Soyez prudent parce qu’une fois 
que c’est fait, il n’est plus question de revenir en arrière. La 
fonction Undo est inopérante.

Choisissez File > Delete File(s). Vous verrez un message d’alerte 
qui vous informe du nombre de fichiers que vous êtes sur le 
point d’effacer.
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Cliquez sur Cancel pour mettre fin au processus, ou cliquez sur 
Delete pour effacer définitivement les fichiers audio concernés.

À ce stade, assurez-vous que les fichiers que vous êtes sur le 
point d’effacer ne sont pas utilisés par un autre song.

Faire des copies de sauvegarde
La fonction File > Backup File(s) permet l’enregistrement des 
fichiers sélectionnés à la même place sur le disque dur (en ajou-
tant l’extension ‹dup›).

N’oubliez pas la fonction backup (copie de sauvegarde) disponi-
ble dans la fenêtre d’édition de sample.

Copier les fichiers audio
La fonction File > Copy File(s) permet la copie des fichiers à un 
autre endroit sur votre disque dur (ou tout autre média de stoc-
kage). Lorsque vous copiez un fichier vous pouvez lui attribuer 
un nouveau nom dans la boite de sélection de fichiers (la même 
chose est obtenue via la commande ‹Save A Copy As…›.

Logic vérifie que la place est bien disponible pour la copie à la 
destination demandée.  S’il y a déjà un fichier portant le même 
nom, Logic vous demande si vous souhaitez le remplacer. 
Logic vous donne également la possibilité de remplacer le 
fichier audio dans le song en cours avec la copie que vous venez 
de faire.

Déplacer les fichiers audio
La fonction File > Move File(s) Vous permet de déplacer des 
fichiers audio sur votre disque dur, contrairement à  la fonction 
copy le  fichier source disparaît alors.

Si les disques/partitions de départ et d’arrivée sont identiques, 
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les fichiers sont simplement déplacés vers le dossier de destina-
tion. C’est une méthode très rapide pour réorganiser votre 
production.
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Activez la fonction ‹Select Used› depuis la fenêtre Audio (cela 
sélectionne tous les fichiers utilisés dans la fenêtre Arrange), et 
déplacez-les vers un nouveau dossier. Ce dossier ne contiendra 
donc plus que les fichiers associés à votre Song.

Faites très attention en utilisant cette fonction: les fichiers 
déplacés peuvent être utilisés par un autre song qui ne connaîtra 
pas le nouveau chemin d’accès.

LA Pro ISIS sait réactualiser les informations sur le chemin 
d’accès des fichiers déplacés dans tous les songs ouvertes. Par 
conséquent, afin d’éviter tout problème, il sera préférable 
d’ouvrir tous les songs  utilisant  le ou les fichiers que vous venez 
de déplacer. Puis déplacez les fichiers vers le nouvel emplace-
ment, et sauvegardez toutes les songs ouvertes pour conserver 
les références de stockage.

Fonctions particulières au format stéréo
La structure interne d’un système «direct to disc» est telle que 
chaque piste audio peut être traitée indépendamment. De ce 
fait un fichier audio séparé est créé pour chaque piste.

LA Pro ISIS peut enregistrer les fichiers audio stéréo de deux 
façons distinctes . La première est de «coupler» deux pistes 
mono, par conséquent deux fichiers audio; c’est le format dit 
«splitté». 

Certains programmes, (en particulier pour le mastering) créent 
des fichiers contenant les deux canaux d’un enregistrement. Ils 
sont composés d’une séquence de petit groupe de données pro-
venant en alternance des deux canaux. Ce type de fichier à pour 
nom générique: fichier stéréo entrelacé  (interleaved stereo for-
mat) . Logic 3.6 (à l’opposé des précédentes versions) peut 
maintenant enregistrer directement au format entrelacé, don-
nant à ces fichiers une compatibilité directe avec les autres pro-
grammes de mastering ou de gravage de CD.
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Fonctions particulières aux fichiers stéréo «splittés»
Il y a plusieurs fonctions destinées au traitement particulier des 
fichiers stéréo «splitté»:

• Dans la boite de sélection de fichiers, les fichiers stéréo 
«splittés» sont traités comme un fichier unique bien que 
strictement parlant ils soient indépendants .

• Dans l’audio list vous pouvez voir chacun d’eux. Ils ont le 
même nom sauf pour les extensions de fichier(.WAL) 
et(.WAR). Si vous renommez un des deux canaux d’un 
fichier stéréo, le fichier de l’autre canal est immédiatement 
renommé.

• Leurs régions peuvent être également renommées.

• Si vous utilisez la commande ‹Add Region› pour créer une 
nouvelle région, Logic le fera pour les deux fichiers audio 
qui y sont rattachés.

• Toute modification pratiquée sur l’une des régions est auto-
matiquement appliquée à l’autre région. Cela s’applique au 
point de début, de fin, comme à la position de l’ancre.

• Si l’une des deux régions est déplacée vers la fenêtre 
Arrange pour créer une séquence audio, l’autre région est 
déplacée de concert.

Conversion stéréo manuelle

Convertir en WAV Stéréo

Cette commande a pour effet de convertir deux (stéréo 
«splitté») fichiers audio en un seul fichier stéréo au format WAV 
. C’est utile si vous voulez éditer un fichier stéréo utilisant un 
autre programme, par exemple pour du mastering de CD .

Sélectionnez les fichiers audio et choisissez File > Convert to 
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WAVStereo. . Si ces fichiers sont «splittés», ils seront automati-
quement convertis.
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LA Pro ISIS enregistre automatiquement les fichiers WAV à la 
même place que les fichiers mono originaux (pourvu qu’il y ait 
assez de place sur le disque).

Conversion de format de fichiers audio
Lorsque vous utilisez la fonction File > Copy Files(s)…, vous 
pouvez définir le format de destination du fichier. Choisissez le 
format dans la boite de sélection de fichiers.

Tous les fichiers audio peuvent être copiés dans n’importe quel 
format de fichiers suivants:

…Original Type: Le format original est utilisé (WAV).

…AIFF File: les copies sont au format AIFF.

Echanger des fichiers audio entre Mac et PC
Macintosh convertit automatiquement le nom des fichiers 
longs de MacOS en nom de fichiers courts DOS 
(‹12345678.WAV›). Si un conflit de nom apparaît, Logic ne sup-
prime pas simplement le nom mais place une lettre à la fin.

Exemple:

‹Bass+Drums 1› et ‹Bass+Drums 2›deviendront tous deux 
‹Bass+Dru.WAV›, ce pourquoi Logic assigne automatiquement 
les noms ‹Bass+Dr1.WAV› et ‹Bass+Dr2.WAV›.

Windows 95 autorise les nom de fichiers longs, mais la plupart 
des utilitaires d’échange entre MAC et PC non.(ex. DOS 
Mounter, Formatter 5 et la plupart des programmes Internet).

Pour transférer un song complet de Logic Mac vers Logic Win-
dows, rendez-vous dans la fenêtre Audio et copiez tous les 
fichiers audio dans le  lecteur MS-DOS ou dans le PC net (s’il 
est disponible), en tant que fichier.WAV. Le fichier du song lui-
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LA Pro ISIS Windows reconnaît la song qui a été créée sur Mac 
et cherche un nom de fichier .WAV à la place des originaux 
SDII.

Pour transférer depuis Logic Windows vers Logic Mac, vous 
devez donc exporter les fichiers audio de Windows comme des 
fichiers AIFF (via le lecteur de Mac/HFS). Logic Mac cherche 
alors un nom de fichier AIFF à la place  du nom de fichier .WAV 
qui serait utilisé sur le PC.

Note: store the LA Pro ISIS song file in the same folder as the 
audio files. Then LA Pro ISIS (Mac or Windows) will find the 
audio files immediately after loading.

Autres fonctions impliquant les fichiers 
audio 

Analyse de fragmentation

Réassigner des fichiers audio
Si Logic ne peut trouver un ou plusieurs fichiers audio (par 
exemple quand il ouvre une song), les régions apparaissent 
comme des blocs grisés dans la fenêtre Audio. 

Si les fichiers correspondants existent sous un autre nom ou si 
vous voulez définir un fichier de remplacement. Vous pouvez 
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pratiquer de la façon suivante:
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Double-cliquez la région à réassigner ou sélectionnez la fonc-
tion File > Update File Information. 

Choisissez Locate dans la boite de dialogue et un champ de 
sélection de fichiers apparaît ou vous pouvez charger le fichier 
audio désiré. 

Que faire si Logic ne trouve pas le fichier audio 
Parfois, Logic ne trouve pas le fichier assigné. Cela peut être dû 
au fait que:

• Vous avez déconnecté le disque dur ou en avez changé le 
nom de drive.

• Vous avez enregistré ou déplacé les fichiers dans un autre 
drive.

• Vous avez renommé le fichier dans  Windows Explorer, ou 
les avez renommés dans la fenêtre Audio d’un autre song.

• Vous avez effacé les fichiers.

Dans ce cas, Logic fait apparaître la boite de dialogue suivante:
7 - 34
Emagic
Logic Audio Pro ISIS 

Vous pouvez répondre de chacune des façons suivantes:



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

IxImportant
Autres fonctions

Locate

Le drive courant est utilisé pour la recherche. Si le résultat est 
négatif, Logic vous demande si vous souhaitez poursuivre la 
recherche sur d’autres drives Cela permet de regrouper des 
fichiers audio éparpillés sur plusieurs supports.

Skip

(Ne pas chercher ce fichier). Utilisez cette fonction si vous vous 
souvenez que ce fichier a été effacé ou renommé. Ce bouton se 
transforme en Skip All si après le premier abandon aucun autre 
fichier audio ne peut être trouvé .

Skip All (for Several Files)

(Ne plus chercher les fichiers). Utilisez cette option si vous 
savez que tous les fichiers audio de la song n’existent plus, ou 
ont été renommés.

7.5 Autres fonctions

Enregistrement audio
Vous pouvez rappeler la couche audio de l’environnement par 
le menu option de la fenêtre Audio(Options > Audio Record/
Returns).

Choisir la fréquence d’échantillonnage
Dans le menu Option de la fenêtre Audio, vous pouvez choisir 
l’une des fréquences d’échantillonnage disponibles, par exem-
ple 44.1 kHz ou 48 kHz. (Si vous ne savez pour laquelle opter, 
référez-vous au manuel d’introduction).

Le réglage de la fréquence d’échantillonnage est global et 
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s’applique à la lecture de tous les fichiers audio de la song en 
cours. Il n’est pas possible de jouer simultanément différents 
fichiers audio utilisant différentes fréquences d’échantillon-
nage.
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Si vous avez chargé plusieurs songs, chacune avec des fréquen-
ces d’échantillonnage différentes, Logic peut automatique-
ment en tenir compte lorsque vous passez de l’une à l’autre. 
Chaque song ne doit contenir que des fichiers à la même 
fréquence d’échantillonnage.

Convertir la fréquence d’échantillonnage

LA Pro ISIS peut convertir par calcul la fréquence d’échan-
tillonnage:

• Double-cliquer dans une région pour ouvrir le Sample Editor.

• Appuyez sur ça afin de sélectionner le fichier dans son 
ensemble.

• Choisissez Factory > Sample Rate Convert.

• Entrez la fréquence souhaitée en Hertz (Hz) dans la case 
destination (ex. 44100), et

• Appuyez sur R.

Pour de plus amples détails, lisez le paragraphe «Convertisseur 
de fréquence d’échantillonnage» à la page 9 - 35.
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Audio Driver

Accès aux hardwares Audio utilisant le 
driver
Logic Audio Pro ISIS fonctionne seulement avec la audio hard-
ware «Maxi Studio ISIS». Vous avez accès aux paramètres en 
sélectionnant File > Preferences > Audio Extensions.
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Chapitre 9

La fenêtre Sample 
Edit

La fenêtre de l’éditeur d’échantillon (Sample Edit) offre un 
grand nombre de fonctions propres à modifier ou éditer les 
données d’un fichier audio. L’éditeur d’échantillon vous 
permet d’éditer aussi bien des fichiers mono que stéréo. 

La fonction «zoom» de l’éditeur vous permet d’agrandir une 
portion de l’affichage, et d’ajuster la longueur des régions audio 
avec une parfaite précision. Un même degré de précision peut 
être retenu pour positioner les points d’ancrage.

Ouvrir la fenêtre Sample Edit
Il y a plusieurs façons d’ouvrir la fenêtre d’édition d’échan-
tillon:

• Sélectionner Window > Open Sample Edit.

• Double-cliquer sur la région audio de votre choix, dans la 
fenêtre Arrange; cette manœuvre affiche la région dans 
l’éditeur d’échantillonr.

• Double-cliquer sur la région audio de votre choix, dans la 
fenêtre Audio; cette manœuvre affiche également la région 
dans l’éditeur d’échantillon.

Si aucune région n’est sélectionnée, Logic vous demandera si 
vous voulez charger un nouveau fichier dans la fenêtre Sample 
Edit.

Si vous exploitez une région de format interlacé ou bien la 
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moitié d’une région stéréo «splittée», les deux canaux (ou bien 
les deux fichiers audio) seront affichés dans la fenêtre Sample 
Edit, le canal de gauche en haut, et celui de droite en bas.
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Si vous ouvrez l’éditeur à partir de la fenêtre Arrange, ou bien à 
partir de la fenêtre Audio, la règle de l’éditeur vous permet de 
positionner les régions dans le Song. Le pointeur de position 
vous fournit toutes les informations: une ligne pointillée ne 
vous indique aucune connexion temporelle (fenêtre audio), 
tandis que des tirets vous indiquent une connexion temporelle 
pour la région, employée comme région audio dans la fenêtre 
Arrange.

9.1 Disposition 

1 Vue générale: la forme d’onde du fichier audio est représen-
tée dans sa totalité.

2 Zone de paramètres de la sélection en cours. La valeur des
marqueurs de début et de fin de la sélection y est indiquée.

3 Lorsque la fonction Catch (symbolisée par un homme en

5

6

7

!≠
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4 L’échelle d’amplitude (Affichée en pourcentage, ou en va-
leur décimales 16-bit). 

5 Le cadre en pointillé rend compte de la sélection de la for-
me d’onde présentée dans la zone d’affichage détaillé de
l’éditeur.

6 Vue détaillée de la forme d’onde.
7 Ligne de position de la LPP (également visible dans la vue

d’ensemble).
8 Fonction zoom (longue vue): permet l’agrandissement

d’une partie de la forme d’onde, dans la zone d’affichage
détaillé.

9 La règle de temps horizontale affiche, en haut à gauche, le
nom de la région éditée. En dessous du libellé figure
l’échelle de temps, dont les formats sont variables. 

!≠ Le point initial, l’ancrage et le point final peuvent être mo-
difiés par simple «presser-glisser».

9.2 Affichage

Vue générale
Entre la barre de titre de la fenêtre de l’éditeur et la règle de 
temps, se trouve la zone de vue générale (‹Overview›). Cette 
zone, quel que soit le facteur d’agrandissement appliqué par le 
zoom, affiche en permanence la totalité du fichier audio en 
cours: Attention, la vue générale n’indique aucun ordre de 
grandeur. Un son de grosse caisse d’une durée de 0,3 seconde 
occupera le même espace qu’un extrait de chorale d’une durée 
de 3 minutes.

Pendant la lecture, la position de la LPP est indiquée en 
permanence par une ligne verticale se déplaçant en temps réel. 
Cette ligne s’affiche aussi bien dans la vue générale que dans la 
vue détaillée.
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La portion d’onde affichée dans la vue de détail, est signalée 
dans la vue générale par un rectangle en pointillé.

La vue générale: le cadre en pointillé 1 indique la portion 
contenue dans la vue détaillée. Une partie de la sélection en 
cours 2 est également visible dans la vue détaillée.

Fonctions de la vue générale
Un clic rapide, dans la vue d’ensemble, sur un segment de la 
forme d’onde, affiche le segment dans la vue de détail.

Un clic prolongé déclenche la relecture à partir de la position 
pointée. Lorsque le bouton de la souris est relâché, la lecture 
s’arrête.

Un double-clic vous permet d’écouter l’échantillon à partir de 
la position pointée.

Fonctions de la fenêtre
Les fonctions Catch et Link fonctionnent de la même manière 

1 2
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Mode Catch 
En mode Catch , l’éditeur affiche en permanence la LPP (si un 
Song est joué, ou si un échantillon est en cours d’écoute). Acti-
vez ou désactivez le mode au moyen du bouton «homme en 
marche», ou bien au moyen de la commande clavier.

Mode Link 
En mode Link , l’éditeur affiche en permanence la séquence 
sélectionnée dans la fenêtre Arrange. Activez ou désactivez le 
mode au moyen du bouton «Chaîne», ou bien au moyen de la 
commande clavier.

Si vous employez souvent le mode Link, effectuer la manipula-
tion suivante: Ouvrez l’éditeur d’échantillon, puis activez le 
mode Link,.  Fermez la fenêtre. Dés lors, Logic active le mode 
Link, par défaut, chaque fois que le Sample Editor est appelé.

Double-cliquez la région audio de votre choix. Vous pouvez 
constater que les deux fenêtres sont liées.

La vue détaillée

Échelle d’affichage

Les zooms

Vous pouvez utiliser la «longue vue» de gauche pour agrandir 
ou réduire l’échelle verticale; vous modifiez ainsi l’amplitude 
affichée par la vue de détail.

La «longue-vue» de droite permet d’agrandir ou de réduire 
l’échelle horizontale, vous modifiez ainsi l’affichage de l’axe 
des temps, dans la vue de détail.

Vous pouvez également utiliser les commandes clavier.
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The Zoom Tool

Comme dans les autres fenêtres, un outil zoom (la loupe) est 
disponible dans la boîte à outils de l’éditeur. Si, au moyen de 
cet outil, vous tracez un rectangle autour d’une zone pour 
l’agrandir, la surface ainsi définie remplira la zone d’affichage 
de la vue de détail. Vous pouvez répéter l’action plusieurs fois 
de suite. Si vous cliquez (outil loupe sélectionné), vous revenez 
au grossissement précédent.

Si le pointeur standard est actif, vous pouvez sélectionner la 
loupe au moyen du raccourci clavier A. Avant de pouvoir défi-
nir une surface pour l’agrandir, vous devez cliquer dans un 
espace vide de la fenêtre.

Échelle des axes X et Y
L’échelle verticale, l’axe Y, rend compte de l’amplitude de la 
forme d’onde en pourcentage (on obtient cette échelle par la 
sélection de View > Amplitude Percentage). Par contre, si vous 
sélectionnez View > Amplitude Sample Value l’échelle est affi-
chée en unités d’échantillon.

L’axe X (l’échelle de temps) rend compte du déroulement du 
fichier audio dans le temps. Différentes unités d’échelle sont 
disponibles dans le menu View.

N’oubliez pas que ce format d’affichage modifie les valeurs affi-
chées dans la barre d’Info et dans le champs des paramètres de 
sélection:

View > Samples

Affiche la valeur de l’échantillon depuis le début de la Song, ou 
du fichier audio.

View > Min:Sec:Ms

Donne l’échelle en heures, minutes, secondes, millisecondes à 
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View > SMPTE Time

Donne l’échelle en temps SMPTE (en heures, minutes, secon-
des, images). L’échelle de temps commence au début du 
morceau, sur la valeur d’offset SMPTE.

View > Bars/Beats…

Donne l’échelle en mesures, pulsations, divisions, et pas 
d’horloge, de la même façon que sur l’échelle des autres fenê-
tres en temps relatif . Le «Point zéro» est représenté par la 
valeur «1 1 1 1», par contre les longueurs sont calculées par 
rapport à la valeur «0 0 0 0»..

Temps absolu et temps relatif
Les différentes échelles des axes de l’éditeur peuvent être 
calculées sur la base de deux valeurs de référence:

• par référence à l’axe de temps du song(position absolue)
• par référence au début du fichier audio (position relative)

Position relative

Les unités de l’axe de temps (entre la vue générale et la forme 
d’onde) seront affichées en ligne pointillée lorsque l’affichage 
est en mode «Position relative». Vous obtiendrez ce mode si 
vous ouvrez l’éditeur à partir de la fenêtre audio, ou bien si 
l’éditeur est en mode Link et que vous sélectionnez une région 
dans la fenêtre audio.

Le début de la section est automatiquement indexé à la valeur 
zéro, ou en termes de mesure à la valeur «1 1 1 1». Attention: 
cela ne correspond pas nécessairement à la position réelle du 
Song. Le calcul de l’échelle est basé sur la définition de tempo 
(pour l’échelle en mesure).

Position absolue
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Vous pouvez reconnaître ce format aux lignes brisées qui figu-
res sous les unités portées dans l’axe de temps. Vous obtiendrez 
une ligne brisée sous les unités de l’axe de temps, quand l’affi-
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chage est en position absolue. Vous obtiendrez ce mode si vous 
ouvrez l’éditeur à partir de la fenêtre Arrange , ou bien si l’édi-
teur est en mode «Lien» (Link)et que vous sélectionnez une 
région dans la fenêtre Arrange .

Le temps est mesuré à partir du début du Song, indexé à la 
valeur zéro (ou, en termes de mesure, à la valeur «1 1 1 1»). 
Dans ce cas, l’axe définit la position absolue et les valeurs ne se 
référent pas au fichier audio.

Afficher la forme d’onde par échantillons
Pour un facteur élevé de zoom, vous pouvez opter pour un affi-
chage classique de la forme d’onde dans la vue de détail, ou 
bien pour une représentation de structure des valeurs numéri-
ques enregistrées. Pour ce faire, activer la commande View > 
Show as Sample & Hold. Ce mode d’affichage peut s’avérer 
utile, par exemple, pour éliminer les clicks et les pops de vos 
enregistrements.

Grâce aux techniques de sur-échantillonnage et aux filtres 
passe-bas appliqués aux différentes étapes de la conversion 
Numérique/Analogique, les valeurs d’échantillonnage enregis-
trées (présentées à droite) seront converties en une forme 
d’onde semblable à celle présentée à gauche.
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9.3 La fenêtre Sample Edit en 
action

Pré-écoute d’échantillon
Il existe différentes manières d’écouter les sections affichées 
dans l’éditeur d’échantillon, afin d’opérer un contrôle sonore au 
fur et à mesure de votre édition. La pré-écoute est totalement 
indépendante de la position de la LPP dans le Song. Si, part 
ailleurs, vous préférez écouter le passage sélectionné dans le 
contexte général du Song, vous devrez recourir aux commandes 
de déplacement habituelles de la LPP.

Lecture à partir de la vue d’ensemble
La pré-écoute à partir de la vue d’ensemble s’obtient exacte-
ment de la même manière que celle des régions dans la fenêtre 
audio . Il suffit de presser le bouton de la souris, après avoir 
placé le pointeur à l’endroit où commence l’écoute. Relâcher le 
bouton de la souris pour arrêter l’écoute en cours. Vous pouvez 
également déclencher la pré-écoute à partir de n’importe quel 
point par un double-clic.

Lecture de la sélection 
Pour écouter la sélection en cours cliquez sur le bouton marqué 
d’un haut-parleur.

Vous pouvez également activer cette fonction avec la 
commande clavier Play/Stop Selection.

Lecture à partir d’une position donnée
Si vous double cliquez sur un point quelconque de l’axe de 
temps, le fichier audio sera joué à partir de ce point, jusqu’à la 
9 - 9
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fin de la sélection en cours. Si vous double-cliquez un point 
situé après la sélection en cours, la pré-écoute se fera de ce 
point jusqu’à la fin du fichier.
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Lecture en mode Cycle 
Le bouton de commande du mode cycle est disposé sur la 
gauche de la fenêtre de l’éditeur, au-dessus du bouton marqué 
par un haut-parleur. Si vous activez le mode cycle, la sélection 
en cours est jouée en boucle.

Notez que vous pouvez modifier les limites de la sélection, 
alors que vous êtes en train de l’écouter en mode cycle. Vous 
pouvez ainsi modifier le point de départ et d’arrivée de la sélec-
tion jusqu’à obtenir la boucle désirée. Lorsque vous avez 
obtenu le résultat voulu, vous pouvez sélectionner une 
nouvelle région au moyen de la commande Edit > Selection-
>Region.

Choix de la sortie audio 
Les petites boîtes situées sous les boutons «haut-parleur», vous 
permettent de choisir la sortie du hardware et le canal de pré-
écoute.

Régler le numéro de canal de sortie dans la boîte Cha située 
sous le bouton «haut-parleur». 

Lecture de régions
Vous pouvez ne jouer qu’un partie sélectionnée des fichiers 
dans la fenêtre Sample Edit. Si vous effectuez la lecture d’une 
région, vous devez tout d’abord la sélectionner grâce à la fonc-
tion Edit > Region->Selection.

Lorsque vous ouvrez le Sample Editor ou bien lorsque vous 
double-cliquez sur une région audio, cette région sera automa-
tiquement sélectionnée dans le Sample Editor. La même chose 
se passe lorsque vous cliquez sur une région quand le Sample 
Editor est en mode Link .
9 - 10
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Défilement automatique
Vous pouvez utiliser les ascenseurs, en bas et à droite de la fenê-
tre d’échantillon, pour faire défiler le contenu de la vue de 
détail. Toute fois, si vous voulez accéder à un point particulier 
dans la suite du fichier audio, l’emploi de raccourci clavier vous 
feront gagner du temps. Vous pouvez, pour cela, programmer 
vos propres raccourci clavier, à partir de la fenêtre Key commands 
(Voir le premier chapitre pour plus d’informations) — Le 
tableau suivant vous présente les raccourcis par défaut.

Ces fonctions afficheront le point visé au milieu de l’écran.

Définir une sélection

Sélection complète du fichier audio
Vous pouvez sélectionner un fichier audio entier avec la fonc-
tion Edit > Select All (ça).

Sélection manuelle
Pour sélectionner un segment précis du fichier, pointez le 
début ou la fin du segment, puis étendre la sélection vers la 
gauche ou la droite, au moyen d’un presser-glisser.

Déplace l’écran à: nom de la commande 
clavier

Key

Début de la sélection Goto Selection Start J

Fin de la sélection Goto Selection End K

Début de la région Goto Region Start

Fin de la région Goto Region End

Ancre Goto Region Anchor
9 - 11
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Pour modifier les limites d’une sélection
A tout moment, vous pouvez modifier les limites d’une sélec-
tion avec un simple raccourci clavier. Si vous cliquez sur un 
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point de la sélection, la touche S enfoncée, ce point définit la 
nouvelle limite de la sélection. Selon que ce point est plus près 
du début ou de la fin du segment sélectionné, il définit la fin ou 
le début de la nouvelle sélection. C’est le plus proche qui 
l’emporte....

Modifier la limite la plus éloignée

Si vous maintenez enfoncées les touches çS c’est le point le 
plus éloigné qui est modifié (et non plus le point qui marque la 
limite la plus proche). 

Déplacer l’aire de sélection
Si vous maintenez la toucheç enfoncée, vous pouvez faire 
glisser la sélection sans modifier sa longueur.

La boîte des paramètres de sélection
Notez que le point initial et la longueur de la sélection en cours, 
sont affichés en permanence dans la boîte des paramètres de 
sélection.

Les relations entre sélection et région

1

2

3

9 - 12
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Arrange), la forme d’onde affichée est celle de la région sur 
laquelle vous avez cliqué. Modifier la sélection après coup 
n’aura pas d’effet quant à l’étendue de la section éditée. La pré-
écoute jouera exclusivement la sélection en cours.

Logic dispose de deux fonctions pour définir les rapports entre 
sélections et régions audio qui vous permettent de créer et 
d’éditer des régions de façon suffisamment intuitive.

Sélection d’une région
Avec la commande Edit > Region->Selection, vous sélectionnez 
la totalité de la région en cours dans l’éditeur. En l’occurrence, 
la région en cours est celle qui a été sélectionnée dans la fenêtre 
audio (ou bien la région sur laquelle la séquence a été sélection-
née dans la fenêtre Arrange).

Cette fonction peut s’avérer particulièrement utile: ainsi, par 
exemple, après avoir réalisé de multiples éditions ponctuelles, 
vous pouvez sélectionner à nouveau l’ensemble de la région et 
l’écouter en boucle.

Convertir une sélection en région
ISi vous voulez convertir votre sélection courante en région 
audio, activez Edit > Selection->Region. De la sorte, vous 
pouvez prendre un passage audio, le définir comme sélection, 
puis le convertir en région. Celle-ci remplace alors le segment 
original que vous aviez sélectionné.

Créer de nouvelles régions
Pour créer une nouvelle région à partir d’une sélection en cours, 
il vous suffit de choisir Edit > Create New Region. Vous pouvez 
attribuer à cette fonction une commande clavier.
9 - 13
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Edition de régions dans le Sample Editor
Si vous voulez une très grande précision, vous éditerez les 
points de début et de fin de région dans la fenêtre d’édition 
d’échantillon, plutôt que dans la fenêtre audio .

Vous procéderez de même pour le positionnement de l’ancre, 
laquelle, dans la plus part des cas, doit être disposée juste sur la 
crête d’amplitude, plutôt que sur la phase de monté du signal. 
L’exemple nous en est donné par l’enregistrement des cuivres, 
qui nécessitent parfois d’être construit sur une crête. Grâce au 
déplacement de l’ancre sur ces crêtes, la région se placera sur la 
grille dans votre arrangement, avec l’ancre comme point de 
pivot. La souplesse d’emplois du zoom vous permet d’obtenir 
toute la précision que vous souhaitez; à l’échantillon près, avec 
les plus forts agrandissements.

Attention! Chaque changement du point d’ancrage modifie la 
position relative de la région audio dans la song. Attendu que la 
position par défaut de l’ancre est relative au point de départ de 
la région, vous devez également être attentif lorsque vous 
modifiez le début de la région.

Les petits marqueurs disposés sous la forme d’onde, vous 
permettent d’accéder rapidement à l’ancre, ainsi qu’aux limites 
de la région. Comme à l’accoutumé, vous pouvez les saisir et les 
déplacer par presser-tirer!
9 - 14
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1 Début de région
2 Fin de région
3 Ancre

Protection de la position de l’ancre

Si vous déplacez le début ou la fin de la région au de-là du point 
d’ancrage, l’ancre sera également déplacée. Bien souvent ce 
n’est pas ce que vous auriez souhaité.

Maintenez enfoncée la touche ç pendant que vous déplacez 
les marqueurs de début et de fin d’une région pour empêcher 
tout déplacement de l’ancre.

Rechercher le passage au point zéro
Si cette option est active, Logic cherchera le point pour lequel 
la forme d’onde est au plus près de l’axe d’amplitude zéro, 
chaque fois que vous modifiez la limite d’une sélection. Ceci 
afin d’éviter les «clics» à la relecture. Le programme cherche 
toujours ce point avant le début, ou bien après la fin de la sélec-
tion, selon la position visée.

Commandes d’édition
Comme les autres fenêtres, la fenêtre d’échantillon exploite les 
traditionnelles commandes d’édition Cut, Copy, Paste, Clear et 
Undo dans son menu Edit (ou par les raccourcis clavier).

Attention: dans l’éditeur toutes les commandes (à l’exception 
de Copy) modifient les données du fichier audio lui-même. En 
d’autres termes elles ont une fonction destructive. En consé-
quence la fonction Undo ne permet pas d’annuler ces comman-
des.

Cut
9 - 15
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Supprime du fichier audio le passage sélectionné et le copie 
dans le Presse-papiers. Toute la portion d’échantillon inscrite 
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après le passage modifié est décalée à la place de la coupure, 
pour combler le vide.

Copy

Copie la sélection en cours dans le presse-papiers, sans suppri-
mer la sélection.

Paste

Insère le contenu du presse-papiers à la place du curseur, ou 
bien à la place de la sélection en cours. Si aucune sélection n’est 
en cours, c’est la position du curseur qui définit le point d’inser-
tion (Il est représenté par une mince ligne pointillé). Si des 
données audio figurent après le point d’insertion, elles sont 
reportées après le contenu du presse-papiers.

Clear

Efface la sélection sans la copier dans le presse-papiers. Toutes 
les données inscrites après le passage effacé sont reportées à la 
place de la coupure pour combler le vide.

Undo
Annule la dernière commande. Cette fonction s’applique 
également aux commandes d’édition destructrives décrites au 
paragraphe «Fonctions» à la page 9 - 18 ou encore au paragra-
phe «Le Digital Factory™» à la page 9 - 27.

Souvenez vous que la commande Undo de l’éditeur est indé-
pendante des autres instances du programme. Cela vous per-
met de tester une opération d’édition dans la fenêtre Arrange. Si 
le résultat ne vous convient pas, vous pouvez revenir à l’éditeur 
et corriger la modification en utilisant la commande Undo.

• Un espace est réservé sur le disque dur pour les pistes armées, 
lesquelles ne sont pas disponibles en tant que fichiers undo. 
9 - 16
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Logic coupe alors automatiquement le mode «prêt pour l’enre-
gistrement» pour les pistes audio, si le disque est quasi plein et 
l’édition possible dans le Sample Editor.
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9.4 Gestion de fichier

Copies de sauvegarde (Backup)

Sauvegardes automatiques
Avant d’entreprendre une édition destructive sur un fichier 
audio via l’éditeur, Logic vous demandera si vous souhaitez 
effectuer une copie de sauvegarde du fichier en cours, à moins 
qu’il existe déjà une sauvegarde de cette version.

Le bouton No Dialog évite que ce message d’alerte apparaisse à 
nouveau, pendant que vous effectuez des travaux d’édition 
dans la fenêtre en cours.

Vous pouvez même inhiber totalement les messages d’alerte 
des sauvegardes via la commande File > Preferences… > Audio. 
Dans ce cas le message d’alerte est affiché exclusivement lors-
que le programme est chargé, et lorsque vous effectuez la 
première opération d’édition. Vous pouvez opérer les sauvegar-
des selon les modalités suivantes:

Process

Aucune sauvegarde n’est effectuée et la commande d’édition 
est lancée. Le message d’alerte n’apparaîtra plus jusqu’à ce que 
Logic soit relancé.

Cancel

Interrompt la commande d’édition en cours.

Preferences

Ouvre la fenêtre des préférences audio (Audio Preferences) et 
vous permet de réinitialiser la boîte de dialogue Backup, qui 
apparaît chaque fois que vous effectuez une commande 
9 - 17
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Sauvegardes manuelles
Vous pouvez effectuer des sauvegardes manuelles sur le fichier 
en cours, ou le remplacer par une version de sauvegarde chaque 
fois que vous le souhaité. Vous pouvez lancer les sauvegardes à 
partir de l’éditeur de différentes façons: 

File > Create Backup

Crée une copie du fichier audio en cours (avec l’extension 
«.dup») et le place dans le même répertoire (au même niveau) 
que l’original.

File > Revert to Backup

Cette commande remplace la totalité du fichier audio en cours, 
par la sauvegarde (pour autant qu’il existe une sauvegarde, 
évidemment). Un message d’alerte vous informe de la date de 
création de la sauvegarde avant de remplacer le fichier en cours.

Notez que vous ne pouvez pas annuler cette fonction avec 
Undo.

File > Save A Copy As…

Copie le fichier en cours à l’emplacement de votre choix.

File > Save Selection As…

Sauve la sélection en cours en tant que fichier audio indépen-
dant. Après l’avoir sauvegardé, vous pouvez choisir si vous 
souhaitez afficher le fichier dans l’éditeur.

9.5 Fonctions
La section suivante décrit les différentes commandes utiles 
opérant à partir de l’éditeur, pour affiner vos enregistrements. 
Vous pouvez ainsi apporter une touche finale à votre travail.
9 - 18
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fier l’ensemble du fichier audio, vous devez d’abord employer 
la fonction Select All .

Toutes les commandes suivantes sont destructives: elles modi-
fient les fichiers en cours lors de leur enregistrement sur votre 
disque dur. Vous pouvez employer la commande d’annulation 
Undo, tant que vous n’avez pas recours à une nouvelle fonction 
destructive. Ainsi, par exemple, vous pouvez modifier les limi-
tes de la sélection audio entre deux commandes d’édition 
destructives, tout en conservant le bénéfice d’un recours à 
l’Undo.

Attendu que Undo s’applique de manière autonome dans l’édi-
teur: vous pouvez tester une opération d’édition dans l’Arrange 
, et opérer là votre modification. Dés la réouverture de l’éditeur 
(ou bien, dés que vous affichez sa fenêtre au premier plan), la 
commande Undo est disponible pour annuler la dernière com-
mande d’édition que vous avez effectué.

Avant l’exécution de chacune de ces modifications, une boîte 
de dialogue vous demande d’en confirmer la sauvegarde. L’affi-
chage de ces messages d’alerte peut être supprimé via la 
commande File > Preferences… > Audio > Warning before 

process Function in Sample Edit (Menu).

Logic propose des fonctions d’édition plus élaborées dans le 
menu Factory qui sont décrites dans le paragraphe «Le Digital 
Factory™» à la page 9 - 27.

Normalize
La normalisation est un traitement par lequel l’amplitude d’un 
échantillon est portée à son plus haut niveau, sans générer de 
distorsion. Dans Logic vous appliquerez une normalisation au 
moyen de la commande Functions > Normalize.

Le processus se déroule ainsi: Logic identifie le point de plus 
9 - 19
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forte amplitude (-xdB) dans la sélection, puis il détermine 
l’écart qu’il y a entre ce point et la plus forte amplitude possi-
ble. L’amplitude est alors augmentée, pour l’ensemble de la 
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sélection, relativement à cette valeur. Le contenu sonore de 
l’échantillon est préservé — il est uniquement amplifié.

5-13 Normalize

& Exemple de normalisation. 1 Avant 2 Après

Notez qu’il vaut mieux ne pas effectuer la sélection d’un 
segment destiné à être normalisé, au milieu d’un passage 
sonore continu. Cela provoquerait des sautes de volume subi-
tes. C’est pourquoi on placera les limites de la sélection sur des 
silences. A l’occasion, vous éliminerez les défauts de souffle ou 
de bruit indésirables au moyen de la commande ‹Silence›.

1

2
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Change Gain
Vous pouvez employer la commande Functions > Change Gain 
pour accroître ou diminuer l’amplitude d’un passage sélec-
tionné, selon un facteur paramètré.

Cette fonction affiche une zone de dialogue dans laquelle 
porter les valeurs de correction (gain ou réduction) en pourcen-
tage (Change relative:).

Si vous cliquez sur Search Maximum, la plus haute crête 
d’amplitude est identifiée dans la sélection, et le facteur de gain 
est alors calculé pour correspondre exactement à la fonction de 
Normalisation du fichier audio.

La valeur results in absolute: cette rubrique affiche la valeur 
de gain maximale à employer dans la boîte Change relative: .

Vous ne pourrez jamais modifier une valeur au de-là de 100%, 
car cela générerait un «clipping» numérique.

La modification du gain est effectuée en cliquant sur Change 
(ou R).

Fade In
Utilisez la commande Functions > Fade In pour créer un fade in 
(montée progressive du volume). Par la largeur de la sélection 
vous déterminez le temps de montée du volume(voir 1 et 2). Le 
9 - 21
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volume est à zéro au début de la sélection pour atteindre 100% 
à la fin.

& Exemple d’application de ‹Fade In› . 1 Avant 2 Après

Fade Out
Functions > Fade Out Out est semblable à la commande de Fade 
In, à ceci près qu’il s’agit d’appliquer une baisse automatique 
du volume de 100% à 0%. .

& Exemple d’application de Fade out. 1 Avant 2 Après

Petits trucs sur le Fading 

1: Les effets courants de fade in et fade out (comme le fade out
typique, appliqué à la fin d’une plage sonore) peuvent éga-
lement être obtenus avec les objets de type fader ou poten-
tiomètres intégrés dans l’Environnement, comme au
moyen de l’HyperDraw. L’avantage du mode Midi dans la
création de fondu, c’est qu’il n’est jamais besoin de recourir
aux fonctions d’édition. L’outil crossfade de l’Arrange consti-
tue une option de fondu non destructif d’une très grande
souplesse.

1 2

1 2
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duire aux limites de la sélection, tout comme aux
extrémités du signal audio. Pour atténuer ces ruptures,
n’opérez que sur une courte sélection (par exemple à proxi-
mité du signal) à laquelle vous appliquez le type de fondu
adéquat.

Silence
Utilisez la commande Functions > Silence tSilence pour élimi-
ner toutes les données d’une sélection. Tous les échantillons de 
la sélection sont ramenés à l’amplitude zéro. Vous pouvez utili-
ser cette fonction pour supprimer le bruit de fond lors d’une 
pause.

& Exemple de la fonction ‹Silence› .1 Avant 2 Après

Invert
Functions > Invert inverse complètement la phase du contenu 
de la sélection en cours. Toutes les valeurs d’amplitude négati-
ves sont converties en valeurs positives correspondantes, et 
inversement. Bien que la manœuvre ne modifie pas l’aspect 
auditif du fichier lorsqu’il est écouté tout seul, cette fonction 
(Invert) corrige les effets d’opposition de phase, notamment si 
l’on veut obtenir une sortie mono. Cette possibilité est particu-
lièrement intéressante quand vous voulez mélanger/mixer en 
mono deux signaux légèrement désaccordés, ou traités par des 
effets de chorus en stéréo.

1 2
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5-18 Invert

& Exemple de la fonction ‹Invert› . 1 Avant 2 Après

Astuce pour les ingénieurs du son:

Il est possible d’exploiter la commande Invert  pour le déco-
dage de fichiers codés Mono/Stéréo. Copiez le canal S avec la 
commande File > Copy File(s) dans la fenêtre audio (nommez le 
«xxx-S»). Ouvrez le fichier ainsi copié, et procédez à une inver-
sion de phase complète (Sample Editor ça, plus Functions > 
Invert).Créez trois pistes d’objets audio «S», «M» et «-S». 
Réglez respectivement les panoramiques des pistes «S», «M», 
et «-S» sur Gauche, Centre et Droite. Glissez les fichiers audio 
vers l’Arrange (équilibrez les niveaux à l’oreille autour de -3dB 
pour «S» et «-S», et 0dB pour «M»). Sélectionnez les objets 
audio et utilisez la commande Structure > Merge > Objects > 
Digital Mixdown pour créer les pistes stéréo «L» et «R».

1

2
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Reverse
La commande Functions > Reverse permet d’inverser le sens 

de lecture d’un échantillon

& Exemple de la fonction ‹Reverse› . 1 Avant 2 Après

Trim
La commande Functions > Trim vous permet de supprimer 
toutes les régions qui n’ont pas été sélectionnées. Utilisez Trim 
pour effacer, du début à la fin, tous les passages insignifiants 
d’un fichier audio.

& Exemple de la fonction ‹Trim› . 1 Avant 2 Après

Assurez-vous que toutes les parties détruites ne contiennent 
aucune région dont vous puissiez avoir besoin. Les régions qui 
ne seront pas comprises dans la sélection seront perdues, et 
celles qui seront partiellement intégrées à la sélection seront 
tronquées. Si aucune région ne se trouve dans l’Arrange un 

1 2

1

2
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message d’alerte est affiché afin que vous puissiez annuler la 
fonction Trim en cours.
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Remove DC Offset
Lorsqu’on exploite une configuration hardware aux perfor-
mance limitées, le DC peut générer une couche indésirable par 
dessus le signal audio. Cela provient d’un déplacement vertical 
de la position de la forme d’onde qui ne peut pas être distinc-
tement observé dans l’éditeur. Pendant l’écoute ce phénomène 
peut produire des craquements au début et à la fin de la région.

& Forme d’onde avec 1 et sans 2 DC Offset

La commande Functions > Remove DC Offset permet de 
centrer la forme d’onde autour de la ligne d’amplitude zéro, afin 
de minimiser les craquement sur les points de rupture.

Search Peak
Lorsque vous activez la commande Functions > Search Peak 
celle-ci identifie, dans la sélection en cours, l’échantillon 
offrant la plus grande valeur d’amplitude. Puis, dans l’affichage 
de la forme d’onde, positionne le curseur sur cet échantillon.

Search Silence
Lorsque vous activez la commande Functions > Search Silence 
, celle-ci effectue une recherche de passages de silences dans la 
sélection en cours (zéro numérique). Puis positionne le curseur 
au début du premier segment identifié comme conforme à 
cette définition.

1 2
9 - 26
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9.6 Le Digital Factory™
Avec ses effets en temps réel (voir le paragraphe «Généralités 
sur les effets en temps réel» à la page 6 - 30) le 
Digital Factory™ est l’un des aspect les plus innovants et les 
plus remarquables de Logic. Cette technologie vous permet de 
travailler des sélections audio (par exemple, des régions ou des 
fichiers audio complets) au moyen d’une très riche palette de 
fonctions.

La plus part de ces fonctions sont destructives, vos fichiers 
audio seront modifiées directement sur le disque dur. Toute 
fois, en cas de nécessité, la fonction Undo reste disponible. Vous 
pouvez également programmer une sauvergarde automatique 
des fichiers que vous éditez, ou assurer ces sauvegardes 
manuellement.

Toutes les fonctions du Digital Factory peuvent être appli-
quées à n’importe quelle taille de fichier mono ou stéréo, entre-
lacé ou «splitté».

Reportez vous au fichiers de démonstration du manuel électro-
nique de Digital Factory pour vous faire une idées de la 
richesse de ces fonctions.

Généralités

Time Machine
Modifications indépendantes de la hauteur et de la durée d’un 
enregistrement (pitch shifting et compression/expansion 
temporelle).

Audio Energizer
Augmente le volume perçu, y compris avec des enregistre-
9 - 27
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ments ayant déjà subi une normalisation de niveau maximum.
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Sample Rate Converter
Ajuste la fréquence d’échantillonnage, ou crée des effets 
spéciaux de pitch.

Utilisation
Les fonctions de Digital Factory sont accessibles via le menu 
Factory dans la fenêtre Sample Edit.

• Ouvrir l’éditeur d’échantillon en double-cliquant une 
séquence dans l’Arrange , ou une région de la fenêtre audio .

Sélectionner alors l’objet à éditer.

• soit: sélection de la zone à éditer.
• soit: utiliser le raccourci ça, afin d’éditer la totalité du 

fichier audio.

Les fonctions portent toujours sur la zone sélectionnée.

• Choisir Factory > ….

• Effectuer les paramètrages voulus dans la zone de dialogue.

Avec certaines commandes de Digital Factory, vous pouvez 
activer le bouton Prelisten pour obtenir un aperçu du résultat. 
(Cette option n’est supportée que par les sytèmes hardware 
Audiowerk8 et AudioMedia III.)

• Vous pouvez lancer la lecture si vous le souhaiter. Bien que 
ces fonctions modifient les données du fichier audio sur le 
disque dur, vous pouvez les appliquer néanmoins pendant la 
lecture.

• Cliquer le bouton d’édition en bas (c’est à dire Process & 
Paste).

Le libellé du bouton d’édition est variable selon la fonction en 
cours.
9 - 28
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La ligne supérieure de l’éditeur d’échantillon vous informe de 
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La sélection du fichier audio est ensuite remplacée par les 
données modifiées.

Options
• En activant Edit > Undo (ou çz) vous pouvez à tout 

moment comparer la version en cours et l’original. Dans 
l’intervalle vous pouvez travailler dans l’Arrange , car la 
commande Undo de la fenêtreSample Edit est indépendante 
des autres instances du programme.

• Vous pouvez réitérer la commande d’édition avec d’autre 
régions ou d’autres fichiers audio, sans avoir à fermer et réou-
vrir la fenêtre Functions de la «Factory». La commande sera 
toujours appliquée à la sélection en cours.

• Vous pouvez également utiliser le menu déroulant en haut 
de la fenêtre, pour accéder directement aux diverses fonc-
tions du Digital Factory. Les deux sections du menu Factory 
(séparées par une ligne horizontale) en répartissent les fonc-
tions: Machines (grande fenêtre flottante) et Functions (petite 
fenêtre flottante).

Lorsque l’on joue un song (combinant données MIDI et audio) 
pendant l’édition d’éléments audio, les détenteurs de stations 
plutôt lentes obtiendront peut-être une lecture «hachée», bien 
que la séquence MIDI se déroule normalement. Les temps de 
calcul des fonctions d’édition sont ralentis par la lecture simul-
tanée du song.

9.7 Machines
La partie supérieure du menu Factory rassemble toutes les 
fonctions destructives des données audio contenues dans les 
fichiers.
9 - 29
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Time Machine
Le Time Machine vous permet de modifier radicalement la 
structure temporelle des fichiers audio par un processus 
d’expension/compression et/ou un décalage de hauteur (le 
pitch). 

Résumé des caractéristiques du Time Machine:

• Compression/expansion de temps sans décalage de hauteur,
• Transposition (pitch) avec ou sans modification de durée et 

de tempo,
• Une combinaison quelconque de ces fonctions.

•  et du tempod’un enregistrement sonore numérique. 
Chacun des paramètres peut être défini isolément. Le 
réglage en cours est représenté par la position d’une boule 
dans une représentation en 2-dimensions des axes de 
contrôle de durée (time) et de la hauteur (pitch).

Ouvrir le Time Machine
Pour ouvrir le Time Machine, choisissez Factory > Time & Pitch 
Machine. Pour les instructions portant sur la sélection à traiter, 
ou pour les opérations élémentaires, reportez vous au paragra-
phe «Utilisation» à la page 9 - 28.

Paramètres
La plupart des paramètres sont inter-dépendants; Il n’est pas 
nécessaire de les ajuster tous pour obtenir le résultat satisfai-
9 - 30
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Sous le libellé Original à gauche, vous pouvez voir la valeur 
actuelle (valeur d’origine), et sous le libellé Destination à droite, 
le champ dans lequel entrer la nouvelles valeur (valeur cible) à 
éditer.

Tempo Change (%)

Modification du tempo en pourcentage. (La valeur d’origine 
n’est pas indiquée pour ce paramètre).

Tempo

Tempo en bpm (battement, ou pulsation par minutes). Assurez 
vous d’un paramètrage exacte des mesures, sinon la mention 
correcte du tempo original ne sera pas indiqué!

Length (Samples)

Longueur des échantillons.

Length (SMPTE)

Longueur en temps SMPTE.

Length (Bars)

Longueur en mesures. Si vous avez déjà fixé le tempo de la 
région que vous éditer, la valeur originale sera automatique-
ment retenue. Dans le cas contraire, vous devez saisir manuel-
lement la valeur originale de la longueur en mesure de votre 
sélection.

Transpose (Cent)

Transposition de la sélection en centièmes de demi-ton (cents).

Free Transposition
A côté du paramètre de transposition se trouve la description 
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C’est probablement l’option la plus couramment utilisée du 
Time Machine. Elle définit un mode de calcul indépendant 



Chapitre 9
La fenêtre Sample Edit

pour la compression/expansion et pour la transposition. Dans ce 
cas, on peut éditer séparément la hauteur et le tempo de la 
sélection en cours.

Classic (correlated) Transposition
Ici vous pouvez , via un menu déroulant, passer du mode Free 
au mode Classic. Le mode Classic est dévolu aux cas pour 
lesquels vous voulez transposer une région sélection, et, en 
même temps, en modifier le tempo. Cela reproduit l’effet, qui 
vous est probablement familier, d’une molette «Pitch Wheel» 
contrôlant un enregistrement. Ainsi, la hauteur, le timbre, et la 
vitesse de lecture sont modifiés ensemble.

A gauche dans la zone de dialogue Time Machine, vous pouvez 
observer une représentation graphique du réglage en cours. 
Vous pouvez déplacer librement la boule curseur au travers du 
graphisme pour ajuster la compression/expansion et la transpo-
sition. Plus le déplacement de la boule éloigne celle-ci de la 
position centrale, plus l’algorithme est complexe, plus le calcul 
est lent et plus la qualité du son obtenu sera faible.

Rappelez-vous aussi que la qualité du résultat dépend large-
ment du matériau sonore sur lequel vous travaillez.

Ne vous laissez pas décourager par ces observations. Gardez 
votre liberté d’esprit:oser des réglages de compression/expan-
sion ou de transposition. Dans certain cas, le résultat ne sera pas 
toujours celui escompté, et s’apparentera plutôt à un «effet».

Utilisation de l’affichage graphique
Vous pouvez déplacer la boule dans les 2 dimensions du 
graphisme.   La position de la boule interfère directement sur 
les valeurs numériques, et vice versa.

Vous pouvez réinitialiser la position de la boule au centre et 
9 - 32
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toute les valeurs numériques (position et valeurs neutres), 
simplement en cliquant dans le graphisme tout en maintenant 
enfoncée la touche ç.
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Technologie de la Time Machine
La Time Machine analyse les composantes spectrales et dyna-
miques des matériaux sonores numériques, puis effectue les 
calculs. Les algorithmes de haut niveau s’emploient à conser-
ver le maximum d’informations spectrales et dynamiques, et à 
minimiser les variations de phase. Dans les fichiers stéréo la 
relation de phase entre les canaux de gauche et de droite est 
définie et n’est pas modifiée. Les cas de «son doublé» sont 
réduits au minimum. Les résultats obtenus sont d’une grande 
qualité. Ils sont moins parasités que les résultats auxquels vous 
êtes probablement habitués.

Cependant, ne perdez pas de vue qu’un ré-échantillonage 
(transposition) ne peut être géré de la même manière. Dans ce 
cas la Time Machine doit obtenir ce qui est «physiquement 
impossible»: Quand un échantillon est allongé l’information 
doit être «inventée» (extrapolation). Ceci de façon aussi 
réaliste que possible. Et inversement quand un échantillon doit 
être raccourci, l’information doit être tronquée, ce, autant que 
possible, sans altérer notre perception du son. Étendre la durée 
d’un échantillon est plus difficile que la réduire. Si vous avez le 
choix, il est préférable d’accélérer une boucle de batterie trop 
lente plutôt que l’inverse.

Il existe toujours une petite dérive entre le facteur d’expan-
sion/compression, et le résultat effectif. Ceci est dû au fait que 
l’algorithme nécessite un peu de tolérance afin d’optimiser la 
qualité du spectre et de la dynamique (la qualité sonore). La 
dérive de la valeur de réglage n’est que de quelques millisecon-
des (fraction de bpm). Cela ne pose aucun problème, puisque la 
valeur absolue de la dérive est indépendante de la longueur de 
la sélection à traité. Autrement dit, n’est pas plus importante 
avec des fichiers plus longs.

Audio Energizer
9 - 33
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tion d’une augmentation de volume, en modifiant le son aussi 
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peu que possible et sans provoquer de parasites (clipping). La 
distorsion numérique (qui serait inévitable du simple fait de 
l’élévation du niveau sonore, et qui produirait un son très 
déplaisant) est évitée grâce à l’emplois de cet algorithme.

On peut comparer cet effet à celui obtenu avec un matériau 
sonore saturé en raison d’un niveau d’enregistrement élevé. 
Toute fois, le facteur de distorsion généré par l’Audio energizer 
est bien moins important.

Voici un exemple d’effet obtenu. Si un fichier audio normalisé

(données sonores dont la dynamique est optimisée à son maxi-
mum) est édité, l’effet est le suivant: un VU-mètre indique un 
niveau maximum, témoignant de l’augmentation moyenne 
d’energie dans le signal. Cependant l’affichage d’un pic 
montrera le même niveau qu’auparavant, jusqu’a ce que le 
niveau maximal du signal n’est pas été dépassé.

Ouvrir l’Audio Energizer
Sélectionnez la commande Factory > Audio Energizer dans le 
Sample Editor. Concernant la sélection du matériau à traiter, et 
les opérations élémentaires, reportez-vous au paragraphe 
«Utilisation» à la page 9 - 28. La fonction est exécutée par un 
clic sur le bouton Energize.

Paramètres
Le paramètre principal est Factor. C’est avec ce paramètre que 
9 - 34
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vous définissez le taux d’expansion. 0% ne modifie pas le 
fichier, tandis que des valeurs plus élevées induisent une 
augmentation d’energie. Votre réglage dépendra du matériau 
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sonore sur lequel vous travaillez, de vos essais préalables et de 
vos préférences en matière de sonorité. Commencez par tester 
des valeurs dans une plage comprise entre 40et 100%. Les 
valeurs en dessous de 10% resteront pratiquement sans effet, 
des valeurs de plus de 100% peuvent altérer le son de façon 
indésirable Les valeurs au-delà 200% sont déconseillées avec 
les fichiers normalisés, car elles produisent des effets nuisibles 
à la qualité du son et de sa dynamique. De plus elles requièrent 
des temps de calculs bien plus longs. Avec des fichiers non 
normalisés, même de grandes valeurs peuvent offrir de bons 
résultats, dans la mesure où le traitement initial de ces fichiers 
ne modifie pas leur dynamique.

Les paramètres Attack et Release permettent de contrôler le 
caractère plus ou moins «lisse» du filtre. Vous pouvez essayer 
en augmentant du double ou du quadruple la valeur par défaut 
(lissage plus prononcé), si le résultat sonne trop «digital» ou 
trop «brut». Cela peut se produire quand des éléments 
d’arrière-plan, masqués dans l’original par des éléments de 
premier-plan, sont trop amplifiès à l’enregistrement. Parfois il 
arrive ainsi que la réverbération, par exemple, devienne plus 
retentissante.

Le passage sonore offre la sensation d’une augmentation du 
volume moyen. Si le contenu original comporte des anomalies 
comme des bruits, celles-ci se trouvent également amplifiées et 
deviennent parfois audibles. En cas de nécessité, la fonction 
Silencer vous permet d’effectuer une réduction du bruit.

Convertisseur de fréquence d’échantillon-
nage
Le convertisseur de fréquence (Sample Rate Converter) est 
employé, par exemple, pour convertir à une fréquence de 44,1 
kHz, des fichiers audio enregistrés avec une fréquence 
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d’échantillonnage de 48 kHz (enregistré avec un DAT Hi-Fi et 
transférés numériquement sur ordinateur.
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Ouvrir le convertisseur de fréquence
En principe, vous cherchez à convertir la totalité du fichier 
audio. Pour cela sélectionnez le fichier complet dans le Sample 
Editor (ça).

Sélectionnez Factory > Sample Rate Convert… dans la fenêtre 
de l’éditeur d’échantillon. Pour plus d’informations sur  la 
sélection du contenu et les fonctions élémentaires, reportez-
vous au paragraphe «Utilisation» à la page 9 - 28. Pour lancer la 
fonction cliquez sur le bouton Convert.

Paramètres

Source (Hz)

Ce facteur indique la fréquence d’échantillonnage avec 
laquelle est enregistré le fichier. Pour modifier une fréquence 
erronée (par exemple sur des fichiers édités avec d’autres 
programmes) — ou pour obtenir des effets particuliers — vous 
pouvez saisir une autre valeur dans le champ Source (Hz). Toute 
fois n’intervenez sur ce paramètre que si vous possédez une 
parfaite maîtrise des effets induits.

Destination (Hz)

Le champ Destination (Hz) vous permet de saisir la valeur de 
fréquence d’échantillonnage à laquelle un fichier sera converti.

IDans la plupart des environnements professionnels, on utilise 
une fréquence de 44.1 kHz. Il n’y a qu’un faible avantage 
9 - 36
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sonore à exploiter une fréquence de 48kHz. C’est le format le 
plus fréquemment utilisé par les plus anciens DAT.
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L’Event List

L’Event List fait apparaître les données Midi sous la forme 
d’une liste combinant toutes les fonctions d’édition des autres 
éditeurs, excepté pour les fonctions graphiques et les options 
expressives offertes dans l’éditeur de partition (Score Editor).

Usage
L’Event List est utilisable pour faire des modifications précises 
lorsque les fonctions graphiques des autres éditeurs, soit ne 
conviennent pas, soit se révèlent moins pratiques à l’usage. 
C’est en outre le seul éditeur capable de visualiser de manière 
exhaustive l’ensemble des données enregistrées. Vous pouvez 
pour plus de commodité limiter l’affichage en filtrant les types 
d’événements dont vous n’avez pas l’utilité.

Ouvrir l’Event List
Pour ouvrir l’Event List et voir le contenu de la séquence sélec-
tionnée, activez la fonction Windows > Open Event List , ou 
utilisez la commande clavier appropriée (Open Event Editor…).

Vous pouvez également l’ouvrir en double-cliquant sur une 
séquence avec le bouton droit de la souris.

Structure
Aux boutons standards s’ajoutent deux boutons-flèches 1 to 
servant au déplacement dans la liste. Les boutons de type 
d’événement (Event type) 2 situés au-dessous du premier pavé, 
vous permettent de supprimer ou d’activer l’affichage de 
10 - 1
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certains types d’événements, selon vos besoins (en leur 
cliquant dessus avec le bouton droit de la souris). En dessous de 
la boîte à outils se situe le champ de définition de la quantifica-
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tion (au-dessus de 3). Un champ (sur la gauche de 3) permet 
également de définir la division de mesure qui correspond au 
paramètre Division de la fenêtre transport. Si la fonction Catch 
est active, la petite flèche pointant la liste 4 sera toujours en 
face de l’événement en cours. La structure de l’affichage de la 
liste 5 est décrite à la page 10 - 7.

10.1 Affichage
Les boutons de types d’événement permettent de «filtrer» 
l’affichage, afin de ne conserver que les éléments utiles. 
Cliquez le bouton correspondant avec n’importe quel outil (à 
l’exception de l’outil stylo).

Si le bouton est grisé, le type d’événement qu’il représente ne 
sera pas affiché.

L’ensemble des fonctions d’édition ne s’appliquent qu’aux 
événements non-masqués. Les événements masqués sont ainsi 
protégés contre les éventuelles modifications que vous pourriez 

1

2

3

4 5
10 - 2
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leurs faire subir.

Voici une rapide description. Pour de plus amples informations 
voir page 10 - 11.
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Le symbole note représente les événements de type note.

Le symbole représentant un afficheur double à cristaux liqui-
des représente les événements de type program change.

Le symbole représentant une molette à position centrale repré-
sente les événements de type pitch bend.

Le symbole représentant une molette (de modulation) avec un 
marqueur en bas, représente les événements de type control 
change.

Le poids (seul) représente les événements de type aftertouch 
(pression de canal).

Les poids (plusieurs) représentent les événements de type 
polyphonic key pressure (aftertouch polyphonique).

Ce symbole représente les blocs de données SysEx.

Le symbole avec des 1 et des 0 est appelé bouton full message . 
Il ne filtre aucun événement, mais affecte le format d’affichage 
de l’ensemble de la zone d’édition.

En temps normal, l’Event List affiche les événements en n’utili-
sant qu’une seule ligne par événement. Cependant, lorsque ce 
bouton est enfoncé, toutes les informations sont affichées, 
même s’il faut pour cela plusieurs lignes. C’est particulière-
ment important dans le cas de messages SysEx.

When examining note events in the Event List, you will also 
notice Logic’s internal score layout information included in the 
list. You can edit this in the Event List if you want, but it serves 
little purpose.

10.2 Utilisation
10 - 3
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Scrolling
Cliquer sur l’une des flèches fait défiler l’affichage par événe-
ment, dans le sens de la flèche. L’événement situé devant le 
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marqueur est systématiquement sélectionné (donc la sélection 
change dès que vous faîtes défiler les informations). La vitesse 
de défilement peut varier en fonction du déplacement vertical 
de la souris. La commande-clavier Scroll to Next/Previous Event 
est également utilisable à partir de la fenêtre Event, elle procure 
le même résultat.

Souvenez-vous que si le bouton Midi Out est enfoncé, chaque 
nouvel événement sélectionné sera émis en sortie. Ce qui 
signifie que vous pouvez vous déplacer dans la liste et vous 
repérer à l’oreille.

Si vous souhaitez conserver une sélection, utilisez l’ascenseur.

Technique de sélection
Lorsque vous sélectionnez les événements à l’aide de la souris, 
vous devez cliquer à coté de la colonne de statut afin d’éviter de 
modifier accidentellement un des paramètres.

Vous pouvez utiliser toutes les techniques standard de sélec-
tion: sélection individuelle par simple clic, sélection multiple 
en tirant une zone avec la souris, ou les deux (sans modifier la 
sélection précédente), conjointement avec la touche S enfon-
cée. N’oubliez pas que le menu Edit vous permet d’opérer des 
sélections selon des critères prédéfinis (lire le paragraphe 
«Techniques de sélection» à la page 1 - 24).

Chaque événement que vous enlevez de l’affichage en cliquant 
sur le bouton de sélection de type d’événement (event type) est 
immédiatement désélectionné. Cela assure que vous n’interve-
nez que sur les événements affichés (donc sélectionnés).

Fonctions de sélection spéciale
Certaines commandes de sélection (auxquelles on peut avoir 
accès depuis les fenêtres d’édition via leur menu Edition) 
10 - 4
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peuvent également être utilisées dans l’Event List en sélection-
nant un élément avec la souris tout en maintenant enfoncé des 
touches de modification additionnelles.
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1. Si vous cliquez sur un événement en maintenant enfoncée
la touche ç, vous pouvez sélectionner tous les événe-
ments entre le dernier qui a été sélectionné et celui en
cours de sélection.

2. Si vous cliquez sur un événement en maintenant enfoncé
la touche A, tous les éléments similaires sont aussi sélec-
tionnés.

3. Si vous cliquez sur un événement en maintenant enfoncé
les touches A et ç, tous les événements identiques sont
également sélectionnés.

Edition des Evénements

Ajouter des événements
Pour ajouter un événement, cliquez sur le bouton du type 
d’événement désiré avec l’outil stylo (ou n’importe quel outil 
en maintenant enfoncé le bouton droit de la souris). L’événe-
ment est alors ajouté à la position en cours et automatiquement 
sélectionné.

Dupliquer des événements
Pour dupliquer des événements existants (par exemple, pour 
pouvoir modifier la valeur d’un paramètre de la copie) cliquez 
sur l’événement d’origine avec le stylo. Une boîte d’entrée 
apparaît, dans laquelle vous pouvez entrer la position souhaitée 
pour l’événement dupliqué. Si vous appuyez simplement sur 
R, l’événement dupliqué apparaitra au même endroit que 
l’original.

Ajouter à partir du presse-papiers

En ajoutant des événements via la fonction Paste fdu presse-
papiers, une boîte de dialogue apparaît, vous permettant 
10 - 5
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d’entrer la position du premier événement. Une fois encore, si 
vous confirmez en pressant juste la touche R, la position origi-
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nale de l’événement est conservée. La position relative de 
chaque événement est toujours maintenue.

Cela veut dire que les événements ne sont pas ajoutés à la posi-
tion courante, dans la song comme dans les éditeurs graphi-
ques. Pour plus de détails sur la façon dont fonctionne le 
presse-papiers, referez-vous à la page 1 - 27.

Déplacer des événements
Pour déplacer un événement dans le temps, modifiez directe-
ment son indicateur de position. Dés que cela est fait, la liste 
est automatiquement et immédiatement remise à jour, bien 
que la sélection en cours demeure inchangée.

Modifier les valeurs
Les positions ou les valeurs de paramètre peuvent être modi-
fiés en utilisant la souris comme un curseur (en les saisissant et 
en déplaçant la souris), ou via une entrée de texte (double-clic 
sur la valeur d’un paramètre).

Vous ne pouvez modifier le type de message par cette méthode. 
Il vous faudra utiliser les fonctions de transformation, ou bien 
créer un nouvel événement du type désiré, puis supprimer 
l’événement original.

Modifier les valeurs de plusieurs événements
Si le paramètre d’événement d’une sélection est modifié, alors 
tous les événements de la sélection seront modifiés également.

Modification de valeur relative

Lorsque vous modifiez les valeurs de paramètre dans une sélec-
tion multiple, les différences relatives entre les valeurs de para-
mètre reste inchangé. Les valeurs de paramètre que vous saisis-
10 - 6
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sez ou que vous double-cliquez peuvent seulement être 
modifiées jusqu'à ce que la valeur de l’un des événements 
sélectionné ait atteint sa valeur maximum ou minimum.
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Modification de valeur avec relation destructive

ISi vous voulez poursuivre la modification d’un paramètre dans 
un sélection multiple, alors même que l’une des valeurs de la 
sélection est au maximum ou au minimum, maintenez la 
touche ç enfoncée lorsque vous déplacez la souris(ou pres-
sez R pour confirmer l’entrée de la valeur numérique).

Modification de valeur absolue

Si vous désirez régler un paramètre sur une même valeur pour 
tous les événements sélectionnés, maintenez les touches S et 
ç tout en déplaçant la souris (ou pressez R pour confirmer 
l’entrée de la valeur numérique).

Entrée de valeurs numériques
Si vous souhaitez entrer directement un nombre, double-
cliquer le paramètre correspondant.

La commande-clavier ‹Duplicate Event and Numerical Edit› 
permet également la duplication et la création d’un événe-
ment. Si un événement est sélectionné, il sera dupliqué, si 
aucun événement n’est sélectionné, un nouveau est créé.

10.3 Structure de l’Event list
Les différentes colonnes de la liste ont la disposition suivante:
10 - 7
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Position

La position de l’événement dans la song; pour des événements 
de type note, il s’agit du début de la note (note on). Cette posi-
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tion est exprimée en mesures, pulsations, divisions et pas 
d’horloge(voir page 2 - 13).

Le compte commence à 1 pour chaque unité (première mesure, 
première pulsation, première division, premier pas d’horloge: 
1111) et continue jusqu’à atteindre l’unité de plus haut rang.

Les saisies numériques se font par la gauche (ce qui signifie que 
vous pouvez entrer le numéro de mesure que vous souhaitez). 
Les unités peuvent être séparées par des espaces, des points ou 
des virgules.

Position dans la séquence

En choisissant View > Local Position, les positions de l’événe-
ment prennent pour référence le début de la séquence au lieu 
de le song.

Status
C’est ici que vous voyez le type de message, tel qu’il apparaît 
dans l’octet de status du message Midi (Pour plus de détails, 
referez-vous au paragraphe «Structure du type d’événement» à 
la page 10 - 11). Vous ne pouvez pas éditer directement ce para-
mètre.

Cha
Le canal Midi d’enregistrement de l’événement.

Rappelez-vous que pendant la lecture, ce canal sera remplacé 
par celui de l’instrument assigné à la piste. L’événement est 
émis sur le canal Midi d’enregistrement quand le paramètre 
Cha est réglé sur All.

Gardez à l’esprit que dans la partition, le canal Midi est utilisé 
pour affecter une des voix de l’écriture pour plus d’informa-
tions, lisez le chapitre  Fenêtre Score Edit).
10 - 8
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Num, Val
Ces colonnes contiennent les octets de données des événe-
ments. Leurs significations dépendent du type d’événement:

Length/Info
Pour les événements de type contrôleur, le nom du contrôleur 
est spécifié en clair, selon la norme Midi, ainsi que le nom du 
constructeur pour les messages SysEx.

Avec des événements de pitch bend, une valeur de 14-bit est affi-
chée ici, laquelle est composée du premier (Num) et du second 
(Val) byte de données combinés. Cette valeur peut être éditée 
ici directement.

Pour des notes ou des séquences, la durée est affichée dans 
cette colonne.

Cette colonne est exprimée aussi en mesures, temps, divisions 
et coups d’horloge. Pour clarifier l’affichage, lorsqu’une des 
unités affiche un zéro, le symbole ___est utilisé. La durée mini-
male est d’un pas d’horloge (_ _ _ 1) et non de 0 pas d’horloge, 
car cela n’a évidement pas de sens d’émettre simultanément un 
note on et un note off pour la même note.

Les entrées numériques se font par la droite, travail vers la 
gauche, et vous pouvez entrer un seul pas d’horloge si vous le 
souhaitez. Les unités sont séparées par des espaces, des points 
ou des virgules.

Status Num Val

Note Pitch Velocity
Control Controller number Value
Pitch LSB MSB
C-Press (not used) Value
P-Press Pitch Value
Program Bank Select Program number
10 - 9
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Affichage de la fin au lieu de la longueur

Si vous choisissez View > Length as absolute Position , cette 
colonne affichera la position de la note off du dernier événe-
ment de la séquence.

Structure de la liste au niveau de l’Arrange
Lorsque vous cliquez ce symbole, ou bien lorsque vous double-
cliquez sur n’importe quelle entrée, ou enfin lorsque que vous 
double-cliquez dans la zone blanche au-dessus ou en dessous 
des limites de la liste (si elles sont visibles), vous remontez d’un 
niveau dans la hiérarchie des dossiers/séquences . 

Cela vous permet de voir tous les objets d’arrangement 
(séquences ou dossiers) dans le song en cours (ou le dossier). Au 
niveau de l’Arrange, la liste comprend les colonnes suivantes:

Position
Le point de départ de l’objet Arrange (voir page 10 - 7).

Name
Nom de la séquence ou du dossier. Double-cliquer sur le nom 
10 - 10
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descend le niveau d’affichage d’un cran en visualisant le conte-
nue de l’objet, c’est à dire, pour une séquence, les événements 
qui la composent.
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Vous pouvez modifier le nom d’une piste à l’aide de l’outil 
texte.

Track
Affiche le numéro de la piste. Vous ne pouvez pas éditer cette 
valeur à partir de là (vous pourriez totalement détruire votre 
arrangement). Si vous souhaitez déplacer un objet d’arrange-
ment dans une autre piste, il est préférable de le faire graphi-
quement depuis la fenêtre Arrange.

Length
La longueur de l’objet d’arrangement (voir page 10 - 9).

10.4 Structure du type 
d’événement

Evénements de type Note 

Num

Numéro de note Midi (note #). L’étendue est comprise entre C-
2 (note #: 0) et G8 (note #: 127). Le Do de «serrure» ou Do du 
«milieu» correspond à la note # 60. Elle est appelée C3 dans la 
terminologie Midi.

Sur certains claviers et expendeurs (notamment ceux de Korg 
et Roland), La plage de notes va de C-1 (#0) à G9 (#127). Dans 
ce cas le Do du «milieu» est appelé C4.

Dans les Preferences (page Display) vous pouvez référencer ce 
10 - 11
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Do moyen selon la position majoritaire de votre configuration 
(Display middle C as…).
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Val

Les vélocités sont comprises entre 1-127. La valeur zéro corres-
pond au message note off et n’est donc pas utilisée dans le cas 
d’une note on.

Length/Info

Longueur de note. Bien que le Midi ne définisse la longueur 
d’une note qu’entre les instants d’émission d’un message note 
on et note off messages, Logic préfère utiliser cette notion de 
longueur, qui correspond mieux à la signification musicale de la 
longueur de note. Le message note off est généré automatique-
ment durant la lecture.

Notes des instruments complexes

Si la séquence éditée doit être jouée par un instrument 
complexe, la définition symbolique de note est affichée dans la 
ligne Status . Pour rappeler qu’il s’agit bien d’un événement de 
type note, une petite note est ajoutée à gauche du nom symbo-
lique.

Evénements de type Program Change 

Les évènements de type program changes sont émis vers les 
appareils Midi raccordés, afin de rappeler un de leur 
programme interne. Ceux-ci peuvent-être des sons pour des 
10 - 12
Emagic
Logic Audio Pro ISIS 

synthétiseurs, des configurations d’effets (dans des unités de 
traitement), ou des «snapshots» pour des consoles de mixage 
automatisées.
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Val

Un numéro de programme entre 0 et 127.

Certains constructeurs (ex. Yamaha) numérotent les program-
mes de leur machine de 1 à 128, non de 0 à 127. Dans ce cas, 
vous retranchez 1 au numéro de programme à émettre.

D’autres constructeurs utilisent des méthodes différentes pour 
répartir les programmes en groupes (ou banques) de sons. La 
plus commune est l’utilisation de 8 groupes de 8 sons, numé-
roté de 1 à 8. Ces machines répondent aux Program Changes de 
0 à 63 en appelant les mémoires depuis 11 jusqu’à 88. Les 
instructions des constructeurs vous permettent, en règle géné-
rale, de construire les tables de conversion adéquates.

Num

Sélection de banque. Normalement, vous verrez ce symbole, 
qui signifie qu’aucun message bank select ne sera émis. Si vous 
réglez ce champ entre 0 et 62, un événement de type bank select 
est émis avant le program change. Cela vous permet d’adresser le 
contenu d’une machine disposant de plus de 128 sons (ex 
presets, interne, carte). Le synthétiseur doit pouvoir reconnaî-
tre le contrôleur n° 32 en tant que sélection de banque, mais, 
malheureusement, ce standard n’est pas adopté par tous. Si 
vous détectez un problème dans les changements de banque, 
consultez la notice de votre synthétiseur afin de vérifier le 
format exact de ce message

Program Change variable

Si un ‹x› apparaît dans la case de validation de la colonne Num, 
elle sera suivie de la mention of Instrument. Dans ce cas, la 
valeur de programme réglée dans la boîte de paramètres 
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Evénement de type Pitch Bend 

Les événements de type Pitch Bend sont utilisés afin de faire 
varier en continue la hauteur de note. Ils sont utilisés le plus 
souvent via la molette pitch bend ou le joystick d’un clavier.

Num

pas de décalage de hauteur précis (LSB). Un grand nombre de 
claviers transmettent pour ce paramètre la valeur 0 ou 64. Cela 
indique que le clavier en question ne propose qu’une résolu-
tion de 8 bits pour sa molette de pitch bend.

Val

Décalage de hauteur (MSB) entre 0 et 127. La valeur 64 corres-
pond à l’état de repos de la molette.

Length/Info

La valeur 14-bit est indiquée dans la colonne sous forme déci-
male comprise entre -8192 et 8191. Cette valeur peut être 
éditée de la façon habituelle.

Evénements de type Control Change 

Ces événements servent à la transmission de tous les autres 
contrôleurs Midi (ex. modulation, sustain, volume et panorami-
que).

Num
10 - 14
Emagic
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Le numéro du contrôleur. Tous les différents contrôleurs Midi 
(comme la molette de modulation ou la pédale de sustain) ont 
leur propre numéro (n° 1 ou n°64). Certains autres effets sont 
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également définis comme le volume général (n°7) ou le pano-
ramique n° 10).

Les contrôleurs définis dans la norme Midi standard, sont 
décrits en clair dans le champ Length/Info .

Val

Valeur du contrôleur. Les contrôleurs continues ont une plage 
allant de 0 à 127. Les contrôleurs de type «interrupteur» (n°64 
et n°90) n’utilisent que deux états: off (val=0) et on (val quel-
conque entre 1 et 127).

Evénements de type Aftertouch 

L’Aftertouch (ou pression en mode canal) est généré à partir 
d’un capteur de pression situé sous le clavier. La modulation 
résultante affecte toutes les notes d’un même canal Midi.

Num

Cette colonne est inutilisée dans la mesure où les évènements 
d’aftertouch n’utilisent qu’un octet de données.

Val

Force de la pression sur le clavier (0-127).

Evénements de type Poly Pressure 

Les événements de type Pression polyphonique sont générés à 
partir de capteurs de pression, situés en dessous de chacune des 
touches du clavier. La modulation résultante n’affecte indivi-
duellement que les notes émises.
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Num

Note Midi.

Val

Force de pression sur cette touche.

Evénements de type SysEx 

Ce paragraphe explique la façon de programmer des faders 
SysEx. (Important: Les flèches encadrant le mot EOX servent 
à rajouter ou supprimer des octets de données dans les messa-
ges SysEx.

Données SysEx au format Hexa

Dans l’Event list ou l’éditeur de faders SysEx, en sélectionnant 
View > SysEx in Hex Format, vous pouvez afficher les valeurs 
SysEx au format hexadecimal ou décimal.

Les valeurs hexadécimales dans Logic sont précédées d’un $.

Deux conseils à l’intentions des mordus:

& L’entrée numérique (en double-cliquant) est toujours indépendante du mode d’affi-
chage, ou du type d’événement et peut être utilisée dans plusieurs autres zones du 
programme:

& 1. Utilisez les décimales comme 1, 01, 2, 3, 4,127,..

& 2. utilisez les hexadecimales comme $1, $01, $2, $3, $A, $0A, $7F

& 3. Utilisez les notes comme ‹C3›, ‹C#3›, ‹Cb3›, ‹C##2› (equivalent à D2), ‹Dbb2› 
(equivalent à C2)

& Si vous double-cliquez sur la note ‹E3›, vous pouvez saisir une valeur décimale 
10 - 16
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comme ‹64› ou une valeur hexadécimale tel que ‹$40› au lieu de la note elle même.

& Dans de nombreux endroits de Logic, des opérations mathématiques peuvent être 
employées pour changer des valeurs, par exemple:
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& 1. En ajoutant l’ancienne valeur (ex. ‹+5›, ‹+$10› etc.)

& 2. En soustrayant de l’ancienne valeur (ex. ‹-5› etc.)

& 3. En additionnant deux valeurs (ex. ‹38+17›etc.)

& 4. BEn soustrayant deux valeurs (ex. ‹38-17› etc.)

& 5. En multipliant deux valeurs (ex. ‹7*8› etc.)

& 6. En divisant deux valeurs (ex. ‹80/5› etc.)

Evénement de type Meta 

Les événements de type Meta ne sont pas des événements 
Midi. Ils sont utilisés pour piloter certains paramètres de Logic 
et ajouter des informations qui ne peuvent pas être représen-
tées par des événements Midi.

Pour créer un événement Meta, cliquez sur le bouton Full 
Message Avec le bouton droit de la souris.

Num and Val

Num détermine la fonction du Meta-événement. Dans l’Event 
list, vous ne pourrez ajouter que les valeurs Num suivantes: 

Num = 47 Envoie l’octet en Midi. Ce qui 
permet l’envoi de n’importe quelle 
valeur de Byte (val) comprise entre 0 
et 255 ($00-$FF). Par exemple: si 
vous envoyez 246 comme byte cela 
équivaut à un message de requête 
Midi tuning. Est alors affiché ‹Send 
Byte $F6›. N’employez un tel Meta-
événement que si vous mesurez très 
exactement la portée de votre inter-
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vention; dans le cas contraire, vos 
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modules de sons et vos synthés 
pourraient avoir des comportements 
très étranges… 

Num = 48 Switch Fader. Cela permet l’envoi 
d’événements Midi vers un numéro 
de sortie particulier (Val) via un câble 
switcher. Vous devez au préalable 
connecter un câble entre la piste 
instrument (ex. ‹M-Playback›) et le 
«commutateur de câble» en ques-
tion.

Num = 49 Goto Screenset. Rappelle un des 
screenset (Val détermine le numéro). 
La piste instrument n’est pas 
concernée.

Num = 50 Song Select. Permet de commuter 
entre les songs présentes en 
mémoire (Val = le numéro du song). Il 
n’y a pas de correspondance entre la 
piste dans laquelle apparaît l’événe-
ment et l’événement lui-même.

Num = 51 Goto Marker. Lorsque cet événe-
ment est envoyé, la pré-écoute 
«saute» au marqueur demandé (Val 
détermine le numéro de marqueur 
souhaité). Une fois encore la piste 
sur laquelle apparaît cet événement 
n’est pas concernée.

10.5 Fenêtre Event Float 
La fenêtre Event float peut être ouverte à partir de la plupart des 
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autres fenêtres.

Choisissez Options > Event Float… (ou la commande-clavier 
Open Event Float) pour ouvrir une telle fenêtre. Celle-ci vous X
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donne les informations sur l’objet sélectionné, juste comme le 
ferait une Event list d’une seule ligne. Vous pouvez éditer tous 
les paramètres dans cette fenêtre.

Les paramètres suivants sont affichés:

• Le point de départ de l’objet sélectionné en mesures, pulsa-
tions, divisions et pas d’horloge,

• Le type ou le nom de l’objet,

• Si c’est un événement Midi: le canal Midi enregistré, 
premier octet de donnée (note=nom Midi) et second octet 
de donnée (si nécessaire);

• Longueur de l’objet en mesure, temps, divisions et pas 
d’horloge.

Cliquez sur le petit symbole «film», à l’extrême gauche, pour 
basculer entre l’affichage de la position et la longueur en temps 
SMPTE et l’affichage normal expliquée ci-dessus.

Cliquez sur le symbole SMPTE avec le bouton droit de la 
souris détermine la mise en fonction du bouton ‹Midi Out› et de 
ce fait la pré-écoute Midi est «donnée à voir» via la fenêtre flot-
tante d’événements.
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L’Hyper Editor

Usage
L’Hyper Editor a beaucoup de fonctions. Les principales créent 
et modifient des séquences de batterie, et  modifient graphi-
quement les données de contrôleurs. Malgré certaines similari-
tés, ne confondez pas l’Hyper Editor avec la fonction Hyper 
Draw.

Ouvrir l’Hyper Editor
Pour ouvrir une fenêtre d’Hyper Editor, selectionnez Window > 
Open Hyper Edit (ç avec double-clic sur le bouton droit de la 
souris, ou bien avec un raccourci clavier prédéfini). Vous pour-
rez alors voir le contenu de la séquence sélectionnée dans la 
fenêtre Arrange.

12

3

4

5

11 - 1
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

Structure
La structure de la fenêtre de l’Hyper Editor ressemble que à 
celle de la fenêtre Arrange: il y a une barre de titre horizontale 
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en haut (1) et le panneau optionnel de transport (2)) dans le 
coin en haut à gauche. Sur la gauche il y a la zone de paramètre 
optionnel (3), puis la colonne de nom d’événement (4)) et à 
droite la zone d’édition (5) qui peut être liée à la zone conte-
nant les pistes dans la fenêtre Arrange.

Les lignes individuelles dans l’Hyper Editor sont fonctionnel-
lement similaires aux pistes dans la fenêtre Arrange, dans cette 
dernière, chaque ligne possède une définition d’événement qui 
détermine le type d'événement affiché dans cette ligne 
(comme les pistes dans l'Arrange qui contiennent un instru-
ment). Lorsque vous sélectionnez une ligne dans la colonne de 
nom, sa définition d'événement est montrée dans la boîte de 
paramètres.

L'affichage des événements prend la forme d'une rangée hori-
zontale de barres verticales dont la hauteur indique la valeur de 
l’événement accessible. Vous pouvez directement modifier la 
valeur en saisissant la ligne de repère. Il est possible de sauve-
garder une combinaison de définition d’événements affichés 
simultanément comme un hyper set.

11.1 Hyper Sets
Un Hyper Set est une façon de mémoriser une combinaison  de 
définitions d'événement . Lorsque un Hyper Set est sauvegardé, 
le réglage du zoom vertical de l'Hyper Editor est mémorisé (cela 
détermine le nombre de définitions d'événement affichées 
simultanément). Vous pouvez sauvegarder autant d’Hyper Sets 
que vous avez besoin dans un Song.

Choisir un Hyper Set
Juste au-dessus du champ de paramètre de définition d'événe-
ment, il y a le champ de sélection d’Hyper Set. Cliquer dessus 
11 - 2
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ouvre un menu déroulant qui permet de sélectionner un Hyper 
Set différent.
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Créer un Hyper Set
Pour créer un nouveau Hyper Set, selectionnez Hyper > Create 
Hyper Set. Le preset de définition d'événement dans le 
nouveau Hyper Set est le contrôleur de volume (#7). Toute les 
modifications que vous faites, telles qu’ajouter ou redéfinir les 
définitions d'événement, ou ajuster le réglage du zoom vertical, 
sont automatiquement emmagasinées dans l’Hyper Set actuel 
(comme avec les réglages d’écran).

Nommer l’Hyper Set
Pour nommer l’Hyper Set actuel, double-cliquez sur le champ 
de sélection de de l’Hyper Set.

Effacer a Hyper Set
Pour effacer l’Hyper Set actuel, sélectionnez Hyper > Clear 
Hyper Set.

11.2 Définitions d'événements
La définition d'événement d'une ligne d’hyper edit détermine 
quels événements elle affiche. Cette sélection concerne habi-
tuellement l'octet de statut et le premier octet de données de 
l'événement. Le deuxième octet de données contient alors la 
valeur ajustable, qui est représentée par un huitième de barre. 
Par exemple, dans une ligne de définition d'événement, la 
valeur d'un contrôleur ou la valeur de vélocité d'une note est 
montrée comme une barre. Ne vous inquiétez pas si cela 
semble un peu confus au début: Lorsque vous réglez les para-
mètres de l’hyper definition, Logic vous aide en fournissant des 
menus déroulants contenants des définitions écrites de l'octet 
de statut et (dans la plus grande mesure possible) le premier 
octet de données. Il y a une façon plus simple pour régler les 
11 - 3
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hyper définitions: vous pouvez automatiquement créer des défi-
nitions d'événement pour des événements choisis: voir en 
dessous.
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Il y a de nombreuses manières de modifier la façon dont les 
barres sont  affichées, et les ajuster aux types particuliers 
d'événements. Vous pouvez aussi employer la grille pour 
aligner l'affichage des événements existants, et ajouter de 
nouveaux événements. Cette grille peut être réglée indépen-
damment pour chaque définition d'événement dans un hyper 
set. La hauteur des lignes dans l’hyper set est ajustée en utilisant 
les fonctions de zoom vertical de la fenêtre d’Hyper Edit.

Sélectionner la définition d'événement

Comme avec des pistes dans l'Arrange, vous pouvez sélection-
ner une définition d’événement en cliquant sur la colonne de 
nom. Cela vous permet de voir ses paramètres dans la boîte de 
paramètre de définition d'événement. A la différence des pistes 
d’arrangement, il est cependant possible de faire une sélection 
multiple.

Créer une définition d'événement

Lorsque vous choisissez Hyper > Create Event Definition une 
nouvelle définition événement est ajoutée à la position de la 
définition de l'événement actuellement choisi. Initialement, il 
a les mêmes paramètres. Les définitions d’événement au-
dessous de lui sont déplacées vers le bas.

Créer automatiquement des définitions d'événement

Si vous sélectionnez un événement dans une autre fenêtre 
d’édition ouverte, vous pouvez créer automatiquement une 
définition d'événement équivalente en Validant Auto Define .Si 
l’Hyper set actuel contient déjà une définition d'événement qui 
correspond au type de l'événement choisi, Logic ne crée pas 
une définition superflue. Au lieu de cela cette définition 
d'événement est déplacée dans la zone visible.

N'oubliez pas de désactiver Auto Define aussitôt après avoir 
11 - 4
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Créer plusieurs définitions d'événement automatiquement

Vous pouvez également créer automatiquement plusieurs défi-
nitions d'événement.  Sélectionner les événements sur lesquels 
vous voulez baser les définitions d'événement. Vous pouvez 
employer la même fonction pour créer des définitions d'événe-
ment pour tous les types d’événements de la séquence choisie.

Créer un nouveau Hypet Set avant tout serait une bonne idée.

Si vous choisissez Hyper > Multi Create Event Definition… _ 
une boîte de dialogue paraît et vous demande si vous voulez 
créer des définitions d’événement pour tous les types d'événe-
ment (sélectionnez All ou appuyez sur R) ou juste pour les 
événements choisis (Selected). Appuyez sur Cancel pour quitter.

Effacer une définition d'événement
Choisissez Hyper > Delete Event Definition pour effacer la défi-
nition d'événement sélectionnée.

Hyper Sets: Copier des définitions d'événement
Sélectionner la définition d'événement que vous voulez copier 
et  choisissez Hyper > Copy Event Definition. Allez à la destina-
tion Hyper Set et choisissez Hyper > Paste Event Definition.

Convertir des définitions d'événement
Vous pouvez redéfinir une définition d'événement avec tous ses 
événements. Les valeurs des événements sont retenues mais le 
type d'événement est changé à la nouvelle définition d’événe-
ment. Choisissez Hyper > Convert Event Definition…, ou 
double-cliquez sur la colonne de nom de la définition d'événe-
ment que vous voulez convertir. 

La boîte montrée ci-dessus apparaît. Sur la gauche (convert), 
vous pouvez voir les paramètres de la définition d’événement 
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sélectionnée, et sur la droite vous pouvez définir les paramètres 
du type d’événement de destination. Les réglages actuels sont 
utilisés comme valeur par défaut.
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Si vous validez Quantize Events (donc si vous y inscrivez une 
croix), les positions de l'événement sont quantifiées selon le 
réglage Grid sur le côté droit du champ de saisie. Si vous ne 
faites plus de modifications, cela vous permet de quantifier 
juste les positions des événements. S'il y a une valeur de Delay 
sur le côté droit, elle est prise en compte par la quantification.

Trier les définitions d'événement
Pour changer l'ordre vertical des diverses définitions d'événe-
ment, saisissez la définition d'événement que vous voulez 
déplacer par sa colonne de nom, et tirez la à la position désirée.

La boîte de paramètre de définition 
d'événement (Event Definition parameter box)
La boîte de paramètre de définition d'événement est l’endroit 
vous faites les réglages pour la définition de lignes d'événe-
ments actuellement choisies. Les paramètres les plus impor-
tants sont Status et -1- (page 11 - 9).

Ouvrir la boîte de paramètre de définition d'événement.
11 - 6
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Vous pouvez montrer (ou cacher) la zone de paramètre gauche 
entière en activant (ou en désactivant View > Parameters. Vous 
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pouvez fermer ou bien ouvrir la boîte de paramètre en cliquant 
sur le triangle dans le coin en haut à gauche.

Le nom de la définition d'événement

En cliquant sur le nom à côté du triangle ,vous pouvez détermi-
ner ce qui apparaît dans la colonne de nom. Si vous définissez 
un contrôleur MIDI nommé ou une note d'un instrument 
mappé via les paramètres de Statut et de - 1-, le nom sera consi-
déré comme un preset. modifier le nom d’une note dans la défi-
nition d'événement modifie également le nom de la note dans 
l'instrument mappé.

Vous pouvez aussi afficher, ajouter, et modifier les Meta Events 
dans la définition d'événement de l’Hyper Editor.

Affichage et Modification de la grille

Le paramètre Grid est réglé via le menu de quantification 
déroulant typique. De nouveaux événements peuvent alors 
être ajoutés aux positions de grille réglées. Les positions 
d'événements actuels ne sont pas affectées.

Si vous désirez quantifier les positions, vous pouvez le faire en 
utilisant la quantification d’affichage (voir page 1 - 34) ou plus 
simplement avec la conversion de définition d’événement 
(page 11 - 5).

La même quantification temporaires sont disponibles comme 
pour les paramètres de playback, incluant le Groove Template 
que vous avez défini vous-même.

Pendant l’édition de rythmes complexes de batterie, il peut 
être utile de créer plusieurs hyper définitions pour une note de 
batterie, chacune avec une grille de quantification différente. 
Par exemple, s'il y a deux lignes pour une caisse claire, une avec 
une grille de 1/16 et l'autre avec une grille de 1/96, vous pouvez 
employer l’outil crayon pour ajouter des coups individuels dans 
11 - 7
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la grille principale et des roulements dans la grille avec la plus 
fine quantification.
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Largeur des barres 

Vous pouvez régler la largeur des barres d'événement entre 1 et 
16 en utilisant le paramètre Penwidth. Indépendamment de la 
largeur de la barre, la position exacte de l'événement est 
toujours marquée par le bord gauche de la barre.

Réglés à la valeur maximale (Penwidth = 16) les événements de 
note sont affichés avec leur longueur réelle.

Affichage des barres 

Le paramètre Style vous permet de choisir quatre couleurs 
différentes de variation d’affichage pour les barres. Les styles 
de 5 à 8 sont les mêmes que de 1 à 4, mais les événements choi-
sis clignotent pour les souligner.

Delay

Le paramètreDelay peut être employé pour retarder (avec des 
11 - 8
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valeurs positives) ou pour avancer (valeurs négatives) tous les 
événements dans une ligne de définition d'événement par un 
nombre ajustable. Le changement dans la position est visible 
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immédiatement. Mêmes les nouveaux événements sont déca-
lés des positions de grille par la valeur de Delay. Si vous cliquez 
entre le mot Delay et la valeur de paramètre vous pouvez 
employer un menu déroulant pour entrer des valeurs de note 
(p. e. 1/16 etc.) directement.

A la différence de l’option de delay de la lecture de séquence, 
cela concerne seulement les types d'événement individuels ou 
les numéros de note, ce qui est très utile pour la programmation 
de la batterie.

En général, il est utile de transmettre les données de contrôleur 
légèrement avant ou après les positions de grille exactes pour 
améliorer le timing des notes se trouvant sur les positions de 
grille.

La longueur de notes à ajouter 

Vous pouvez employer le paramètre Length pour régler la 
longueur de  notes à ajouter, mesurée en divisions (le nombre 
gauche) et en pas d’horloge (le numéro de droite).

Afin de garantir le timing optimum pendant la programmation 
de la batterie, vous devez vous assurer que les événements de 
note off ne doivent pas être transmis au même moment que des 
événements de note on. Utilisez des longueurs de note qui ne 
sont pas fermées à des valeurs de notes fixes, e.g. 100 ticks (1/48 
note = 80 ticks, 1 /32 note = 120 ticks). De très petites valeurs 
de tick sont aussi inadaptées, parce que les événements de note 
off peuvent des fois être transmis en même temps que des 
événements de note on à la même position.

Le statut d'événement 

Si vous saisissez le côté droit de la ligne de Status , line un menu 
déroulant s’ouvre et vous pouvez y déterminer le statut 
d'événement pour cette ligne de définition d'événement.
11 - 9
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Canal Midi 

à côté de Cha se trouve une boîte de validation et à la droite de 
celle-ci vous pouvez régler un numéro de canal Midi. Si vous 
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mettez une croix dans cette boîte, l’affichage sera réservé aux 
événements sur le canal réglé. Si vous ne mettez pas de croix, le 
paramètre de canal est ignoré, et tous les événements sur tous 
les canaux sont affichés.

Premier octet de données

Dans la ligne du bas il y a le paramètre -1- où vous pouvez 
déterminer le premier octet de données de l'événement affi-
ché.

Par exemple, si Note est réglé comme statut d'événement, vous 
pouvez déterminer ici quelle hauteur de note (note #) devrait 
être affiché dans cette ligne de définition d’événement. Si la 
séquence modifiée est jouée par un instrument mappé, un 
menu déroulant apparaît ici avec les noms des notes d'insertion 
(noms de son de batterie).

Comme avec le canal MIDI, la Boîte de validation détermine 
(si elle est cochée) si seulement les événements avec le premier 
octet de données défini doivent être affichés, ou si (si elle n’est 
pas cochée) le réglage devrait être ignoré. Dans le cas d'événe-
ments de note, les valeurs de vélocité de toutes les notes (indé-
pendamment de la hauteur de note) seront affichées dans la 
ligne de définition d'événement correspondante.

Si Control est réglé comme statut d'événement vous pouvez 
employer un menu déroulant pour déterminer le type de 
contrôleur (contrôleur #).

Avec l’aftertouch de canal (statut C-Press) ou bien les événe-
ments program changes (statut Program) Le réglage du paramè-
tre -1- est toujours ignoré, étant donné que le premier octet de 
données est affiché comme hauteur de barre. Avec les données 
de pitch bend (statut PitchBd) le réglage est également ignoré, car 
les deux octets de données sont employés pour afficher la 
hauteur de la barre.
11 - 10
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Faire des définitions différentes simultanément
Comme les paramètres dans plusieurs séquences vous pouvez 
régler les paramètres de plusieurs définitions d'événement 
simultanément. Sélectionner plusieurs définitions d'événe-
ment dans la colonne de nom en maintenant la touche S 
enfoncée tout en cliquant sur eux. Vous pouvez également 
utiliser Hyper > Select All Event Definitions pour sélectionner 
toutes les définitions d'événement et alors désélectionnez en 
certaines en appuyant sur S tout en leur cliquant dessus.

Toutes les modification que vous faites dans la boîte de para-
mètre de définition d'événement concernent absolument 
toutes les définitions d'événement sélectionnées.

ModeHi-Hat 
Dans ce mode, les définitions d'événement peuvent être 
rassemblés ensemble dans des groupes dans lesquels un seul 
événement de chaque groupe peut être joué à n’importe quelle 
position de temps. Un emploi typique est de collecter plusieurs 
notes de hi-hat (ouvert, fermé, pédale...) en un groupe.

Pour définir un groupe hi-hat, cliquez dans une des lignes au 
bord gauche de la colonne de nom. Cliquer ici une fois de plus 
pour couper le mode hi-hat pour cette ligne. Toutes les lignes 
d’un groupe hi-hat doivent être verticalement adjacentes.

Si vous ajoutez un événement dans un groupe hi-hat, tous les 
événements actuels à cette position de temps seront effacés. 

Vous pouvez créer autant de groupes hi-hat que vousdésirez 
dans un hyper set, mais ils doivent tous être séparés par au moins 
une ligne dans laquelle le mode hi-hat est désactivé.

11.3 Utilisation
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La grille définie par le paramètre Grid dans la boîte de paramè-
tres de définition d'événement est très importante:
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• Pendant la sélection, tous les événements dans une section 
de grille sont sélectionnés,

• Lorsque vous changez les valeurs d'événements existants, 
tous les événements dans une section de grille sont modifiés, 
et

• Les nouveaux événements sont ajoutés aux positions de la 
grille, conformément à la valeur du paramètre Delay. 

Techniques de sélection
Vous pouvez employer une des techniques habituelles de 
sélection, comme décrites au paragraphe «Techniques de 
sélection» à la page 1 - 24. Cependant, il y a les différences 
suivantes:

• Pour sélectionner des événements individuels appuyez sur 
la touche S , comme lorsque vous sélectionnez plusieurs 
d'événements qui sont éparpillés à travers l’écran,et;

• Lorsque vous faites une sélection au lasso (Rubberband) 
appuyez sur la touche S (faites attention à ne pas cliquer sur 
un des événements).

Déplacer et copier des événements
Lorsque vous déplacez des événements sélectionnés, vous 
devez également appuyer sur la touche S.

Pour copier des événements, utilisez la toucheç comme 
d’habitude.

Avec les deux opérations, vous pouvez déplacer des événe-
ments à d’autres lignes de définition d’événement. Les événe-
ments seront automatiquement convertis.
11 - 12
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Modifier des valeurs d'événement
Vous pouvez modifier des valeurs individuelles en saisissant la 
barre d'événement (avec l’outil crayon ou le pointeur de la 
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souris). Lorsque vous changez la valeur de l'événement, la 
valeur actuelle est montrée dans la ligne supérieure.

Modifier plusieurs événements

Si plusieurs événements sont sélectionnés, vous pouvez modi-
fier toutes les valeurs de façon relative, en saisissant juste une 
des barres d'événement. La différence absolue entre les valeurs 
d'événement reste la même. Si une des barres atteint le 
sommet ou le plafond, vous ne pourrez pas aller plus loin dans 
cette direction.

Cependant, si vous appuyez sur la touche ç durant cette 
action, vous pouvez continuer à élever ou à abaisser les valeurs 
du groupe d'événement sélectionné, jusqu'à ce que la barre que 
vous êtes en train de bouger atteingne le plafond ou le plan-
cher.
11 - 13
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Réglage d’une série manuelle

Evénements existants 

Tracez les événements avec le pointeur de la souris tandis que 
vous appuyez sur le bouton de la souris.

Créer de nouveaux événements

Tracez les événements avec le crayon tandis que vous appuyez 
sur le bouton de la souris. Le crayon est préréglé comme 
deuxième outil (bouton droit de la souris).

Configuration d’une série linéaire

• Sélectionner l’outil crosshair.

Cliquer n'importe où dans la zone d'affichage de barre et 
11 - 14
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maintenir le bouton de la souris.
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• Garder un oeil sur l'affichage montrant la valeur de l'événe-
ment et la position exacte dans la ligne du haut. Déplacer la 
souris au point de départ de la ligne que vous désirez.

• Relâchez le bouton de la souris.

• Déplacer la souris au point de fin de ligne désiré (à droite ou 
à gauche). Vous pouvez aussi garder un oeil sur la position 
et sur la valeur de l’événement dans la ligne du haut.

• Cliquez pour aligner les barres d’événement le long de la 
ligne.

S'il y avait déjà des événements dans la zone entre les points de 
début et de fin, ils sont alignés le long de la ligne.

S'il y avait pas d'événements dans la région de nouveaux événe-
ments sont créés aux positions de la grille (conformément au 
paramètre Grid).

Si vous voulez définitivement créer de nouveaux événements, 
appuyez sur la touche ç lorsque vous cliquez pour la dernière 
fois.

Cela crée un événement à chaque valeur de grille. Avec des 
pentes très plates, ou des grilles très fines, les positions de grille 
individuelles restent inoccupées si la valeur qui va être ajoutée 
ici est la même que la valeur de l’événement précédent. Cela 
réduit le flot de données dans le bus MIDI sans réduire la réso-
lution du contrôleur.

Quand vous définissez le paramètre Grid pour ajouter des 
successions de contrôleurs employez la devise, _aussi rude que 
possible et aussi fin que nécessaire _ pour préserver le rende-
ment des données. Logic peut traiter avec une très grande 
somme de données mais malheureusement la même chose ne 
peut pas être dite du MIDI.
11 - 15
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Séries linéaires dans les sections
La dernière fois que vous avez cliqué (indépendamment du fait 
que vous ayez ou non appuyé sur la touche ç O pour insérer 
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de nouveaux événements) si vous avez aussi appuyé sur S, 
vous pouvez aussitôt tirer une autre ligne à partir du point de fin 
de cette ligne.

Ajouter des événements individuels
Employez l’outil crayon pour ajouter des événements indivi-
duels. Vous pouvez modifier la valeur ajoutée même avant de 
libérer le bouton de la souris. Le crayon est le deuxième outil 
(bouton droit de la souris).

Fixer la valeur
Si vous validez Fix Value , vous pouvez empêcher la hauteur de 
toutes les barres d'événement d’être modifiées avec le pointeur 
de la souris ou le crayon.

Lorsque vous ajoutez des événements avec l’outil crayon, tous 
les événements ajoutés sont donnés avec la valeur de l'événe-
ment choisi auparavant. Cela vous permet de tirer une succes-
sion d'événements avec  la même valeur.

En sélectionnant un événement avec le crayon, vous pouvez 
adopter cette valeur comme preset, parce que en mode fix 
value, il est impossible de modifier la valeur en cliquant dessus.
11 - 16
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Lorsque vous ajoutez des événements avec l’outil crosshair, la 
valeur de preset est toujours employée comme point de départ 
de la ligne.
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Chapitre 12

Le Matrix Editor

Le Matrix Editor est utilisé pour éditer graphiquement des 
événements de note. Sont gros aventages sur les autres éditeurs 
est sont habilité à fournir un affichage beaucoup plus précis de 
la longueur , de la position et de la vélocité des notes. Le Matrix 
Editor est conçu pour un réglage précis des positions et des 
longeurs des notes.

Ouverture du Matrix Editor
Pour ouvrir une fenêtre Matrix Editor montrant le contrnu de la 
séquence sélectionnée, passez par Window > Open Matrix Edit () ou 
bien par un raccourci clavier que vous aurez défini (Open Matrix 
Editor).

Vous pouvez également double-cliquer sur une séquence 
pendant que vous maintenez enfoncée la touche ç.

1

23

4

5
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Le champ de paramètre optionnel 1 1 contient les boutons 
standard et la boîte à outils. Comme pour la fenêtre Arrange 
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(ainsi que les éditeurs Hyper et Score), il y a une règle se trou-
vant en haut de la fenêtre 2. Sur la gauche de cette règle 
(comme avec la fenêtre Transport), vous pouvez définir les 
sous-divisions 3. Le clavier d’écran vertical 4 indique la 
hauteur des notes qui sont affichées comme durée 5.

12.1 Affichage
Seules les notes sont montrées dans le Matrix Editor. Les barres 
représentant la durée (et la façon dont elles peuvent être 
éditées) sont similaires aux séquences dans la fenêtre Arrange.

Noms des notes et de leurs hauteurs
La hauteur est indiqué par le clavier vertical se trouvant sur la 
gauche. Les lignes horizontales traversant l’écran entre le Si et 
le Do et entre le Mi et le Fa sont là pour vous aider au position-
nement.

Souvenez-vous que vous pouvez adapter la numérotation 
d’octave aux machines Roland et Korg (page 17 - 15).

Si une séquence d’instrument assigné (mappé) doit être affi-

1

2

4

5

3

12 - 2
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chée, les noms des notes doivent être joués lorsqu’ils apparais-
sent sur le clavier vertical au lieu des notes Do et Fa.
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Remarquez que lorsqu’une note d’un instrument assigné est 
déplacée son nom peut être visualisé dans la ligne d’informa-
tion.

Position
Vous pouvez lire la position d’une note sur la régle. L’arrière-
plan est marqué d’une ligne verticale pour vous assister au posi-
tionnement:

• Une ligne épaisse à chaque mesure,

• Une ligne fine à chaque pulsation

• Une ligne pointillée à chaque division (vous pouvez modifier 
la valeur des divisions dans la fenêtre Transport ou dans la 
zone de paramètre en haut à gauche).

Arrière-plan
En choisissant View > Change Background vous pouvez passer 
à un arrière plan plus «design». Mais ce type d’affichage ne 
permet pas la présence des lignes verticales pointillées indi-
quant la position des divisions.

autres options d’affichage
Toutes les autres options d’affichages sont détaillées dans le 
paragraphe «Fonctions d’Affichage» à la page 1 - 36. Dans le 
Matrix Editor, vous désirerez le plus souvent déplacer la section 
visible (en utilisant les barres de défilement), et modifier le 
zoom d’affichage (avec les boutons telescope et loupe).

12.2 Edition des notes 
Vous pouvez utiliser les mêmes fonctions intuitives d’édition 
12 - 3
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que pour les séquences dans la fenêtre Arrange.
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Il existe également quelques options d’édition qui sont dispo-
nibles dans toutes les fenêtres d’édition. Elles sont détaillées 
dans le paragraphe «Fonctions d’édition» à la page 1 - 30.

Création de notes
Pour créer une note, cliquez avec l’outil crayon à l’emplace-
ment désiré sur l’arrière-plan.

Duplication de notes
Pour copier une note existante à une autre position ou une 
autre hauteur, cliquez tout d’abord sur la note originale avec 
l’outil crayon (près du centre).

Maintenant, toutes les notes que vous créez en cliquant sur 
l’arrière-plan doivent avoir exactement la même longueur et la 
même vélocité que la note originale.

Déplacer des notes
Vous pouvez déplacer les notes sélectionnées en les saisissant 
(près du centre) et en les déplacant. Si vous déplacez les notes 
verticalement, elles seront transposées, et si vous les déplacez 
horizontalement, elles seront déplacées dans le temps. tant que 
vous maintenez enfoncé la bouton de la souris, la position cible 
et la hauteur seront indiquées dans la ligne d’information en 
haut.
12 - 4
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Lorsque vous déplacez des notes horizontalement, elles se 
place sur les positions des divisions (Vous poubvez modifier le 
réglage des divisions si vous le désirez.
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Souvenez-vous que vous pouvez limiter le mouvement à une 
direction pour éviter de transposer accidentellement les notes 
lorsque vous les déplacez verticalement (et vice versa). Pour 
cela , le chemin d’accès est File > Preferences > Global: Limit 
Dragging to one direction in Matrix and Score.

Réglage d’une grille plus fine
Lorsque vous déplacez des notes dans la fenêtre Matrix, vous 
pouvez faire des ajustements plus fins à une grande résolution 
en maintenant enfoncée la touche A pendant que vous les 
déplacez. La résolution exacte que vous utilisez dépends du 
réglage actuel du zoom de la fenêtre.

Si vous maintenez enfoncées les touches A+S keys, vous 
pouvez déplacer les notes en pas d’horloge, indépendamment 
du zoom et de la grille de temps.

Copie de notes
Maintenez enfoncé la touche ç pendant que vous déplacez 
les notes.

Bien sûr, Vous pouvez également copier (Edit > Copy ou çc) 
ou déplacer (Edit > Cut or çx) les notes dans le presse-
12 - 5
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papier, puis les ajouter à la position courante de la song à la 
hauteur original (choisissez Edit > Paste ou çv; voir page 1 - 
28).
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Modifier les longueurs
Pour altérer la longueur d’une note, saisissez-la par son coin en 
bas à droite et déplacez la à sa longueur désirée. Pendant que 
vous modifiez la longueur, la ligne d’info vous informe de la 
longueur précise de la note. 

Modifier la longueur de plusieurs notes simultané-
ment
Vous pouvez ajuster la longueur de plusieurs notes sélection-
nées à la fois en altérant simplement la longueur d’une d’elles.

Rendre des notes de même longueur
Si vous désirez rendre plusieurs notes sélectionnées de même 
longueur, maintenez enfoncées les touches çS (comme 
dans la liste d’événement lorsque vous donnez la même valeur 
à plusieurs paramètres).

Quel outils utiliser

Lors de la modification de longueur de notes, vous pouvez aussi 
bien utiliser le pointeur que le crayon. Malgré tout, il est préfé-
rable d’utiliser le pointeur cas sinon vous pourriez accidentelle-
ment écrire de nouvelles notes avec l’outil crayon.

Lorsque vous avez de très petites notes, il ce peut que les saisir 
par le coin inférieur droit soit difficile. Dans ce cas, vous pouvez 
utiliser l’outils doigt qui vous permet de saisir les notes 
n’importe où, et modifier leur longueur.
12 - 6
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Modifier la vélocité
TPour altérer la valeur de vélocité, cliquez sur la note grâce à 
l’outil V. La ligne d’info doit alors indiquer la vélocité de la note 
sur laquelle vous avez cliquer. 

ISi vous maintenez enfoncé le bouton de la souris, vous pouvez 
modifier la vélocité par un mouvement vertical de la souris. Si la 
fonction Midi Out est activée, la note doit sortir chaque fois que 
vous modifiez la vélocité.

Modifier la vélocité de plusieurs notes

Toutes les notes sélectionnées peuvent être modifiées simulta-
nément, avec les différences dans les valeurs maintenues. Si la 
vélocité d’une des notes sélectionnées atteint une valeur extre-
mum (0 ou 127), vous ne pouvez pas aller plus loin. Malgré cela, 
en appuyant simultanément sur les touches A, vous pouvez 
continuer à modifier la vélocité jusqu’à ce que la note sur 
laquelle vous avez cliquer ait atteint une valeur extremum.

Pour doner à toutes les notes la même vélocité, maintenez 
enfoncées les touches A+S pendant que vous modifiez les 
valeurs.

Hyperdraw dans le Matrix Editor
Dans le Matrix Editor et le Score Editor, vous pouvez utiliser la 
commande View > HyperDraw… pour incérer un affichage 
12 - 7
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Hyperdraw. Ceci permet une édition rapide et facile des 
données de contrôleur en fonction des données des notes.

Une fois que vous avez incérer l’affichage Hyperdraw, vous 
pouvez choisir le type d’événement que vous désirez afficher 
via le menu de pointage se trouvant sur la gauche.

Vous pouvez ajuster la taille de l’Hyperdraw en saisissantla ligne 
de séparation et en la déplacant verticalement.

Fonctions de l’HyperdrawEffacement rapide

Vous pouvez effacer tous les événements affichés dans l’Hyper-
draw pour une séquence en appuyant sur Sçet en double-
cliquant dans la zone bleu de l’Hyperdraw. 

Ajout de nouveaux points

Pour ajouter de nouveaux points, cliquez simplement sur 
l’arrière-plan bleu de l’affichage de l’Hyperdraw. Vous pouvez 
12 - 8
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également utiliser le pointeur ou l’outil crayon, et un point doit 
apparaitre. Tant que vous maintenez enfoncé le bouton de la 
souris, vous pouvez déplacer n’impotre lequel de ces points. La 
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position et la valeur sont affichés dan la ligne d’info au sommet 
de la fenêtre Arrange.

Aucun événement ne sera inséré dans une séquence tant que 
vous ne relâchez pas le bouton de la souris.

Effacer des points

Pour effacer un point, cliquez simplement dessus.

Déplacer un point existant

Saisissez un point avec la souris et déplacez-le. Si vous mainte-
nez enfoncé le bouton de la souris pendant que vous effectuez 
cette opération, vous pouvez retrouver des points éffacés de la 
courbe en déplaçant la souris au dessus de leur emplacement 
d’origine.

Réglage fin des points de la courbe 

Pendant que vous déplacez un point, maintenez enfoncée la 
touche A Vous serez alors limité à l’axe vertical en déplace-
ment, mais capable de sélectionner les 127 niveaux possibles.

Effacement
Vous pouvez effacer les notes sélectionnées en appuyant sur la 
touche B ou bien en cliquant sur elles avec l’outil gomme.

12.3 Techniques de sélection
En plus des options habituelles de sélection, vous pouvez 
selectionner toutes les notes de même hauteur à travers toute la 
séquence en cliquant sur une des touches se trouvant à l’écran.

Si vous maintenez enfoncé le bouton de la souris, vous pouvez 
également dessiner (sous la forme d’un lasso (Rubberband)) une 
12 - 9
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gamme de hauteurs par dessus le clavier d’écran et ainsi sélec-
tionner toutes les notes s’y trouvant. 
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N’oubliez pas les options de sélection spéciales disponibles via 
le menu Edit (ou bien grâce aux raccourcis clavier). Elles sont 
détaillées page 1 - 27.

12.4 Fonctions
Pour une description de toutes les autres fonctions du Matrix 
Editor, telles que la correction de longueur automatique, et 
l’effacement ou le copiage selectifs, référez-vous au paragraphe 
«Fonctions Générales des Editeurs» à la page 1 - 29.
12 - 10
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Fenêtre Score Edit 

Ce chapitre contient tout ce qui concerne les modifications de 
vos séquences en utilisant la notation conventionnelle. Bien 
que l’Event Editor et le Matrix Editor possèdent des caractéris-
tiques qui sont conçues pour des tâches spécifiques (telles que 
les modifications de longueur de note et de vélocité), si vous 
lisez la musique, il y a rien de mieux que d’être capable de 
travailler directement sur les voies. 

Ce chapitre commencera avec une discussion sur les fonctions 
du Score Editor comme elles se réfèrent à l’édition d’événe-
ments Midi et  leur sortie via Midi. La partie finale du chapitre 
traitera de la mise en page et de l’impression du score.

Ouverture du Score Editor
Le Score Editor est automatiquement ouvert Lorsque vous 
cliquez avec le bouton gauch sur une séquence. Vous pouvez 
aussi sélectionner la séquence et choisir Window > Open Score.

Les éléments standard dans le Score Editor
Comme résumé de ce qui est disponible, voici les éléments 
énumérés:

• Les boutons Catch, Link, Midi Out, Zoom
• Une boîte à outils
• Les règles de mesure

L’utilisation de ces éléments devrait vous être familière main-
tenant.
13 - 1
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La boîte de paramètre
Le menu Options est où vous pouvez cacher la boîte de paramè-
tre . C’est utile si vous employez un petit écran puisque ça 
laisse plus de place aux voies.

Zooming
Le Score Editor a trois niveaux de zoom. Employez le zoom 
télescopique comme d’habitude .

Graphik

Les trois niveaux de zoom

Lorsque vous ouvrez le Score Editor pour la première fois, il se 
régle par défaut au niveau de zoom moyen.

13.1 Justifier l’affichage
La qualité d’affichage par défaut est généralement assez suffi-
sante quand vous modifiez juste des notes, comme on est plus 
concerné par l’efficacité et la vitesse qu’avec la volonté de 
perfectionner un score pour l’impression. Cependant, il peut 
devenir nécessaire d’ajuster certains paramètres d’affichage 
pour une meilleure accomodation à la matière musicale qui a 
été modifiée. Vous trouverez les paramètres d’affichage dans la 
13 - 2
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boîte de paramètre d’affichage qui est  décrite en détail dans le 
paragraphe «Mise en page et Impression» à la page 13 - 9.
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Cliquez sur la petite boîte à côté du nom de 
la séquence pour ouvrir la boîte de paramè-
tres d’affichage. 

Elle contient quelques fonctions importan-
tes dont Logic a besoin pour fournir une 
base destinée à l’affichage de notation.

‹Style›
Les styles de score dans Logic sont des réglages standards pre-
programmés pour des instruments spécifiques. Si c’est un piano 
ou une contrebasse ou des instruments transposés tels que le 
saxophone, le Style contient, parmi d’autres choses, la bonne 
clef, la transposition et la gamme d’octave. Sélectionner un 
style ajuste automatiquement l’affichage des notes dans la 
séquence. Logic Audio Silver fournit 10 presets de Styles de 
score. (L A Gold et Platinum fournissent un nombre illimité de 
style de score définissables) par exemple, regardez comment la 
sélection de ‹Bass-8› affecte l’affichage de la séquence de basse 
montrée en dessous.

Meilleure lisibilité en choisissant un autre Style (à droite)

Autostyle
Logic attribue automatiquement aux nouveaux enregistre-
ments un style qui se base sur la gamme des notes jouées. Les 
notes dans la gamme de basse sont affichées avec une clef de 
basse et les notes plus hautes avec une  clef aigue. Si l’enregis-
trement contient des notes des deux gammes alors une voie de 
13 - 3
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piano est employée.
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Logic permet aussi des champs de chevauchement. Par exem-
ple, si la note la plus haute dans un enregistrement est Ré, une 
clef de basse est employée. Cependant, si la note la plus basse 
est Si, l’enregistrement sera encore montré dans une voie avec 
une clef aigüe.

Quantification de l’affichage
L’affichage de quantification est fait pour choisir le format de 
rythme correct pour la matière musicale. Vous devez régler la 
valeur ‹Qua› à la plus petite valeur de note qui paraît dans la 
musique. Si les plus petites notes de la séquence sont des 
double-croches, règlez le sur ‹1⁄16› et rien de plus petit, car un 
réglage de quantification trop fin peut rendre la musique illisi-
ble:

Graphik

La valeur ‹Qua› est trop petite

Le réglage ‹Default› signifie que la quantification d’affichage 
adopte la valeur de ‹display format› de la fenêtre Transport .

La quantification d’affichage concerne l’affichage seulement, et 
non les événements Midi représentés par l’affichage. Ne 
confondez pas ce paramètre ‹Qua› avec celui de la fenêtre 
Arrange ou de l’Event Editor.

Les autres fonctions de paramètre d’affichage sont décrites 
dans le paragraphe «Mise en page et Impression» à la page 13 - 
9.
13 - 4
Emagic
Logic Audio Pro ISIS 



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Edition des notes

13.2 Edition des notes

Sélection
Les notes individuelles sont sélectionnées en cliquant comme 
d’habitude. Pour sélectionner un groupe de notes, telles  que 
les notes dans un accord, traînez un  lasso autour d’elles. Pour 
sélectionner des notes incongrues, appuyez sur la touche S 
Pendant que vous cliquez.

La Ligne Info 
La ligne d’info du score Editor est affichée juste sous la barre de 
titre de la fenêtre dès que vous copiez ou déplacez un objet. La 
ligne d’info fournit des informations sur la position exacte des 
événements et, lorsque c’est faisable, la longueur. Il est donc 
très utile de la contrôler pendant une opération de modifica-
tion.

La boîte de paramètre d’événement 
Cette boîte est située en dessous de la boîte de paramètre 
d’affichage et fournit les données sur l’objet choisi. Les para-
mètres réels affichés dépendent de l’objet. Quand une note ou 
des notes sont sélectionnées, les paramètres sont la hauteur de 
note(Pitch), la vélocité(Velocity) et la longueur(Lenght). Ces para-
mètres peuvent être modifiés et appliqués à plus d’un événe-
ment en même temps.

Les paramètres fonctionnent de la même façon que dans 
l’Event Editor. Si les valeurs de notes choisies sont différentes 
les unes des autres, le paramètre accessible montre une astéris-
que. Dans ce cas, Modifier une des valeurs les change toutes, 
de la même valeur relative. 

EXEMPLE: si vous sélectionnez un accord, le paramètre de 
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hauteur de note montrera un astérisque. Si vous tenez cliqué et 
que vous déplacez la souris, toutes les notes de l’accord bouge-
ront.
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Si vous maintenez la touche ç en modifiant les valeurs, le 
paramètre est réglé à la même valeur pour tous les objets sélec-
tionnés. Cela peut être utile par exemple quand vous voulez 
changer les longueurs de toutes les notes dans un accord à la 
même valeur.

Vous pouvez aussi transposer la piste ou la séquence entière -
dépendant du niveau- en utilisant ‹Select All› à partir du menu 
d’édition local.

Déplacer et transposer
Pour déplacer ou transposer des notes, choisissez les et faites 
les glisser à la position désirée; la ligne d’info apparaîtra sous la 
barre de titre de la mesure et montrera la position actuelle du 
curseur de la souris,  en terme de hauteur de note et de temps. 
La résolution des pas est défini par le format d’affichage dans la 
fenêtre transport.

Copier
Pour copier des notes, choisissez les et faites les glisser à la posi-
tion désirée en maintenant ç  . Vous pouvez aussi employer 
les fonctions copier et coller du menu d’édition.

Insérer
Les notes peuvent être créées en utilisant l’outil stylo. Cliquez 
et maintenez le stylo à la position désirée. Une fois que la ligne 
d’Info montre l’emplacement et la hauteur de note désirés, 
lâchez le bouton de la souris et Logic créera une nouvelle note 
dont la longueur est équivalente au format d’affichage. La 
longueur est aisément modifiable par la suite.

‹Insert Defaults›
13 - 6
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ISi vous cliquez dans une partie vide de la superficie de score, 
la boîte de paramètre d’événement 
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changera et montrera la légende‹Insert Defaults›. Les valeurs 
réglées dans ce mode détermineront les valeurs de défaut pour 
les événements nouvellement insérés comme ci-dessous.

Channel c’est le canal Midi auquel la note est attribuée. Dans 
le rédacteur de score le canal est accessible seulement quand 
vous avez des double voies ou une notation polyphonique, où 
Logic affecte les notes aux voies selon leurs canaux. Il est 
important d’avoir sélectionné le style correct de score, tel que 
‹Piano 1/3›ou ‹Organ›. Pour plus d’infos, lire le paragraphe 
nommé "L’affectation de notes dans les multi-voix", à la page 
15.

Velocity Les notes insérées recquièrent cette valeur de vélo-
cité. Cela concerne seulement leur son, par leur affichage.

Diatonic Insert
Lorsque Options > Diatonic Insert Insert est actif, les notes 
seront entrées seulement aux hauteur de notes de la signature 
actuelle de clé. Les hauteurs de note qui ne font pas partie de 
cette clé seront ignorées (par exemple les notes chromatiques). 
Diatonic Insert est très utile pour entrer rapidement une nota-
tion conventionnelle étant donné qu’il est très complaisant par 
rapport à l’endroit où vous cliquez sur une voie.

Effacer
Pour effacer des notes, sélectionnez-les et 

• cliquez avec la gomme, ou 
• choisissez Edit > Clear, ou
• appuyez sur ∂.

HyperDraw dans la fenêtre Score Edit
13 - 7
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Dans le Score Editor Vous pouvez utiliser la commande View > 
HyperDraw… pour insérer un affichage HyperDraw. Cela 
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permet une édition rapide et facile des données de contrôleur 
en relation avec les données de notes.

Une fois que vous avez activé l’affichage HyperDraw, vous 
pouvez choisir le type d’événement que vous voulez afficher 
par le menu flèche à gauche.

Vous pouvez ajuster la taille de l’affichage HyperDraw en saisis-
sant, et en déplaçant verticalement la ligne de démarcation.

Dans la fenêtre Score, L’Hyper Draw peut seulement être activé 
en vue linéaire, si seulement une séquence est affichée. Si vous 
changez à un autre mode (Page Edit, ou full score), la zone 
d’Hyper Draw disparaîtra. Les réglages sont sauvegardés, donc 
si vous revenez à une séquence simple, et en vue linéaire, le 
précédent réglage d’Hyper Draw sera rappelé.

Dans la fenêtre Score, l’affichage Hyper Draw est étiré horizon-
talement en fonction du score affiché au-dessus de lui. Sa 
hauteur peut êtremodifiée en tirant la limite horizontale avec la 
souris. 

Fonctions de l’Hyper DrawEffacement rapide

Vous pouvez effacer tous les événements affichés dans l’Hyper 
13 - 8
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Draw pour une séquence en appuyant sur les touches Sç-et 
en double-cliquant dans la zone bleue de l’HyperDraw. 
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Ajouter de nouveaux points

Cliquez simplement dans l’arrière-plan bleu de l’Hyper Draw, 
vous pouvez employer le curseur ou le crayon,  et un point 
apparaîtra. Aussi longtemps que vous tenez le bouton de la 
souris, vous pouvez déplacer n’importe lequel de ces points. La 
position et la valeur sont affichées dans la ligne d’information 
sur le bord supérieur de la fenêtre Arrange.

Aucun événement ne sera inséré dans la séquence jusqu’à ce 
que vous libériez le bouton de la souris.

Effacer des points

Cliquer brièvement sur n’importe quel point pour l’effacer.

Déplacer un point existant

Saisissez un point avec la souris et déplacez le. Si vous mainte-
nez le bouton de la souris tandis que vous faites cela, vous 
pouvez restaurer des points de courbe effacer en faisant glisser 
la souris où ils doivent être employés.

réglage précis des points de la courbe

Tandis que vous déplacez un point, maintenez la touche A . le 
déplacement sera alors limité à l’axe vertical, mais vous pourrez 
sélectionner l’ensemble les 127 pas possibles.

13.3 Mise en page et Impression
Logic crée automatiquement un affichage de notation des 
événements Midi qui sont dans les séquences. Etant donné 
que l’interprétation des hauteurs de notes et des positions est 
concernée,  il est toujours 100 % exact. Cela n’implique pas que 
l’affichage est aussitôt 100 % lisible, étant donné que la 
longueur des notes joue un grand  rôle dans leur affichage final. 
13 - 9
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Logic permet une tolérance dans l’interprétation de l’affichage 
ce qui signifie que des modifications supplémentaires sont 
souvent nécessaires pour produire le résultat désiré. 
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L’illustration suivante montre un exemple typique de 
comment les double-croches peuvent paraître sur la voie avant 
qu’une modification supplémentaire soit appliquée:

Graphik

La façon dont le Midi est interprété dans la forme de notation si le mauvais 
affichage de a quantification est sélectionné…

Cet affichage peut bien être correct, mais il est illisible. Pour-
quoi ceci?

Les événements de note Midicontiennent l’des informations 
rès précises sur l’endroit où la note commence, sa longueur et sa 
hauteur, et cela doit être exactement reproduit lors de la 
lecture. La sensation du groove peut être modifié si les notes 
sont un petit peu en dessous d’une durée de doubles croches . 
Si elles devaient être exactement affichées dans la notation, 
elles serait illisibles, comme au-dessus. Donc, les événements 
Midi purs n’ont aucune façon de communiquer si l’écart entre 
deux notes est un silence réel, quelle est la clé, quelles doivent 
être attachées et la façon dont la dynamique du morceau 
devrait être traité. C’est pourquoi la conversion automatique de 
Midi à la notation est toujours plus ou moinsdifférente de ce 
qui est attendu.

Heureusement, Logic offre une gamme de fonctions de 
contrôle automatiques et manuelles qui sont conçues pour 
rendre un score lisible avec le minumum de différences avec 
l’original. Ceux-ci apportent un grande différence, comme vous 
pouvez voir dans l’illustration en dessous, qui montre comment  
l’exemple au-dessus sera après l’application de ces réglages:
13 - 10
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…et à quoi le score devrait ressembler.
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Les fonctions de mise en page et de score traitées dans ce chapi-
tre…

• optimisent la conversion des événements Midi en notation 
prête à être imprimée,

• offrent des signes de dynamique, des clefs, des liaisons et 
beaucoup d’autres symboles pour compléter la notation,

• offrent un texte avec des polices définissables pour des 
commentaires musicaux, des titres, les noms d’instrument, 
et plus,

• offrir une caractéristique de prévisualisation d’impression 
pour voir précisément ce que l’on aura à l’impression.

Préparer la notation pour l’impression
Bien qu’un des objectifs de Logic est de fournir un score lisible 
sans changer la performance Midi ce n’est pas toujours réaliste. 
Un exemple de ceci est si vous avez besoin de modifier des 
longueurs de note si bien que l’affichage montre le silence ou la 
valeur de note correcte; ce type de modification concernerait 
bien sûr le playback. Pour cette raison, nous recommandons 
généralement que vous ayez deux versions de votre chanson, 
une pour le sequencing et l’autre pour la mise en page et 
l’impression. Cela vous permet de modifier les événements 
Midi tandis que vous préparez le score pour l’impression sans 
vous inquiéter de la façon dont la lecture sera concernée.

La zone de paramètre
La zone de paramètre qui occupe le côté gauche de la fenêtre 
de score comporte les éléments suivants:

• Le filtre de piste 

• La boîte de paramètre d’affichage
13 - 11
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• La boîte à outils 
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• La boîte de partition dans les deux sections 

Nous avons traité des boîtes de paramètre d’événement et 
d’affichage et de la boîte à outils dans le chapitre précédent. 
Les nouveaux éléments sont principalement employés pour la 
configuration de la mise en page de notation, prête à être impri-
mée.

Changements de niveau
Comme dans l’Event Editor, le Score Editor vous permet de 
sélectionnez entre deux niveaux: le niveau séquence et le 
niveau song.

Le niveau «séquence»
Lorsque vous ouvrez le Score Editor , il commence en affichant 
une seule séquence. 

Le niveau séquence

Le niveau «song»
Lorsque vous travaillez sur la mise en page et l’impression de 
votre score, vous pouvez préférer voir la piste entière, ou toutes 
les pistes du song. Dans ce cas, changer le niveau afin de vous 
placer au niveau «song». Pour obtenir du niveau «séquence» le 
niveau «song», cliquer sur le bouton Levels dans la fenêtre de 
rédacteur de score. Vous pouvez aussi double-cliquer dans un 
espace vide dans la zone du score.
13 - 12
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Graphik

Le niveau song

Employez le niveau «song» pour voir et modifier la notation des 
différentes sections de votre song comme divers extraits du 
score. Cela permet de faire des choses comme contrôler visuel-
lement si une note de basse  est au même endroit qu’un coup 
de grosse caisse, etc. Les notes qui surviennent en même 
temps sont montrées directement les unes en dessous des 
autres.

Pour retourner au niveau «séquence», double-cliquez sur la 
voie d’une piste seule, ou, si le mode Link est activé et que vous 
êtes dans la fenêtre Arrange ou dans l’Event List , cliquez sur la 
séquence.

Le filtre de piste
Même si vous êtes au niveau «Song», vous pouvez vous limiter 
vous-même à la vue d’une seule piste. En dessous des boutons 
de Modes, il y a un menu déroulant: au niveau «séquence» il 
affiche simplement ‹single seq.› et ne peut pas être ouvert. Sur 
le niveau de la chanson il dit ‹ALL TRACKS›.

Ceci signifie que le niveau «song» débutent en montrant toutes 
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les pistes disponibles. Pour voir une piste spécifique ouvrez le 
menu et sélectionner la piste. C’est comme cela que vous 
pouvez jongler entre les pistes que vous êtes en train de modi-
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fier sans changer de niveau. Cette option est également impor-
tante car elle vous permet de voir des séquences multiples sur 
une seule piste comme une voie continue de musique. 

Le filtre de piste concerne aussi l’impression, vous permettant 
de produire des extraits de score pour des instruments spécifi-
ques.

La boîte de paramètre d’affichage 
Ses paramètres vous aident à optimisez la notation pour impri-
mer.

Nom
Le domaine d’insertion de texte est disponible ici pour 
nommer la séquence:  cliquez sur une note avant de cliquer sur 
le nom.

‹Style›
Logic offre 10 presets de styles de score. Ce sont les défauts 
pour l’affichage de notation, et ils peuvent être comparés avec 
les formats de paragraphe standards que vous trouvez dans les 
traitements de texte tels que «Microsoft Word». Le style 
concerne la clé, la transposition et les nombres de voies pour les 
styles de Piano et d’Orgue. L’avantage est que vous n’avez pas 
à régler manuellement ces paramètres pour des instruments 
ordinaires tels une trompette ou un violoncelle, mais sélection-
nez simplement le style correspondant.
Graphik

Style Clef Transposition Staves

Piano Violin – 2
Bass Bass –
Bass −8 Bass (−8) −1 Octave
13 - 14
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Treble Violin
Treble +8 Violin (+8) +1 Octave
Treble −8 Violin (−8) −1 Octave
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Autostyle

Logic attribue automatiquement aux nouveaux enregistre-
ments un style conforme à la gamme des notes jouées. Les 
notes dans la gamme de basse sont affichées avec une clef de 
basse et les notes plus hautes avec une clef aigue. Si l’enregis-
trement contient des notes des deux gammes alors une voie de 
piano est employée.

Logic permet aussi des chevauchements: par exemple, si la 
plus haute note dans l’enregistrement est Ré moyen, une clef 
de basse est  employée. Cependant, si la plus basse note est Si 
grave, l’enregistrement sera montré dans une voie avec une clef 
aigue.

L’affectation de notes dans les multi-voix
Logic offre quatre multi–voix pour la notation d’orgue et de 
piano. Notez que les canaux Midi des événements déterminent 
la voies à laquelle ils sont alloués.

Alto Sax Violin Eb
Baritone Sax Bass Eb, −1 Octave 
Horn in Eb Violin Eb
Horn in F Violin F
Organ 1/1/5 Violin – 3
Organ 1/3/5 Violin – 3
Piano 1/3 Violin – 2
Piccolo Violin −1 Octave
Soprano Sax Violin Bb, −1 Octave
Tenor Sax Bass Bb
Trumpet in A Violin A
Trumpet in Bb Violin Bb
Viola Alt –

Style Clef Transposition Staves
13 - 15
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Insertion 
Lorsque vous entrez des notes en multi - voix, Logic leur 
donne automatiquement le canal Midi de la voies dans laquelle 
elles sont mises et ignore les réglages ‹Insert Defaults› .

Affichage
En multi-voies, Logic affiche seulement ces notes dont les 
canaux Midi qui s’apparentent au Style ou aux voies. Donc, le 
Style Piano 1/3 montrera une voie vide si toutes les notes sont 
réglées sur le canal 4.

‹Piano 1/3›
Ce Style vous permet de régler un point variable de séparation 
entre  le deux voies. Toutes les notes du canal 1 seront affichées 
dans la première voie et  les notes du canal 3 dans celle du bas. 
Changer un canal Midi de note permet de déterminer sa voie. 
Le canal Midi peut être modifié dans la boîte de paramètre 
d’événement ou dans l’Event Editor.

Graphik

Le style Piano normal (gauche), et le style Piano 1/3 avec des canaux mo-
difiables (droite))

L’illustration ci-dessus montre un passage qui ne se réfère pas 
au point de séparation C3. La version de droite montre 
comment il sera une fois les canaux changés.

‹Organ 1/1/5›
Ce Style combine un piano double-voies avec une voie supplé-
13 - 16
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mentaire de pédale pour les orgues. Les notes du canal 1 vont à 
la double - voie (qui correspond au Style de piano normal). Les 
notes du canal 5 vont à la voie de pédale.
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Graphik

Exemple de notation d’orgue d’un passage du Tutorial Song

‹Organ 1/3/5›
Ce style améliore le style ‹Organ 1/1/5› la voie du bas de la 
double-voie obtient les notes du canal 3.

‹Hide/Show Parameters›
Si vous désirez employer la fenêtre entière pour l’affichage de  
notation, employez cette commande du menu Options pour 
cacher toute la zone de paramètre. Cela vous permet de voir un 
peu plus de mesures en même temps.

Affichage de la quantification
Le Score Editor a un réglage supplémentaire de quantification 
qui concerne le comportement des notes dans la notation. Il n’a 
aucun effet sur la sortie Midi, seulement sur ce que vous voyez. 
Pour cette raison il se réfère à la quantification d’affichage 
(display quantization.

Si la valeur est réglée sur ‹default›, LA Pro ISIS adopte la réso-
lution ‹display format› comme dans la fenêtre Transport.

La quantification d’affichage offre aussi des résolutions hybri-
des telles que 16/12 ou 16/24. Choisissez celles-cis  quand le 
passage contient une combinaison de binaire et de ternaire, par 
13 - 17
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exemple, des doubles croches avec des triolets de double 
croches (1/24th note).
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Passage contenant du binaire et du ternaire

L’illustration ci-dessus montre le même passage sous des quan-
tifications de 1/16 (en haut) et de 16⁄12 (en bas).

‹Interpretation›
Ceci contrôle les silences automatiques et l’algorithme de 
correction de liaison. Dans un sens, il fonctionne comme une 
fonction qui quantifie seulement la longueur de affichage. 
Lorsqu’il est activé, Logic affiche des silences et des liaisons 
dans le but de rendre le sens de la musique le meilleur possible; 
il ne concerne pas la lecture. Vous trouverez plus de détails dans 
le paragraphe «Mise en page et Impression» à la page 13 - 9.

Graphik

Le même passage sans (en haut) et avec l’Interprétation

L’interprétation s’applique aussi aux notes qui sont créées avec 
la souris à partir de la Partbox (voir en dessous).

‹Syncopation›
Cette option concerne la façon dont les notes syncopées sont 
13 - 18
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affichées. Lorsqu’elle est activée, elle affiche généralement les 
syncopations comme  des notes indépendantes au lieu de notes 
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de petite valeur liées aux notes. Cela peut aider à améliorer la 
lisibilité du score.

Graphik

Le même passage sans (en haut) et avec Syncopation

Syncopation n’a de sens que lorsqu’elle est employée en combi-
naison avec ‹Interpretation› activée.

‹No Overlap›

Le même passage sans (gauche) et avec No Overlap

Cette fonction supprime l’affichage des liaisons où les notes 
chevauchent leurs voisines. Cela arrive souvent quand un 
passage est joué legato. . 

‹Max. Dots›
Ce réglage détermine le nombre maximum de points dans 
l’affichage de notes pointées. Quand il est sur ‹0›, Logic ne 
montre pas de points du tout.
13 - 19
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Max. Dots = 3 (en haut) et 1

Dans un emploi normal, vous pouvez laisser la valeur ‹1›. Le 
nombre de points qui sont montrés est aussi concerné par la 
quantification d’affichage et les modes d’interprétation et de 
Syncopation.

Insérer des symboles à partir de la partbox
Un score complet a besoin de plus de symboles (liaisons, signes 
dynamiques, fermata, ainsi de suite) et d’autres signes de nota-
tion que le programme est capable de créer automatiquement à 
partir de l’interprétation des événements Midi que vous enre-
gistrez. Ces symboles peuvent tous être insérés à partir de la 
Partbox en utilisant la souris. Les Clefs, les signatures de temps 
et les signatures de clé peuvent aussi provenir de cette Partbox.

La plupart de ces symboles n’ont aucun effet sur la lecture, 
mais seulement sur l’affichage.

Les symboles sont tous dans la Partbox et peuvent être transfé-
rés aux voies.

Si vous ne pouvez pas voir la Partbox, verifiez que ‹Hide/Show 
Parameters› dans le menu local d’options est actif. D’autre part, 
agrandissez on minimisez les fenêtres des boîtes de paramètre 
d’événement et d’affichage. La largeur de la Partbox peut être 
variée en tirant horizontalement la ligne de séparation verticale 
entre la zone de paramètre et du Score.

Comme vous pouvez voir du diagramme (gauche),  la largeur de 
13 - 20
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la Partbox s’adapte elle-même à la largeur de l’aire de paramè-
tre. De cette façon vous pouvez l’ajuster à la taille de votre 
écran.
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La Partbox comprend deux parties:

La partie du haut contient des boutons qui sélectionnent les 
familles de symboles généraux. Cliquer sur un bouton et la 
famille correspondante se déplacera en haut de la partie infé-
rieure de la Partbox.

Insérer des symboles
Les symboles sont insérés de la même façon que des notes: 
cliquer avec l’outil stylo (bouton droit de la souris) dans la voie. 
utilisez l’outil gomme pour les effacer, et l’outil pointeur pour 
les bouger ou les copier (en appuyant sur ç). Vous pouvez 
aussi faire glisser des symboles (incluant des notes) en dehors 
de la Partbox avec le pointeur de la souris.

Attribuer un symbole à plusieurs notes
Pour attribuer le même symbole à plus d’une note tel les points 
de staccato sélectionnez les notes, insérez alors le symbole à 
une des notes.

Sélection de symboles
 

Voici un aperçu des groupes de symbole. Les groupes suivants 
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sont disponibles (ils seront détaillés en dessous): notes, signes 
de pédale, clefs, symboles dynamiques, têtes de note, articula-
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tions, liaisons,  lignes et flèches, clés, signatures de temps, 
symboles de section et de reprise, mode de texte et trilles.

Notes

Sélectionner la valeur de note que vous voulez insérer avec la 
souris. Logic offre toutes les formes binaires, ternaires et poin-
tées des rondes aux doubles sextolets (1⁄32 de triolet).

Pour créer des accords, il est plus facile d’insérer la première 
note, et de la copier (with ç) pour créer les autres notes.

Signes de pédale 

Les signes de pédale représentent l’action de la pédale de 
sustain (on/off) et le Control Change Midi 64 (pédale de sustain). 
Lorsque vous insérez un signe de pédale ,  son  événement 
Midi correspondant est aussi inséré et concerne donc ce que 
vous entendez.

Clefs

Logic offre trois clefs: violon, basse et ténor.

Logic fait la distinction entre deux types de clef: la clef fonda-
mental, et le changement de clef. La clef fondamentale est 
toujours affichée dans la première mesure ou au début de 
chaque voie, et est déterminée par le Style.

Une clef de la Partbox est interprétée comme un changement 
de clef, et peut être insérée n’importe où, même au milieu 
d’une mesure. Les clefs peuvent être effacées en utilisant 
l’outil gomme.

Les changements de Clef peuvent être insérés n’importe où
13 - 22
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Symboles dynamiques 

Il y a une gamme complète de symboles dynamiques disponi-
bles. Les signes dynamiques n’ont aucun effet sur la sortie 
Midi.

Têtes de note 

Logic donne par défaut à chaque note la tête qui correspond à 
sa valeur. Les têtes de note de la Partbox se réfèrent aux percus-
sions et peuvent être manuellement attribuées à des notes exis-
tantes: sélectionnez une ou plusieurs notes et insérez la tête 
désirée à n’importe laquelle d’entre elles.

Signes d’articulation 

Ces signes sont attribués aux notes individuelles. Chaque 
modification d’une note (par exemple la transposition) 
concerne aussi son signe de la même façon. Logic positionne 
automatiquement le signe relatif à la note: sélectionnez une ou 
plusieurs notes et insérez la tête désirée à l’une d’elles.

Dim/Cresc, liaisons , lignes et flèches 

Ces symboles peuvent être placés n’importe où dans la nota-
tion et sont librement modifiables. Si vous insérez une liaison 
ou que vous la sélectionnez sur la voie, une petite boîte qui 
vous permet de changer sa forme paraîtra. Pour déplacer le 
symbole en entier, tirez le en utilisant les espaces entre les 
angles de redimentionnement.

Les signatures de clé

Les clés peuvent être entrées où vous le désirez dans une voie: 
elles s’appliquent alors à toutes les voies du song à partir de ce 
point. Si vous avez défini un Style pour un instrument trans-
posé, sa transposition par apport à la nouvelle clé est assurée.

Pour entrer une nouvelle clé, choisir la lettre correspondante,  
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et le programme entrera automatiquement les dièses et les 
bémols nécessaires.
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La clé à la position temporelle la plus proche du début est 
considérée comme la signature de clé fondamentale.

Les changements de clé existants peuvent être modifiés 
comme suit: double-cliquer sur la signature pour ouvrir la boîte 
de dialogue dans laquelle vous pouvez choisir une nouvelle 
signature de clé. Vous pouvez sélectionner entre des signatures 
de clé mineures ou majeures. Alternativement vous pouvez 
insérer la nouvelle clé de la Partbox en la plaçant sur l’ancienne.

Pour effacer une signature de clé, cliquez dessus avec l’outil 
gomme.

Signatures de temps

Logic fait la distinction entre la signature de temps fondamen-
tale et les changements de signature de temps. La signature 
fondamentale est celle qui vient en premier. Les changements 
de signature de temps peuvent être placés où vous le désirez 
dans une voie et n’a aucun effet sur la lecture. Ils s’appliquent 
à toutes les voies dans le song à partir de ce point et sont auto-
matiquement montrés  dans toutes les voies.

La signature de temps affecte les parties suivantes de Logic:

• Fe format de l’affichage dans la fenêtre de transport
• Affichage de toutes les positions et toutes les longueurs
• La règle de mesure
• Le click du métronome et du compteur.

Symboles de reprise et de section

Ces symboles incluent les symboles de début, de fin et de 
reprise plus des barres de début et de fin de section. Vous 
pouvez aussi ajouter ces symboles dans une mesure. Cepen-
dant avant de faire ceci il doit y avoir des notes dans cette 
mesure.

Ces symboles sont globaux, ils s’appliquent à toutes les 
13 - 24
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Trilles

Cela vous donne une gamme des symboles de trille les plus 
communs que vous pouvez situer où vous voulez.

 mode de texte

Comme alternative à l’utilisation du curseur, vous pouvez ajou-
ter du texte et des paroles en déplaçant les symboles correspon-
dants à partir de la partbox.

Les symboles comme vus dans l’Event 
Editor
Un symbole non-Midi est montré comme un ‹Meta event› dans 
l’Event List. . Ce type d’événement est aussi montré dans la 
ligne d’info lorsqu’il est inséré dans le Score Editor. Théorique-
ment, les Meta events ne sont pas modifiables dans l’Event List, 
quoiqu’il soit plus naturel de faire cela dans le Score Editor.

Manipulation de la notation
Les fonctions suivantes servent à manipuler seulement la nota-
tion et ne concernent pas la lecture. Néanmoins, ils sont vitaux 
pour créer un score qui est lisible et prêt à être imprimé.

Enharmonic shifting
Logic montre automatiquement des altérations selon la signa-
ture de clef courante. Il y a des situations, cependant, où vous 
avez besoin de changer la représentation des altérations pour 
certaines notes pour améliorer la lisibilité. Cela peut être fait en 
utilisant manuellement le menu suivant.

Pour changer l’harmonie d’une ou plusieurs notes , choisissez 
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les et choisissez un des articles suivants du menu local Func-
tions:
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• enharmonic shift # convertit les ‹b› en ‹#› 
• enharmonic shift b convertit les ‹#› en ‹b› .
• default accidentals restaure la note à ce qu’elle était aupa-

ravant.
Graphik

Enharmonic shifting

Vous pouvez appliquer ces fonctions plus d’une fois pour créer 
des doubles dièses ou bémols.

Queues des notes 

Vous pouvez déterminer la direction des queues des notes choi-
sies, et de ce fait outrepasser l’affichage automatique de Logic. 
Sélectionnez les notes et choisissez un des articles suivants du 
menu local Functions (leur utilisation est évidente):

• Stems up
• Stems down

• Stems default.

Groupement manuel des notes 
Vous pouvez déterminer les barres de groupement des notes 
(beaming) choisies, et de ce fait outrepasser l’affichage automa-
tique de Logic. L’illustration suivante montre le groupement 
automatique (en haut) après qu’il ait été manuellement changé 
(en bas).
13 - 26
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Graphik

Beaming

Pour grouper des notes, sélectionnez-les et choisissez Func-
tions > Beam selected.

Pour enlever la barre de groupement de notes , sélectionnez-les 
et choisissez Functions > Unbeam selected.

Pour restaurer les barres à leur position d’origine, choisissez 
Funcitons > Default beams.

Ces fonctions s’appliquent seulement aux notes choisies. Pour 
restaurer toutes les altérations d’une séquence à leurs valeurs 
d’origine, sélectionnez la séquence entière.

Déplacer verticalement les portées
Chaque portée peut être déplacée verticalement: cliquer et 
maintenez le bouton dans la zone de la clef fondamentale dans 
l’espace vide entre deux lignes de la portée. la ligne d’info affi-
che ‹Move Stave›.

Maintenant déplacez simplement la portée là où vous le dési-
rez.

Multi–voies 

Quand vous utilisez un style de score multi -voies pour piano ou 
orgue, vous pouvez déplacer ces voies ensemble aussi bien que 
modifier la distance entre les différentes voies individuelles.

• Pour déplacer les voies ensemble, saisissez le groupe par la 
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portée du haut.
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• Pour modifier la distance entre les voies individuelles, saisis-
sez celle du bas. Cela ne concernera pas la position générale 
de l’ensemble.

Graphik

Accroître une double - voies

Texte
Logic vous permet d’introduire du texte dans le score pour  les 
noms des voies, pour donner un titre à votre chanson, ou pour 
donner le nom du compositeur etc…  Le texte est montré 
comme un Meta Event dans la l’Event List.

Sélectionner une police de caractère 
Logic vous permet de choisir une des polices (fonts) vous avez 
installé dans votre ordinateur pour l’affichage et l’impression de 
texte dans votre score. Logic préfère travailler avec des fonts 
Truetype; elles sont capables d’être montrés sur l’écran dans 
toutes les tailles. Vous pouvez reconnaître les fonts Truetype  
par le symbole TT qui est avant le nom de font dans la fenêtre 
de police. Pour sélectionner une police dans Logic, choisissez 
Font > Score Font et une fenêtre s’ouvre dans laquelle vous 
pouvez choisir la police, son style et sa taille.

La police s’applique à tout le texte dans un song. Si vous chan-
gez la police du texte d’un score après avoir entré un texte, cela 
reformatera le texte entier du song, souvent avec des consé-
quences indésirables. C’est pour cela qu’il est préférable de 
choisir une police avant de commencer à travailler.
13 - 28
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Graphik

Choisir une font pour le texte, ici sur une fenêtre PC 

Insérer un texte
Choisissez le curseur de texte de la boîte à outils. Cliquer à 
l’endroit où vous désirez entrer le texte. Cela ouvre un champ 
d’insertion de texte et la ligne d’info.

Tapez le texte et terminez cette saisie en appuyant sur R. Les 
textes restent sélectionnés et clignotent. Vous pouvez mainte-
nant utiliser le pointeur pour définir sa position exacte. Une fois 
que vous cliquez dans un espace vide le texte est fixé dans la 
position. Pour modifier un texte existant, cliquez sur celui-ci 
avec l’outil texte ou cliquez avec le bouton gauche dessus.

Positionner le texte
Le texte peut être déplacé de la même façon que les autres 
événements, en utilisant le pointeur de la souris. Il estégale-
ment possible de déplacer le texte en utilisant numériquement 
les paramètres de la boîte de paramètres d’événement. Cette 
méthode peut également être employée pour assigner le texte 
à une autre voie de la façon suivante:

Stave Cette valeur est accessible seulement avec des styles 
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d’orgue et de piano et définit le numéro de la voie à laquelle le 
texte appartient. Vous pouvez instantanément changer le texte 
d’une voie à une autre en changeant simplement le numéro de 
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la voie. Si vous entrez un nombre de voie qui dépasse le 
nombre de voies disponibles, le texte disparaît.

vert. pos la position verticale du bas du texte relative à la ligne 
de numéro de voie du haut, en pixels.

hor. pos la position horizontale du côté gauche du texte rela-
tive à la position la plus proche à laquelle une note peut être 
entrée sur les voies, en pixels.

Paroles
Vous pouvez entrer des paroles avec des références de note 
dans le Score Editor. Les paroles ont des caractéristiques spécia-
lespar rapport au texte normal (par exemple le titre ou compo-
siteur):

• Les mots sont directement attribués aux notes, et
• L’espacement des notes s’adapte aux longueurs de mot.

Pour entrer des paroles:

1. Choisissez la lettre ‹A› dans la Part box.

2. Cliquez sur ‹Lyrics› et avec le bouton de souris maintenu 
enfoncé, déplacez le pointeur de la souris en dessous de la 
première note à laquelle vous voulez attribuer les paroles.

Lyrics.bmp

Un curseur de texte clignotant paraît avec La ligne d’info.

3. Entrer le texte pour la première note,
13 - 30
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5. Pour terminer, appuyez sur R.
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Les paroles peuvent être modifiées, copiées ou déplacées 
comme le texte normal.

Page Edit
Vous pouvez être tombés sur le concept de ‹Page Edit› (édition 
de page) dans les programmes de traitement de texte ou DTP. 
Logic calcule le contenu d’une face entière de feuille et les 
montre sur l’écran comme elles paraîtront à l’impression.

Page Edit et l’affichage normal
Vous pouvez passer de l’un à l’autre en cliquant sur le bouton 
‹Page Edit› qui est à coté du bouton Midi Out.

Page Edit n’est uniquement là pour manipuler le score avant 
pour l’impression, mais peut être employé pour modifier un 
passage long du score. Certes, toutes les modifications que nous 
avons traitées jusque là s’appliquent en mode Page Edit. Le 
‹word-wrapping› (ou encore le ‹stave-wrapping›) signifie que 
vous pouvez voir sensiblement plus de mesures sur l’écran en 
même temps .

Faire défiler l’affichage en mode Page Edit
La barre de défilement verticale est employée pour tourner les 
pages d’un affichage en mode Page Edit. Le nombre de pages 
est montré en haut du score.

Page Edit et les imprimantes
Vous devez installer votre imprimante et la régler correctement 
avant de commencer à manipuler la mise en page de votre score 
final. Ce que vous voyez en mode Page Edit dépend de votre 
imprimante et de son format de papier ainsi que de ses réglages 
de règle. L’avantage est que le mode Page Edit est alors exac-
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tement capable de montrer de quoi l’impression aura l’air. Pour 
plus d’informations sur les réglages d’impression, voir le chapi-
tre ci-dessous.



Chapitre 13
Fenêtre Score Edit

13.4 Impression
Les paramètres d’impression sont relativement simples à 
préparer étant donné que Logic emploie essentiellement les 
réglages standards de Windows pour les imprimantes. Cela 
signifie que Logic est capable de fonctionner avec toutes les 
imprimantes que vous avez installé dans le panneau de configu-
ration de Windows.

Le menu d’impression 
Le menu d’impression est là où vous entrez le nombre de pages 
à imprimer, et là où vous lancé l’opération.

Choisissez ‹Parameter› pour déterminer la première et la 
dernière page. Choisissez Alors ‹Start›. ‹Abort› annule toute 
impression en cours.

Paramètrage des imprimantes
Vous devez installer votre imprimante avant de faire démarrer 
Logic. Faites cela dans Ajout d’imprimante en cliquant sur 
‹Install›. Les fenêtres suivantes s’ouvrent.
13 - 32
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Les meilleurs résultats sont obtenus par une imprimante laser

Vous n’avez normalement pas à configurer spécialement votre 
imprimante pour Logic. Si par hasard l’imprimante n’est pas ce 
qu’elle devrait être, ou si vous obtenez des messages d’erreurs, 
cela peut être dû aux points suivantes:

RAM
Logic requiert beaucoup de RAM de secours pour imprimer. Si 
vous avez juste quatre méga-octets de RAM et que vous impri-
mez un score long, vous pouvez avoir des problèmes. Donc …

• Réduisez la mémoire réservé pour les disques ou pour Smar-
tdrive qui ne sont pas nécessaires à Logic,

• Quittez les autres programmes,
• Imprimez le score peu à peu,
• Installer plus de barrettes de RAM.

Resolution
Logic supporte théoriquement toutes les résolutions de votre 
13 - 33
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

imprimante. Cependant, vous devez vérifier que les valeurs de 
résolution horizontale et verticale sont compatibles pour ne pas 
avoir une impression déformée. Vous devrez donc choisir la 
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résolution où les valeurs horizontales et verticales sont les plus 
proches.

Les paramètres de résolution d’impression se trouvent sous 
‹Printer›/‹Install›, dans le panneau de configuration de 
Windows.

Vous pouvez trouver qu’avec des imprimantes 9-broches (voir 
l’exemple en dessous), ces valeurs horizontales et verticales 
peuvent être différentes. Dans ce cas l’impression est étirée 
dans la direction correspondante.

La résolution problématique: imprimantes à 9-broches
13 - 34
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La fenêtre Transform

Usage
La fenêtre Transform peut être utilisée pour changer certains 
événements existant en fonction de paramètres définis. Ces 
paramètres peuvent être sauvés comme des «Transform Sets» 
et rappelés pour des utilisations ultérieures (pour plus de 
renseigenements, voir le paragraphe «Appeler des presets» à la 
page 14 - 13).

L’Environnement contient des objets de treansformation simi-
laires pour l’édition en temps réel de données Midi (paragraphe 
«Ligne à Retard (Delay Line)» à la page 5 - 40).

Pour ceux d’entre vous qui utiliseraient des séquenceurs 
comme Vision et Transformer, la fenêtre de Transform sera 
l’une des zones les plus agréables parmi d’autres dans Logic à 
étudier. Ceux familiarisés par Cubase et Notator SL, seront en 
terrain familier, parceque la fenêtre de Transform possède des 
pages similaires à ces programmes. 

Malgré un certain temps d’adaptation la fenêtre Transform 
possède un système à haut degré de flexibilité, quand vous avez 
besoin d’effectuer des éditions complexes et des transforma-
tions de données Midi. Cette opération ne demandant que peu 
de temps, allègera cette perte de temps occasionnée par vos 
déplacement dans le séquencing. Vous penserez alors, qu’il n’y 
a pas  d’opération d’édition, ou de transformation que vous ne 
puissiez accomplir ici.

Ouvrir la fenêtre Transform 
14 - 1
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Choisissez Window > Open Transform pour ouvrir la fenêtre de 
Transform.
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Portée des opérations
La fenêtre Transform, est utilisée pour éditer seulement des 
événements . La portée des opérations peut se définir comme 
pour les autre fonctions, c’est à dire:

• Tous les événements sélectionnés (dans l’un des éditeurs),

• Tous les événements sélectionnés (dans l’un des éditeurs)

• Tous les événements dans les dossiers sélectionnés.

Vous pouvez utiliser le bouton Link, dans le coin gauche supé-
rieur, pour étendre la portée à d’autres fenêtres.

Tous les événements sélectionnés sur le même niveau d’affi-
chage se retrouvent dans la portée d’opération de la fenêtre 
Transform, comme font tous les événements dans les objets 
Arrange sélectionnés.

Objectifs de la fenêtre Transform

Conditions
14 - 2
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Cette partie de la fenêtreTransform définie quels événements 
seront édités. Si les options Select and Operate or Select only (voir 
dessous)sont utilisées, le Transformer voit si les parties indivi-
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dans la portée d’opération, comme il est définie dans le menu 
sous Select by Conditions.

Operations
Cette partie de la fenêtre Transform définie les opérations 
d’édition qui seront menées. Ces opérations sont définies dans 
le menu sous Operations on selected Events.

Actions

Ces trois boutons déclenchent les actions dans la fenêtre Trans-
form:

Select only
Tous les événements se trouvant dans la portée d’opération 
répondant aux critères spécifiés par les Conditions sont sélec-
tionnés (Operations est sans effets). Vous pouvez utiliser cette 
fonction pour utiliser vos propres sélections de commandes.

Operate only
Tous les événements sont transformés en fonctions du réglage 
d’Operations (Conditions n’a pas d’effet). Cette action est utile si 
vous voulez éditer des événements que vous avez sélectionnez 
manuellement.

Select and Operate
c’est une combinaison des deux fonctions expliquées ci dessus: 
en premier lieu la sélection en fonction des Conditions, suivi de 
14 - 3
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

la transformation en fonction des Operations.
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Après chaque actions, vous pouvez voir combien d’événements 
ont été sélectionnés et/ ou transformés dans la barre de titre (ci 
dessous):

Après avoir activé Select only, vous pouvez changer la sélection 
dans l’éditeur, avant de déplacer la transformation en activant 
Operate only.

14.1 Transformation

Mode
Vous pouvez définir les modes d’utilisation de base dans le 
menu déroulant au-dessus de la boîte Conditions:

Apply Operations to selected Events

Comme décrit précédemment, les Operations sont appliquées 
sur les événements sélectionnés (réglage par défaut).

Apply Operations & Delete unselected Events

Les événements sélectionnés sont édités, mais parallèlement, 
les événements non sélectionnés sont effacés.Ceci assure que 
les événements restant après l’opération de ransformation 
soient ceux ayant suivis les Conditions.

Si vous éditez les Operations de façon neutre, vous pouvez utili-
sez la fenêtre Transform dans ce mode comme un filtre 
programmable, où seuls les événements définis dans les Condi-
tions survivent.

Delete selected Events

The selected events are deleted.
14 - 4
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événements qui suivent les Conditions conditions sont effacés, 
et tous les autres restent inchangés. Le réglage des Operations 
ne sert à rien dans ce mode.

Copy selected Events & Apply Operations

Les événements sélectionnés gardent leur forme d’origine, 
même lorsqu’ils sont copiés et édités.

Vous pouvez utiliser ce mode pour des applications telles que:

Imaginez que vous voulez ajouter un événement de molette de 
modulation (n°1) de 10 10 pas d’horloge avant chaque note, 
avec une valeurqui correspond à la vélocité de note. Pour faire 
ceci, vous éditer: Status as Note (qui est la condition) et la Posi-
tion de manière à soustraire 10 (ou ajouter -10), le paramètre 
Status sur Fix Control et le paramètre -1- sur Fix 1 (ce sont les 
operations). La dernière de ces opérations signifie «first data bit 
(- 1 -) reçoit la valeur 1› (le premier octet de donnée définit le 
nombre de contrôleur pour les contrôleurs d’événements et les 
événement concernant la molette de modulation en #1).

Paramètres d’événements

Les paramètres indiduels d’événements Midi ont leur propre 
colonne dans les champs Conditions et Operations:

Position

La position temporelle de l’événement, référencée au début de 
la séquence (et non au début du Song) 

Status
14 - 5
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Cha 

canal Midi de l’événement.

-1- / Pitch

Premier octet de donnée(note ou numéro de contrôleur).

-2- / Vel

Second octet de donnée (vélocité ou valeur du contrôleur).

Length

Longueur (ou durée) de la note.

Subposition

La position de l’événement, dans la mesure.

Map

Avec cette condition, les données de l’événement entrant sont 
détournées via la Map avant qu’elles ne soient prises en 
compte. Les deux paramètres «Range» fonctionnent comme le 
paramètre «Inside». Les événements entrant dont les valeurs 
«mappées»se trouvent dans la portée d’opération sont soumis à 
la condition.

Map Set

Cette opération pour le statut d’un événement permetà la Map 
générale d’un Transformer d’être contrôlée. La valeur de ‹-1- 
‹sélectionne la position dans la Map. La valeur de ‹-2-› déter-
mine la valeur à cette position de la Map. Logic envoit une 
paire d’événements: n°123 pour la position, et n°122 pour la 
valeur à cette position. Ces événements Méta pour la modifica-
tion d’une Map de transformation peuvent également être 
créés d’autres façons.
14 - 6
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Conditions
La zone centrale de la fenêtre Transform(Conditions) est 
l’endroit où vous fixez les conditions que doivent remplir les 
événements pour pouvoir être édités. Chaque colonne repré-
sente l’un des paramètres des événements Midi.

La condition est concidérée comme remplie si toutes les sous-
conditions sont remplies pour chacun des paramètres. Ces 
conditions sont exprimées à l’aide d’opérateurs logiques sélec-
tionnables par un menu. Les opérateurs logiques possibles sont 
exposés ci-après.

Le réglage All signifie que toutes les valeurs satifont à la sous-
condition. Aucune valeur de référence n’est alors nécessaire.

Position, Cha, -1- / Pitch, -2- / Vel, Length, Subposition

Vous pouvez assigner l’un des opérateurs suivants pour chaque 
paramètre (excepté le statut):

= La valeur du paramètre de l’événe-
ment doit être égale à la valeur de 
référence pour remplir cette sous-
condition.

Unequal La valeur du paramètre de l’événe-
ment doit être différente à la valeur de 
référence pour remplir cette sous-
condition.

< La valeur du paramètre de l’événe-
ment doit être inférieure à la valeur 
de référence pour remplir cette sous-
condition.

> La valeur du paramètre de l’événe-
14 - 7
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ment doit être supérieure à la valeur 
de référence pour remplir cette sous-
condition.
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Inside La valeur du paramètre de l’événe-
ment doit être dans le segment de 
référence pour remplir cette sous-
condition.

Outside La valeur du paramètre de l’événe-
ment doit être à l’extérieur du 
segment de référence pour remplir 
cette sous-condition.

Status

Vous n’avez que deux choix possibles, All (tous les événements 
sont accepés) et ‹=›. Cliquer dans la boîte de dessous ouvre un 
menu où vous pouvez choisir entre note, poly pressure, control 
change, program change, channel pressure or pitch bend.

Operations

La partie inférieure de la fenêtre Transform (Operations) est 
l’endroit où vous définissez l’opération qui va être appliquée, 
avec toujours une colonne par paramètre de l’événement Midi.

Le réglage Thru signifie que cette partie de message ne sera pas 
altérée par l’opération, aucune n’opérande n’est nécessaire.

Position, Cha, -1- / Pitch, -2- / Vel, Length, Subposition

Pour tous les paramètres (sauf le statut), la boîte du haut déter-
mine le type d’opération effectuée avec les valeurs des boîtes 
de dessous. Les opérations suivantes sont identiques pour le 
canal, le premier et le second octet de donnée. La formulation 
des opérandes est adaptée en conséquence.

Fix Le paramètre prend la valeur de 
14 - 8
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Sub L’opérande est soustraite au para-
mètre.

Min Tout paramètre se trouvant en 
dessous de l’opérande prend la 
valeur de ce dernier. Les paramètres 
au-dessus ne sont pas modifiés.

Max Tout paramètre en dessus de 
l’opérande prend la valeur de ce 
dernier. Les paramètres se trouvant 
en-dessous ne sont pas modifiés.

Flip Le paramètre prend la valeur symé-
trique par rapport à l’opérande.

Mul Le paramètre est multiplié par 
l’opérande (opérande à 4 décimale 
de résolution).

Div Le paramètre est divisé par 
l’opérande (opérande à 4 décimale 
de résolution).

Scale Le paramètre est multiplié par 
l’opérande supérieure et augmenté 
de l’opérande inférieure. C’est en 
somme une combinaison de Mul et 
Add. L’opérande inférieure peut 
prendre des valeurs négatives. La 
valeur correspondante est dans ce 
cas retranchée au résultat de la 
multiplication.

Range Les paramètres se situant en dehors 
de la plage définie par les deux 
opérandes prennent la valeur des 
limites (Min et Max).
14 - 9
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Random Le paramètre prend une valeur aléa-
toire comprise entre les deux 
opérandes.
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+ - Rand. Le paramètre est additionné à une 
valeur aléatoire comprise dans un 
segment symétrique autour de 0 de 
rayon égal à l’opérande (positive ou 
négative).

Reverse Le paramètre prend la valeur symé-
trique par rapport au centre de la 
plage maximale.

Quantize Le paramètre est quantifié au 
multiple entier inférieure de 
l’opéramde.

Qua&Min Comme Quantize, mais la valeur 
minimale résultante est obligatoire-
ment l’opérande (équivalent aux 
fonctions Quantize & Min avec la 
même opérande).

Exponent. Le paramètre est recalculé via une 
fonction exponentielle. Les valeurs 
extrêmes (0 et 127) restent identi-
ques. L’opérande détermine la crois-
sance de la courbe. Les valeurs 
positives donneront une transforma-
tion exponentielle (l’augmentation 
de valeur est d’autant plus forte que 
la valeur est élevée), tandis que des 
valeurs négatives donneront une 
transformation logarithmique (la 
diminution de valeur est d’autant 
plus importante que la valeur est 
élevée).

Crescendo Ceci ne fonctionne que si la condi-
tion de position ‹Inside› a été sélec-
tionnée (les crescendos doivent 
14 - 10
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crée une douce altération dans les 
paramètres courants, entre les 
limites de l’opérande.

Rel.Cres Ceci ne fonctionne que si la condi-
tion de position ‹Inside› a été sélec-
tionnée. L’effet est similaire au 
crescendo, mais les valeurs précé-
dentes des paramètres que vous 
modifiez sont prises en compte 
lorsque le crescendo est créé, 
conservant l’impression originale.

Exemple

Créer un crescendo en valeur de vélocité de note. Sélectionnez 
‹Inside› comme la position de condition, et ‹Status = Note›, 
éditez ensuite ‹Crescendo› comme operation, avec une valeur 
minimumet une valeur maximumdans les colonnes ‹-2-› ou 
‹Vel› . En fonction du fait que la première valeur que vous 
réglez peut être supérieure ou inférieure à la seconde, vous 
obtiendrez un crescendo ou un decrescendo. les valeurs origi-
nales des événements que vous modifiez sont hors de propos 
après la transformation puisqu’elles ont été entièrement modi-
fiées par la fonction crescendo. Au contraire, avec l’option 
Rel.Cres., les dynamiques originales assignées aux notes reste-
ront, même après l’application du Crescendo.

Status

Il y a deux réglages possibles: Thru (= le type d’événement 
reste inchangé) et ‹Fix› (= tle type d’événement est modifié). 
Cliquez dans la boîte de dessous ouvre un menu où vous 
pouvez choisir entre note, poly pressure, control change, 
program change, channel pressure ou pitch bend.
14 - 11
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Exchanging Parameter Values
Vous pouvez replacer chacun des trois paramètres d’événement 
Cha, -1- / Pitch et -2- / Vel avec la valeur d’un paramètre différent 
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de ce groupe. Cliquez sur la ligne entre les champs Conditions et 
Operations pour changer la source de la valeur de paramètre.

En premier lieu, la valeur est échangée, et ensuite l’opération 
est menée.

Affichage

La boîte de validation Hide unused Parameters, vous permet de 
refermer tous les menus non utilisés dans les boîtes de condi-
tion et d’opérations. Ceci vous donne un meilleur apperçu des 
réglages effectués, et ainsi protège les menus cachés contre 
toute mauvaise manipulation. 

14.2 Sets de paramètre Transform
Les configurations de tous les paramètres décrits dans le para-
graphe «Transformation» à la page 14 - 4 peuvent être mémori-
sées dans des Sets de paramètre transform, qui sont accessibles 
à partir du menu déroulant se trouvant en haut à gauche.

Presets

Essayez d’appeler quelque uns de ces presets pour vous habi-
14 - 12
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tuer à la fenêtreTransform et à ces paramètres.

• Double Speed (double le tempo en divisant en deux les 
positions et les longueurs)
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• Half Speed (divise par deux le tempo en doublant les posi-
tions et les longueurs)

• Humanize (ajoute une valeur aléatoire à la position, à la vélo-
cité et à la longueur des notes)

• Reverse Position (inverse la position des notes dans une 
section)

• Reverse Pitch (inverse la hauteur de note)
• Transpose (transposes les notes)
• Exponential Velocity (modifie l’échelle de la courbe de vélo-

cité)
• Velocity Limiter (limite la vélocité)
• Fixed Note Length (créé une longueur de note constante)
• Maximum Note Length (limite la durée maximale des 

notes)
• Minimum Note Length (limite la longueur minimale des 

notes)
• Quantize Note Length (quantifie la longueur des notes).

Appeler des presets 
Dans les fenêtres Event Editor, Matrix Editor et Hyper Editor, un 
sous-menu peut être ouvert via Functions > Transform… a 
partir duquel les sets de paramètre transform peuvent petre 
sélectionnez directement (voir ci-dessous).
14 - 13
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Affichage du tempo
Si votre Song n’a qu’un tempo tout le long , vous pouvez définir 
celui ci dans la fenêtre Transport.

Le tempo courant y sera toujours affiché, même en cas de chan-
gement de tempo ou de synchronisation externe.

Piste de Tempo 
Les changements de tempo sont contrôlés par des événements 
de changements de tempo, enregistrés sur une piste tempo 
spéciale. Cette piste n’est pas visible dans la fenêtre Arrange.

La piste de tempo s’applique au Song en entier.

La piste de tempo détermine aussi les relations entre le Time 
code et la position du song(voir page 16 - 18).

Généralités

Information sur les changements de tempo d’un 
Song
La façon la plus simple de déterminer les changements de tempo 
individuels est à partir de la Tempo List (voir page 15 - 2). La 
15 - 1
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Tempo List est un éditeur d’Event List pour les événements de 
tempo.
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 Une autre façon est d’enregistrer les changements de tempo 
avec la souris dans la fenêtre Transport (voir page 15 - 6), ou de 
façon plus précise, dans la fenêtre d’édition graphique du 
tempo (voir page 15 - 4). L’éditeur Graphic Tempo est un Hyper 
Editor avec une définition d’événement fixée pour les événe-
ments tempo, et est très utile pour éditer les changements de tempo 
manuellement (voir page 15 - 4).

Pour trouver comment fixer une mesure particulière d’un Song 
vers un temps SMPTE particulié (pour tous ceux qui utilise 
Logic pour synchroniser la musique à l’image), lisez le paragra-
phe «Positionner les Mesures par rapport aux images» à la page 
16 - 17.

15.1 Editeur de Tempo List 
Vous pouvez ouvrir la Tempo List (liste de tempos) en cliquant et 
en restant ainsi sur le bouton Synchro de la fenêtre Transport . 
Un menu va apparaître, dans lequel vous sélectionnerez Open 
Tempo List…. ou alors, vous pouvez simplement sélectionner 
Options > Tempo and Synchronisation > List Editor.

L’affichage et la manière d’utiliser la Liste de tempo sont simi-
15 - 2
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Créer des changements de tempo
• Réglez la position du Song à l’emplacement souhaité.

• Cliquez sur créer Create.

Un événement de tempo apparaît montrant le tempo en cours. 
Vous pouvez modifier le tempo dans la colonne de tempo.

Ou alors, avec l’outil stylo sélectionné, cliquer sur le mot 
‹Tempo› tempo dans un événement de tempo existant.

Un nouvel événement apparaît, avec une boîte de saisiepour la 
position. Entrez la position de la mesure requise et appuyez sur 
R.

Annuler des changements de tempo
Vous pouvez annuler les changements de tempo en cliquant sur 
eux avec l’outil gomme rou en appuyant sur la touche B. 

Copier les changements de tempo d’un 
passage
• Réglez les locators sur le passage contenant le changement 

de tempo.

• Choisissez Edit > Select inside Locators.

• Copier l’événement de tempo dans le presse-papiers 
(çc).

• Désélectionnez tous les événements de tempo (en cliquant 
sur Start of Eventlist/End of Eventlist ou bien dans le fond).

• Collez les événements provenant du presse papier (çv).

• Un champs d’acquisition pour la position s’ouvre, où vous 
pouvez modifier la position de la mesure. Si ce premier 
événement n’était pas au début de la mesure dans le 
15 - 3
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segment encadré par les locators, assurez vous de ne modifier 
le numéro de mesure en laissant la «partie fractionnelle» 
inchangée.
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• Appuyez sur R. les changements de tempo copiée sont 
sélectionnés, et vous pouvez annuler l’opération si néces-
saire.

Autres fonctions
Les Entrée de la tempo liste sont intéractives et peuvent 
s’influencer l’une à l’autre. Pour plus de détails, voir le paragra-
phe «Positionner les Mesures par rapport aux images» à la page 
16 - 17. Cette fenêtre permet en outre d’effectuer quelques 
paramétrages pour la synchronisation. Toutes les autres fonc-
tions sont identiques à l’Even List (voir page 10 - 1).

15.2 Editeur Graphic Tempo
L’éditeur Graphic Tempo est un Hyper Editor spécialisé, qui 
vous permet seulement de dessiner et d’éditer les événements 
de tempo.

Pour ouvrir l’éditeur Graphic Tempo, sélectionnez en gardant 
appuyé le bouton sync dans le panneau de Transport et choisis-
sez Open Graphic Tempo…. à partir du menu déroulant. Vous 
pouvez également sélectionner Options > Tempo and Synchro-
nisation > Graphic Editor.
15 - 4
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Création de changements de tempo continus
• Choisissez l’outil Crosshair.
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• Cliquez sur la section requise dans la zone d’édition et main-
tenez la souris.

• En dessous de la barre de titre de la fenêtre sont affichées 
avec précision la position et le tempo. Réglez le début (ou la 
fin) du changement de tempo.

• Relâchez le bouton de la souris.

• Vous pouvez maintenant régler la fin(orle début) du change-
ment de tempo. Si vous désirez créer de nouveaux événe-
ments de tempo (au lieu de modifier ceux qui existent déjà), 
maintenez enfoncée la touche ç.

• Cliquez le bouton de la souris.

Rappelez vous que la durée des événements de tempo ajoutés 
dépend du paramètre Grid.

Dans la plus part des cas, une grille au 1/16 de note suffira à 
donner l’impression d’une variation continue de tempo.

Autres Functions
L’utilisation des autres fonctions est identique à celles que 
possède l’ Hyper editor (voir page 11 - 3).
15 - 5
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15.3 Fonctions tempo

Enregistrement des changement de tempo
Allez à File > Song Settings > Recording Options, et activez 
Allow Tempo Change Recording. Toutes les modifications de 
tempo que vous effectuerez durant l’enregistrement seront 
inclues en tant qu’événement de tempo sur la piste de tempo. 
Vous pourrez les éditer par la suite à l’aide de l’un des éditeurs 
de tempo.

Ajuster le tempo aux séquences
‹Adjust Tempo using Object Length and Locators›: Le tempo Midi 
est ajusté de manière à ce que la longueur des séquences Audio 
sélectionnées épouse la distance entre les Locators. Si vous 
désirez utiliser cette fonction pour adapter le tempo Midi afin 
d’égaler le tempo de la boucle, assurez vous avec l’aide du 
Sample Editor, que le cycle de percussion boucle de manière 
correctement , et que la longueur de la séquence corresponde 
exactement à une longueur spécifique musicale de l’Audio, 
telle que deux mesures. réglez ensuite une zone de cycle de 
deux mesures et sélectionnez Functions > Adjust Tempo using 
Object Length….

15.4 Trucs et Suggestions
Double cliquez sur la position de la dernière note de décompte 
(celle, sur le premier temps de la mesure suivante) et collez la à 
la position dans le presse-papiers en appuyant sur 

Musique d’une scène de film
15 - 6
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Le Problème:

Les musiques de films contiennent souvent des segments à des 
tempos différents, qui doivent malgré tout commencer à des 
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temps fixes dans le film (Position SMPTE certaine). Cepen-
dant chaque segment doit avoir son propre tempo, et quelques 
références aux mesures et au temps. Après tout, c’est ainsi que 
fonctionne la position de grille et la quantification de Logic.

Exemple:

Imaginez que vous travaillez sur une musique de film T.V. Le 
temps de départ du Time code est 00.00.00.00, et les exigences 
de la direction sont de 20 secondes, intro lente, et 12 secondes 
sans musique, et ensuite un thème rapide pur accompagner les 
poursuites.

Règle de base:

Utilisez les changements de tempo pour s’assurer que la grille 
de mesure du séquenceur corresponde avec l’originale.

Solution pour l’exemple:

• Tout d’abord, jouez l’intro au tempo que vous désirez. Un 
événement de tempo apparaîtra à la mesure 1, qui s’appli-
quera à la totalité du Song en premier lieu.

• Ajoutez un second changement de tempo à la fin de la 
longue intro.(si la tempo est de 120 bpm, le changement de 
tempo arrivera à la mesure 11). Le nouveau tempo n’est pas 
important, il pourra être replacé dans une minute de toute 
façon.

• Arrive alors la pause: dans cette exemple, 12 secondes, c’est 
un temps relativement long. C’est là que vous entrez  le troi-
sième changement de tempo. Tout ce que vous avez à faire 
est de taper en temps SMPTE le moment ou vous désirez 
que l’événement ait lieu (dans l’exemple 32 secondes). Le 
nombre de mesure peut être celui que vous voulez, de 
manière à ce qu’il y est une distance raisonnable entre le 
second et le troisième changement de tempo. Logic change 
15 - 7
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

automatiquement le tempo au second changement de 
tempo pour que le troisième arrive au temps SMPTE dési-
gné au bon moment. Placez le troisième changement de 
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tempo sur une barre de mesure (mesure 15), de façon à utili-
ser le métronome et quantifier les fonctions plus tard.

Et voilà! Le second changement de tempo et déterminant: il 
protège le tempo de la première section, et assure ainsi que le 
troisième changement de tempo arrive précisément sur une 
mesure.
15 - 8
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Chapitre 16

Synchronisation

Ce chapitre commence par la description de la fenêtre ‹Synchro-
nisation›. C’est là que se font tous les réglages synchronisation 
de Logic.

Les parties suivantes traitent des autres fonctions dans le 
domaine de la synchronisation (page 16 - 12), de la synchroni-
sation d’un film numérisé, stocké sous forme de fichier (page 16 
- 18), des bases de la synchronisation en générale (page 16 - 18), 
et enfin des problèmes possibles et de la façon de les résoudre 
(page 16 - 28).

16.1 La fenêtre Synchronisation 
Cette fenêtre s’ouvre à partir de la fenêtre Arrange en passant 
par Options > Tempo and Synchronisation > Synchronisation… 
ou alors en grâce à un clique maintenu sur le bouton Sync dans 
la fenêtre Transport.

Sur le bord supérieur vous pouvez changer de page: General, 
Audio, Midi, Unitor.

General
Cette page de la fenêtre synchronisation contient les paramètres 
de synchronisation les plus importants pour faire fonctionner 
Logic en esclave.

Sync Mode
16 - 1
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Ce paramètre défini le maître avec lequel Logic sera synchro-
nisé:
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Internal

C’est l’horloge interne de Logic. Logic est maître. Des péri-
phériques externes peuvent être synchronisés en passant par 
l’horloge Midi ou le MTC (les réglages en rapport se font sur la 
page ‹Midi›).

MTC

‹Midi Time Code›. Logic fonctionne en esclave. Le MTC peut 
soit arriver par un port Midi In, soit être généré par une interface 
Midi à partir de codage SMPTE ‹traduit› qui rentre.

Midi Clock

L’horloge Midi et le Song Position Pointer. Logic fonctionne en 
esclave. Clock et SPP peuvent être reçus à n’importe quel 
entrée.
16 - 2
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External Stop ends Record Mode
Si vous utilisez cette option pendant une synchronisation, 
l’enregistrement s’arrêtera Lorsque le time code (code temporel) 
cesse.

Si l’option est désactivée, Logic s’arrête mais reste en mode 
enregistrement (Record + Pause).

Frame Rate

C’est ici que se règle le nombre «d’images» par seconde (en 
‹fps›, images par seconde). Cette vitesse s’applique aussi bien 
au time code transmis que reçu.

& ‹d› signifiie ‹drop frame›. (sauter une image). Dans les formats ‹drop frame›, certaines 
«images» sont laissées de côté suivant un schéma réguilier. Pour faire la distinction, 
les formats sans ‹drop frame› sont parfois appelés ‹nd› ou ‹non drop›.

Auto Detect Format of MTC
Avec cette option le timecode entrant est analysé et le frame rate 
se règle automatiquement. Il faut en général laisser cette 
option activée.

Notez bien qu’il est impossible de faire automatiquement la 
distinction entre les frame rate MTC de 29,97 et 30, car;

1. Le standard MTC ne permet pas de faire une distinction

Frame rate  applications Typiques

24 Film

25 Audio (Europe )et Video PAL 

(30 d) non utilisé (ce n’est pas un temps réel)

30 Audio (USA)et Video NTSC (s/w)

29,97 d Audio (USA))et Video NTSC (couleur)

29,97 Extrêmement rare (ce n’est pas un temps réel)
16 - 3
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2. Une mesure de 30fps pourrait être un timecode de 
29,97fps qui va trop vite, et vice versa.
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LA Pro ISIS interprète les frame rate d’‹environ 30fps› soit en 
29,97df ou en 30nd, ça dépend si le format drop est utilisé ou 
non. Cette interprétation sera en général correct, parce que ce 
sont les deux seuls formats standards actuellement.

‹Auto Detect…› ne se cale sur 29,97df ou 30nd que si le format 
précédant était un format conventionnel. Si vous voulez 
synchroniser Logic sur un frame rate non conventionnel, vous 
devrez définir ce format manuellement. Ce réglage ne sera pas 
modifié par ‹Auto Detect…›.

SMPTE Offset
C’est ici que se règle le SMPTE Offset pour le song. Un song ne 
commence pas forcément sur la mesure n°1, c’est pourquoi 
vous pouvez faire jouer n’importe quel position de mesure au 
temps SMPTE choisi.

La valeur par défaut est 1/1/1/1 à 1:00:00:00. Le SMPTE Offset 
utilisé normalement est 1:00:00:00, car cela permet d’envoyer 
un timecode avant le début.

Audio
Cette page de la fenêtre de dialogue concernant la synchronisa-
tion contient tous les paramètres pour synchroniser l’Audio et 
le Midi. 

Nominal Sample Rate
Le taux (ou encore fréquence) nominal d’échantillonnage 
sélectionné est visible ici.

& Vous pouvez changer le taux d’échantillonnage dansle menu la Audio window > 
Options, si votre hardware supporte plusieurs taux d’échantillonnage différents.
16 - 4
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MTC [Hz]
L’écart entre le MTC entrant, et son frame rate nominal est affi-
ché ici.

Si l’écart est trop grand, vérifiez que vous avez fixé le bon frame 
rate (sur la page ‹General› de la fenêtre synchronisation). En cas 
de doute, fixez le frame rate à 24fps et activez ‹Auto Detect 
format of MTC›.

Si le frame rate est correct, vous pouvez alors régler la vitesse de 
la bande de la machine maître afin d’obtenir la valeur nominal 
(c’est à dire à la vitesse utilisée pendant l’enregistrement du 
timecode). Ajustez le contrôle du varipitch sur la machine maître, 
jusqu’à ce que la ligne jaune verticale soit exactement au 
milieu.

Sample Rate
16 - 5
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C
L’écart entre le taux d’échantillonnage et sa valeur nominal est 
affiché ici.



Chapitre 16
Synchronisation

N’oubliez pas que certains éléments de hardware audio (par ex. 
SoundManager ou MME) ne permettent pas de variation du 
taux d’échantillonage.

Deviation
L’écart de phase entre la word clock et le timecode master est affi-
ché ici, en d’autres termes c’est le décalage entre l’audio et le 
Midi.

& Avec le timecode qui varie vous pouvez voir ici comment Logic Audio régule le taux 
d’échantillonnage du hardware dans le mode de synchro ‹MTC continuous›. Même 
avec des variations importantes dans le timecode, il n’y a pas d’écart entre audio et 
Midi. Pour que ceci fonctionne, votre hardware audio doit être capable de varier le 
taux d’échantillonnage en continu.

& Des petits décalages entre audio et Midi sont inévitables, car le Midi peut (et doit) 
suivre directement le timecode master.

Sync Mode
C’est ici que vous définissez la façon dont chaque élément 
séparé de hardware audio sera synchronisé avec un timecode 
master externe.

Tous les éléments de hardware audio ne fonctionnent pas 
forcément dans chaque mode de synchro décrits plus bas: cela 
dépend de leur architecture. Cela dépend surtout de la capacité 
ou non du hardware a pouvoir contrôler son taux d’échantillon-
nage.

MTC Continuous 

Les régions audio sont lancées en synchro, et le taux d’échan-
tillonnage est régulé en continu en accord avec les variations 
dans le timecode master. Avec cette méthode, même de longues 
régions audio restent synchronisées.
16 - 6
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MTC Trigger

Les régions audio sont lancées en synchro, mais sont ensuite 
jouées à un taux d’échantillonnage constant, sans tenir compte 
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de variations dans le timecode master. Logic Audio utilise 
toujours le taux d’échantillonnage standard (44,1 ou 48kHz).

Ce mode est adapté lorsque la hauteur absolu de l’enregistre-
ment doit être respecté. Si la vitesse du timecode master dévie 
de la valeur nominal, il vous faudra découper vous longues 
régions audio en éléments plus courts.

MTC Trigger / Auto Speed Detection

Ressemble à ‹MTC Trigger›, sauf qu’en plus, la détection de 
vitesse vérifie constamment la vitesse du timecode master, 
pendant que Logic lit. La prochaine fois que vous démarrerez 
Logic, il utilisera le même taux d’échantillonnage que celui 
mesuré (Logic utilise un taux d’échantillonnage qui s’écarte 
autant du taux d’échantillonnage standard que la vitesse du 
timecode master s’écarte du frame rate standard.)

Ce mode garde les longues régions en meilleur synchro avec le 
timecode master, mais pas autant que ‹MTC Continuous›. 
Cependant, il utilise un taux d’échantillonnage continu, qui 
n’est pas affecté par des variations dans le timecode master.

External/Free

Logic n’influe pas sur le taux d’échantillonnage. Le hardware 
audio doit s’assurer que la position et le taux d’échantillonnage 
des régions audio soient calés ensemble. Ce mode de synchro 
n’est conseillé que si vous pouvez être sûr que leWord clock et 
le timecode sont synchronisés, par exemple en utilisant un 
synchroniseur externe SMPTE/wordclock 

Digital

Ressemble à ‹External/Free›, mais en plus le hardware est 
configuré pour être synchronisé avec le taux d’échantillonnage 
du signal digital entrant (avec du hardware DAE vous devez 
faire ce réglage dans DAE Hardware Setup).
16 - 7
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Midi
C’est sur cette page que vous suivez tous les réglages envoyés 
par Logic à travers le Midi lorsque le séquenceur tourne. Cela 
permet de synchroniser à Logic, qui fonctionne en maître, des 
périphériques externes en esclave.

Transmit Midi Clock
Le bouton sur la droite active la transmission de l’horloge Midi. 
Juste à côté, vous pouvez choisir le port (Midi Out Driver) à 
partir duquel est envoyé l’horloge Midi.

A chaque fois que vous démarrez un song, un ‹Song Position 
Pointer› (SPP) est également envoyé.

Puisque tous les périphériques ne peuvent pas traiter SPP le 
message en temps réel ‹Continue› est également envoyé. Il y a 
une exception: si vous commencez à la position 1/1/1/1. Dans ce 
16 - 8
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cas le message temps réel ‹Start› est envoyé au lieu de ‹Conti-
nue›.



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Note
La fenêtre Synchronisation

Midi Clock to all Ports (All Ports)

L’horloge Midi et le MTC peuvent être envoyés à tous les ports 
simultanément: choisissez ‹All Ports›.

L’ horloge Midi peut facilement être envoyé à travers un bus 
accompagné d’autres événements Midi classiques (notes, 
contrôleurs). Avec des interfaces Midi dotées de plusieurs ports 
(comme Unitor8 ), il est préferable pour des raisons de calage, 
d’envoyer l’horloge Midi sur tous les ports plutôt que sur 
plusieurs ports individuels.

& Si l’horloge Midi est transmise par tous les ports, alors les événements ne sont envoyé 
qu’une fois de l’ordinateur vers l’interface. Si vous envoyez vers des ports individuels, 
alors un événement doit être envoyé pour chaque port individuel, ce qui alourdi la 
synchronisation pour tous les ports.

Allow Song Position Pointer while playing
En accord avec le standard Midi, Le Song Position Pointer n’est 
envoyé que lors du démarrage. Cette option permet d’envoyer 
SPP pendant que le séquenceur tourne. L’avantage est que les 
périphériques externes peuvent suivre Logic en mode Cycle.

Si les périphériques externes ne peuvent traiter SPP, alors il 
faut éteindre cette option. Cela améliore le tempo en mode 
cycle.

Send MMC (Midi Machine Control)
Ceci est l’endroit ou vous pouvez activer la transmission du 
MMC. Ces commandes sont toujours envoyées lorsque vous 
utilisez les fonctions de transport de Logic.

& Habituellement, le MMC est utilisé lorsque Logic fonctionne en esclave par rapport 
à un maître externe (par exemple un ADAT), ou vous désirez commander les fonc-
tions de transport du maître externe à partir de Logic. Logic joue donc le rôle de 
MMC maître, et d’eslcave MTC simultanément.
16 - 9
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Si vous souhaitez utiliser les fonctions de transport du maître 
externe alors vous n’avez pas besoin du MMC. Dans ce cas 
Logic, en esclave, suivra le MTC master.
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Vous pouvez aussi utiliser MMC pour placer des pistes qui 
viennent du périphérique esclave MMC en mode enregistre-
ment. Pour plus de détails, reportez vous au paragraphe «Midi 
Machine Control (MMC)» à la page 16 - 15.

Unitor
C’est dans cette page que vous configurez les paramètres de 
synchronisation les plus importants pour Unitor8.

Notez que vous pouvez éditer de façon détaillé Unitor8 en 
utilisant le logiciel ‹Unitor8 Control› fourni avec celui-ci (ou le 
module Sound-Driver correspondant).

SMPTE Mode
Ici vous pouvez dire à Unitor8 d’écrire en SMPTE. Vous devez 
basculer de Read à Generate,et régler le frame rate et le start-
16 - 10
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time sur la page ‹General›.
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SMPTE Type
C’est ici que vous définissez le format SMPTE que vous dési-
rez utiliser:

LTC Longitudinal Time Code est écrit sur 
une piste.

VITC Vertical Interval Time Code est écrit de 
façon invisible dans un signal vidéo.

TV Format
Permet la définition du format télévision pour l’inscription du 
timecode:

PAL Le format vidéo utilisé en Europe. 
Si vous travaillez la vidéo avec la 
norme SECAM, choisissez PAL ici.

NTSC Le format vidéo utilisé aux Etats 
Unis et au Canada.

Ce réglage ne sert pas uniquement lors de l’écriture et de la 
lecture de VITC. Si vous utilisez LTC et que vous voulez géné-
rer une image vidéo avec écriture du temps SMPTE, vous 
devez choisir le bon format ici.

Refresh
En mode Refresh, du timecode «neuf» est généré en synchro 
avec le timecode reçu. ‹Refresh› fonctionne aussi bien avec le 
VITC que le LTC.

Il faut toujours utiliser ‹Refresh› lorsque vous avez une piste 
LTC à copier, car vous ne pouvez pas copier directement le 
LTC sans une perte de qualité considérable. Lors de la copie 
entière de cassettes multipistes vous devriez patcher toutes les 
pistes directement, mais rafraîchir la piste TC en passant par 
16 - 11
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Unitor8.

N’utilisez le mode Refresh que si vous en avez vraiment 
besoin.
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LTC Freewheel, VITC Freewheel
Ici, vous pouvez régler le temps de «roue libre» en frames 
(images) pour le LTC et le VITC individuellement.

Le paramètre freewheel influe sur le lecteur SMPTE, et spécifie 
la durée pendant laquelle le sychroniseur va continuer à trans-
férer le MTC au séquenceur, après que le timecode ne soit plus 
lu.

& Une durée de roue libre importante peut prolonger la synchronisation, même s’il 
manque du timecode, mais cela augmente le temps que met Logic à arrêter le 
timecode master. En pratique, il faut donner une valeur aussi grande que nécessaire 
(pour des temps d’opération prolongés), et aussi faible que possible (pour raccourcir 
les temps d’attente)..

VITC Line 1, VITC Line 2
Le VITC s’écrit sur deux lignes de l’image vidéo, qui sont 
normalement invisibles. Les lignes ne devraient pas être consé-
cutives et sont situées habituellement entre 12 et 20.

Dans le réglage ‹Scan› setting, les lignes VITC sont reconnus 
automatiquement. Vous ne devez entrer ces lignes à la main 
que lorsqu’il y a des problèmes.

Visible Timecode on Video
vous pouvez définir Ici la position, la taille et la couleur de l’affi-
chage du timecode qui est gravé avec l’image vidéo.

16.2 Fonctions Spéciales

Activer la synchro externe
En activant le bouton sync du Transport, Logic se synchronise à 
16 - 12
Emagic
Logic Audio Pro ISIS 

la source de synchro que vous avez choisi.

Vous pouvez utiliser le bouton sync pour désactiver la synchro 
externe à n’importe quel moment, sans changer la source de 
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synchro choisie. Ceci permet d’enlever temporairement Logic 
de l’axe du temps du sync master, ce qui se révèle utile si, par 
exemple, vous avez besoin d’éditer rapidement une séquence 
pendant que la source de synchronisation externe (machine à 
bandes, VTR etc.) continue de tourner.

Enregistrer avec une synchronisation externe
Lorsque vous appuyez sur ‹Record› pendant une synchro 
externe, Logic se met en mode d’enregistrement Midi, mais ne 
démarre pas tant qu’il ne rencontre pas de timecode provenant 
de l’exterieur.

Témoin de Time Code Midi Entrant
Le point clignotant sur le bouton sync de la fenêtre Transport 
indique que Logic est en train de recevoir du timecode Midi sans 
erreurs.

Si le point s’arrête de clignoter, alors une erreur est survenu. 
Bien que Logic soit capable de gérer tout seul beaucoup 
d’erreurs MTC, vous devriez quand même vérifier la qualité de 
votre signal SMPTE, et aussi les autres sources d’erreurs .

Interprétation du MTC 
Puisque le standard Midi ne supporte que quatre des six 
formats de timecode possible (les formats 30fps et 29,97fps ne 
peuvent être différenciés), Logic doit décider quel format est 
‹désiré› lorsqu’il rencontre un timecode entrant:

 format MTC entrant est interprété comme

24 fps 24 fps

25 fps 25 fps

30 drop fps 29,97 drop fps

30 fps 30 fps
16 - 13
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En d’autres termes, les formats plus courants 29,97fps et 
30drop fps sont préférés au format inhabituel de 30fps et au 
format quasi inconnu de 29,97drop fps.

Cependant, vous pouvez fixer le format manuellement à partir 
de l’éditeur deTempo List: par exemple pour convertir du 30fps 
pour une transmission TV monochrome dans le format NSTC.

Recevoir l’horloge Midi et le SPP
La synchro par horloge Midi et SPP est la méthode la plus 
précise, si Logic est synchronisé à un maître qui travaille par 
rapport à la mesure.

& L’horloge Midi possède une résolution de 24PPQN (pulsations par quart de note 
(noire)), alors que Logic en a une de 960PPQN (quelque 40 fois plus précis!). C’est 
pourquoi, Logic doit interpoler tout seul les 39 pas entre les deux pulsations 
d’horloge.

Si vous êtes dérangés par de petits décalages entre le maître et 
l’esclave, vous pouvez améliorer la relation lorsque vous êtes en 
synchro externe, en entrant les changements de tempo atten-
dus du maître dans la liste interne de tempo de Logic.

Même si vous ne faîtes pas cela, la synchro devrait s’en sortir 
plutôt bien, tant que vous évitez de grands écarts, comme un 
tempo interne de 200bpm avec un tempo externe de 40bpm.

Continue Event

Lorsqu’un Midi Continue Event (événement Midi continu) est 
reçu, Logic ne passe pas à dernière position valide reçu par 
l’horloge MidiAu lieu de cela, la lecture recommence à la posi-
tion de song en cours. Ceci vous permet changer la position du 
song manuellement pendant que le séquenceur est arrêté, et 
recommencer à partir de la nouvelle position, avec une 
commande Midi Continue..
16 - 14
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Midi Machine Control (MMC)
MMC est un jeu de commandes Midi qu’utilise Logic pour 
commander les fonctions de transport d’une machine à bandes 
MMC. Le processus d’enregistrement peut aussi être 
commandé et «automatisé» à partir de Logic avec MMC. La 
machine à bandes produit ensuite le signal SMPTE auquel 
Logic se synchronise en esclave (voir leparagraphe «General» à 
la page 16 - 1).

Vous pouvez commander des périphériques connectés à partir 
de Logic avec les fonctions classiques de transport (ce qui 
inclus le positionnement direct et sauts de cycle). N’oubliez 
pas que Logic doit attendre que le périphérique ait fini de 
rembobiner ou d’avancer.

activer le MMC
Activez Midi Machine Control à partir du menu déroulant du 
bouton sync. Vous pouvez également désactiver cette fonction 
ici, ce qui vous permet d’effectuer rapidement une édition.

Cette option est également accessible en choisissant File > Song 
Settings > Midi Options.

Fonctions d’Enregistrement

Logic supporte jusqu’à 64 pistes MMC il peut donc gérer des 
périphériques tels que l’ADATtm d’Alesis avec Midi Machine 
Control.

Chaque piste arrange peut jouer le rôle d’une piste cassette 
(bande) en choisissant un instrument avec l’icône (n°305) 
‹Tape Deck›. Il est conseillé de regrouper ces pistes dans leur 
propre dossier. Ces pistes doivent être placées en haut du Track 
List, dans la fenêtre arrange. Si vous les placez dans un dossier, 
alors ce doit être la première piste dans la liste.
16 - 15
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& L’icône (n°305) ‹Tape Deck› est le seul icône qui influe la façon dont se comporte un 
objet. Tous les autres icônes sont uniquement de nature graphique.
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Si la piste cassette (bande) est la piste d’enregistrement en 
cours alors les instructions suivantes s’appliquent:

• La sélection de la piste bande fait basculer la piste corres-
pondante de la machine à bande sur ‹Record Ready›, et 
désactive le statut ‹Record Ready› de toutes les autres 
pistes. Pour sélectionner plusieurs pistes pour l’enregistre-
ment, utilisez S.

• Dans le panneau de transport, le bouton record envoie la 
commande ‹record strobe› à la machine à bande. Cette 
commande place Logic en mode d’enregistrement Midi, et 
envoie une commande MMC ‹Play› à la machine à bande 
(HDR ou autre). Logic ne démarre pas tant qu’il n’a pas reçu 
du timecode de la part du multipiste.

• Lorsque vous utilisez la fonction autodrop, la machine à 
bande se met à enregistrer à la postion du locateur gauche, et 
s’arrête d’enregistrer à la position du locateur droit.

• ISi vous cliquez sur une piste – pas uniquement une piste 
bande – tout en enfonçant les touches ç et S, vous 
pouvez basculer le statut prêt à l’enregistrement pour 
chaque piste de la machine à bande, les pistes sélectionnées 
sont allumées et les pistes non sélectionnées sontdésacti-
vées. En cliquant sur une piste tout en enfonçant la touche 
ç vous pouvez désactiver toutes les autres pistes d’enregis-
trement. Un icône tape deck a été assigné à la piste d’enregis-
trement en cours (voir au dessus), alors vous ne devez pas 
utiliser la touche ç.

• V (ou la commande clavier Record Toggle) est utilisé pour 
basculer le statut d’enregistrement si une piste à bande est la 
piste d’enregistrement sélectionnée.

• Après avoir fini un enregistrement commandé en MMC, 
Logic crée automatiquement une séquence vide sur une 
piste à bande, pour que vous sachiez qu’un enregistrement à 
16 - 16
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eu lieu sur la bande. Ceci s’applique à tous les enregistre-
ments MMC, ce qui inclus ceux commandé par la fonction 
autodrop. Si vous activez plusieurs pistes en utilisant S, le 
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nombre correspondant de séquences seront crées. S’il y a 
déjà une séquence avec un point de départ identique sur une 
piste à bande, alors aucune nouvelle séquence ne sera crée 
sur la même piste, afin d’éviter des objets qui se chevauche-
raient.

Vous devriez terminer chaque enregistrement commandé par 
MMC avec STOP ou V. Certaines machines à bande réagis-
sent différemment à une série de commandes ‹MMC Record›. 
Parfois Logic montre une piste en enregistrement alors que la 
bande défile en lecture (ou pire, la situation inverse). Alors pour 
être prudent, il faut toujours finir un enregistrement avec 
STOP ou V.

Pour les utilisateurs de l’unité de commande BRC: configurez 
le BRC pour que le Midi timecode soit filtré pendant le rembo-
binage et l’avance rapide. ‹Gen Sync› doit être allumé pour 
permettre le transfert de MTC.

Positionner les Mesures par rapport aux 
images
Si vous voulez arriver à une position dans un song à un temps 
SMPTE spécifique, vous devez changer le tempo du passage 
précédant. Pour éviter de le faire approximativement:

• Ouvrez la Tempo List (page 15 - 2).

• Créez un événement Tempo à la position de mesure en 
question (page 15 - 3).

• Réglez la position dans le temps de cet événement tempo 
dans la colonne SMPTE-Position. L’événement de tempo 
précédant est ajusté automatiquement pour générer la posi-
tion de mesure et de temps correct pour ‹l’événement de 
tempo auxiliaire›.
16 - 17
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• Vous pouvez ensuite effacer l’événement de tempo auxi-
liaire‹ si vous désirez garder le même tempo pour le passage 
suivant.
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16.3 Synchronisation de Fichiers 
Vidéo

AVI
Logic ouvre les films en format Video for Windows (*.AVI).

Ces vidéos peuvent se dérouler dans une fenêtre Logic 
synchronisé avec la chanson. Quand vous bougez la position 
dans la chanson, le film suit. Vous pouvez écrire une musique 
de film, ou appliquer des effet sonores aux images individuel-
les.

Afin de garantir une lecture fluide, vous devriez essayer de lire 
les fichiers audio et le matériel vidéo sur des disques dur diffé-
rents, si possible.

Ouvrir un Film
Si vous sélectionnez Video > Open Video dans la fenêtre princi-
pal, le sélecteur de fichiers s’ouvre et vous pouvez prendre un 
film *.AVI sur votre disque dur.

Régler un Offset
Cliquez avec le bouton droit sur la barre de titre de la fenêtre 
Video, un menu s’ouvrira. Sélectionnez Offset, et une  fenêtre 
apparaîtra où vous pourrez choisir le point de départ du film.

16.4 Les bases

Résumé
16 - 18
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Si vous désirez synchroniser Logic avec un deuxième système 
de séquenceur (station de travail, boîte à rythmes) utilisezle 
signal Midi Clock/SPP.
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Pour toutes les autres situations où vous utilisez une synchro 
externe (machine à bande, enregistreur multipiste sur disque 
dur, enregistreur vidéo) utilisez MTC. Pour synchroniser Logic 
avec un signal SMPTE vous aurez besoin d’un ‹synchroniseur› 
qui convertit SMPTE en MTC. Pratiquement toutes les inter-
faces qui possèdent plusieurs ports Midi peuvent effectuer 
cette conversion.

Synchronisation de Timecode et d’horloge
La synchronisation, c’est s’assurer que plusieurs périphériques 
fonctionnent ensemble, en même temps. Cela ne veut pas dire 
que les périphériques commencent en même temps, et fonc-
tionnent à la même vitesse. Régler tous les périphériques à la 
même vitesse demanderait une précision infini (même avec des 
périphériques numériques). En réalité, synchronisation veut 
dire que pendant que tous les périphériques sont en marche, 
chaque point sur l’axe du temps de tous les périphériques 
doivent être reliés.

Pour ce faire les périphériques doivent être constamment 
‹connectés› entre eux. Ceci n’est possible que si un des péri-
phériques fonctionne en maître qui définit la position actuelle, 
pendant que tous les autres périphériques fonctionnent en 
esclave et essayent se suivre constamment cette position 
d’aussi près que possible.

Il y a deux façons de faire, cela dépend du type de matériel 
utilisé:

1.  Avec des périphériques comme un séquenceur ou une boî-
te à rythme, l’information de position partagée est expri-
mée en position de mesure (en d’autres termes, ils utilisent
une synchronisation avec comme référence le temps en
mesures).

2. Les périphériques comme les machines à bande ou les en-
16 - 19
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registreurs à disque dur utilisent habituellement une syn-
chronisation avec comme référence le temps (l’information
de position partagé par ces périphériques est l’information
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sur le temps, appelée plus couramment le timecode). Les
périphériques qui utilisent le time code sont par exemple
Les machines à bande pour signaux vidéo, comme les VTR
(video tape recorders) et les VCR (video cassette recor-
ders). Avec la synchro qui utilise comme référence le
temps, la vitesse de la bande ou le taux d’échantillonnage
n’est pas dépendant du tempo musical de la chanson enre-
gistré.

& la sychronisation sur la base des mesures n’est approprié que si vous utilisez des péri-
phériques de la première catégorie. En ce concerne les périphériques de la deuxième 
catégorie, la synchro sur la base du temps devrait être utilisé. Une seule machine à 
bande pourrait en théorie contrôler plusieurs périphériques de la première catégorie, 
en utilisant un time code enregistré en mesures. Cependant, pour des raisons 
diverses, la plupart des professionnels travailleraient avec un codage en temps, déjà 
parce que c’est le seul moyen de synchroniser d’autres machines avec la bande par 
la suite. 

Un séquenceur synchronisé à une bande doit calculer la posi-
tion de mesure à partir de la position en temps, en utilisant sa 
piste tempo.

Synchronisation référencée aux mesures
La Synchronisation à base de Mesures...

& Horloge à pulsations (pulse clock) et FSK (historique)
La méthode d’origine pour synchroniser entre eux les séquenceurs analogues, 
ou boîtes à rythmes, sétait d’envoyer des impulsions électriques (signaux 
d’horloge) à des intervalles spécifiques. La norme était 24ppqn (pulsations 
par quart de note), ce qui est équivalent à une résolution de 1/96ème de note. 
Cependant, certaines compagnies utilisait 48 (Korg, Linn), 64 (PPG), 96 
(Oberheim) ou 384ppqn (Fairlight). En comparaison, la résoulution de Logic 
est de 960ppqn).
En encodant ces impulsions comme le glissement entre deux notes (FSK code, 
frequency shift keying), il fut possible d’enregistrer ce genre de codage sur 
bande. Ce fut principalement utilisé pour synchroniser les boîtes à rythmes 
aux machines à bande, mais cette méthode comportait de nombreux incon-
vénients:
• le codage FSK imposait un tempo fixe.
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• Il était impossible de programmer une intro/une fin ultérieurement.
La Pulse Clock et le FSK avaient encore deux inconvénients:
• Si des impulsions étaient perdus par défaut de signal, les périphériques 
synchronisés se désynchroniseraient à partir de ce point.
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• Comme il n’y avait pas d’indicateur de position, il fallait toujours démarrer 
le morceau à partir du début (FSK 2 ou Smart FSK surmontait ce problème en 
inscrivant également la position du morceau).

Ces désavantages ont fini par enterrer clock et FSK, ces deux méthodes de 
synchronisation ne sont plus utilisées professionnellement aujourd’hui.

Midi Clock / SPP

Avec l’arrivé du standard Midi, un équivalent à «l’horloge 
d’impulsion» fut incorporé dans le protocole de commande: 
Midi Clock. Les événements Midi Clock sont transmis par le 
maître 24 fois par quart de note (noire). Afin d’éviter d’avoir à 
recommencer les morceaux systématiquement depuis le début, 
une autre commande Midi est transféré: song position pointer 
(SPP). Celui-ci transmet des 1/16ème de note (double croche) à 
partir du début du morceau. Comme deux octets de données 
sont utilisés pour l’encodage (14 bit), il est possible de distin-
guer un maximum de 16384 double croches ou 1024 mesures. 
L’esclave reconnaît la position du morceau dans cette région, et 
se synchronise avec.

Les périphériques modernes utilisent toujours une combinai-
son du Midi Clock et du song position pointer.

Si un logiciel se séquence possède une résolution temporelle 
plus élevé que 1/96ème de mesure, alors les positions entre 
doivent être interpolées. La résolution de Logic est de 1/
3840ème de mesure.

Synchronisation référencée au temps
La synchronisation référencée au temps prend ses origines 
dans la synchronisation de films, mais elle est aujourd’hui 
également utilisé pour le travail audio. C’est pourquoi elle 
divise un seconde non pas en dizaines et centaines mais en 
images. A l’origine, une image représentait le temps que 
mettait une image de film à passer au travers d’une camera ou 
16 - 21
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Malheureusement, le nombre d’images utilisées par seconde 
varie en fonction du pays, de la norme et de l’usage. pour le 
film, la norme international est de 24 images par seconde. La 
télévision en noir et blanc aux Etats Unis utilise 30ips. Avec 
l’arrivé de la télévision en couleur, le nombre d’images par 
seconde de la norme NTSC, utilsée aux Etats Unis et au 
Canada a du être réduit à 29,97 ips pour des raisons techniques. 
En Europe, le nombre d’images par seconde est de 25, et avec 
l’introduction de la télévision en couleur, ce taux a été adopté 
par le standard européen PAL TV, qui est utilisé en Europe 
aujoud’hui.

& La raison des différents standards vient du fait que le courant alternatif n’a pas la 
même fréquence sur les différents continents (EU:60Hz, Europe:50Hz), ce qui corres-
pond au nombre de demi-images de film qui passent dans une camera / un projec-
teur par seconde.

SMPTE/EBU

C’est l’American Society of Motion Picture and Television Engineers 
(SMPTE) qui a le premier posé une norme pour l’encodage des 
images individuelles. Cela désigne exactement 80bits par 
image pour encoder l’heure, la minute, la seconde, et l’image 
(numéro de l’image dans la seconde). Quelques uns des bits 
restants servent à indiquer le nombre d’images par seconde. Ce 
flux de données encodés de 80bits par image est connu sous le 
nom de SMPTE time code. Comme les bits individuels sont 
espacés de façon fixe dans le temps, ils deviennent la division 
suivante d’une image appelé ‹subframe›.

Ce codage a été adopté sans changements par l’European Broa-
dcasting Union (EBU), pour utilisation avec le nombre 
d’images par seconde Européen, et a été renommé ‹EBU Time 
Code›. Dans la pratique ce time code est habituellement 
appelé SMPTE time code, ou tout simplement SMPTE 
(prononcé ‹simptee›).
16 - 22
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Drop Frame (df)

Un des problèmes techniques était le nombre d’images par 
seconde de 29,97. Seuls les images entières peuvent être comp-



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix

Note
Les bases

tées, mais compter jusqu’à la 30ème image à chaque seconde 
causerait un décalage entre le temps en time code, et le temps 
réel (une différence d’environ 5,4 secondes pour un film classi-
que). Le moyen suivant a donc été employé: toutes les minutes 
2 images sont laissées de coté (‹dropped=laissé›), sauf dans les 
minutes divisibles par 10.

& Cela peut paraître compliqué, mais c’est plus facile que ‹une année bissextile tous les 
4 ans sauf dans les années divisible par 100, sauf si elle est également divisible par 
400›!

Pour indiquer cette méthode on ajoute ‹drop› ou ‹df› après le 
nombre d’images par seconde. Comme on utilse le plus 
souvent 30ips, l’habitude a été pris d’indiquer le non-usage en 
ajoutant ‹non drop›, ‹nd› ou ‹ndf› pour éviter toute confusion.

Le format 29,97nd est très peu utilisé (tout comme le 30df, sans 
interêt), car le temps du timecode ‹dérive› par rapport au temps 
‹réel›.

Frame Rates

Le nombre d’images par seconde (frame rate) en SMPTE doit 
être le même pour tous les périphériques connectés; vous ne 
pouvez pas avoir de différents taux d’images par seconde dans 
un système. Le tableau ci-dessous montre les divers taux avec 
la durée d’une image ou sous-image (subframe):

En Europe le 25 fps est aussi bien utilisé pour l’audio que pour 

Frame Rate [fps] images[ms] Bit [µs] Source

24 41,67 520,8 Film

25 40 500 PAL

29,97 drop 33,37 417,1 -

29,97 33,37 417,1 NTSC color

30 drop 33,33 416,7 -

30 33,33 416,7 NTSC S/W
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Les productions audio Américaines utilisent principalement 30 
fps, mais avec la vidéo le nombre d’images par seconde est pres-
que toujours 29.97 df.

Les productions internationales sont enregistrées avec 25 fps, 
et 330fps sur des pistes differents.

LTC / VITC

Les 80bits par image du timecode SMPTE peuvent être stoc-
kés de deux manières:

• comme un signal audio sur une piste son. On l’appelle longi-
tudinal time code (LTC).

• comme un signal dans l’espace de non balayage de l’image 
vidéo. (L’information complète de l’image est transféré légè-
rement plus rapidement que la durée de l’image. Il y a donc 
un petit vide, pendant que le faisceau électronique du tube 
cathodique revient de la fin de la dernière ligne, jusqu’au 
début de la ligne du haut. Comme le faisceau est éteint 
pendant ce passage, le timecode envoyé pendant ce laps de 
temps n’interfère pas avec l’image.) On l’appelle vertical 
interval time code (VITC).

Le LTC est utilisé pour toutes les productions audio, et 
souvent pour la synchronisation vidéo. Un appareil de duplica-
tion de bande peut enregistrer le LTC sur une des pistes audio, 
en général la piste 2. Le temps SMPTE peut aussi être gravé 
sur l’image. Du fait de la quasi universalité du LTC pour le 
travail audio, le terme ‹SMPTE› est utilisé comme synonyme 
de LTC.

Avec la synchronisation vidéo, le LTC ne peut être envoyé que 
lors de la lecture à vitesse normale. VITC (prononcé ‹vitzi›) a 
l’avantage d’être envoyé pendant le rembobinage ou l’avance 
rapide. Ceci est très utile lors de la création d’effets sonores qui 
sont synchronisés avec les images, ou des phrases musicales.
16 - 24
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& L’Unitor 8 d’Emagic, interface Midi 8x8 qui permet le travail en réseau, possède un 
synchroniseur qui peut lire et écrire le LTC et le VITC.
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Midi Time Code (MTC)

MTC est une conversion des bits SMPTE en Midi Standard, et 
contient l’information sur le temps et le nombre d’images par 
seconde. Ceci demande un octet de statut et huit octets d’infor-
mation. MTC ne définit que 24, 25 30df et 30ndf.

Synchroniseurs
Un synchroniseur professionnel est un périphérique qui peut 
lire et écrire les signaux SMPTE. Il est connecté à un maître, et 
à une ou plusieurs machines à bande esclaves dont il peut 
contrôler leurs fonctions de transport.

Dans les interfaces Midi d’ordinateurs, les synchroniseurs 
internes ont généralement qu’une entrée et une sortie 
SMPTE. L’interface fait passer automatiquement à l’ordina-
teur les signaux SMPTE qui arrivent à l’entrée, sous forme de 
MTC.

Quelle machine utiliser en maître, et laquelle en esclave?

En règle général, la machine la plus lente doit être utilisé en 
maître, afin de réduire les temps d’attente pour les esclaves lors 
du rembobinage ou de l’avance rapide. Comme un séquenceur 
‹rembobine› plus rapidement que les machines à bande, il doit 
toujours fonctionner en esclave.

Procédure de Synchronisation
Les instructions qui suivent s’appliquent aux périphériques 
plutôt qu’à Logic.

L’enregistrement du SMPTE

Si vous souhaitez synchroniser un programme séquenceur à 
une machine à bande, alors la première chose à faire est d’enre-
gistrer un signal SMPTE sur une des pistes extérieurs (les 
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pistes extérieurs sont d’une qualité légèrement inférieure, à 
cause des (léger) pulsations sur la bande, mais conviennent 
largement pour du timecode). Connectez la sortie SMPTE de 
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l’interface avec l’entrée de la machine à bande (ou l’entrée de la 
console, si vous voulez router le timecode, et fixer un niveau). Il 
est de coutume d’utiliser la piste qui à le nombre le plus élevé. 
Réglez le niveau du timecode à –10VU. Evitez d’enregistrer du 
timecode fixe en démarrant le générateur de timecode avant 
l’enregistrement. Pour plusieurs raisons – poue éviter par 
exemple les erreurs qui peuvent mener à des trous ou des sauts 
dans le timecode, et pour vous laisser la possibilité de rallonger le 
morceau par la suite; on enregistre souvent le timecode sur toute 
la bande. Il est également de coutume de régler le temps de 
départ SMPTE juste un peu avant une heure (01:00:00:00). Le 
premier morceau sur une bande démarre du coup à une heure. 
Les autres bandes d’un même projet peuvent recevoir différent 
temps SMPTE avec des heures consécutives, ce qui veut dire 
que le temps SMPTE peut être utilisé pour identifier une 
bande, si jamais on se trompait dans les boîtes.

Synchroniser un Séquenceur sur une Bande

Connectez la sortie de la piste timecode à l’entrée SMPTE de 
l’ordinateur. pour minimaliser la diaphonie, il vaut mieux faire 
une connection directe plutôt que de router le signal par la 
table de mixage. L’ordinateur n’est pas obligé de commencer la 
première mesure au temps SMPTE de 0 heures, 0 minutes, 0 
secondes, 0 images (00:00:00:00), vous pouvez régler l’‹offset› 
pour que l’ordinateur attende la bonne position SMPTE avant 
de démarrer le morceau. Si le deuxième morceau sur la bande 
démarre à 01:04:50:00, alors vous devrez régler l’offset en 
conséquence. Notez l’offset SMPTE sur une feuille qui 
concerne les pistes ou à côté du titre du morceau sur la boîte de 
la bande.

La position en mesures atteinte à un temps SMPTE spécifique 
dépend du tempo du séquenceur. Si vous avez commencez à 
enregistrer sur la bande, vous ne pourrez plus changer le tempo 
sans perturber la synchronisation. Vous devriez donc également 
16 - 26
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L’offset SMPTE et le tempo sont sauvegardés avec le morceau, 
mais cela arrive que le fichier du morceau et la bande soient 
séparés.

Synchroniser plusieurs Séquenceurs

Si vous désirez synchroniser plusieurs programmes de séquen-
ceurs avec une machine à bande comme maître, vous devriez 
essayer à tout prix de ne synchroniser qu’un séquenceur avec le 
SMPTE ou le MTC. Vous pouvez ensuite synchroniser les 
autres séquenceurs à celui-ci, avec Midi Clock/SPP. Lors de la 
synchronisation de plusieurs séquenceurs (sans machine à 
bande) vous ne devriez utiliser que Midi Clock/SPP. Cela évite 
des déviations dans la position de mesure, car sinon, chaque 
séquenceur doit la calculer indépendamment, à partir de 
l’information sur le temps en utilisant sa propre piste tempo.

Piste de clic

En plus de la piste de Time Code, il est d’usage d’enregistrer une 
piste de clic audio, c’est à dire un métronome au bon tempo 
tout le long du morceau. Ceci en raison en partie aux décalages 
possibles dans le calcul de la position des différents séquen-
ceurs à partir du code SMPTE enregistré. Cela permet égale-
ment de reprendre des bandes dans des studios dépourvus de 
matériel Midi, bien que de nos jours, de tels studios soient 
plutôt rares.

Lors de l’enregistrement de la piste de clic sur la piste adja-
cente à celle du code SMPTE, il est préférable d’avoir un faible 
niveau d’enregistrement. Une diaphonie d’un signal qui a 
beacoup de niveau sur la piste SMPTE peut corrompre la piste 
SMPTE, et empêcher la bonne synchronisation.

Synchronisation Audio
Le problème le plus courant avec la synchronisation externe et 
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l’audio numérique est le fait qu’on ait deux horloges sources: le 
timecode maître, et le wordclock audio. Dans tous les systèmes 
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qui possèdent plusieurs références temporelles, il y a de la 
place pour la dérive.

Dans le monde analogique, ce problème bien connu est réglé 
car la vitesse de la bande est constamment vérifiée afin de mini-
miser le décalage entre le timecode de la machine esclave et le 
timecode maître.

La même chose s’applique à un ordinateur – à condition que le 
hardware audio supporte des variations continues de ‹la vitesse 
de la bande› (taux d’échantillonnage), comme l’Audiowerk8.

Vous pouvez employer ‹à tort› la sortie numérique sur 
l’Audiowerk8 afin de synchroniser d’autres éléments de hard-
ware audio (par exemple AudioMedia ) en passant par l’entrée 
numérique de l’autre élément de hardware.

Si votre hardware audio ne possède pas d’horloge externe ou de 
taux d’échantillonnage variable, il y a d’autres façons de 
synchroniser à un timecode maître, décrites dans le paragraphe 
«Sync Mode» à la page 16 - 6.

Si vous avez des Problèmes de Synchro
… vous trouverez peut-être des conseils ici …

Synchronisation Numérique Défectueuse

Si Logic est synchronisé à un wordclock externe (Audio Sync 
Mode: External /free), vous devez vous assurer qu’un signal 
numérique valide est toujours disponible. Si vous avez des 
messages d’erreur tels que ‹Sample Rate 13,x kHz recognized› 
il se peut que l’enregistreur DAT (ou la source horloge que 
vous avez connectée à l’entrée numérique de votre hardware 
audio) ne transmette pas wordclock en mode stop ou pause (ou 
qu’il se soit désactivé).
16 - 28
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Synchronisation Défectueuse avec une Machine à Bande
Externe

Créez un nouveau morceau, faîtes un nouvel enregistrement et 
voyez si ça résout le problème. Pourquoi? Si un vieil enregistre-
ment sur bande n’est pas synchronisé avec le timecode, vous ne 
pourrez pas l’utiliser. Une règle de base: les conditions de lec-
ture doivent être les mêmes que celles de l’enregistrement.

Si tout marche bien avec le nouvel enregistrement, cela veut 
dire que le setup actuel est bon. Ensuite, vérifiez si quelque 
chose a changé dans le global setup. Est-ce que le frame rate a 
changé? Est-ce que la vitesse de la bande a changé? Si vous 
avez changez un réglage de 30ips, essayez les variations comme 
30drop ou 29,97.

Si l’audio et le Midi ne sont pas Synchronisés

Allez dans la page Audio dans la fenêtre de dialogue synchroni-
sation et ssous Audio Sync Mode, selectionnez MTC continuous ou 
MTC Trigger/ASD. 

Si votre hardware audio ne supporte pas ce mode d’opération, 
vous devriez réduire les parties qui sont longues en des 
morceaux plus petits.

Si le Midi et le SMPTE ne sont pas Synchronisés

Vérifiez tous les frame rates. Le frame rate de tous les périphéri-
ques doit être identique, ce qui inclut le timecode de la machine 
à bande, du synchroniseur, et dans Logic.

Certains synchroniseurs encodent le mauvais frame rate en 
MTC. Dans ce cas ouvrez le Tempo Editor, désactivez l’option 
Detect, et réglez le frame rate manuellement.

Note pour les Etats Unis: essayez les différentes sortes de 30ips 
(30drop, 29,97ips). 

En Europe, le nombre d’images par seconde est pratiquement 
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Song Settings et 
Préférences

Les Song Settings et les Preferences… peuvent être atteints 
par le menu File. Les deux fenêtres obtenues sont des boîtes de 
dialogue qui vous permet d’accéder à des sous-menus que l’in 
nomme alors des pages. Certaines de ces pages peuvent aussi 
être atteintes directement à partir des menus locaux de Logic 
(par exemple dans la fenêtre Score), ou des boutons de trans-
port, grâce aux menus.

Song Settings et Preferences sont les endroits où vous pouvez défi-
nir quelques paramètres fondamentaux des opérations de 
Logic. Cette section explique chacun des articles de menu de 
fenêtre individuellement. A part contre-indication, les descrip-
tions des diverses options sont celles qui s’appliquent lorsque 
la boîte de validation se trouvant à côté de l’option est cochée 
(en d’autres termes, lorsqu’elle est active).

17.1 Song Settings
Les Song Settings (ce qui serait traduit par «la configuration des 
songs». Mais pour être plus clair, nous garderons le terme 
anglais)sont sauvegardés indépendamment avec chaque Song, 
ce qui signifie que des Songs différentes peuvent avoir des 
réglages différents. Vous pouvez sauver tous vos réglages ordi-
naires dans  un modèle de song. De cette façon, vous pouvez 
commencer chaque séance de Logic avec vos réglages préférés.
17 - 1
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Pour atteindre les pages de la fenêtre de dialogue concernant 
les song settings, choisissez File > Song Settings à partir du menu 
principal.
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Options d’enregistrement 
Cette page peut être atteinte de diverses manières: par le 
raccourci clavier (Recording Options…), par le menu local dans la 
fenêtre Arrange (Options > Recording Options…), ou via Recor-
ding Options… dans le menu déroulant du bouton de métro-
nome, sur la barre de transport.

Ces réglages déterminent comment Logic répond dans le mode 
Record (Enregistrement). Si cette page est ouverte, vous pouvez 
cocher/décocher quelques unes des boîtes de validation par le 
clavier de l’ordinateur en utilisant les touches indiquées entre 
crochets après la fonction. Tandis que cette page est ouverte, 
tous les raccourcis clavier assignés normalement à ces touches 
sont temporairement désactivés.

Merge New Recording With Selected Sequences

Après chaque enregistrement, toutes les données nouvelle-
ment enregistrées sont fusionnées  avec toutes les séquences 
17 - 2
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choisies sur la piste enregistrée, pour former une séquence. En 
même temps, la fonction suivante est automatiquement activée 
(voir en dessous).
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Merge only New Sequences in Cycle Record (n)

Lorsque vous enregistrez avec le Mode Cycle activé, cette fonc-
tion fusionne toutes les données enregistrées pendant des 
cycles ultérieurs à la séquence enregistrée durant le premier 
cycle. Cette fonction peut être employée indépendamment de 
Merge New Recording With Selected Sequences.

Auto Mute in Cycle Record (m)

Si vous enregistrez avec le Mode Cycle activé, cette fonction 
crée une nouvelle séquence pour chaque cycle pendant laquel 
il y a une insertion de données. Toutes les séquences créées 
durant des cycles précédents sont automatiquement mutées. Si 
Auto Create Track dans la fonction Cycle Record (décrit plus bas) 
n’est pas active, toutes les séquences sont couchées sur une 
piste. Cette fonction désactive les deux fonctions de fusion.

Auto Create Tracks in Cycle Record

En enregistrant avec le mode Cycle activé, cette option crée une 
nouvelle piste chaque nouveau cycle,lorsqu’il y a une insertion 
de données.  Les séquences enregistrées lors cycles précédents 
sont poussées vers le bas, ainsi les pistes anciennes se retrou-
vent en dessous. Cette fonction désactive les deux fonctions de 
fusion. Cette fonction est utile lorsque, par exemple, vous 
faites des prises multiples d’un solo, en bouclant une section de 
musique. Les enregistrements faits pendant chaque répétition 
du cycle paraîtront sur leur piste propre, ce qui rend facile de 
les trier lorsque vous avez fini d’enregistrer.

Allow Tempo Change Recording

Tous les changements de tempo faits en mode record sont enre-
gistrés. Pour des détails sur la façon d’éditer enregistrements de 
tempo, voir le paragraphe «Tempo» à la page 15 - 1.

Data Reduction
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Les événements de contrôleur sont réduits pendant l’enregis-
trement, pour raccourcir le chargement des données sur le bus 
Midi pendant la lecture. Ceci améliore le timing des arrange-
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ments denses sur des interfaces avec peu des ports Midi. La 
fonction réduit réellement la durée des événements de contrô-
leur, en utilisant un algorithme intelligent qui retient la valeur 
à la fin d’une succession de données de contrôleur.

Click

Click in Record Mode (e)

Le click de métronome est automatiquement activé pour enre-
gistrer. C’est la même chose que l’activation du métronome 
dans la barre de transport pendant l’enregistrement.

Click in Play Mode (p)

Le click de métronome est automatiquement activé pour le 
playback. C’est la même chose que l’activation du métronome 
dans la barre de transport pendant le playback.

Polyphonic Clicks

L’objet de métronome Midi dans l’Environnement envoie 
toutes notes définies et activées pour les mesures, les temps et 
les divisions  (voir le paragraphe «Clic du Métronome Midi» à la 
page 5 - 44). Par exemple, au début de chaque mesure, deux ou 
trois notes peuvent être envoyées simultanément. Si la boîte de 
validation n’est pas cochée, alors le métronome transmet seule-
ment une note en même temps.

Speaker Click

Cela envoie le click de métronome au haut-parleur de l’ordina-
teur.

Midi Click

Le click de métronome est envoyé comme une note Midi.
17 - 4
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Count In

Ce menu déroulant est l’endroit où vous réglez le décompte qui 
précède l’enregistrement.
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Wait for Note Logic continue à faire une boucle 
symétrique d’une note, centrée 
autour du point de début de l’enre-
gistrement, jusqu’à ce que des 
événements Midi soient insérés. 
Etant donné que la boucle part 
d’une moitié de temps avant le point 
de départ, vous pouvez rajouter un 
temps qui ne devra pas être supé-
rieur à la moitié de la valeur du déno-
minateur de la mesure (par ex. avec 
des mesures en n/4, un maximum de 
1/8 de  note)..

No count-in l’enregistrement commence sans 
décompte.

1-4 Bar count-in décompte de 1 à 4 mesures.

Click only during Count In

Quand cette option est active, le click d’enregistrement sonne 
seulement pendant le décompte et est alors désactivé.

Midi Options
Cette page peut être atteinte de la fenêtre Arrange en sélec-
tionnant Options > Midi Options…. Ces réglages déterminent la 
façon dont se comportent les entrées et les sorties Midi.

Input Filter

Les commutateurs de filtre d’entrée servent à filtrer certains 
types d’événements à l’entrée du sequencer. Les symboles 
correspondent à ceux de l’Event List. Quand un commutateur 
est grisé,  il filtrera les événements correspondants.

Evénements de note
17 - 5
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Evénements de Program Changes

Evénement de Pitch Bend 
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Evénement de contrôleur 

Evénements d’Aftertouch 

Evénement de «pression de touche» polyphonique 

Evénement SysEx.

Sysex with Midi Thru function

Les messages de SysEx passent par l’ordinateur avec les autres 
données Midi thru. C’est particulièrement important Lorsque 
vous utilisez des programmeurs hardware pour pouvoir être  
capables de contrôler les changements de son en temps réel. Si 
vous voulez juste enregistrer des dumps de SysEx ne validez pas 
cette option. Il n’y a aucun sens à faire passer un Sysex par 
l’ordinateur si vous ne voulez pas l’enregistrer ou l’envoyer à 
une autre machine.

Instrument without Midi Thru Function
17 - 6
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L’instrument sélectionnait ici ne passera pas d’événements par 
l’ordinateur, quand l’instrument est choisi pour la   piste  choi-
sie. Normalement l’instrument ‹No Output› est choisi ici.
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Si votre clavier maître n’a pas de réglage ‹Local Off› vous 
pouvez utiliser cette fonction pour éviter des doublements de 
note pendant l’enregistrement.

• Avec des sources de son multitimbrales, sélectionner 
l’instrument qui joue la partie multitimbrale de votre clavier 
maître que vous entendez lorsque vous jouez alors que 
l’ordinateur est éteint.

• Avec des sources de son monophoniques, sélectionner 
l’instrument qui représente la partie générée par votre 
clavier maître.

Dans les deux cas, vous devez couper le volume de votre clavier 
maître lorsque vous enregistrez des pistes pour un autre instru-
ment.

Synchronisation

Transmit Midi Clock 

Logic transmet l’horloge Midi avec le pointeur de position de 
song. Pour plus de détails sur ces termes, voir le paragraphe 
«Recevoir l’horloge Midi et le SPP» à la page 16 - 14. La sortie 
Midi est sélectionnée à la droite de cette option (voir le 
prochain paragraphe).

Transmit MTC (Midi Time Code)

Le time code Midi est transmis lorsque ceci est activé.  Vous 
pouvez régler le port de la sortie Midi dans le champ de saisie à 
droite de cette option. Sélectionner le port en cliquant .

Source de synchronisation
Vous pouvez régler la source de synchronisation par le bouton 
de menu déroulant Sync dans la fenêtre de Transport:
17 - 7
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Internal Sync Logic se synchronise toujours à son 
horloge interne, même si un signal 
externe de synchro est disponible. 
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SMPTE Sync (MTC) Logic se synchronise au MTC (Midi 
Time Code). Rappelez vous que beau-
coup d’interfaces multi-port sont 
équipées avec des entrées et des 
sorties pour le code SMPTE, qui est 
converti en MTC.

Midi Clock Sync Logic se synchronise à l’horloge 
Midi et au SPP.

Rappelez vous que même si vous avez réglé une source de 
synchronisation externe, vous pouvez encore démarrer Logic 
par lui-même, dans ce cas il emploiera sa source d’horloge 
interne.

Midi Machine Control

Logic envoie des commandes de Midi Machine Control (mais 
n’y répond pas), donc il peut contrôler des fonctions de trans-
port de dispositifs externes. Si ces items ne sont pas cochés, les 
fonctions sont désactivées (voir page 16 - 15).

Initialisation des instruments

Send Used Midi Instrument Settings after loading 

Après qu’un song ait été chargée, tous les réglages d’instrument 
(tels que le numéro de programme, le volume et le panorami-
que) sont envoyés aux instruments employés dans le song (i.e. 
ceux qui sont joués par les séquences).

Send All Fader Values after loading 

Après qu’un song ait été chargé, tous les objets fader envoient 
des messages contenant leurs réglages. Cela vous permet 
d’initialiser, par exemple, une console de mixage contrôlable 
via Midi, si vous avez créé un groupe d’objets d’environnement 
qui contrôlent ses paramètres.
17 - 8
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Send All Fader Values after loading

Cette option s’applique aussi aux faders audios pour le volume, 
le panoramique, etc. Dès qu’un song est chargé, les valeurs 
courantes de fader sont automatiquement transmises. Cela 
signifie que vous pouvez jouer le song aussitôt après avoir char-
ger et dès que tous les réglages corrects sont faits.

Chase Events
Cette page est pour faire des réglages relatifs à la fonction Chase 
Events décrite page 2 - 23. Y. Vous pouvez également atteindre 
cette page à partir du menu local de la fenêtre Arrange en sélec-
tionnant Options > Chase Events….

Boutons de «type de message»
Ces commutateurs définissent quels types de messages la fonc-
tion Chase Events va rechercher. Ces symboles sont identiques à 
ceux trouvés dans l’éditeur d’Event List. Si un bouton est grisé, 
17 - 9
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il indique que le type de message correspondant ne sera pas 
recherché.
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Notes
Ce bouton n’affecte que les événements Note On et Note Off 
dans les séquences jouées des instruments dont l’option No Seq 
Trp (aucune transposition de séquence) est désactivée.

Chase sustained Notes

Cette option est utilisée pour chercher autour du point de 
départ de lecture courant toute note qui doit encore être jouée 
en raison d’une pédale de sustain appuyée.

Chase Notes in No Seq Trp Instruments

Cela signifie que mêmes les notes jouées avec des instruments 
possédant l’option No Seq Trp sont recherchés. Si ce sont des 
instruments déstinés à des boucles ou à des percussions, 
comme c’est habituellement le cas, cette option ne devrait pas 
être activée.

Program Change
Le dernier program change avant le point de départ de lecture 
actuel est envoyé. Gardez à l’esprit qu’un module de son pren-
dra habituellement un petit temps de réponse.

Pitch Bend Events
Les données de Pitch bend sont recherchées.

Controller Events
Si ce bouton est actif, vous pouvez activer/désactiver trois  grou-
pes de contrôleur individuellement:

Chase Control 0–15

Les numéros de contrôleur de 0 à 15 sont recherchés. Ceux-ci 
17 - 10
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incluent les contrôleurs suivant: modulation, breath, foot, 
volume, pan, portamento time, balance et expression, plus les 
MSB pour l’entrée d’édition et la sélection de banque.
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Chase Control 64–71

Les contrôleurs de 64 à 71 sont recherchés. Ceux-ci incluent le 
sustain, sostenuto, hold 2, soft pedal et portamento.

Chase all other Controls

Tous les autres numéros de contrôleur sont cherchés.

Aftertouch or Channel Pressure Events
Les données d’Aftertouch générées par le détecteur de pression 
sous le clavier sont recherchées.

Polyphonic Key Pressure Events
Les données d’Aftertouch Polyphonique, générées par des 
détecteurs de pression sous les touches individuelles sont 
recherchées.

System Exclusive Events
Les derniers messages SysEx dans les séquences avant le point 
d’entrée sont transmis. Si la séquence contient l’enregistre-
ment de données SysEx d’un fader,  l’état de celui-ci est 
restauré au point d’entrée.

Gardez à l’esprit que ces événements recherchés ne peuvent 
pas toujours restaurer pleinement l’état correct des données de 
SysEx au point d’entrée. Faire ceci n’impliquerait pas seule-
ment de chercher, mais aussi d’analyser  tous les messages de 
SysEx dans le song entier, avant et après le point d’entrée. A 
cause des structures de données de Sysex non-standardisées, 
c’est totalement impossible.

Même si les variations d’un paramètre sonore interne ont étés 
enregistrées par des Faders Sysex différents, il y aura des dévia-
tions dans le son. Il sera nettement plus sûr de piloter ce type 
17 - 11
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de Faders par un contrôleur et d’enregistrer celui ci. Comme la 
fonction Chase recherche et rétablit tous les contrôlleurs, la 
programmation par Sysex des générateurs sera correcte au point 
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d’entrée. Un autre avantage de cette méthode est de pouvoir 
par la suite éditer facilement ces contrôleurs dans l’Hyper 
Editor.

Chase sep. channels in ‘All Cha’ instruments

Cette option concerne les instruments dont le paramètre Cha 
est réglé sur All (c’est à dire que les événements y sont joués 
selon leur canal d’origine). Tous les types d’événements 
concernés par la fonction Chase sont alors recherchés séparem-
ment pour chaque canal Midi.

Chase on Cycle Jump

Permet d’actionner la fonction Chase event lors du rebouclage de 
cycle.

Send Midi Reset before Chasing

Un reset Midi est envoyé avant que la recherche ne commence, 
en conformité avec les réglages actuels dans les Préférences 
(voir le paragraphe «Reset Messages» à la page 17 - 18).

17.2 Préférences

. Ouvrir les Préférences
La fenêtre Préférences peut être atteinte à partir du menu prin-
cipal en sélectionnant File > Preferences… .

Bien que les réglages que vous faites dans les Préférences 
concernent la façon dont Logic traite tous les songs qu’il ouvre, 
vous devez ouvrir un song avant de pouvoir modifier les Préfé-
rences. Vous ne pouvez pas ouvrir le fichier ‹LA Pro ISIS.PRF› 
directement.
17 - 12
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Préférences

Initialisation des Préférences...
Si vous effacez le fichier ‹LA Pro ISIS.PRF› dans votre dossier 
Windows de votre PC, Logic créera un nouveau fichier de 
Préférences la prochaine fois que vous le lancerez. Tous les 
paramètres seront alors réinitialisés à leurs valeurs par défaut.

Lorsque vous effacez le fichier Préférences, vous perdez aussi 
toutes les raccourcis clavier que vous avez défini.

Global
Cette page contient les pré-réglages globaux.

Add ‘Last Edit Function’ to sequence name

Après avoir exécuté toute opération de modification (par exem-
ple couper), la description de l’opération de modification est 
ajoutée au nom de l’objet d’arrangement (ou des objets résul-
17 - 13
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tants).
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Disable safety alert for Undo

Cela ne signifie qu’aucune alerte de sécurité ne paraît lorsque 
vous utilisez la fonction undo.

Enable Catch when Sequencer starts

Chaque fois vous démarrez le sequenceur (start ou pause), la 
fonction Catch est automatiquement activée, dans toutes les 
fenêtres (voir page 1 - 20). 

Enable Catch when Sequencer starts

Cette option signifie que dès que vous déplacez le pointeur de 
position, la fonction Catch est activée.

Limit Dragging to one direction in Matrix and Score

Dans le Matrix Editor ou le Score Editor, vous pouvez seulement 
déplacer les notes dans une direction par opération. Cela signi-
fie qu’une note peut être soit transposée, soit déplacée dans le 
temps, mais pas les deuxà la fois. Cela empêche la modification 
accidentelle du second paramètre.

Limit dragging to one direction in Arrange

Cela limite la direction dans laquelle vous pouvez déplacer des 
séquences et des dossiers dans l’Arrange, d’une façon similaire, 
et pour les mêmes raisons, que l’option précédente.

‘Export Midi File…’ saves single Sequences as Format 0

Si seulement une séquence est sélectionnée lorsque vous choi-
sissez File > Export Midi File… le contenu de la séquence est 
sauvegardé en format 0 de fichier Midi. Ce format de fichier est 
garanti compatible avec tous les lecteurs de fichiers Midi (voir 
page 18 - 5).
17 - 14
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Allow Content Catch by Position if Catch and Link enabled

Si les fonctions Catch et content Catch (saisie du contenu) sont 
actives, le contenu de la séquence à la position actuelle de song 
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est ce qui est montré. Si la boîte n’est pas cochée, la vue de 
fenêtre continue à suivre la position de Song de la séquence affi-
chée, mais ne se met pas à jour pour montrer le contenu des 
séquences subséquentes lorsqu’elles deviennent la séquence 
courante (voir page 1 - 21).

Display
Cette page contient les diverses options d’affichage.

Wide Song Position Line

Une ligne plus épaisse pour le pointeur de position est utilisée.

Display Middle C as C3 (Yamaha)

Cette option concerne la description de notes dans les éditeurs. 
Le Do du bas dans un clavier à 5 octaves (note # 36) est étiqueté 
C1 et le Do central (#60 ou cï) est étiqueté C3. Selon cette 
norme, la note Midi (# 0) la plus basse est  appelée C-2. C’est la 
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norme officielle qui est employée par la plupart des fabricants.
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Si cette option n’est pas activée, le Do du bas dans un clavier à 
5 octaves est étiqueté C2 et le Do central étiqueté C4. En utili-
sant ce standard, la note Midi la plus basse est C-1.

Allow ‘All Objects’ Layer Option in Environment

Un calque, montrant tous les objets dans votre Environnement, 
est disponibleà partir du bouton Layer dans l’Environment. Si 
cette option n’est pas activée, le calque ‹All Objects› n’est pas 
disponible.

Sort Instrument Menu by Layers

Les instruments dans le menu déroulant de sélection d’instru-
ment sont triés par calque.

Sort Instrument menu by Icons

Les instruments dans le menu déroulant de sélection d’instru-
ment sont triés en fonction du nombre interne d’indexage des 
icônes.

High Resolution Background

Dans les fenêtres Arrange et Matrix, un modèle d’arrière plan 
Emagic est employé (si la résolution d’écran le  permet). Avec 
les ordinateurs plus lents, le taux de rafraîchissement de l’écran 
peut être légèrement plus lent. Si il n’y a pas de croix dans la 
boîte, un arrière-plan gris ordinaire est utilisé. Aucun arrière-
plan n’est visible si vous avez choisi un arrière-plan blanc dans 
le menu View.
17 - 16
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Score
Cette page des Préférences peut également être atteinte par le 
menu local de la fenêtre Score en sélectionnant Options > Score 
Preferences.

Dashed Song Position Line

Le pointeur de position du Score Editor est affiché en pointillés. 
Si cette option n’est pas activée, la ligne du pointeur est conti-
nue

Do not show Stave selection

Toutes les portées sont toujours noires. Si cette option n’est pas 
activée, les portées sélectionnées seront noires, et toutes les 
autres seront grises.

Fast (Lower Resolution) Curves on Screen

Le taux de rafraîchissement de l’écran est accéléré en utilisant 
17 - 17
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un affichage légèrement plus mince des barres et des liaisons.
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Reset Messages
C’est là où vous définissez quels contrôleurs sont envoyés 
comme message de reset .

Quand est-ce que sont transmis les messages de 
Reset?
Un Reset Midi est transmit lorsque:

• le sequenceur est stoppé en appuyant rapidement deux fois 
de suite sur stop 

• vous cliquez sur l’affichage Midi Out dans la fenêtre transport;
• vous utilisez le raccourci clavier «Full Panic» ;
• ou automatiquement lorsqu’un nouveau Song est ouvert ou 

activé (sans se soucier des réglages de la fonction Chase, voir 
paragraphe «Send Midi Reset before Chasing» à la page 17 - 
12).

Smart Reset
17 - 18
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Le reset a été optimisé pour une utilisation avec les contrôleurs 
suivants, pour minimiser une congestion de données aux sauts 
de cycle, ou bien lorsque le sequenceur est arrêté:
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1. Pitch Bend

2. Pression de canal

3. Molette de Modulation (Contrôle 1)

4. Pédale Sustain (Contrôle 64)

Logic manie ces messages isolément pour chaque instrument, 
et chaque canal Midi. Aussitôt que Logic est stoppé, ou que 
leur position est altérée, les messages ci-dessus seront transmis 
aux instruments correspondants, et non aux autres.

& Par exemple; si un instrument en particulier n’a reçu aucune donnée de pitch bend,  
alors aucun reset de donnée de pitch bend ne sera envoyé à cet instrument. Encore 
mieux: si l’instrument a reçu des données de pitch bend, mais que le dernier événe-
ment de pitch bend s’est terminé par une valeur de 0, aucun reset de pitch bend ne 
sera envoyé non plus. Toutes ces aides coupent les données Midi inutiles qui se trou-
vent autour de votre système.

& Pour les utilisateurs expérimentés:
Généralement, la fonction de ‹Smart reset› améliore le timing de votre système 
considérablement. Il y a quelques exceptions à cette règle, cependant, qui feront 
baisser la vitesse si un ou plusieurs des messages Midi susnommés sont attribués à 
des emplois extraordinaires

Par exemple, si vous automatisez une console de mixage, et attribuez le contrôleur 
Midi n°64 au gain de l’EQ, Smart Reset pourrait être une mauvaise idée, car chaque 
fois que vous arrêtez le sequenceur, le gain de l’EQ sera réduit à 0.

Il y a deux solutions possibles à ce problème:
• Vous pourriez éviter d’utiliser les contrôleurs Midi Smart Reset pour des applica-
tions Midi extraordinaires. Il y a assez de contrôleurs entre n°1 et le n°64 pour 
pouvoir en utiliser un autre pour éviter des conflits, dans la plupart des cas, à 
n’importe quelle vitesse.
• L’autre alternative est de désactiver les messages de reset de certains instruments. 
Ceci peut être fait en activant le paramètre No reset dans la boîte de paramètre 
d’instrument de n’importe quel instrument standard, d’un instrument mappé ou 
d’un sous canal d’un Multi-instrument.

Les resets sont seulement transmis aux instruments employés 
dans la fenêtre Arrange. Si vous voulez employer le Smart 
17 - 19
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Reset sur les autres objets de l’Environment (par exemple un 
fader), vous devrez insérer un instrument dans le flot de 
données: 
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1. Créez un instrument ordinaire, et activez l’option No Reset.
Reliez la sortie de l’instrument à l’objet de l’Environne-
ment que vous désirez utiliser.

1. 2. Sélectionnez l’instrument nouvellement créé comme 
instrument de piste.

Send Used Instrument Settings On Reset

Lorsque cette option est activée, tous les paramètres des instru-
ments actuellement employés seront transmis, même si un 
Reset Midi survient.

Audio

Warning before closing Sample Edit
17 - 20
Emagic
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Si vous avez exécuté un ordre de modification destructif dans le 
Sample Editor, par exemple Normalize ou bien Fade Out,il vous 
sera demandé si vous désirez annuler cette modification lors-
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que vous fermerez la fenêtre.  Bien sûr, une fois que vous avez 
l’habitude de travailler dans cette fenêtre, vous pouvez trouver 
cette boîte irritante, c’est à ce moment là que vous pourrez la 
désactiver.

Warning before process Function in Sample Edit (Key)

Avant que vous exécutiez une modification destructive dans le 
Sample Editor en utilisant un raccourci clavier, un avertissement 
paraît pour vous donner l’occasion d’annuler, avant de modifier 
les données.

Vous pouvez définir des raccourcis clavier pour tous les ordres 
de modification destructifs dans Logic, qui seront alors valables 
seulement si la fenêtre de Sample Edit est active (la barre de 
titre étant active). En fonction des commandes et des 
combinaisons de fenêtre que vous utilisez, il y a des risques à 
exécuter des ordres de modification accidentellement. Ainsi, 
Logic est paramétré afin qu’une boîte d’alerte apparaîsse en 
premier. Si vous êtes sûrs que vous ne traiterez pas 
accidentellement un dossier, vous pouvez désactiver le 
message d’alerte ici.

Warning before process Function in Sample Edit (Menu)

Cette option est presque identique à la précédente, la seule 
différence étant que l’avertissement paraît même si vous utili-
sez un menu pour exécuter un ordre destructif dans la fenêtre 
Sample Editor.

Une fois que vous êtes plus expérimenté, vous n’avez plus 
besoin de cette boîte d’alerte lorsque vous appelez une 
commande d’édition via un menu, vous pouvez donc la désac-
tiver.

Ask for complete Backup…

C’est là où vous pouvez désactiver la boîte d’alerte dans le 
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Sample Editor qui vous demande si vous voulez faire une copie 
de sécurité du dossier audio avant de modifier de façon destruc-
tive un échantillon.
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Display Color in Audio Window

Si les régions acoustiques dans la fenêtre Arrange sont colorées 
très brillamment, il peut parfois être difficile de faire l’affichage 
des formes d’onde dans la fenêtre Audio. Vous pouvez donc 
retourner à un affichage en noir et blanc grâce à cette option.

New Style Audio Objects

Choisissez File > Preferences… > Audio et vous pourrez utiliser 
l’option New Style Audio Objects se trouvant sous ‹Display›,pour 
activer ou désactiver la nouvelle apparence d’objet (à partir de 
la version 3.0).

Create Undo file for «Normalize»

Sauvegarder les fichiers ‹Undo› des données de modification 
destructive de données audio peut prendre beaucoup de temps 
et de mémoire, dépendant de la longueur des données audios. 
Normalize est généralement une sécurité, et habituellement un 
type bénéfique d’édition de données.Désactivez cette fonction 
si vous désirez retirer la fonction Undo pour Normalize.

Quick Record without prepare of Play Tracks

Normalement, au début d’un enregistrement ou d’une lecture, 
tous les dossiers audios se trouvant à la position du song sont 
préparés pour la lecture. En fonction du nombre de pistes, et du 
type de système, cela peut prendre d’une fraction de seconde à 
plus d’une seconde. Dans certaines situations, vous pourrez 
préférer éviter cette préparation de toutes les pistes pour la lec-
ture, afin de vous permettre de commencer à enregistrer aussi-
tôt. Dans un tel cas, vous devrez activer cette option. L’enregis-
trement (et la lecture) peut commencer alors bien avant, bien 
que les pistes acoustiques ne commenceront pas à jouer avant 
quelques secondes. 

Release Audio in Background if Stopped
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Lorsque vous activez cette option, Logic libère les équipe-
ments audios dès que la lecture s’arrête. Cela vous permet de 
passer à un autre programme, comme un Editeur d’échantillon,  



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Préférences

qui requiert aussi l’emploi des hardwares audio, sans devoir 
quitter Logic avant tout.

Audio Drivers 

Les boîtes de validation se trouvant sur la gauche sont 
employées pour activer/désactiver les drivers audio.

Rappelez-vous que toute modification effectuée ne sera pas 
valable tant que vous n’aurez pas redémarrez Logic.

NOTE: Si vous désactivez tous les drivers, vous pouvez effec-
tivement utiliser Logic en une application Midi qui peut fonc-
tionner sur des ordinateurs ayant peu de RAM.

PC AV
Référez-vous également à Audio Driver.

Force Half Duplex Mode

Lorsque vous activez cette option, il devient impossible 
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d’enregistrer et de lire de l’audio en même temps, vous pouvez 
donc seulement faire l’un ou l’autre.
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Cette option est utile si votre driver audio n’est pas capable 
d’enregistrer en 16 Bits en mode full duplex.

Record Driver

C’est là que vous choisissez le driver pour l’enregistrement 
audio. La sélection inclut tous les drivers qui ont été installés 
dans le système d’exploitation. Si votre hardware a plus de 2 
entrées, et est adressé par des drivers stéréos multiples, sélec-
tionnez la première paire d’entrées, et Logic la détectera auto-
matiquement, et utilisera le reste des drivers. Mettez une croix 
dans la boîte étiquetée ‹Multi Channel›.

Playback Driver

C’est là où vous choisissez le driver pour le playback. La sélec-
tion inclut tous les drivers installés dans le système d’exploita-
tion. Si votre équipement a plus de 2 sorties, et est adressé par 
des drivers stéréos multiples, sélectionnez la première paire de 
sorties, et Logic la détectera automatiquement. Mettez une 
croix dans la boîte étiquetée ‹Multi Channel›.

Playback Driver Delay, Record Driver Delay

Les paramètres Playback Driver Delay et Record Driver Delay per-
mettent de retarder l’enregistrement et la lecture de toutes les 
pistes audio par rapport aux pistes Midi. Comme d’habitude, 
vous pouvez aussi régler des temps de Delay négatifs pour 
avancer les sorties audio dans le temps. Les valeurs négatives 
peuvent être employées pour compenser les retards dans la 
plupart des drivers audio, et donc le Midi et l’Audio peuvent 
être joués simultanément.

Si Logic reconnaît votre hardware AV, il pré-réglera une valeur 
qui est calculée pour le retard dans le driver audio. Cependant, 
étant donné qu’il y a beaucoup de facteurs qui peuvent influen-
cer le timing de votre système, vous pouvez aussi ajuster ce 
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Ajuster le Record Driver Delay
• Enregistrer le son du Métronome Midi sur une piste audio.

• Vérifier la position des pics dans le Sample Editor. Vous devez 
afficher l’axe en unités musicales (View > Bars/Beats…).

• Pour mesurer le retard, sélectionner les données entre une 
pulsation et un pic. Si les pics sont trop loin à gauche, vous 
devez augmenter le paramètre Delay; s’ils sont trop loin à 
droite, diminuez le.

Répéter ce procédé jusqu’à ce que les pics soient exactement 
sur les pulsations.

& Note technique: si vous essayez de supprimer le retard de la transmission Midi et, 
plus important, les temps de réaction des modules de son, vous  pouvez enregistrer 
directement le signal Midi: relier la brocheMidi 2 qui est reliée à la masse et la broche 
Midi 4 reliée au signal input.

Ajuster le Playback Driver Delay
• Faitent jouez le click audio enregistré avec le click Midi.

• Ajustez le Playback Driver Delay jusqu’à ce que le retard et le 
flanging deviennent minimes (l’effet de filtre combiné attei-
gne sa fréquence maximale).

& Une autre façon est d’enregistrer deux signaux ensemble, et de les comparer dans le 
Sample Editor.

Maintenant, il devrait seulement y avoir un retard minime 
entre le Midi et l’audio.  

De petits décalages (‹Jitter›) de peu de millisecondes peuvent 
des fois survenir pour diverses raisons mais cela ne peut pas être 
évité.
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Transfert de fichiers

18.1 Songs de Logic sur d’Autres 
plateformes

Logic est actuellement disponible sur les ordinateurs suivants:

• PC-compatible fonctionnant sous Windows 95/98
• Apple Macintosh (processeurs 68040)
• Apple Power Macintosh (PowerPC et processeurs G3)
• Atari ST, TT et Falcon

Quelque soit la plateforme, tous les fichiers de Song sont 
compatibles. Assurez vous que vou utilisez la version du 
programme la plus récente (voir paragraphe «Différentes 
versions de programme» à la page 18 - 2). Les Songs créés dans 
la version 3.5 ou ultérieure ne pourront être ouvert par les 
versions précédentes, en raison des mises à jours et des modifi-
cations en objets Audio stéréo.

Formats des disquettes
Avant d’échanger des fichiers Song entre différentes platefor-
mes, vous devez choisir un format de disque qui peut être lu par 
les deux. Le format MS-DOS est compatible avec toutes les 
platesformes sitées ci dessus.

Un Macinosh doit fonctionner en système MacOS 7.5 (ou ulté-
rieur) de manière à être capable de lire le format M-S Dos. De 
plus, un des panneaux de contrôle suivants doit être installé: 
‹PC Exchange›, ‹AccessPC›, ou encore l’extension système 
‹DOS Mounter›.
18 - 1
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Transfert
Le transfert lui-même est extrêmement simple:

• Formatter une disquette au format MS-Dos,
• Sauvegardez le Song sur cette disquette à partir de l’ordina-

teur source, et
• Chargez le Song de la diquette dans l’ordinateur de destina-

tion.

Caractéristiques spéciales de l’Atari ST
Lorsque vous transférez vers (ou bien à partir) d’un Atari, utili-
sez des disquettes double densité (DD), l’Atari ne sait pas lire 
les disquettes HD. 

Caractéristiques spéciales du Macintosh
Lorsque vous transférez des fichiers à partir d’un Mac vers 
d’autres plates-formes, assurez vous que les noms de fichiers 
correspondent aux conventions du DOS (pas plus de 8 caractè-
res). Lorsque vous transférez vers un PC, ajoutez l’extension 
‹.LSO› LSO au nom du fichier Song. Lorsque vous transférez 
vers Atari ajoutez ‹.LOG› à la fin du nom du fichier.

Différentes versions de programme
Lorsque vous transférez des fichiers Song  entre deux versions 
différentes de Logic, les règles sont les suivantes:

Les nouvelles versions peuvent lire sans problèmes les fichiers 
créés par les anciennes versions.

Une ancienne version peut lire les fichiers créés sur une plus 
récente version à condition que le format d’enregistrement des 
données n’a pas changé entre les deux versions. Ceci n’est pas 
garanti dans tous les cas, en raison des évolutions constantes de 
18 - 2
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Version 3.5

Pour des raisons techniques la version 3.5 utilise un format de 
Song différent des versions plus anciennes. les Songs créés par la 
version 3.5, ne peuvent pas être utilisés dans les versions anté-
rieures. 

Les Song des versions plus anciennes seront automatiquement 
convertis lorsque vous chargerez la version 3.5. Sur la première 
commande de sauvegarde, « Save as... », un dailogue apparaît 
vous permettant de convertir le Song sous un nom différent. De 
cette façon, la version originale du Song en 3.5 reste inchangée. 

Version 2.5

Si vous avez créés un Song en 2.0, qui contient des commuta-
teurs de câbles dans l’Environnement, vous devrez vous assu-
rez que ces commutateurs soit changés en Faders d’événe-
ments Méta dans la version 2.5. Ce problème est résolu…

• en sélectionnant de tous les interrupteurs de câble dans 
l’Environnement,

• en leur donnant la valeur 48 comme définition de sortie 
dessous -1 (le numéro de canal est sans rapport).

• et en Vérifiant enfin que cette modification a bien résolu le 
problème en faisant apparaître de nouveau les commuta-
teurs configurés en Auto Style comme commutateurs dans 
l’affichage.

18.2 Fichiers d’Autres 
Programmes

Pour vous aider à transférer sur Logic des séquences écrites sur 
d’autres programmes et vous permettre d’utiliser vos anciens 
Songs, Logic est capable de lire les données d’autres program-
mes.
18 - 3
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Sélectionnez File > Open. une boîte de sélection de fichier appa-
raîtera, et vous pourrez alors choisir (en haut de ‹File Type›) le 
type de Song que vous désirez importer.

Songs MicroLogic
Les fichiers MicroLogic utilisent le même type de format de 
fichier que Logic. Ils peuvent être chargés comme n’importe 
quel type de fichier Logic.

Songs Notator SL 
Avant d’importer des Songs écrits sur Notator, il convient de 
faire la préparation suivante dans notator SL:

• Certains paramètres de lecture du SL (tels que les Mutes) ne 
sont pas reconnus par Logic. Supprimez toutes les séquen-
ces dont vous n’avez pas besoin.

• Logic ne peut pas lire directement les événements tempo du 
notator SL. Si votre Song contient des informations de chan-
gements de tempo, créé d’abord une référence synchro dans 
la fenêtre SMPTE du Notator SL.

Vous trouverez plus d’informations à ce sujet dans le manuel du 
Notator SL.

Transfert
• Formattez une disquette DD au format Ms-Dos.
• Sauvegardez le Song, ainsi préparé sous Notator SL, sur la 

disquette.

Chargez le Song dans Logic avec File>Open. Dans le sélecteur 
de fichiers, installez le volume contenant le Song Notator. Dans 
le paramètre ‹Files of Type›, sélectionnez‹Notator SL Songs›.

Suivant la structure du song importé, Logic doit parfois réorga-
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niser la structure de données et commencer le chargement par 
une réinitialisation complète. C’est tout à fait normal et ça 
permet d’éviter un gaspillage des ressources mémoire.
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Lorsque le song notator SL est chargé, il est créé comme un 
nouveau song Logic. Les niveaux d’arrangement de ‹a› à ‹d› 
sont convertis en dossiers sur quatre pistes. Chaque dossier 
représente un «pattern» de 16 pistes. L’ordre des dossiers 
correspond à l’ordre des patterns dans l’Arrange List.

Les ports Atari A, E, F, G/B, H/C, I/D sont assignés aux drivers 
MME (dans l’ordreou ils apparaissent dans la liste de sélec-
tion).

18.3 Fichiers Midi
Les fichiers Midi ne sont pas spécifiques à un séquenceur ou un 
ordinateur donné. Ils contiennent des informations suivantes:

• Les événements Midi avec leur position temporelle est leur 
assignation de canal,

• Noms de pistes individuelles,
• Noms et positions des marqueurs,
• Changements de tempo,
• Notifications de Copyright.

Logic supporte les fichiers Midi de format 0 et 1:

• Le format 0 ne peut contenir qu’une piste,
• Le format 1 peut contenir plusieurs pistes.

Aucun de ces formats ne gère la structure interne d’une piste 
(par exemple organisation en séquences).

Chargement des fichiers Midi
Pour charger un fichier Midi, utilisez la fonction File > Open. 
Dans le sélecteur de fichier, choisissez Midi File dans la boîte 
‹Files of Type›.

Si un song est déjà en mémoire, Logic vous demandera si vous 
18 - 5
Manuel de l’utilisateur 
Version 3.5 –Français– 

B

C

désirez créer un nouvel environnement, ou bien appliquer 
celui qui est en cours: ‹Create new environment or copy 
current envi-ronment for Midi File? New/Copy›. Si vous 
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cliquez sur Copy, l’environnement en mémoire est copié pour 
le nouveau song. Les pistes du fichier Midi sont automatique-
ment assignées aux instruments adaptés.

Si aucun song n’est en mémoire, ou bien si vous avez répondu 
New, à la question précédente, l’environnement par défaut 
pour les nouveaux songs est utilisé.

Copyright

La notification de copyright est lue comme une notification de 
texte.

Sélection de banque

Lorsque vous ouvrez des fichiers Midi standards, les événe-
ments program changes et controllers apparaissant à la même posi-
tion sont déplacés d’un pas d’holroge; ils restent ainsi dans 
l’ordre qui leur est donné. Ceci permet à Logic de prévenir tout 
inversement dans l’ordre de transmission des événements. La 
raison est que certaines machines Midi ne répondent pas 
correctement aux événements program changes et Bank Select qui 
ont alors lieu dans un ordre différent.

Ceci garanti qu’il n’y aura pas de problèmes, car la transmission 
d’un événement Midi est toujours plus longue qu’un pas 
d’horloge.

Sauvegarde des fichiers Midi standards
Si vous désirez jouer un Song de Logic par un autre séquenceur, 
vous pouvez le sauvegarder dans un fichier Midi Standard. 
Consultez le manuel d’instruction du séquenceur pour voir 
quel format de fichier standard Midi peut être lu. Tous les 
séquenceur sont capable de lire un fichier de format 0.

Préparation du Song
18 - 6
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standard, vous devrez faire les préparations suivantes pour 
votre Song logic:
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• Neutralisez les paramètres de lecture avec la fonction (sélec-
tionnez les en utilisant les touches ça, puis choisissez 
Functions > Sequence/Instrument Parameters > Normalize 
Sequence Parameters), 

• Fixez toutes les quantifications (ça, Functions > 
Sequence/Instrument Parameters > Fix Quantize,

• Convertissez tous les Alias en copies réelles (ça, Struc-
ture > Alias > Turn to Real Copy,

• Convertissez toutes les boucles en copies réelles (ça, 
Functions > 
Sequence/Instrument Parameters > Turn Loops to Real 
Copies),

• Convertissez toutes les séquences de chaque piste en une 
séquence unique (ça, Structure > Merge > Objects per 
Tracks.

Répondez à la question ‹Convert multiple Event Midi Chan-
nels to Instrument Midi Channel? No/Convert› en utilisant 
R ou bien en cliquant sur Convert.

Préparations supplémentaires pour le format de fichier 0

Puisque une seule séquence ne paut être enregistrée à la fois 
dans le format 0, vous devez fusionner toutes les pistes en une 
seule et grosse séquence (ça, Structure > Merge > Objects).

Sauvegarde d’un Song en fichier Midi standard
Sélectionnez toutes les séquences concernées et utilisez la 
fonction File > Export Midi File…. Vous pouvez alors indiquer le 
répertoire de destination.

Au format 0

Verifiez si Export Midi File… > Save single Sequences as File 

Format 0 check box (File > Preferences…> Global) est activé. Si 
c’est le cas, le fait d’activer File > Export Midi File… lorsqu’une 
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seule séquence est sélectionnée produira automatiquement un 
fichier au format 0.
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Adaptive mixer

Ce mixeur se configure automatiquement lui-même afin de 
pouvoir afficher à l’ecran toutes les pistes audio et Midi, dans 
l’ordre ou elles apparaissent dans la fenêtre Arrange ou dans un 
répertoire ouvert. Si vous déplacez les contrôles sur l’Adaptive 
Mixer durant un enregistrement, la donnée d’Automation est 
mémorisée dans les pistes concernées sous la forme de contrô-
leurs Midi normaux.

ADAT

Abréviation pour Alesis Digital Audio Tape. un ADAT 
(supporté par Alesis, Studer et Fostex) est enregistreur de 
cassette multi-piste numérique avec huit pistes audios en utili-
sant une cassette vidéo S-VHS. avec un quantization de 16 ou 
20 bit. Le port optique permet la transmission parallèle des huit 
canaux audio.

Aftertouch

Egalement connu sous le nom de pression. Les données de 
Type Midi générées par pression sur les touches après qu’elles 
aient été jouées.Il en existe deux types: Channel aftertouch, 
pour lequel la valeur est mesurée par un détecteur de stret-
ching sur la totalité du clavier et dont les données couvrent 
l’ensemble des canaux Midi, et le Polyphonic Aftertouch  (bien 
plus rare) qui est mesuré et transmit individuellement pour 
chaque touche.

AIFF
Gl - 1
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Abréviation pour Audio Interchange File Format. C’est un format 
de données pour les fichiers audio dans le système d’exploita-
tion du Macintosh.



Alias

C’est le double d’un objet qui ne contient aucune donnée en 
lui même, il n’est qu’une représentation de l’objet original. Un 
alias est l’équivalent d’un raccouci (Shortcut) dans windows.

Autodrop, Auto Punch

C’est un enregistrement Punch In automatique avec les posi-
tions de Drop-In et de Drop-Out ajustables.

Bar

 Mesure

Barre de défilement et pointeur de position

C’est la barre grise se trouvant au sommet de la fenêtre avec un 
curseur permettant d’ajuster la sélection d’uns song  affichée 
dans la fenêtre.

BBS

Abréviation pour Bulletin Board System. C’est une boîte de 
message électronique.

Boîte de Dialogue

C’est une fenêtre qui contient une requête ou un message. Elle 
peut être annulée ou repliée avant qu’elle ne disparaisse et 
qu’elle vous permette de continuer vos manipulations. 

Boîte de paramètre

champ se trouvant sur le côté gauche de l’écran ou vous pouvez 
ajuster les paramètres de l’objet sélectionné.

Câble

Un câble virtuel représente la connexion Midi entre deux 
objets de l’environnement.
Gl - 2
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C’est une fonction qui permet à la section du song actuellement 
affichée dans la fenêtre de refléter la position courante de le 
song.

Cha

Abréviation pour canal ou bien pour canal Midi

Check box (boîte de validation)

C’est un petite boîte dans laquelle on place le symbole de vali-
dation (Check) en cliquant dessus pour activer une option.

Classe de la fenêtre

C’est le statut de la fenêtre qui peut être une fenêtre flottante 
ou bien une fenêtre normale.

Click

Rapport au métronome, ou bien au son de ce dernier.

Clock, ou horloge

C’est l’impulsion de synchronisation transmise tous les 1/96 de 
note. Elle était utilisée dans les anciennes boîtes à rythme 
avant l’invention du Midi (c’est à dire avant l’utilisation de 
l’horloge Midi).

Coller

permet de coller le contenu de votre presse-papiers (c’est à dire 
ce que vous avez copié grâce à la commande çc ou encore 
couper grâce à la commande çx) par le raccourci-clavier 
çv à la position du curseur, ou au pointeur de position.

Control Change

C’est une information Midi provenant d’un contrôleur Midi tel 
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que les curseurs, les pédales, les boutons ou encore les paramè-
tres standard comme le volume et le panoramique. Le type de 



commande est codé dans le premier octet, et la valeur dans le 
second.

Colonne de piste (Track column)

Située sur la gauche de la zone de travail de la fenêtre Arrange, 
elle affiche les instruments assignés aux diverses pistes.

Count-in

Pulsations qui apparaissent  avant le début de l’enregistrement.

C-press

Signifie «Channel pressure» ou en d’autres termes aftertouch.

Cueing

C’est effectuer une écoute durant une avance rapide ou bien 
durant un retour rapide.

Cycle

C’est une fonction qui permet de répéter constament le 
passage se trouvant entre les locators. 

Défaut (valeur par défaut)

Valeur de paramètre pré-sélectionnée.

Delay

Dans la fenêtre Environment, c’est un objet qui peut créer une 
série de répétitions. Dans le fenêtre Arrange, c’est un paramè-
tre de lecture qui peut effectuer un delay de la piste sélection-
née en donnant un nombre en millisecondes.

DIMM

Abréviation pour Double Inline Memory Module. C’est donc un 
genre de mémoire.
Gl - 4
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Drag & drop

Action de saisir des objets avec la souris, les déplacer et ensuite 
les relacher à l’emplacement désiré.

Driver

Dans logic, c’est un support spécialisé pour l’hardware audio. 
C’est donc la section de Logic qui vous permet d’adresser et 
d’utiliser cet hardware.

Drop (Drop-In, Drop-Out)

Permet d’activer ou de désactiver l’enregisrement pour enre-
gistrer par dessus une section d’un enregistrement déjà exis-
tant.

Edit (menu Edit)

Menu local avec les fonctions d’edition.

Editeur

Fenêtre mettant à disposition les outils d’édition des évene-
ments Midi.

EQ

Fonction utilisée pour augmenter ou abaisser les fréquences 
dans un spectre sonore. Il y en a de nombreux types disponibles 
dans Logic.

Evénement meta

C’est un type d’événement dans la liste d’événement. Il 
contient les événements non Midi qui peuvent contrôler des 
caractéristiques spéciales de Logic, telles que les configurations 
du texte ou du réglage de l’écran.

Evénement Midi
Gl - 5
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C’est une commande Midi individuelle, telle qu’une note. Les 
mouvements de contrôleurs continus (c’est à dire la molette de 



modulation) produisent une rapide succession d’événements 
individuels de valeurs absolues.

Envois (send)

Abréviation pour les envois auxiliaires (utilisés pour les effets 
ou bien les écoutes).

Définition des évenements

Paramètre permettant de définir l’affichage d’une ligne dans le 
Hyper Editor. 

Fichier

Dans Logic, les deux types de fichiers les plus importants 
sont...

1. Les fichiers song qui contiennent tous les événements Midi 
et les réglages des paramètres d’un song (incluant les données 
d’automation du mixer) avec en plus les informations à propos 
des fichiers audio qui sont utilisés.

2. Les fichiers audio contenant les enregistrements de guitare, 
de voix, etc. (qui ne sont pas mémorisés dans les fichiers song).

Flottante (fenêtre)

Fenêtre possédant la particularité de se trouver toujours en 
dessus des autres fenêtres, mais ne pouvant être utilisée que 
grâce à la souris.

Folder (dossier)

C’est «un song dans un song». Il peut contenir soit un arrange-
ment complet, soit seulement une partie d’arrangement: des 
séquences ou d’autres folders.

Format d’affichage
Gl - 6
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C’est la valeur d’une note ajustable pour la grille utilisée dans 
les affichages et les utilisations. Le troisième chiffre est la posi-
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Frame (image)

C’est une unité de temps. Une seconde pour le standard 
SMPTE est divisée en frames, correspondant aux images dans 
un film ou une vidéo.

GM (General Midi)

C’est un standard pours les modules de son Midi, incluant des 
sons d’instruments standard sur les 128 numéros de 
programme, une assignation de touche standard pour les sons 
de percussion sur le canal Midi 10, un multi-timbre sur 16 
parties et une polyphonie de 24 voix.

GS

Standard GM étendu développé par Roland inc.

Hiérarchique (menu)

Menus structurés où un choix surligné dans un menu ouvre un 
autre menu.

Horloge Midi

Petit message Midi pour les signaux d’horloge (Clock). Voir 
également SPP

Hyper set

Toutes les définitions d’événement sont affichées simultané-
ment dans le Hyper Editor.

Icône

Petit symbole graphique. Dans Logic, une icône peut être assi-
gnée aux objets de l’environnement.

indicateur de position

Unités: Mesure, pulsation, sous-divisons (également nommées 
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plus simplement divisions dans ce manuel), et pas d’horloge.



Instrument

représentation dans Logic d’une réelle source de son ou d’un 
module de synthétiseur. 

Legato

méthode de jeu qui consiste à relier une note avec la suivante.

Ligne d’information

Ligne d’affichage se trouvant en haut de la fenêtre qui vous 
donne la position des objets lors de l’utilisation des outils de la 
souris.

Local (menu)

Menu se trouvant dans une fenêtre contenant des fonctions qui 
concernent une fenêtre particulière.

Local Off

Utilisation d’un synthétiseur Midi avec un clavier où ce dernier 
(local) ne joue pas directement son propre son intégré. Ceci est 
très utile lors de l’utilisation d’un clavier maître dans une confi-
guration Midi avec un séquenceur.

Locators (gauche et droit)

Ce sont deux positions de song programables qui définissent 
les limites du cycle dans la fenêtre Transport. Les locators 
peuvent être également utilisés pour définir une zone à éditer 
par certaines fonctions.

Loop

Répétition constante d’un objet, jusqu’à l’objet suivant de la 
même piste, ou bien jusqu’à la fin du folder ou du song 
courant(e) (le premier des deux qui est atteint).
Gl - 8
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Mémoire virtuelle

Zone du disque dur qui peut être utilisée comme extension de 
la mémoire RAM. Le gros désaventage de son utilisation est 
son long temps d’accès. 

Menu déroulant

C’est un menu de sélection qui s’ouvre lorsque vous saisissez la 
boîte d’entrée d’un paramètre.

Midi (Musical Instrument Digital Interface)

Interfaçe série et asynchrone standard basée sur les évene-
ments. destinée aux instrument musicaux électroniques.

Mise à jour (update)

1. Nouvelle version révisée et améliorée d’un programme

2. Dans le mode automation de mixeur dans Logic, c’est le fait 
de remplacer les enciennes données d’automation par les 
nouveaux enregistrements des contrôleurs existants.

Mode Multi Midi

C’est un mode d’utilisation multi-timbre d’un module de son 
Midi dans lequel différents sons peuvent être contrôlés de 
manière polyphonique sur différents canaux Midi. Un module 
de son en mode multi fonctionne comme les modules polypho-
niques. le General Midi prescrit un mode multi à 16 parties 
(c’est à dire l’abilité de contrôler 16 différentes parties indivi-
duellement). Les générateurs de son les plus modernes sont 
adressés grâce à plusieurs intruments.

Modulation

Généralement, c’est une variation continuelle de modification 
de la tonalité. le Standard Midi est le contrôleur n°1, transmit 
au clavier par la molette de contrôle décentrée (ou par l’utilisa-
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tion du joystick vertical).



MTC

c’est l’abréviation de Midi Time Code (code temporel Midi). 
C’est la traduction du signal SMPTE en Midi standard.

Normalize

1. Cette fonction appelle les réglages du paramètre de lecture 
(playback) actuel pour les événements sélectionnés (en alté-
rant les événements actuels eux-mêmes), et efface les réglages 
du paramètre de lecture.

2. (en audio): Cette fonction augmente le volume d’un fichier 
audio enregistré au niveau numérique maximum sans pour 
autant altérer la dynamique.

Numéro de note (note#)

C’est le ton d’une note Midi contrôlé par le premier octet d’un 
événement de note Midi.

Objet

Pour la fenêtre Arrange, c’est un terme général qui regroupe les 
folders et les séquences. Dans l’environnement, ce terme est 
également utilisé pour les instruments, les faders, les mixeurs, 
les claviers, les moniteurs, les objets audio, etc.

Objet de piste (Track object)

Objet de l’environnement défini dans la colonne de piste de la 
fenêtre Arrange affichant l’instrument assigné à la piste corres-
pondante.

Octets de données

Ils définissent le contenu d’un message Midi. Le premier 
d’entre eux représente la note ou bien le numéro de contrôleur, 
et le second la vélocité ou bien la valeur du contrôleur.
Gl - 10
Emagic
Logic Audio Pro ISIS 

Option

C’est une fonction alternative, le plus souvent sous la forme 
d’une boîte de validation (checkbox).



l
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Gl

Ix
Paramètres de lecture

Ce sont les paramètres Quantization, transposition, vélocity, 
compression et delay qui n’altèrent pas les données mémorisées 
mais affectent plus particulièrement la façon dont les événe-
ments sont joués.

Pitch bend (message)

Message Midi transmit par une molette de Pitch Bend d’un 
clavier.

Pixel

C’est un point de matrice d’écran. C’est l’abréviation de Picture 
Element.

pointeur de position

C’est la ligne verticale se trouvant dans les fenêtres Arrange, 
Matrix et Score qui indique la position courante du song. Elle 
peut être saisie par la souris et déplacée.

Police

Style de caractère d’écriture.

Post fader

C’est un effet positionné après le fader dans le cheminement 
du signal, c’est à dire que le niveau d’un signal routé en post 
fader à un auxiliaire est modifié lorsque le fader est déplacé. 
Les envois aux. Post fader sont généralement utilisés pour les 
effets (tels que la Reverb) afin que le niveau de ces effets soit 
modifié avec le niveau du canal, et pour que le ratio Original/
Effet du signal reste constant. 

P-Press

Ceci signifie  «Polyphonic key pressure», ou autrement dit l’after-
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touch. c’est un type de commande rare et comprenant beau-
coup de données, mesurant la pression exercée sur chaque 



touche individuellement. De nombreux claviers possèdent des 
capteurs pour la pression polyphonique.

Pre fader

C’est un effet positionné avant le fader dans le cheminement 
du signal, c’est à dire que le niveau d’un signal routé en pre 
fader à un auxiliaire n’est pas modifié lorsque le fader est 
déplacé. Les envois aux. Post fader sont généralement utilisés 
pour les mix d’écoute afin que le niveau de ces effets dans les 
casques ou les écoutes ne change pas lorsque les niveaux sont 
modifiés dans la salle de contrôle.

Préférences

Ce sont les réglages mémorisables pour un programme.

Punch (Punch In, Punch Out)

Permet d’effectuer ou d’arrêter un enregistrement d’une 
section déja enregistrée (non vierge).

Quantification

Cette opération consiste en une correction automatique de 
position temporelle des notes en les déplaçant au point le plus 
proche de la grille de quantification sélectionnée.

Raccourci clavier

Fonction pouvant être exécutée en utilisant une (ou plusieurs) 
touche(s) spécifique(s).

Région

C’est une zone sélectionnée d’un fichier audio qui est enregis-
trée dans la fenêtre Audio pour l’utilisation dans une song, et 
pouvant être placé dans la fenêtre Arrange sur les pistes audio, 
tout comme une séquence peut être placée sur les pistes Midi. 
Gl - 12
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La région peut être de la taille du fichier audio entier, ou 
simplement une portion. Une région est crée automatiquement 
après chaque enregistrement audio.
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Règle de mesure

C’est simplement la règle se situant en haut de l’écran qui est 
divisée en unité de mesure.

Replace

C’est un mode d’utilisation ou tout nouvel enregistrement 
remplace le précédent (comme les enregistreurs cassette).

Rubber band (lasso)

Technique de sélection qui consiste à cliquer et maintenir ainsi 
la souris, et effectuer un «lasso» pour sélectionner un groupe 
d’objets adjacents.

Screenset

C’est l’emplacement de mémorisation pour la forme des diver-
ses fenêtres de Logic. Chaque song de Logic peut mémoriser 
un maximum de 90 screensets.

Scrubbing

Sur les machines à bande magnétique, c’est l’action de déplacer 
la bande manuellement sur la tête de lecture. Pour un séquen-
ceur, c’est le fait de déplacer manuellement le pointeur de posi-
tion, provoquant la lecture des événements Midi.

Séquence

C’est une collection des événements Midi qui est montrée 
dans la fenêtre Arrange comme barre horizontale avec un nom.

SMF

Abréviation de «Standard Midi File».C’est un format de fichier 
standard pour l’échange de songs  entre différents séquenceurs 
ou lecteurs de fichiers Midi.
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SMPTE

Standard pour le codage temporel utilisé pour synchroniser 
différentes machines. Il y a six formats. SMPTE signifie 



«Society of Motion Picture and Television Engineers». ce code 
spécifie la position du compteur d’une horloge SMPTE. Il est 
exprimé en Heures, minutes, secondes et frames. La variation 
Midi du SMPTE est le MTC.

Source sonore

Terme général pour le synthétiseur, l’échantillonneur, la boîte à 
rythme, le piano numérique, etc. contrôlables par Midi.

SPP, pointeur de position de song

C’est un type spécifique de message Midi qui donne la distance 
à partir du début de la song  en 1/16 de notes, et qui est transmis 
avec l’horloge Midi.

Statut (octet de)

C’est le premier octet dans un message Midi qui détremine le 
type de message.

Subframe

C’est une subdivision d’une frame SMPTE, correspondant aux 
bits individuels d’une frame. Une frame  est constituée de 80 
bits.

Swing

Paramètre qui altére le temps rigide d’une grille de quantifica-
tion en décalant toute autre note d’une sous-division spécifiée 
d’une valeur pouvant être définie.

Synchronisation

C’est une méthode pour verrouiller plusieurs machines d’enre-
gistrement ou de lecture sur un unique comptage de temps.

Synchroniseur
Gl - 14
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Système de messages exclusifs Midi

les SysEx forment la partie hiérarchique supérieure des 
commandes Midi. Ces messages sont inscrits avec un numéro 
d’identification correspondant à chaque constructeur (le 
numéro d’identification (ID) du constructeur du SysEx). Le 
contenu de ces commandes Midi dépend du constructeur. Ils 
sont utilisés pour transférer l’intégralité des programmes de son 
et/ou les configurations du système, et pour l’adressage des 
paramètres individuels utilisés dans la génération du son ou 
dans le calcul du signal. Les programmes d’édition (tels que le 
SoundDiver d’Emagic) transmettent et recoivent les messages 
SysEx des machines Midi, vous permettant de programmer ces 
appareils sur votre ordinateur.

Tick (pas d’horloge)

C’est la plus petite division dans la mesure du temps. elle se 
rapporte donc directement au signal de l’horloge. Dans Logic, 
elle représente 1/3840 de note. Le termepas d’horloge est donc 
couramment utilisé dans ce manuel.

Timing

mesure de la capacité à jouer les notes dans le temps juste.

Toggle

basculer entre deux états (fenêtres, valeurs de paramètres,etc.).

Undo

Fonction permettant d’annuler l’opération précédente.

Update

voir «mise à jour»

Vélocité
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C’est la force avec laquelle une note Midi est frappée. la vélo-
cité est contrôlée par le deuxième octet d’un événement de 
note.



View

Menu local avec les options d’affichage.

*.WAV (fichier)

Format de fichiers audio du système d’exploitation Windows 
95/98.

WYSIWYG

abréviation pour «What You See Is What You Get». C’est l’habilité 
d’un programme à afficher précisément ce qui va apparaître 
lorsque l’on imprime, c’est à dire le mode de visualisation de 
page de la fenêtre Score de Logic.

XG

Standard General Midi étendu de Yamaha, compatible avec 
Roland GS.

Zero Crossing 

C’est un point dans un fichier audio ou la forme du signal croise 
l’axe d’amplitude zéro. Si vous coupez un fichier audio à un 
Zero Crossing il n’y aura pas de click au point de coupe.

Zoom (fonction)

Réduit ou élargit l’affichage des fenêtres de Logic.
Gl - 16
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